
R A D I A N C E K I T

Benutzerhandbuch

Photorealistische 3D-Rekonstruktion
via Gaussian Splatting

Version 1.5.0 · macOS 26.0+ · Mai 2026

B J O E R N  K I N D L E R  ·  K I N D L E R - D E V. D E



I N H A LT

Übersicht

Einleitung — Was du wissen solltest . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠3
Was ist RadianceKit? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠3
Was ist Gaussian Splatting? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠3

Kapitel 1 — Menüleiste . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠5
File-Menü . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠6
Mode-Menü . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠9
Training-Menü . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠11
Viewport-Menü . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠14
Export-Menü . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠20
Help-Menü . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠25
Hinweis: Cmd-Z im Edit-Menü . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠29
Tastatur-Kurzbefehle in der Übersicht . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠30

Kapitel 2 — Inspector (Expert View) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠31
Look-Sektion (L1–L5) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠34
Presets-Sektion (I1–I11) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠37
Trainingskonfiguration-Sektion (I12–I22) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠43
Enhancements-Sektion (I26–I29, I42–I44) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠49
Metriken-Sektion (I30–I38) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠56
Verlust-Diagramm-Sektion (I39–I41) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠62
Wann nach Inspector greifen? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠65

Kapitel 3 — Einstellungen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠67
General-Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠68
AI-Helpers-Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠73
Inspector-Spiegel-Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠76
Wann was? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠77

Kapitel 4 — Aux-Fenster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠78
User Guide (W1–W4) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠79
Keyboard Shortcuts (W5–W6) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠82
Manage Storage (W7–W12) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠84
Pareto Dashboard (W13–W22) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠88
Holdout Analysis (W23–W29) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠95
BayesOpt Console (W30–W39) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠100
Hauptfenster: Verlustverlauf und Gaussian-Count (I39–I41, Querverweis) . . . . . . . . . . . . . ⁠108
Faustregel-Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠109

Kapitel 6 — Trainings-Konfiguration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠110
Iteration (T1–T2) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠112
Learning Rates (T3–T10) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠114



Densification — Classic (T11–T16) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠121
Loss (T17–T20) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠126
SH-Degree-Progression (T21) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠130
Performance (T22–T25) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠131
Diagnose und Punktwolken-Vorbereitung (T26–T30) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠133
Regularisierung (T31–T37) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠136
Refinement (T38–T44) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠139
Sky-Dome (T45–T48) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠144
Adam + LR-Schedule (T49–T55) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠146
Post-Processing + Apple AI (T56–T60) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠150
MCMC-Densification (T61–T73) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠152
Mip-Splatting (Q1.5) (T74–T76) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠159
Adaptive Densification (Q5) (T77–T79) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠161
Curriculum (Q6) (T80–T81) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠162
Statische Presets (TP1–TP9) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠163
Methode: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠166
Welches Feld wofür? (Cheat-Sheet) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠167
Gefährliche Felder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠168

Kapitel 7 — Eingebaute Qualitäts-Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠169
Wann welches Preset? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠179
Schnell-Vergleich . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠180
Eigene Presets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠182

Kapitel 8 — Export-Formate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠183
Welches Format wann? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠197
Schnell-Vergleich . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠198

Kapitel 9 — SfM-Backends . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠199
Welches Backend wann? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠205
Schnell-Vergleich . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠205

Kapitel 10 — Einsteiger-Modus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠206
Z1 — Import (Bilder & Preset wählen) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠206
Z2 — Verarbeitung (SfM + Training) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠215
Z3 — Vorschau (3D-Modell drehen) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠222
Z4 — Export (Format wählen & speichern) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠226
Wechsel zu Expert-Modus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠231
Häufige Fragen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ⁠232



L E S E H I L F E

So liest du dieses Handbuch

Jeder Eintrag im Handbuch folgt demselben Schema. Auf der linken Seite stehen die 
Bedienpfade und technischen Details, rechts in einem warmen Seitenkasten findest du 
immer die einfache Erklärung. Kleine Icons am Zeilenanfang verraten dir auf einen Blick, 
welche Art von Information jetzt folgt.

D I E  V I E R  I C O N S

Wo finde ich das? Der konkrete Klickpfad durch die App — Menüleiste, Inspek
tor-Sektion oder Einsteiger-Modus-Schritt. Auch die zugehörigen Tastatur-Kurz
befehle stehen hier. Das Icon ist ein Karten-Pin und zeigt: Hier sitzt die Funktion 
in der Benutzeroberfläche.

Details. Standardwerte, Wertebereiche und Code-Pfade. Begegnet dir vor allem 
bei den Trainingseinstellungen, die kein Menü-Eintrag sind, sondern Zahlen-Pa
rameter. Das Icon zeigt eine kleine Spezifikations-Karte.

Technisch. Was die Funktion intern tut, welche Parameter wirken, worauf sie re
agiert und welche Nebenwirkungen sie hat. Für Leser, die verstehen wollen, was 
im Hintergrund passiert. Das Icon ist ein Schieberegler-Block und steht symbo
lisch für die Stellschrauben unter der Haube.

Einfach gesagt. Die Kernaussage in klaren Worten — ohne Fachsprache, ohne 
Code. Lies diesen Abschnitt zuerst, wenn du nur schnell wissen willst, wofür 
eine Funktion da ist und wann du sie brauchst. Das Icon ist eine Sprechblase 
und steht für „auf den Punkt gebracht„. Diese Spalte ist immer in einem warmen 
Sand-Ton hinterlegt, damit das Auge sie sofort findet.

K A P I T E L- FA R B E N

Jedes Kapitel hat eine eigene Akzentfarbe, die du an der ID-Marke (zum Beispiel M1 ) 
links neben jedem Eintragstitel und an den kleinen Icons davor wiedererkennst. Beim 
Blättern siehst du so sofort, in welchem Kapitel du gerade bist.

1 Menüleiste 2 Inspektor 3 Settings 4 Hilfsfenster 6 Training

7 Vorlagen 8 Exporte 9 SfM 10 Einsteiger



T I P P S  Z U R  N AV I G AT I O N

Schnell-Start. Wenn dich nur die Bedienung interessiert, springe direkt zu Kapi
tel 10 — Einsteiger-Modus. Das ist die geführte Variante mit vier Schritten und 
braucht keinerlei Vorwissen.

Tieferer Einstieg. Kapitel 2 — Inspektor und Kapitel 7 — Vorlagen erklären die 
Bedienelemente und voreingestellten Qualitäts-Profile, die du im Experten-Modus 
zur Verfügung hast.

Nachschlagen. Inhaltsverzeichnis und PDF-Volltextsuche helfen, eine bestimmte 
Funktion zu finden. Du musst das Handbuch nicht von vorn nach hinten lesen.



R A D I A N C E K I T

K A P I T E L

Einleitung — Was du wissen solltest

Was ist RadianceKit?

RadianceKit ist eine native macOS-App, die aus einer Reihe normaler Fotos oder einem 
Video eine begehbare 3D-Rekonstruktion macht. Die Eingabe sind beispielsweise 50 bis 
500 Aufnahmen, die du um ein Objekt herum, durch einen Raum oder über eine Land
schaft gemacht hast. Die Ausgabe ist eine sogenannte Gaussian-Splatting-Szene — ein 
3D-Modell, das du am Mac in Echtzeit aus jeder Perspektive ansehen kannst, das sich 
exportieren und auf Webseiten einbetten lässt und das in den Hauptaspekten photoreal 
aussieht.

Die App läuft komplett lokal auf deinem Mac — es werden keine Bilder in die Cloud 
hochgeladen, kein Login wird verlangt, kein Abo. Sie nutzt die GPU deines Apple-
Silicon-Macs (M-Serie) intensiv: ein vollständiges Training kann je nach Szene und 
Preset zwischen zwei Minuten und mehreren Stunden dauern. Während der Berechnung 
kannst du am Mac ganz normal weiterarbeiten, RadianceKit läuft im Hintergrund weiter 
und meldet sich, wenn das Ergebnis fertig ist.

Es gibt zwei Bedien-Modi: der Einsteiger-Modus (Simple Mode) führt dich in vier Schrit
ten durch den Workflow Import → Vorlagen wählen → Training → Export. Der Experten-
Modus (Expert Mode) öffnet einen großen Inspector mit allen Stellschrauben, einem 
Live-Vorschau-Fenster und Diagnose-Charts. Du kannst jederzeit zwischen den Modi 
wechseln; die Daten in der Szene bleiben dabei erhalten.

Was ist Gaussian Splatting?

Gaussian Splatting (oft kurz 3DGS oder einfach Splatting) ist eine relativ neue Methode 
für photorealistische 3D-Darstellung, vorgestellt 2023 in einem Paper aus Graz und 
INRIA. Die Idee: statt eine Szene als klassisches Polygonnetz (Dreiecke) oder als 
Voxel-Grid zu modellieren, wird sie aus Millionen kleiner, weicher 3D-Wölkchen zusam
mengesetzt — jede einzelne Wolke ist eine 3D-Gaußverteilung (daher der Name) mit 
eigener Position, Größe, Form, Farbe und Durchsichtigkeit. Diese Wölkchen werden so 
trainiert, dass sie aus allen Blickwinkeln deiner Eingabe-Fotos zusammen das richtige 
Bild ergeben.
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R A D I A N C E K I T Einleitung — Was du wissen solltest

Praktisch heißt das: Gaussian Splatting kann Reflexionen, Glanzlichter, weiches Laub, 
Haare oder Vorhänge so darstellen, wie klassisches 3D-Modellieren es nicht oder nur 
mit immensem Aufwand kann. Im Gegenzug ist das Ergebnis kein editierbares 3D-
Modell im klassischen Sinn — du kannst nicht einfach eine einzelne Wand verschieben 
oder eine Vase umsetzen. Es ist eher eine gefrorene Aufnahme des Raumes, durch 
die du dich frei bewegen kannst. Für viele Anwendungen — Architektur- Visualisierung, 
Produkt-Präsentation, virtuelle Touren, Forensik, Kulturerbe — ist genau das die richtige 
Stärke.

Damit aus den Eingabe-Bildern eine 3D-Szene wird, sind zwei Schritte nötig. Zuerst 
rechnet die App über ein Verfahren namens Structure-from-Motion (SfM) aus, wo deine 
Kamera bei jedem Foto gestanden hat. Dabei entsteht nebenbei eine grobe Punkt-
Wolke der Szene. Dann startet das eigentliche Gaussian-Splatting-Training: ausgehend 
von dieser groben Wolke werden die Millionen 3D-Wölkchen schrittweise verteilt, 
vergrößert, verfeinert und in Position und Farbe nachjustiert, bis sie aus allen Eingabe-
Blickwinkeln das passende Bild ergeben.

Du musst von beidem nichts wissen, um RadianceKit zu benutzen. Der Einsteiger-
Modus blendet diese Schritte komplett aus. Aber wenn du verstehen möchtest, was 
die Diagnose-Zahlen im Experten-Modus (Iteration, Loss, Gaussians, SSIM …) bedeuten 
oder warum manche Szenen schöner werden als andere, dann findest du in den späte
ren Kapiteln des Handbuchs die Antworten.
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R A D I A N C E K I T Einleitung — Was du wissen solltest

K A P I T E L

Kapitel 1 — Menüleiste

Die Menüleiste von RadianceKit gliedert alle Funktionen, die nicht unmittelbar im 
Hauptfenster oder im Inspector liegen. Das sind in erster Linie Aktionen, die auf die 
ganze Szene wirken (Öffnen, Speichern, Neues Projekt), das Training steuern (Start, 
Pause, Fortsetzen), den Viewport bedienen (Auto-Rotation, Screenshot, Hintergrundfar
be) und Exporte in verschiedene 3D- und Medien-Formate auslösen. Dazu kommen 
Sprungpunkte zu allen Hilfsfenstern (User Guide, Pareto Dashboard, Holdout Analysis, 
BayesOpt Console).

Tastatur-Kurzbefehle stehen jeweils rechts vom Menüeintrag. Konventionen: ⌘  bedeu
tet die Command-Taste (Apfel-Taste), ⇧  ist Shift, ⌥  ist Option (Alt) und ⌃  ist Control. 
Beispiel: ⇧⌘T  steht für Shift+Command+T. Alle hier dokumentierten Kurzbefehle sind 
über Help → Keyboard Shortcuts (⌘/​) zusätzlich in einem eigenen Übersichtsfenster 
aufgelistet.

Die folgenden 42 Einträge sind in der Reihenfolge der Inventur (M1–M42) dokumen
tiert, gruppiert nach dem zugehörigen Top-Level-Menü. Alle Einträge wurden gegen 
den aktuellen Code-Stand in (Zeilen 175–477) verifiziert. Keine Einträge sind entfernt 
oder gegenüber der Inventur überholt; ein neuer Edit-Menü-Eintrag (Cmd-Z für „Remo
ve Image„) wird durch das System-NSUndoManager-Framework aufgenommen und 
erscheint daher nicht im RadianceKitApp-Code (siehe Hinweis am Ende des Kapitels).
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File-Menü

Abbildung 1:  Ablage-Menü aufgeklappt — Einträge M1 bis M6

Das File-Menü ersetzt Apples Standard-„New Window„-Eintrag durch projektspezifi
sche Aktionen. Es umfasst Szenen laden/speichern, eine dynamische Recent-Liste, den 
Workspace-Import sowie das harte Zurücksetzen auf einen Leerzustand.

M1 File > Open Scene…

WO

Menüleiste → File → Open Scene… (⌘O).

T E C H N I S C H

Öffnet einen Datei-Dialog für die Forma
te RadianceScene -Bundle, .ply , .splat  und 
.spz . Single-Selection, kann sowohl Dateien als 

auch Verzeichnisse zeigen (für das Bundle-Format). 
Nach erfolgreicher Auswahl wird der Pfad in die 
Recent-Liste eingetragen und die Szene asynchron 
geladen — die vorherige wird ersetzt und die 
Trainings-Pipeline mit dem geladenen Stand initiali
siert. PLY/SPZ/Splat-Dateien werden über die jewei
ligen Format-Loader gelesen; das .radiancescene
-Bundle ist ein Verzeichnis mit Manifest, Cloud-
Snapshot und SfM-Resultaten.

E I N FAC H  G E S AG T

So lädst du eine bereits trai­
nierte Szene wieder in die App. 
Funktioniert mit dem Radiance­
Kit-eigenen Format und mit den 
Standardformaten PLY, SPLAT 
und SPZ, die andere Splatting-
Programme erzeugen. Verwende 
das, wenn du z. B. eine Sze­
ne über Nacht trainiert hast 
und am nächsten Tag weiter­
machen oder exportieren willst. 
Beim Öffnen wird der bisherige 
Stand im Hauptfenster ersetzt — 
speichere also vorher, wenn dir 
die aktuelle Szene noch wichtig 
ist. Der Pfad landet automatisch 
in „Open Recent„ (M3), damit 
du beim nächsten Mal schneller 
dran kommst.
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M2 File > Save Scene…

WO

Menüleiste → File → Save Scene… (⌘S).

T E C H N I S C H

Öffnet einen Datei-Speichern-Dialog mit dem Con
tent-Type RadianceScene -Bundle und vorausge
fülltem Dateinamen scene.radiancescene. Schreibt 
ein Verzeichnis-Paket mit manifest.json , der se
rialisierten Gaussian-Cloud (PLY-Snapshot) und ei
nem Dump des SfM-Resultats, sodass nach dem 
Wiederöffnen auch das Continue-Training funktio
niert. Der Eintrag ist deaktiviert, solange noch 
keine Gaussians existieren. Speichert nicht in 
den Training-Logs-Pfad, sondern dorthin, wo der 
Speichern-Dialog zeigt — typischerweise unter ~/​
Documents/​.

E I N FAC H  G E S AG T

Speichert deine aktuelle Szene 
als Datei (genauer: als Paket-
Ordner, der wie eine Datei aus­
sieht). Erst danach kannst du 
diese Szene später mit „Open 
Scene…„ (M1) wieder öffnen. Im 
Paket landen sowohl die Gaus­
sian-Cloud als auch das SfM-Re­
sultat, sodass du auch Continue-
Training (M12–M14) später noch 
anhängen kannst. Solange du 
noch kein Training abgeschlos­
sen hast, ist der Eintrag aus­
gegraut. Der Standardname ist 
scene.radiancescene — du 
kannst aber im Save-Dialog einen 
eigenen Namen vergeben.

M3 File > Open Recent > [Szenennamen]

WO

Menüleiste → File → Open Recent → (Liste).

T E C H N I S C H

Dynamisches Submenü, das aus einer Liste der zu
letzt geöffneten Pfade (in den Einstellungen gespei
chert) generiert wird. Jeder Listen-Eintrag wird mit 
dem Dateinamen benannt und bei Klick geladen. 
Wenn die Liste leer ist, erscheint stattdessen das 
deaktivierte Label „No Recent Scenes„. Apple-ty
pisch hält die Liste die N zuletzt geöffneten Szenen 
— die Begrenzung findet beim Schreiben in die Ein
stellungen statt und nicht im Menü-Builder selbst.

E I N FAC H  G E S AG T

Hier siehst du die zuletzt geöff­
neten Szenen und kannst mit 
einem Klick wieder reinspringen, 
ohne über den Datei-Dialog ge­
hen zu müssen. Wenn du gerade 
erst angefangen hast, ist die Lis­
te leer und steht grau im Menü. 
Jede Szene, die du über „Open 
Scene…„ (M1) öffnest, landet au­
tomatisch in dieser Liste. Wenn 
dir die Liste irgendwann zu voll 
wird oder du sie aus Daten­
schutzgründen leeren willst, nut­
ze „Clear Recent“ (M4).
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M4 File > Open Recent > Clear Recent

WO

Menüleiste → File → Open Recent → Clear Recent.

T E C H N I S C H

Leert die Recent-Liste in den Einstellungen. Wirkt 
sofort, ohne Bestätigungsdialog. Der Eintrag er
scheint nur dann im Submenü, wenn überhaupt Ein
träge in der Recent-Liste vorhanden sind (er steht 
unter einem Divider nach den Pfaden).

E I N FAC H  G E S AG T

Löscht die Liste der zuletzt 
geöffneten Szenen. Praktisch, 
wenn du mit einem Test-Daten­
satz herumgespielt hast und die 
Pfade nicht mehr sehen willst. 
Die Szenen-Dateien selbst wer­
den dabei nicht gelöscht — nur 
die Verknüpfung im Menü. Die 
Aktion wirkt sofort, ohne Rück­
frage; danach erscheint im Sub­
menü „No Recent Scenes„. Der 
Eintrag taucht nur dann auf, 
wenn überhaupt Szenen in der 
Liste sind — bei leerer Liste ist er 
nicht sichtbar.

M5 File > Import COLMAP / Metashape Workspace…

WO

Menüleiste → File → Import COLMAP / Metashape 
Workspace… (⇧⌘I).

T E C H N I S C H

Öffnet einen Ordner-Picker. Erwartet einen Ord
ner mit dem COLMAP-Workspace-Layout (z. B. 
sparse/​0/​cameras.{bin,txt} plus images/​). Nach 
Auswahl wird eine Vorprüfung des Workspace 
durchgeführt — diese erkennt die drei Layouts 
(sparse/​0/​, sparse/​, Root) und ob die Recon
struction binär ( cameras.bin ) oder als ETH3D-
Text ( cameras.txt ) vorliegt. Bei Erfolg wird der 
Workspace importiert; andernfalls erscheint nur ei
ne Warnung im App-Log. Siehe auch Kapitel 9 
„SfM-Backends„, Q6 für die volle Pipeline-Logik.

E I N FAC H  G E S AG T

Wenn du Metashape, COLMAP, 
RealityCapture oder eine ähnli­
che Software für die Kamerare­
konstruktion benutzt und einen 
Export hast, lädst du den Ord­
ner hier rein. RadianceKit über­
springt dann die SfM-Stufe und 
startet direkt mit dem Trai­
ning — das spart bei großen 
Szenen Stunden. Drag-and-Drop 
auf das Hauptfenster funktio­
niert genauso. Erwartet wird ein 
Ordner mit COLMAP-Layout (al­
so sparse/​0/​ mit cameras.*  
plus images/​-Ordner). Mehr zu 
den unterstützten Layouts und 
Workflows steht in Kapitel 9 
„SfM-Backends„.
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M6 File > New Project

WO

Menüleiste → File → New Project (⇧⌘N).

T E C H N I S C H

Prüft, ob ungesicherte Arbeit vorhanden ist. Falls 
ja, erscheint ein Bestätigungsdialog, bevor irgend
etwas verloren geht. Wenn nichts zu speichern ist, 
läuft das Zurücksetzen direkt — es leert importierte 
Bilder, das SfM-Resultat, die Gaussian-Cloud, Trai
ning-State und alle abhängigen UI-Indikatoren. Ach
tung: Eine vom Nutzer angelegte Preset-Bibliothek 
bleibt erhalten, weil sie in den App-Einstellungen 
und nicht im Projektstand liegt.

E I N FAC H  G E S AG T

Setzt alles zurück auf einen lee­
ren Start — als ob du die 
App gerade frisch geöffnet hät­
test. Wenn du noch ungesicherte 
Arbeit hast, fragt die App vor­
her nach. Verwende das, wenn 
du mit einer ganz anderen Sze­
ne anfangen willst. Importier­
te Bilder, SfM-Resultat, Gaussi­
an-Cloud und Trainings-Zustand 
werden komplett geleert. Deine 
eigenen Presets bleiben aber er­
halten, weil die in den App-Ein­
stellungen liegen und nicht zur 
Szene gehören.

Mode-Menü

Abbildung 2:  Modus-Menü mit Simple- und Expert-Mode-Schalter

Zwei einfache Schalter zwischen dem geführten Simple Mode (Wizard-artig, 4 Schritte) 
und dem vollen Expert Mode (klassisches Inspector-Layout mit allen Reglern).

9 / 233



R A D I A N C E K I T Kapitel 1 — Menüleiste

M7 Mode > Simple Mode

WO

Menüleiste → Mode → Simple Mode (⌘1).

T E C H N I S C H

Schaltet den App-Zustand auf den Simple Mode 
um. Der Hauptbereich der App zeigt dann den ge
führten Workflow statt des Expert-Layouts. Der Mo
de-Zustand wird in den Einstellungen gespeichert 
(siehe S1 „Default Mode„ in Kapitel 3 Settings).

E I N FAC H  G E S AG T

Schaltet auf die Schritt-für-
Schritt-Variante um, bei der dich 
die App durch Importieren, Ver­
arbeiten, Vorschau und Export 
führt. Empfohlen, wenn du ge­
rade erst anfängst oder schnell 
ein Ergebnis brauchst. Die meis­
ten Detail-Regler sind ausge­
blendet — du arbeitest mit sinn­
vollen Voreinstellungen. Wenn du 
später tiefer einsteigen willst, 
wechsle einfach in den Expert 
Mode (M8). Welcher Modus beim 
App-Start aktiv ist, kannst du in 
den Einstellungen (Kapitel 3, S1) 
festlegen.

M8 Mode > Expert Mode

WO

Menüleiste → Mode → Expert Mode (⌘2).

T E C H N I S C H

Schaltet den App-Zustand auf den Expert Mode. 
Damit erscheint das volle Inspector-Layout mit allen 
Sections (Presets, TrainingConfig, Enhancements, 
Metrics, LossChart, ProjectNavigator). Im Expert 
Mode sind sämtliche Training-Parameter, COLMAP-
Picker, Mid-Compact-Toggles und Diagnostics zu
gänglich. Auch der Live-Preview funktioniert nur in 
diesem Modus.

E I N FAC H  G E S AG T

Schaltet in die Vollansicht mit 
allen Reglern. Hier siehst du 
Loss-Charts in Echtzeit, kannst 
alle Parameter feinjustieren und 
mehrere Vergleichs-Configs par­
allel über Presets verwalten. 
Empfohlen, wenn du verstehen 
willst, was das Training intern 
macht, oder wenn du gezielt 
experimentieren möchtest. Auch 
die Live-Preview, COLMAP-Picker 
und die Diagnostics sind nur hier 
zugänglich. Wenn du dich über­
fordert fühlst, geh über M7 zu­
rück in den Simple Mode — deine 
Szene bleibt dabei erhalten.
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Training-Menü

Abbildung 3:  Training-Menü mit Continue-Submenü — Einträge M9 bis M14

Vier Aktionen rund um den Trainings-Lauf: starten, pausieren, abbrechen und um eine 
vorgegebene Iterationszahl verlängern. Alle drei Continue-Einträge sind über IAP-gega
ted (in der Free-Trial-Version nicht klickbar).

M9 Training > Start Training

WO

Menüleiste → Training → Start Training (⇧⌘T).

T E C H N I S C H

Startet die Trainings-Pipeline asynchron. Vorausset
zung: ein SfM-Resultat liegt vor und es läuft gerade 
keine andere Pipeline. Beide Bedingungen blockie
ren den Eintrag, falls nicht erfüllt. Beim Start wer
den die aktuellen Konfigurations-Werte gelesen, ein 
neuer JSONL-Log unter ~/​Documents/​RadianceKit/​
Logs/​training_​YYYY-MM-DD_​HHmmss.jsonl angelegt, 
und je nach Strategie-Wahl der klassische oder der 
MCMC-Pfad gefahren. Der Trainings-Zustand wech
selt von „idle„ auf „training“.

E I N FAC H  G E S AG T

Drückt den großen grünen Knopf 
— sobald du Fotos importiert 
hast und die Kamera-Rekon­
struktion durch ist, beginnt da­
mit das eigentliche Gaussian-
Splatting-Training. Lass die App 
laufen; je nach Preset zwischen 
1 Minute (Quick) und mehre­
ren Stunden (MCMC Quality). 
Der Eintrag bleibt grau, solange 
noch kein SfM-Ergebnis vorliegt 
oder gerade eine andere Pipeline 
läuft. Jeder Lauf schreibt neben­
bei ein Log nach ~/​Documents/​
RadianceKit/​Logs/​, das du 
später über das Pareto Dash­
board (M40) auswerten kannst.
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M10 Training > Pause Training

WO

Menüleiste → Training → Pause Training.

T E C H N I S C H

Pausiert das laufende Training. Wird nur freige
schaltet, wenn der Trainings-Zustand „training„ ist. 
Pausieren stoppt den Iterations-Loop am nächsten 
Sicherheits-Sync-Point, behält den vollen GPU-Sta
te (Gaussian-Buffers, Optimizer-Moments, Schedu
ler-Position) und schaltet auf „paused“. Resume 
erfolgt über erneutes Drücken (der Eintrag-Titel ist 
statisch — die App wechselt aber zwischen Pause/
Resume in der eigentlichen Logik). Pausierte Trai
nings überleben kein App-Quit; in dem Fall stattdes
sen die Szene speichern und später per Continue-
Training-Eintrag (M12–M14) erweitern.

E I N FAC H  G E S AG T

Hält das Training kurz an, oh­
ne den Fortschritt zu verlieren. 
Praktisch, wenn du den Compu­
ter kurz für etwas Wichtigeres 
brauchst. Nochmal klicken setzt 
fort. Funktioniert nicht über 
App-Neustarts hinweg — wenn 
du wirklich später weitermachen 
willst, beende das Training mit 
Cancel (M11), speichere die Sze­
ne mit Save Scene (M2) und 
nutze danach Continue Training 
(M12–M14). Während der Pause 
ruht die GPU vollständig; der 
Speicher bleibt aber belegt.

M11 Training > Cancel Training

WO

Menüleiste → Training → Cancel Training.

T E C H N I S C H

Bricht das laufende Training ab. Aktiv, wenn der 
Trainings-Zustand nicht „idle„ ist. Setzt den Can
cel-Flag in der Trainings-Engine, was den Iterati
ons-Loop am nächsten Sync-Point sauber beendet, 
den finalen Summary-Eintrag mit ins JSONL-Log 
schreibt und den Zustand auf „idle“ zurücksetzt. 
Die bisher trainierte Cloud bleibt erhalten (kann 
gespeichert oder exportiert werden), wird aber als 
„cancelled„ markiert.

E I N FAC H  G E S AG T

Bricht das laufende Training end­
gültig ab. Der bisherige Stand 
bleibt — wenn du also nach ein 
paar tausend Iterationen schon 
ein vorzeigbares Ergebnis hast, 
kannst du es danach trotzdem 
exportieren. Wenn du nur kurz 
unterbrechen willst, nutze statt­
dessen Pause (M10). Im Trai­
nings-Log wird der Lauf als „can­
celled„ markiert, der finale Loss-
Wert wird trotzdem mit weg­
geschrieben. Eine abgebrochene 
Szene kannst du auch über Con­
tinue Training (M12–M14) später 
fortsetzen, solange die App nicht 
zwischendurch beendet wurde.
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M12 Training > Continue Training > +5 000 iterations

WO

Menüleiste → Training → Continue Training → 
+5,000 iterations.

T E C H N I S C H

Setzt das Training um 5 000 Iterationen fort. Ak
tiv, wenn ein abgeschlossenes Training fortsetzbar 
ist und die Vollversion freigeschaltet ist. Die Fort
setzbarkeit gilt, wenn ein abgeschlossenes Training 
existiert und der volle Optimizer-State noch im 
Speicher steckt. Beim Continue werden die Adam-
Momente und der LR-Scheduler weitergeführt, so
dass die Fortsetzung sich verhält wie ein durchge
hender 25K-/45K-/60K-Lauf statt eines Neustarts. 
Der JSONL-Log bekommt einen neuen Config-Ein
trag mit dem inkrementellen Setup. Nur in der Voll
version verfügbar.

E I N FAC H  G E S AG T

Hängt 5 000 weitere Trainings-
Schritte an. Verwende das, wenn 
das Ergebnis nach dem ersten 
Lauf nahe dran, aber noch nicht 
ganz scharf ist. Funktioniert nur 
in der bezahlten Vollversion. Im 
Unterschied zu einem komplett 
neuen Lauf bleibt der Optimi­
zer-Zustand erhalten, sodass die 
Fortsetzung sich anfühlt wie ein 
durchgängiger Lauf. Wenn du 
mehr als 5 000 Schritte brauchst, 
nimm gleich M13 (+10 000) oder 
M14 (+20 000).

M13 Training > Continue Training > +10 000 iterations

WO

Menüleiste → Training → Continue Training → 
+10,000 iterations.

T E C H N I S C H

Identisch zu M12, aber mit 10 000 zusätzlichen 
Iterationen. Gleiche Vorbedingungen, gleicher LR-
Scheduler-Pfad. Empfohlen, wenn das initiale Trai
ning mit einem Mid-Tier-Preset gefahren wurde 
und du eine signifikante Qualitätssteigerung sehen 
willst, ohne den Lauf komplett neu zu starten.

E I N FAC H  G E S AG T

Verlängert das Training um 10 
000 Schritte — der mittlere der 
drei verfügbaren Continue-Wer­
te. Gute Wahl, wenn der erste 
Lauf zwar okay war, du aber 
noch klar besser werden willst. 
Wie auch M12 und M14 wird der 
Lernraten-Verlauf nahtlos fort­
gesetzt, statt neu zu starten. Nur 
in der Vollversion verfügbar.
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M14 Training > Continue Training > +20 000 iterations

WO

Menüleiste → Training → Continue Training → 
+20,000 iterations.

T E C H N I S C H

Identisch zu M12 / M13, aber mit 20 000 zu
sätzlichen Iterationen. Der größte vorgegebene 
Continue-Sprung. Bei MCMC-Trainings ist das oft 
das, was den Unterschied zwischen „passt„ und 
„benchmark-tauglich“ macht; bei Classic ab 35–40K 
kommt erfahrungsgemäß wenig dazu.

E I N FAC H  G E S AG T

Hängt 20 000 zusätzliche Trai­
nings-Schritte an, der maxima­
le Continue-Wert. Verwende das, 
wenn du wirklich das letzte 
Quäntchen Qualität rausholen 
willst. Bei klassischem Training 
nach 40 000 Schritten bringt das 
oft nicht mehr viel — bei MCMC 
dagegen lohnt es sich häufig, 
weil dort die Konvergenz lang­
samer einsetzt. Rechne je nach 
Szene mit deutlicher Mehrlauf­
zeit. Wie M12 und M13 ist auch 
dieser Eintrag nur in der Vollver­
sion verfügbar.

Viewport-Menü

Abbildung 4:  Ansichtsfenster-Menü mit Edit-Mode, Kamera-Steuerung und Hintergrund-
Submenü

Steuert den 3D-Viewport: Edit-Mode für Gaussian-Selektion und Cleanup, Kamera-
Steuerung (Auto-Rotation, Playback, Recording), Screenshot, Hintergrundfarbe und 
Reset.
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M15 Viewport > Enter/Exit Edit Mode

WO

Menüleiste → Viewport → Enter Edit Mode (oder 
„Exit Edit Mode„, je nach Zustand). ⇧⌘E.

T E C H N I S C H

Der Eintrag-Titel ist dynamisch und zeigt je nach 
Zustand „Exit Edit Mode„ oder „Enter Edit Mode“. 
Beim Drücken wird der Edit-Mode auf dem View
port-Renderer umgeschaltet. Beim Verlassen des 
Edit Modes wird zusätzlich die aktuelle Auswahl 
zurückgesetzt. Der Edit Mode aktiviert die Klick-
Selection auf Gaussians, die Box-Selection und das 
Löschen markierter Gaussians (siehe Editor-Bereich 
der UI). Deaktiviert solange kein Viewport-Renderer 
angeschlossen ist.

E I N FAC H  G E S AG T

Schaltet zwischen normaler 3D-
Ansicht und einem Bearbei­
tungsmodus um, in dem du ein­
zelne Gaussians markieren und 
löschen kannst (etwa Floater 
oder Ausreißer im Hintergrund). 
Beim Verlassen wird die Auswahl 
automatisch zurückgesetzt. Der 
Eintrag bleibt grau, solange noch 
keine Szene im Viewport sichtbar 
ist. Die Beschriftung wechselt je 
nach Zustand zwischen „Enter 
Edit Mode„ und „Exit Edit Mode“ 
— du siehst also immer, in wel­
chem Modus du gerade bist.

M16 Viewport > Toggle Auto-Rotation

WO

Menüleiste → Viewport → Toggle Auto-Rotation 
(⌘⌥T).

T E C H N I S C H

Schaltet die kontinuierliche Rotation der Viewport-
Kamera um eine vertikale Achse durch das Szenen-
Zentrum an oder aus. Die Achse und Geschwindig
keit kommen aus der Kamera-Steuerungs-Konfigu
ration. Auto-Rotation ist ein reiner Viewport-Effekt 
und beeinflusst weder Training noch Recording — 
wenn du parallel den Turntable-Video-Recorder be
nutzt (M18), liefert die Auto-Rotation aber genau 
den Pfad, den der Recorder einfängt.

E I N FAC H  G E S AG T

Dreht die Kamera dauernd lang­
sam um deine Szene, damit 
du sie von allen Seiten sehen 
kannst, ohne mit der Maus zu 
ziehen. Nochmal klicken stoppt 
die Rotation. Praktisch beim Be­
gutachten fertig trainierter Sze­
nen oder als Hintergrund-Anima­
tion für eine Live-Demo. Wenn 
du parallel ein Video aufnimmst 
(M18), liefert die Auto-Rotation 
genau die Bewegung, die der Re­
corder einfängt.
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M17 Viewport > Toggle Camera Playback

WO

Menüleiste → Viewport → Toggle Camera Playback.

T E C H N I S C H

Schaltet den Kamera-Pfad-Playback um. Wenn ein 
aufgezeichneter Kamera-Pfad existiert (z. B. aus 
einem vorhergehenden Recording oder weil eine 
transforms.json  geladen wurde), läuft der Pfad 

ab — die Viewport-Kamera bewegt sich also nicht 
mehr nach Maus-/Trackpad-Eingaben, sondern re
produziert die Trajektorie Frame für Frame. Erneu
tes Drücken pausiert den Playback.

E I N FAC H  G E S AG T

Lässt eine vorher aufgezeichne­
te oder importierte Kamerafahrt 
ablaufen. So kannst du den Origi­
nalpfad nachvollziehen, mit dem 
die Szene aufgenommen wurde, 
oder eine geplante Orbit-Bewe­
gung vor dem Video-Export prü­
fen. Während der Playback läuft, 
sind Maus- und Trackpad-Einga­
ben deaktiviert — die Kamera 
folgt strikt dem Pfad. Erneutes 
Klicken pausiert die Wiedergabe. 
Wenn du keinen Kamerapfad ge­
laden oder aufgezeichnet hast, 
passiert nichts.

M18 Viewport > Record Turntable Video

WO

Menüleiste → Viewport → Record Turntable Video.

T E C H N I S C H

Schaltet die Viewport-Aufnahme um. Beim ersten 
Drücken startet eine Frame-Aufzeichnung in einen 
temporären Pfad; beim zweiten Drücken wird die 
Aufnahme beendet, encodiert und in einen MP4-
Pfad geschrieben (Pfad wird über einen Speichern-
Dialog abgefragt). Im Unterschied zum Export → 
Media → Orbit Video (M31), das einen festen 360°-
Pfad bei einer einstellbaren Dauer erzeugt, nimmt 
der Turntable-Recorder live das auf, was du im 
Viewport siehst — du kannst also auch eine manuel
le Kamerafahrt aufnehmen.

E I N FAC H  G E S AG T

Nimmt direkt im Viewport ein 
Video auf. Egal ob die Kame­
ra automatisch dreht oder ob 
du sie selbst mit der Maus be­
wegst — alles, was du siehst, 
wird in eine MP4-Datei gespei­
chert. Im Unterschied zum „Or­
bit Video„-Export (M31) gibst du 
selbst die Kamerafahrt vor. Ers­
tes Klicken startet die Aufnahme, 
zweites Klicken beendet sie und 
fragt dich nach dem Speicherort. 
Praktisch, wenn du z. B. einen 
bestimmten Detail-Schwenk zei­
gen willst, der mit der starren Or­
bit-Bewegung nicht möglich wä­
re.
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M19 Viewport > Save Screenshot

WO

Menüleiste → Viewport → Save Screenshot (⇧⌘S).

T E C H N I S C H

Erfasst einen einzelnen Viewport-Frame in voller 
Render-Auflösung (also nicht das Fenster-Pixel-
Layout, sondern den vollen Render-Target-Inhalt) 
als PNG-Datei. Der Pfad wird über einen Speichern-
Dialog abgefragt. Hintergrundfarbe (M21–M23) wird 
mit eingebrannt. MetalFX-/MPS-Upscaling-Einstel
lungen aus den Enhancements (siehe I27/I28) wir
ken sich aus, wenn aktiv — der Screenshot zeigt 
also den hochskalierten Output.

E I N FAC H  G E S AG T

Speichert einen Schnappschuss 
deiner aktuellen 3D-Ansicht als 
PNG-Bild. Praktisch für Marke­
ting-Material oder einen schnel­
len Vergleich. Beachte: Der Hin­
tergrund ist Teil des Bildes — 
falls du Transparenz brauchst, 
exportiere lieber eine Szenen-
Datei. Die Auflösung entspricht 
dem internen Render-Target, 
nicht deiner Fenstergröße — das 
Bild ist also oft schärfer, als 
es im Fenster aussieht. Etwaige 
Upscaling-Einstellungen (Inspec­
tor → Enhancements) fließen 
ebenfalls mit ein.

M20 Viewport > Copy Camera Info

WO

Menüleiste → Viewport → Copy Camera Info.

T E C H N I S C H

Liest die aktuelle Viewport-Kamera-Pose (Position, 
Look-At-Punkt, Up-Vektor) und die FOV-Werte aus 
der Kamera-Steuerung und schreibt sie als Mehr
zeilen-Text in die Zwischenablage. Format ist men
schenlesbar (label = value je Zeile), nicht JSON. 
Praktisch, um eine spezifische Ansicht zu Debug-
Zwecken zu reproduzieren oder mit dem Support zu 
teilen.

E I N FAC H  G E S AG T

Kopiert die aktuelle Kamera-Po­
sition und Blickrichtung als Text 
in die Zwischenablage. Wenn du 
z. B. einem Mitentwickler zeigen 
willst, von wo aus eine Stelle 
in der Szene komisch aussieht, 
fügst du den Text einfach in eine 
Mail oder ein Chat-Fenster ein. 
Das Format ist menschenlesbar 
(eine Zeile pro Wert), kein JSON. 
Hauptsächlich für Bug-Reports 
oder Support-Anfragen gedacht.
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M21 Viewport > Background > Dark Gray

WO

Menüleiste → Viewport → Background → Dark Gray.

T E C H N I S C H

Setzt die Viewport-Hintergrundfarbe auf ein dunk
les Grau (RGB 0.1/0.1/0.1). Der Renderer verwendet 
diese Farbe als Hintergrund, vor dem die Gaussi
ans composited werden. Die Default-Farbe bei App-
Start steuert die Settings-Option S3 „Default View
port Background„.

E I N FAC H  G E S AG T

Färbt den Hintergrund des 3D-
Viewports dunkelgrau. Standard­
wahl für die meisten Szenen — 
bietet einen guten Kontrast zu 
hellen wie dunklen Gaussians, 
ohne dass das Auge sich an einer 
reinen Schwarz- oder Weißfläche 
festkrallt. Die Farbe wird auch in 
Screenshots (M19) und Orbit-Vi­
deos (M31) übernommen. Wenn 
dir Dark Gray zu unspektakulär 
ist, probier zum Vergleich auch 
Black (M22) oder White (M23). 
Welche Farbe beim App-Start ak­
tiv ist, kannst du in den Einstel­
lungen (S3) festlegen.

M22 Viewport > Background > Black

WO

Menüleiste → Viewport → Background → Black.

T E C H N I S C H

Setzt die Viewport-Hintergrundfarbe auf reines 
Schwarz (RGB 0/0/0). Hilft, falls die Szene viele hel
le Floater hat und du sie identifizieren willst, oder 
für Marketing-Material mit dunklem Look-and-Feel.

E I N FAC H  G E S AG T

Schwarzer Hintergrund. Gut für 
sehr helle Szenen oder wenn du 
in den Edit Mode hineinschau­
en willst und kleine helle Gaus­
sians (Floater) suchst, die im 
Grau untergehen. Auch ideal für 
Marketing-Material mit dunklem, 
dramatischem Look. Die Farbe 
wird in Screenshots und Orbit-
Videos eingebrannt — wenn du 
Transparenz für einen späteren 
Composit brauchst, ist Schwarz 
die schlechteste Wahl. Für dunk­
le Floater wechsle nochmal in 
die andere Richtung auf White 
(M23).

18 / 233



R A D I A N C E K I T Kapitel 1 — Menüleiste

M23 Viewport > Background > White

WO

Menüleiste → Viewport → Background → White.

T E C H N I S C H

Setzt die Viewport-Hintergrundfarbe auf reines 
Weiß (RGB 1/1/1). Nützlich, wenn die Szene überwie
gend dunkle Inhalte hat und du dunkle Floater (typi
sches Outdoor-Hintergrund-Rauschen) sehen willst.

E I N FAC H  G E S AG T

Weißer Hintergrund. Praktisch, 
wenn das Motiv hell-auf-dunkel 
besser zur Geltung kommt, oder 
um dunkle Ausreißer zu finden, 
die du danach im Edit Mode 
(M15) entfernen kannst. Bei Out­
door-Szenen ist Weiß oft nützli­
cher als Schwarz, weil die typi­
schen Outdoor-Floater eher dun­
kel sind. Wie bei den anderen 
Hintergrund-Optionen wird die 
Farbe in Screenshots und Videos 
übernommen.

M24 Viewport > Reset Camera

WO

Menüleiste → Viewport → Reset Camera.

T E C H N I S C H

Setzt die Viewport-Kamera zurück, verlässt die Trai
ning-Camera-Ansicht und stoppt die Auto-Rotation. 
Damit ist die Kamera zurück auf der initialen Po
sition (typisch: vor der Szene, leicht von oben bli
ckend), die Auto-Rotation ist aus, und falls der Ren
derer gerade die Training-Camera (eine der SfM-
Posen) anzeigte, geht er zur Free-Camera zurück.

E I N FAC H  G E S AG T

Bringt die Viewport-Kamera in 
die Startposition zurück. Wenn 
du dich beim Rumdrehen verirrt 
hast oder die Szene aus dem 
Bild geschoben hast — einmal 
hier klicken und du siehst wie­
der, was du sehen solltest. Schal­
tet gleichzeitig die Auto-Rotation 
aus, falls die gerade läuft, und 
kehrt aus einer eingefrorenen 
Training-Kamera in die freie An­
sicht zurück. So bekommst du in 
jedem Fall einen sauberen Neu­
start der Ansicht.
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Export-Menü

Abbildung 5:  Exportieren-Menü mit drei Submenü-Gruppen — 3D Formats, Media und Pho
togrammetry

Acht Export-Ziele plus zwei Photogrammetry-Exporte, gruppiert in drei Sections (3D 
Formats, Media, Photogrammetry). Die ersten sechs werden über eine gemeinsame 
Helper-Routine gebaut, die jeweils einen Speichern-Dialog öffnet und den Export am 
Format-Katalog registriert. Die Photogrammetry-Einträge haben individuelle Logik. Alle 
Photogrammetry- und manche 3D-Exporte sind nur in der Vollversion verfügbar.

M25 Export > 3D Formats > Export PLY…

WO

Menüleiste → Export → 3D Formats → PLY (⌘E).

T E C H N I S C H

Öffnet einen Speichern-Dialog mit Vorgabe-Datei
namen gaussians.ply . Bei OK wird die aktuelle 
Gaussian-Cloud ins standardisierte ASCII/Binary-
PLY-Format geschrieben — kompatibel mit SuperS
plat, PolyCam, PlayCanvas und allen gängigen 
3DGS-Viewern. Volle SH-Koeffizienten, volle Präzi
sion (Float32 pro Feld). Datei-Größe oft mehrere 
hundert MB bei ≥ 500K Gaussians.

E I N FAC H  G E S AG T

Speichert deine 3D-Szene als 
Standard-PLY-Datei. Das ist das 
universellste Format — fast jede 
Software kann das laden, von Su­
perSplat über PolyCam bis Play­
Canvas. Die Dateien werden al­
lerdings groß, oft mehrere hun­
dert Megabyte. Verwende PLY, 
wenn du in voller Qualität weiter­
machen oder archivieren willst. 
Wenn du die Szene per Web 
teilen willst, schau dir lieber 
SPZ (M27) oder Compressed PLY 
(M26) an — die sind wesentlich 
kleiner.

20 / 233



R A D I A N C E K I T Kapitel 1 — Menüleiste

M26 Export > 3D Formats > Export Compressed PLY…

WO

Menüleiste → Export → 3D Formats → Compressed 
PLY.

T E C H N I S C H

Schreibt die Gaussian-Cloud im Compressed-PLY-
Format mit Custom-Quantisierung der Position-, 
Scale-, Rotation- und SH-Felder. 5–10× kleinere 
Dateien als das unkomprimierte PLY (M25) bei 
minimalen visuellen Verlusten. Kompatibel mit Su
perSplat (das den Compressed-PLY-Standard liest) 
und PlayCanvas. Standard-Dateiname gaussians_​
compressed.ply.

E I N FAC H  G E S AG T

Wie das normale PLY, aber 5–
10 Mal kleiner. Die Qualität bleibt 
fast gleich. Verwende das, wenn 
du die Datei online teilen willst 
oder per E-Mail verschickst. 
Funktioniert direkt mit SuperS­
plat und PlayCanvas. Wenn dein 
Zielsystem aber noch kleinere 
Dateien braucht (Mobile, Brow­
ser-Demos), nimm stattdessen 
SPZ (M27) — das ist nochmal ag­
gressiver komprimiert. Für volle 
Bearbeitungs-Qualität nimm das 
unkomprimierte PLY (M25).

M27 Export > 3D Formats > Export SPZ…

WO

Menüleiste → Export → 3D Formats → SPZ.

T E C H N I S C H

Schreibt die Gaussian-Cloud im SPZ-Format — das 
von Niantic veröffentlichte komprimierte Splat-For
mat mit aggressiver Quantisierung (~90 % kleiner 
als unkomprimiertes PLY). Vor allem für Web-Viewer 
und mobile Apps optimiert. Kompatibel mit Niantic 
Splatt3R, gsplat.js und dem Niantic-Browser-View
er.

E I N FAC H  G E S AG T

Eines der kleinsten Formate. Et­
wa 10× kleiner als ein normales 
PLY. Verwende das vor allem, 
wenn du die Szene in einem 
Browser zeigen oder per Handy-
App betrachten willst. Für maxi­
male Qualität ist PLY die bessere 
Wahl. SPZ ist von Niantic ent­
wickelt und funktioniert direkt 
mit gsplat.js, Splatt3R und dem 
Niantic-Web-Viewer. Wegen der 
starken Komprimierung kannst 
du SPZ-Dateien nicht mehr ohne 
Weiteres weitertrainieren — für 
Bearbeitung nimm PLY.
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M28 Export > 3D Formats > Export glTF…

WO

Menüleiste → Export → 3D Formats → glTF.

T E C H N I S C H

Schreibt eine .glb -Datei (Binary-glTF) mit der 
KHR_gaussian_splatting-Extension. Standard-kon
form, geeignet für Pipelines, die glTF-Engines 
wie Babylon.js oder Three.js verwenden und die 
KHR_gaussian_splatting-Extension implementieren.

E I N FAC H  G E S AG T

Speichert die Szene im glTF-
Format, das viele 3D-Programme 
und Web-Engines verstehen — 
vorausgesetzt, sie unterstützen 
die Gaussian-Splatting-Erweite­
rung. Wenn du eine spezifische 
3D-Pipeline hast (z. B. Three.js 
oder Babylon.js), die das ver­
steht, ist das dein Format. Die 
Datei kommt als binäres .glb  
raus — ein einzelnes Paket, 
das alles enthält. Für klassische 
Splatting-Workflows ist meistens 
PLY oder SPZ die bessere Wahl, 
weil mehr Tools die direkt verste­
hen.

M29 Export > 3D Formats > Export .splat…

WO

Menüleiste → Export → 3D Formats → .splat.

T E C H N I S C H

Schreibt das Antimatter15- .splat -Format — fixed-
size 32 Bytes pro Gaussian (Position als 3× Float32, 
Scale als 3× Float32, Rotation als 4× Uint8 nor
malisierte Quaternion, RGB+Opacity als 4× Uint8). 
Keine SH-Koeffizienten höher als DC. Kleinste Datei 
mit Browser-Direkt-Kompatibilität. Für gsplat.js und 
antimatter15s Online-Demo-Viewer.

E I N FAC H  G E S AG T

Das simpelste Web-Viewer-For­
mat. Klein und sofort in jedem 
Browser anzeigbar. Verliert aber 
die Detail-Beleuchtung (höhere 
SH-Koeffizienten gehen verloren 
— der Splat sieht aus jedem 
Blickwinkel gleich aus, statt auf 
das Licht zu reagieren). Für 
maximale Web-Performance gut, 
für Foto-Realismus eher SPZ 
oder PLY. Funktioniert mit dem 
antimatter15-Online-Viewer und 
gsplat.js. Jede Gaussian belegt 
fix 32 Bytes, was das Format 
simpel und kompatibel macht — 
aber eben um den Preis der De­
tailtiefe.
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M30 Export > 3D Formats > Export SOG…

WO

Menüleiste → Export → 3D Formats → SOG.

T E C H N I S C H

Schreibt die Gaussian-Cloud im SOG-Format. SOG 
(„Self-Organizing Gaussian„) ist das PlayCanvas-
Format mit Texture-Atlas-Layout und WebP-Kompri
mierung der quantisierten Daten. Skaliert mit 15–
20× besserem Größenverhältnis als PLY. Der Export 
ruft intern cwebp  als externes Werkzeug auf — da
her in der Sandbox-Variante (App Store) potenziell 
eingeschränkt.

E I N FAC H  G E S AG T

Sehr kleines Format für Play­
Canvas-Workflows. Etwa 15–20 
Mal kleiner als PLY, weil die Da­
ten in ein Texture-Atlas-Layout 
gepackt und WebP-komprimiert 
werden. Wenn du keinen Play­
Canvas-Workflow hast, ist SPZ 
oder Compressed PLY meist die 
bessere Wahl. Der Export ruft in­
tern cwebp  als externes Werk­
zeug auf — in der App-Store-
Version (Sandbox) kann dieser 
Schritt eingeschränkt sein.

M31 Export > Media > Export Orbit Video…

WO

Menüleiste → Export → Media → Orbit Video.

T E C H N I S C H

Rendert einen 360°-Orbit um das Szenen-Zentrum 
und encodiert ihn als MP4 (H.264) oder MOV 
(HEVC, je nach System-Default). Im Unterschied zu 
M18 (Live-Recording) ist der Pfad hier fest vorge
geben — Dauer wird in den Settings bzw. im Simple-
Mode-Export-Step gewählt.

E I N FAC H  G E S AG T

Erzeugt automatisch ein Drehvi­
deo um deine Szene. Kein ma­
nuelles Bewegen nötig. Gut für 
Social Media oder eine schnel­
le Demo. Wenn du die Kamera 
selbst steuern willst, nutze statt­
dessen Record Turntable Video 
(M18). Der Pfad ist fest: ein voller 
360°-Orbit um das Szenen-Zen­
trum, Dauer wählst du in den Ein­
stellungen oder im Simple-Mode-
Export-Step. Das Video wird je 
nach System als H.264-MP4 oder 
HEVC-MOV ausgegeben.
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M32 Export > Media > Export Web Viewer…

WO

Menüleiste → Export → Media → Web Viewer.

T E C H N I S C H

Verpackt einen Standalone-HTML-Viewer (gsplat.js-
basiert) plus die Gaussian-Daten Base64-kodiert in 
eine einzige .html -Datei. Diese Datei läuft offline 
in jedem modernen Browser — keine Server-Abhän
gigkeiten, keine externen URLs. Datei-Größe ist 
etwa Faktor 1.3 größer als die SPZ-Variante (wegen 
Base64-Overhead).

E I N FAC H  G E S AG T

Speichert deine Szene als selbst-
startende Webseite. Doppelklick 
auf die HTML-Datei → Browser 
öffnet sich → fertige interakti­
ve 3D-Szene. Funktioniert ohne 
Internet, lässt sich per Mail ver­
schicken, ist die einfachste Art, 
das Ergebnis mit Freunden oder 
Kunden zu teilen. Die Datei ent­
hält den kompletten gsplat.js-
Viewer und die Gaussian-Daten 
in einem einzigen Dokument — 
nichts wird aus dem Web nach­
geladen. Datei-Größe ist etwa ein 
Drittel größer als ein SPZ-Export, 
dafür brauchst du beim Empfän­
ger keine zusätzliche Software.

M33 Export > Photogrammetry > Export SfM (transforms.json)…

WO

Menüleiste → Export → Photogrammetry → Export 
SfM (transforms.json).

T E C H N I S C H

Eigener Export-Pfad (nicht über die gemeinsame 
Helper-Routine), weil keine Gaussian-Cloud, son
dern das SfM-Resultat exportiert wird. Öffnet einen 
Speichern-Dialog mit transforms.json  als Vorga
be und Content-Type json . Bei OK wird eine 
nerfstudio-kompatible transforms.json  mit Kame
ra-Intrinsics, Posen (als 4×4-Matrix in NeRF-Kon
vention) und Frame-Pfaden geschrieben. Hilfetext 
im UI weist darauf hin, dass die Trainings-Bilder 
als Geschwister-Ordner images/​ mitkopiert werden 
müssen. Aktiv nur, wenn ein SfM-Resultat vorliegt 
und die Vollversion freigeschaltet ist.

E I N FAC H  G E S AG T

Wenn du das SfM-Ergebnis 
in einer anderen Software 
wie nerfstudio, Brush, gsplat 
oder OpenSplat weiterverwen­
den willst, exportierst du hier 
die Kamera-Positionen. Lege dei­
ne Trainings-Bilder zusätzlich 
in einen images/​-Ordner ne­
ben der transforms.json -
Datei — sonst kann das Zielpro­
gramm die Bilder nicht zuord­
nen. Der Eintrag ist ausgegraut, 
solange noch kein SfM-Ergebnis 
existiert, und in der Free-Trial-
Version gesperrt. Für den COL­
MAP-Workspace-Workflow nimm 
stattdessen M34.
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M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

WO

Menüleiste → Export → Photogrammetry → Export 
SfM (COLMAP Workspace).

T E C H N I S C H

Öffnet einen Speichern-Dialog mit Vorgabe-Na
me colmap-workspace  (ohne Extension, weil 
es ein Ordner ist). Schreibt einen Standard-
COLMAP-Workspace mit sparse/​0/​cameras.bin, 
images.bin , points3D.bin . Erlaubt es, eine in Ra

dianceKit gerechnete oder importierte SfM-Rekon
struktion in andere Tools wie Postshot, Nerfstudio 
oder Meshroom zu öffnen, oder bei einem A/B-Re-
Run als bereits-gerechnete Eingabe in RadianceKit 
selbst (über M5) wieder zu laden — spart Rechen
zeit. Aktiv nur, wenn ein SfM-Resultat vorliegt und 
die Vollversion freigeschaltet ist.

E I N FAC H  G E S AG T

Wie M33, aber im COLMAP-For­
mat statt nerfstudio. Wenn du 
Postshot, Meshroom, Nerfstudio 
oder ein anderes Tool mit COL­
MAP-Workflow benutzt, ist das 
dein Export. Ein praktischer Ne­
beneffekt: Du kannst diesen Ord­
ner später per M5 in Radiance­
Kit zurückladen und dir die SfM-
Rechenzeit beim nächsten Lauf 
sparen — gerade bei großen Sze­
nen ein Zeitgewinn von Stunden. 
Wie M33 nur verfügbar, wenn ein 
SfM-Ergebnis vorliegt, und in der 
Free-Trial-Version gesperrt.

Help-Menü

Abbildung 6:  Hilfe-Menü mit Dokumentations-, Ordner- und Analyse-Einträgen

Sieben Einträge: zwei Dokumentations-Fenster (User Guide, Keyboard Shortcuts), drei 
Ordner-Shortcuts (Training Logs, Exports, Storage), und drei Analyse-Fenster (Pareto 
Dashboard, Holdout Analysis, BayesOpt Console). Apple-typisch erscheint das Help-
Menü ganz rechts. Das Standard-Help-Menü wird komplett durch die RadianceKit-eige
ne Variante ersetzt.
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M35 Help > User Guide

WO

Menüleiste → Help → User Guide (⌘?).

T E C H N I S C H

Öffnet das User-Guide-Fenster. Es zeigt eine Navi
gation mit Themen-Sidebar und Scroll-Detailbereich 
bei Default-Größe 860×640. Die Inhalte sind sta
tisch hinterlegt (nicht aus Markdown geparsed).

E I N FAC H  G E S AG T

Öffnet die App-interne Anlei­
tung. Wenn du nicht alles in 
diesem Manual nachlesen willst, 
findest du dort die wichtigsten 
Schritte direkt im Programm. Die 
Anleitung ist als eigenes Fens­
ter mit Themen-Sidebar aufge­
baut — du kannst also gezielt 
zu einzelnen Themen springen. 
Die Inhalte sind kürzer als die­
ses Handbuch und konzentrieren 
sich auf die häufigsten Work­
flows.

M36 Help > Keyboard Shortcuts

WO

Menüleiste → Help → Keyboard Shortcuts (⌘/).

T E C H N I S C H

Öffnet das Keyboard-Shortcuts-Fenster — ein 
einfaches Scroll-Layout mit allen App-Kurzbefeh
len, gruppiert nach Top-Level-Menü. Default-Größe 
440×560. Inhalte sind ebenfalls statisch hinterlegt.

E I N FAC H  G E S AG T

Öffnet ein Fenster mit der kom­
pletten Liste aller Tastatur-Kurz­
befehle. Wenn du dir z. B. nicht 
merken kannst, mit welcher Tas­
te man das Training startet, 
schaust du da rein. Eine Zusam­
menfassung steht auch am En­
de dieses Kapitels. Die Liste ist 
nach Top-Level-Menü gruppiert, 
sodass du schnell zum richtigen 
Bereich springst. Hilfreich, wenn 
du dich gerade vom Maus- auf 
den Tastatur-Stil umstellst.
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M37 Help > Open Training Logs…

WO

Menüleiste → Help → Open Training Logs… (⇧⌘L).

T E C H N I S C H

Berechnet den Log-Ordner als ~/​Documents/​
RadianceKit/​Logs, legt ihn falls nötig an und öff
net ihn in Finder. Jeder Trainings-Lauf schreibt 
eine eigene JSONL-Datei training_​YYYY-MM-DD_​
HHmmss.jsonl dorthin.

E I N FAC H  G E S AG T

Öffnet im Finder den Ordner mit 
allen bisherigen Trainings-Proto­
kollen. Wenn etwas schief ge­
laufen ist oder du nachsehen 
willst, wann genau das Training 
auf welchen Wert konvergierte, 
findest du das hier in JSONL-
Dateien. Pro Trainings-Lauf wird 
genau eine Datei mit Zeitstempel 
angelegt — die kannst du auch 
in andere Tools einlesen oder per 
Mail an den Support schicken. 
Wenn du eine grafische Auswer­
tung willst, ist das Pareto Da­
shboard (M40) der bessere Ein­
stieg.

M38 Help > Open Exports Folder…

WO

Menüleiste → Help → Open Exports Folder…

T E C H N I S C H

Analog zu M37, aber mit ~/​Documents/​RadianceKit/​
Exports. Wird beim ersten Auto-Test-Lauf oder 
beim ersten Klick angelegt; danach landen dort 
die Standardpfade aller Auto-Test-Exporte (z. B. 
autotest_​<timestamp>.ply). Manuell über den Spei
chern-Dialog ausgewählte Exporte gehen NICHT 
zwingend hier rein, sondern wohin der Nutzer das 
speichert — daher ist dieser Ordner vor allem für 
Auto-Tests interessant.

E I N FAC H  G E S AG T

Öffnet den Ordner, in dem die 
App ihre eigenen Exporte ab­
legt (vor allem Auto-Test-Läufe). 
Wenn du einen Export manuell 
mit dem Speichern-Dialog woan­
ders hingelegt hast, ist er dort 
und nicht in diesem Ordner. 
Praktisch zum Aufräumen oder 
um nachzuschauen, wieviel Platz 
frühere Test-Exporte belegen. 
Wenn du einen kompletten Über­
blick inklusive Logs und Szenen-
Bundles brauchst, nimm statt­
dessen Manage Storage (M39).
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M39 Help > Manage Storage…

WO

Menüleiste → Help → Manage Storage…

T E C H N I S C H

Öffnet den Storage-Browser (siehe Kapitel 4 Auxi
liary Windows, IDs W7–W12). Listet alle persistier
ten Szenen, Trainings-Logs, Exporte und Caches 
im ~/​Documents/​RadianceKit/​-Ordner mit Größe, 
ermöglicht Reveal-in-Finder und Move-to-Trash pro 
Eintrag.

E I N FAC H  G E S AG T

Öffnet einen Fenster-Browser, 
der dir zeigt, wieviel Platz Radi­
anceKit auf deiner Platte belegt 
— pro Szene, Log und Export. Du 
kannst direkt einzelne Sachen lö­
schen, ohne in Finder gehen zu 
müssen. Praktisch nach länge­
rer Nutzung, wenn die Festplatte 
voll wird — frühere Logs und Au­
to-Test-Exporte können sich auf 
mehrere Gigabyte summieren. 
Per Reveal-in-Finder kommst du 
jederzeit auch zur klassischen 
Ansicht.

M40 Help > Pareto Dashboard…

WO

Menüleiste → Help → Pareto Dashboard… (⇧⌘D).

T E C H N I S C H

Öffnet das Pareto-Dashboard (siehe Kapitel 4, 
IDs W13–W22). Das Dashboard lädt alle JSONL-
Trainings-Logs aus ~/​Documents/​RadianceKit/​Logs/​
, ordnet sie nach Szene und Preset und zeichnet 
einen Pareto-Scatter-Plot (Standard: Loss vs Gaus
sians, optional Loss vs Wallclock oder PSNR vs 
Iterationen).

E I N FAC H  G E S AG T

Öffnet eine Übersicht aller bis­
herigen Trainings-Läufe als Dia­
gramm. Du siehst sofort, welcher 
Lauf die beste Balance aus Qua­
lität und Größe geliefert hat. 
Praktisch, wenn du verschiedene 
Presets miteinander vergleichen 
willst. Standardmäßig zeigt das 
Diagramm Loss gegen Gaussian-
Anzahl — du kannst aber auch 
nach Wallclock-Zeit oder PSNR 
umschalten. Die Daten kommen 
aus den JSONL-Trainings-Logs 
(M37); je mehr Läufe du hast, 
desto aussagekräftiger wird die 
Auswertung.
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M41 Help > Holdout Analysis…

WO

Menüleiste → Help → Holdout Analysis… (⇧⌘H).

T E C H N I S C H

Öffnet das Holdout-Analyse-Fenster (siehe Kapitel 
4, IDs W23–W29). Lädt eine transforms.json , 
zeichnet die Kameras als 3D-Globe und erlaubt 
Train/Test-Fold-Splits (angular oder linear, 2–8 
Folds). Output ist eine fold-assignment.json, die 
das Training in den jeweiligen Trainings-Configs als 
Test-Set verwenden kann.

E I N FAC H  G E S AG T

Hilft dir, deine Kamera-Aufnah­
men in Trainings- und Test-Sets 
zu zerlegen — damit du ob­
jektiv messen kannst, wie gut 
deine Szene ist (auf Bildern, 
die das Training nicht gesehen 
hat). Eher ein Forschungs- und 
Benchmark-Werkzeug. Die Kame­
ras werden als 3D-Globe darge­
stellt; du kannst zwischen 2 und 
8 Folds wählen, entweder gleich­
mäßig im Winkel oder linear über 
die Reihenfolge. Das Resultat ist 
eine kleine JSON-Datei, die das 
Training dann als Test-Set ver­
wendet.

M42 Help > BayesOpt Console…

WO

Menüleiste → Help → BayesOpt Console… (⇧⌘B).

T E C H N I S C H

Öffnet die BayesOpt-Konsole (siehe Kapitel 4, IDs 
W30–W39). Lädt vordefinierte Such-Räume (z. B. 
„MCMC scale-reg + opacity-reg + ssim„), führt 
Bayesian-Optimization-Trials asynchron aus und 
zeigt Konvergenzkurve und Trial-Log live.

E I N FAC H  G E S AG T

Eine eingebaute Auto-Tuner-
Konsole. Statt manuell verschie­
dene Parameter durchzuprobie­
ren, kann die App das selbst über 
Nacht laufen lassen und dir am 
Ende die besten Werte für deine 
Szene vorschlagen. Sehr fortge­
schrittenes Werkzeug — für die 
meisten Workflows ist ein gutes 
Preset (siehe Kapitel 7) ausrei­
chend. Du wählst einen vordefi­
nierten Such-Raum (z. B. „MCMC 
scale-reg + opacity-reg + ssim„), 
und siehst live die Konvergenz­
kurve sowie das Trial-Log. Plane 
je nach Setup mehrere Stunden 
bis Tage ein.

Hinweis: Cmd-Z im Edit-Menü

Seit Mai 2026 unterstützt der Project Navigator im Expert Mode das Löschen impor
tierter Bilder per Minus-Button oder Backspace-Taste, und das Rückgängigmachen via 
Cmd-Z . Diese Cmd-Z-Aktion erscheint im macOS-Edit-Menü (das von SwiftUI bereitge

stellt wird) als „Undo Remove Image„, solange ein gelöschtes Bild noch wiederherstell
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bar ist. Sie wird über das standard-konforme -System registriert, nicht in ; daher gibt es 
keinen eigenen M-ID-Eintrag in der Inventur.

Tastatur-Kurzbefehle in der Übersicht

Menü-Eintrag Kurzbefehl

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Edit-Menü (system-bereitgestellt, im Expert Mode bei aktiver Project-Navigator-Aus
wahl):

Aktion Kurzbefehl

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete
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K A P I T E L

Kapitel 2 — Inspector (Expert View)

Abbildung 7:  Expert-Modus leer — Project Navigator links (Images 0, Cameras, Log), Empty-
Viewport mittig, Inspector rechts mit Presets/Training Configuration/Enhancements/Training 

Metrics-Sektionen

Leerer Inspector vor Import: Linke Sidebar zeigt Images-Counter 0 und Drop-Hint 
„Drop images here / or tap + to import„. Inspector rechts ist voll funktional, aber Presets 
sind nur informativ (kein aktives Training). Default-Preset „Preview“ (5K iters) ist mar
kiert. Camera-Alignment auf Apple Photogrammetry, Densification Classic, SSIM Weight 
0.20, Render Scale 50 %. Empty-States in Training Metrics („Start training to see live 
metrics„) und Loss History („Loss curve will appear during training“).
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Abbildung 8:  Inspector mit 60 flowers-Bildern geladen — Image-Sidebar zeigt erste Datei
namen frame_0001.jpg ff, Header „60 images ready„

Inspector nach Import: Header-Status „60 images ready„. Image-Sidebar listet alle 60 
importierten Frames ( frame_0001.jpg  bis frame_0945.jpg , jeder 16. Frame des 960-
Cam-Bouquet-Datasets als Subset für schnelle Iterationen). Auto-Render-Scale-Logik 
prüft die Bild-Auflösung (1536×2048 = 3.1 MP) und passt Render Scale entsprechend 
an. Play-Button (grün, unten links) ist jetzt aktiv und startet das Training mit dem 
aktiven Preset.

Abbildung 9:  Inspector mid-training — Live-Viewport zeigt flowers-Bouquet-Rekonstrukti
on, Metrik-Bar unten (Loss / LR / Gaussian-Count / Iterationen), Preset-Card „Preview„ mit 

„Modified“-Badge falls Parameter angepasst

Inspector während Training: Titel-Bar zeigt globalen Fortschritt „RadianceKit — Trai
ning NN %„. Viewport rendert die laufende Gaussian-Rekonstruktion in Echtzeit (alle 
50 Iterationen aktualisiert — Live-Preview-Intervall einstellbar in Settings → General 
→ Training → Live Preview). Metrik-Bar unter dem Viewport: aktueller Loss, Learning 
Rate, Gaussian-Count und Iterationen-Counter (z.B. 1,600/5,000 bei Preview-Preset). 
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Inspector-Preset-Card „Preview“ trägt „Modified„-Badge, sobald irgendein Parameter 
vom Built-in-Default abweicht. Sidebar „Log“ sammelt SfM- und Training-Stage-Events.

Abbildung 10:  Inspector nach Training-Abschluss — Viewport zeigt fertige flowers-Bouquet-
Rekonstruktion (2,991 Gaussians nach 5K Iterationen in 13s), Titel-Bar „Training Complete — 

2,991 Gaussians„

Inspector nach Training: Titel-Bar zeigt finale Gaussian-Anzahl (hier 2 991 — sehr 
kompakt, weil die synthetische Blender-Bouquet-Szene auf hellem Hintergrund einfa
che Geometrie hat). Viewport zeigt die fertige Punktwolke — orbitale Drag-Navigation 
aktiv (rotiert um den Szenen-Mittelpunkt). Training-Metrik-Sektion ist jetzt mit Final-
Werten gefüllt, Loss-History-Chart zeigt den Verlauf der gesamten 5 000 Iterationen. 
Export-Sektion unten ist jetzt aktiv (alle Format-Buttons enabled).

Der Inspector ist die rechte Seitenleiste im Expert Mode (⌘2). Er bündelt sämtliche trai
ningsrelevanten Parameter in sieben einklappbaren Sektionen. Die Default-Reihenfolge 
von oben nach unten beim ersten Start ist: Look, Presets, Trainingskonfiguration, Metri
ken, Verlust-Diagramm, Enhancements und Export. Die „Look„-Sektion (post-Training-
Bildanpassungen) ist die reale UI-Umbenennung der früheren „Finishing“-Sektion — 
ihr interner Enum- rawValue  bleibt aus Persistenz-Gründen „Finishing„, die angezeigte 
Überschrift heißt „Look“. Jede Sektion lässt sich per Klick auf den Header zuklappen, 
die Reihenfolge per Drag-and-Drop neu anordnen (InspectorView.swift:81-97). Beim 
ersten Start sind alle sieben Sektionen eingeklappt (inspectorCollapsedSections 
defaultet auf Set(InspectorSection.allCases)); der App-State speichert die Klapp- 
und Reihenfolge-Präferenzen danach über App-Starts hinweg.

Eine Reihe von Bedienelementen aus dem Inspector taucht in fast identischer Form 
auch in den Einstellungen (Kapitel 3) auf — typischerweise SfM-Backend, Sky-Masking 
und ähnliche Defaults. Die Trennung ist bewusst: Die Einstellungen liefern die App-
globale Vorlage für neu angelegte Projekte, der Inspector überschreibt diese Werte für 
das aktuell offene Projekt. Wer einmal die Bedienlogik der einen Seite kennt, kann die 
andere blind benutzen.

Die linke Spalte im Expert Mode — der Project Navigator — gehört nicht zum Inspector, 
ist aber sein direkter Nachbar. Dort lassen sich importierte Bilder per Klick auswählen, 
mit Leertaste in Quick-Look ansehen und über den Minus-Button oder die Entfernen-
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Taste löschen (mit Cmd-Z zum Rückgängigmachen). Der Inspector folgt der aktuellen 
Sidebar-Auswahl mit kontextspezifischen Detail-Informationen, die sieben Hauptsektio
nen bleiben aber immer verfügbar.

Look-Sektion (L1–L5)

Die Look-Sektion (interner rawValue  weiterhin „Finishing„) ist die oberste Inspector-
Sektion und sammelt die post-Training -Bildanpassungen an einem Ort. Alle Regler 
arbeiten nicht destruktiv: Jeder Slider wendet den FinishingPass  erneut auf einen 
unveränderten Pristine-Snapshot (Original-DC-Farbe, -Opacity, -Skalierung) an — die 
Anpassung ist damit idempotent, nicht kumulativ. Das Ergebnis erscheint live im View
port (WYSIWYG, exakt so wie der spätere Export) und wird in jeden Export eingeba
cken. Die Sektion ist erst nach Abschluss eines Trainings-Laufs verfügbar (vorher 
steht „Available after a training run completes.“); ihre Werte werden bei jedem neuen 
Training zurückgesetzt. Solange ein Export läuft, sind alle Regler gesperrt — ein 
Lock-Hinweis „Locked while exporting — the file uses the current settings.„ erscheint 
und die GroupBox ist disabled.

L1 Saturation-Slider

WO

Inspector → Look-Sektion → GroupBox → Saturati
on.

T E C H N I S C H

Slider 0.5–1.2, Anzeige zweistellig (z.B. „1.00″). Ska
liert die SH-DC-Chroma jedes Splats um den Lumi
nanz-Wert: 1.0 = unverändert, < 1.0 = entsättigt 
(Farbe zur Graustufe gezogen), > 1.0 = kräftiger. 
Mathematisch wird die DC-Farbe aus dem Pristi
ne-Snapshot zurückgerechnet ( desaturateDC ), so
dass wiederholtes Schieben nicht aufsummiert. 
Wurde auf DJI-Drohnen-Material validiert (Pens
ford-Viadukt), das tendenziell überzeichnet — der 
Drohnen-Default liegt bei 0.82. Wirkt nur auf die 
Farb-Basis (SH-Grad 0), höhere SH-Koeffizienten 
bleiben unberührt.

E I N FAC H  G E S AG T

Wie kräftig die Farben des ferti­
gen Splats sind. 1.00 lässt alles 
wie trainiert, Werte darunter zie­
hen die Farbe Richtung Grau — 
gut für Drohnen- oder Video-Ma­
terial, das oft übersättigt raus­
kommt. Werte über 1.0 machen 
es kräftiger. Du kannst beliebig 
hin- und herschieben, ohne dass 
sich etwas „aufschaukelt„, weil 
die App immer vom unveränder­
ten Original-Stand neu rechnet. 
Live im Viewport sichtbar und 
genau so im Export.
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L2 Splat length-Slider

WO

Inspector → Look-Sektion → GroupBox → Splat 
length.

T E C H N I S C H

Slider 0.3–1.0, Anzeige zweistellig. Zieht die drei 
Skalierungs-Achsen jedes Gaussians im Log-Raum 
zu ihrem Mittelwert hin ( shortenScale , Faktor 
alpha ): 1.0 = unverändert, kleinere Werte machen 

längliche „Nadel„-Splats runder, 0 wären reine Ku
geln. Greift nadel-artige, überdehnte Splats an, 
ohne die Gesamt-Größe zu verändern, und redu
ziert dadurch typische „Konfetti“-Artefakte. Vom 
Pristine-Snapshot (Original-Log-Skalierung) aus an
gewendet, daher idempotent. Kommutiert mit Splat 
size (L3), weil beides im Log-Raum arbeitet.

E I N FAC H  G E S AG T

Macht überlange, splittrige 
Splats runder. 1.00 lässt die Form 
wie trainiert, niedrigere Wer­
te stauchen die langgezogenen 
„Nadeln„ zu rundlicheren Kleck­
sen — das beruhigt körnige, von 
Konfetti-Artefakten geplagte Re­
konstruktionen. Die Gesamt-Grö­
ße bleibt gleich, es geht nur um 
die Länglichkeit. Lässt sich ge­
fahrlos mit Splat size (L3) kombi­
nieren.

L3 Splat size-Slider

WO

Inspector → Look-Sektion → GroupBox → Splat size.

T E C H N I S C H

Slider 0.5–2.0, Anzeige zweistellig. Skaliert je
den Gaussian auf allen drei Achsen uniform 
( sizeScale ): 1.0 = unverändert, < 1.0 = kleiner/
dichter/schärfer, > 1.0 = größer/„fluffiger„ (füllt Lü
cken zwischen den Splats). Da die Skalierungen im 
Log-Raum liegen, wird die Multiplikation als addi
tiver log(factor) -Offset realisiert — das kommu
tiert mit Splat length (L2), weil ein konstanter Offset 
die Abweichung-vom-Mittelwert unangetastet lässt. 
Vom Pristine-Snapshot aus, also idempotent. Neu in 
dieser Version.

E I N FAC H  G E S AG T

Skaliert alle Splats gleichmäßig 
größer oder kleiner. 1.00 ist der 
trainierte Zustand, Werte darun­
ter machen die Punktwolke en­
ger und schärfer, Werte darüber 
decken Lücken zwischen den 
Splats zu (wirkt weicher/„fluffi­
ger„). Praktisch, um eine löch­
rige Rekonstruktion optisch zu 
schließen oder umgekehrt mehr 
Detail freizulegen. Verträgt sich 
problemlos mit Splat length (L2) 
— beide Regler beeinflussen sich 
nicht gegenseitig.
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L4 Fade far region (mit Sub-Slidern)

WO

Inspector → Look-Sektion → GroupBox → Toggle 
„Fade far region„ plus die Sub-Slider „Fade start 
×radius“ und „Fade floor„.

T E C H N I S C H

Toggle, der einen radialen Opacity-Abfall mit 
der Distanz vom Kamera-Schwerpunkt aktiviert 
— die schwach beobachteten „Far-Konfetti„ im 
Hintergrund werden ausgeblendet. Nur für Or
bit-Aufnahmen: Der Toggle ist disabled, wenn 
finishingContext.fadeEligible false ist (lineare 
Flüge, zu wenige oder degenerierte Kameras); dann 
erscheint statt der Sub-Slider der Hinweis „Far-fade 
applies only to orbit captures (not this scene).“ Die 
Eignung wird per Azimut-Abdeckung der Kamera-
Positionen ermittelt (ein Orbit umkreist den Schwer
punkt und füllt viele Kompass-Sektoren, ein Linear
flug nur ~2). Zwei Sub-Slider steuern die Geome
trie: Fade start ×radius (1.0–3.0) setzt den Innen
radius als Vielfaches des Orbit-Radius, innerhalb 
dessen volle Opacity gilt; Fade floor (0.0–1.0) ist 
der Opacity-Faktor weit jenseits des Fade-Radius. 
Wichtig: Der Fade überspringt den Sky-Dome-Be
reich (die frozen Gaussians der Indizes [0, frozen
Count)), damit die absichtliche Hintergrund-Kuppel 
nicht mitgedimmt wird.

E I N FAC H  G E S AG T

Blendet die schwammigen Res­
te am äußeren Szenen-Rand 
aus — genau die „Far-Konfet­
ti„-Klümpchen, die bei Rundum-
Aufnahmen weit hinten schwe­
ben. Funktioniert nur bei ech­
ten Orbit-/Umkreisungs-Aufnah­
men; bei geraden Drohnen-Flü­
gen oder zu wenigen Kameras 
ist der Schalter ausgegraut und 
ein Hinweis erklärt warum. Ist 
er aktiv, kommen zwei Feinregler 
dazu: „Fade start ×radius“ legt 
fest, ab welcher Entfernung (als 
Vielfaches des Umkreis-Radius) 
das Ausblenden beginnt, „Fade 
floor„ wie stark die fernen Splats 
am Ende noch sichtbar bleiben (0 
= ganz weg, 1 = unverändert). Ein 
bewusst rekonstruierter Sky-Do­
me (I44) wird dabei nie angefasst 
— der Himmel bleibt erhalten.
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L5 Reset finishing-Button

WO

Inspector → Look-Sektion → GroupBox → „Reset fi
nishing„ (unten, kleiner Button).

T E C H N I S C H

Setzt alle Look-Settings auf die Defaults zurück 
(FinishingPass.Settings() = Saturation 1.0, Fade 
aus, Splat length 1.0, Splat size 1.0) und löst sofort 
ein erneutes Finishing aus, sodass der Viewport 
auf den unveränderten trainierten Zustand zurück
springt. controlSize(.small). Da der ganze Look-
Stack idempotent vom Pristine-Snapshot aus rech
net, ist „zurück auf Default„ exakt der ursprüngli
che Trainings-Output — kein Qualitätsverlust durch 
mehrfaches Hin und Her. Wie alle Regler der Sektion 
während eines laufenden Exports gesperrt.

E I N FAC H  G E S AG T

Stellt mit einem Klick alle Look-
Regler auf Standard zurück (Sa­
turation 1.00, Fade aus, beide 
Splat-Slider auf 1.00) — der 
Viewport zeigt danach wieder ex­
akt das frisch trainierte Ergeb­
nis. Praktisch, wenn du dich ver­
spielt hast und sauber von vorne 
anfangen willst. Weil die App im­
mer vom Original-Stand rechnet, 
gibt’s dabei keinen Qualitätsver­
lust. Während ein Export läuft, 
ist der Button (wie die Slider) ge­
sperrt.

Presets-Sektion (I1–I11)

Die Presets-Sektion ist der schnellste Weg, eine getestete Konfiguration anzuwenden. 
Built-in-Presets (Capture Class, Classic, MCMC, Hybrid) liefern reproduzierbare Start
punkte aus 560+ dokumentierten Experimenten; eigene Presets lassen sich speichern, 
exportieren, importieren und teilen. Die Liste ist nach Kategorien gruppiert (Capture 
Class, Classic, MCMC, Hybrid, Custom) und mehr als eine Kategorie kann gleichzeitig 
aufgeklappt sein. Über den Kontextmenü-Mechanismus (Rechtsklick auf eine Zeile) sind 
Export, Duplizieren und — bei eigenen Presets — Löschen erreichbar.
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I1 Save…-Button

WO

Inspector → Presets-Sektion → Save…-Button (Ac
tion-Leiste unten).

T E C H N I S C H

Öffnet ein Popover mit Textfeld und Save-/Cancel-
Buttons. Der aktuelle TrainingConfig-Zustand wird 
als neues benutzerdefiniertes Preset persistiert 
(JSON-codiert, App-übergreifend gespeichert). Der 
Save-Vorgang kopiert alle 81 Trainings-Parameter 
plus die aktuelle Densification-Strategie. Das Preset 
landet automatisch in der Kategorie Custom, unab
hängig davon, von welchem Built-in-Preset es abge
leitet wurde. Leere Namen und reine Whitespace-
Eingaben werden verworfen. Schon existierende 
Namen werden nicht abgewiesen — jedes Preset hat 
eine eigene interne ID, doppelte Namen sind tech
nisch erlaubt, aber praktisch verwirrend.

E I N FAC H  G E S AG T

Sichert deine aktuelle Konfigu­
ration als wiederverwendbares 
Preset. Drück den Button, gib im 
Popover einen Namen ein und 
klick Save — alle 81 Parame­
ter inklusive Densification-Stra­
tegie landen unter dem gewähl­
ten Namen in der Custom-Kate­
gorie. Brauchst du, wenn du dir 
Mühe gegeben hast und nicht 
beim nächsten Projekt wieder 
von vorne fummeln willst. Beson­
ders praktisch für wiederkehren­
de Setups wie „Drohne 4K„ oder 
„Indoor schnell“. Doppelte Na­
men sind technisch erlaubt, aber 
praktisch verwirrend — nimm 
lieber etwas Sprechendes.

I2 Preset Name TextField

WO

Save-Popover → Textfeld „Preset Name„.

T E C H N I S C H

Einfaches Textfeld mit gerundetem Rahmen, breiter 
Form. Der Wert wird beim Klick auf den Save-Button 
als Preset-Name übernommen. Keine Längenbe
grenzung im UI, aber der gespeicherte Name muss 
JSON-codierbar und in den UI-Listen darstellbar 
sein — Emoji und Umlaute funktionieren. Der Inhalt 
wird beim Öffnen des Popovers automatisch auf 
einen leeren String zurückgesetzt. Der Save-Button 
bleibt disabled, solange das Feld nach Trim leer ist. 
Es gibt kein Auto-Suggest und keine Vorbelegung 
mit dem Namen des gerade aktiven Presets.

E I N FAC H  G E S AG T

Hier tippst du den Namen für 
dein Preset ein. Wähle was 
Sprechendes wie „Drohne 4K 
30fps„ oder „Innenraum schnell“ 
— das hilft dir später beim Wie­
derfinden in der Custom-Katego­
rie. Emoji und Umlaute sind er­
laubt, eine harte Längenbegren­
zung gibt’s nicht. Solange das 
Feld leer ist oder nur aus Leer­
zeichen besteht, bleibt der Save-
Button ausgegraut. Beim erneu­
ten Öffnen des Popovers ist das 
Feld wieder leer — es gibt kei­
ne Vorbelegung mit dem aktiven 
Preset-Namen.
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I3 Cancel-Button (Save-Dialog)

WO

Save-Popover → Cancel-Button (links).

T E C H N I S C H

Schließt den Popover ohne Speichern. Verwirft den 
Textfeld-Inhalt — beim nächsten Öffnen wird er 
wieder durch die Save…-Button-Logik (I1) auf leer 
zurückgesetzt. Standard-Button-Style, keine Bestä
tigungs-Dialoge, keine Hotkeys. Die aktuelle Trai
ningConfig bleibt unverändert, da der Save-Pfad gar 
nicht ausgeführt wurde.

E I N FAC H  G E S AG T

Schließt den Save-Popover, oh­
ne irgendetwas zu speichern. 
Falls du dir’s anders überlegt 
hast, dich vertippt oder den Dia­
log versehentlich geöffnet hast 
— einfach Cancel klicken. Dei­
ne aktuelle Trainingskonfigurati­
on bleibt unverändert, weil noch 
gar nichts geschrieben wurde. 
Beim nächsten Öffnen des Popo­
vers startet das Namensfeld wie­
der leer. Keine Sicherheitsabfra­
ge, kein Hotkey — einfach Klick 
und weg.

I4 Save-Button (Save-Dialog)

WO

Save-Popover → Save-Button (rechts, prominenter 
Stil).

T E C H N I S C H

Triggert die eigentliche Persistierung. Validiert 
nochmal nicht-leerer Name (defensiver Check) und 
schreibt dann die aktuelle TrainingConfig als JSON 
in den App-Speicher. Schließt anschließend den Po
pover. Blau hervorgehoben, ausgegraut solange das 
Textfeld leer ist. Wenn das Speichern fehlschlägt 
(z.B. weil der App-Speicher voll ist — sehr unwahr
scheinlich), gibt es momentan keinen sichtbaren 
Fehlerdialog; das Preset würde dann beim nächsten 
App-Start einfach nicht erscheinen.

E I N FAC H  G E S AG T

Mit Klick auf Save übernimmst 
du den Namen und schreibst 
dein aktuelles Setup als neu­
es Preset weg. Der Popover 
schließt sich, das Preset taucht 
sofort in der Custom-Kategorie 
der Preset-Liste auf und kann ab 
jetzt per Klick aktiviert werden. 
Der Button ist blau hervorge­
hoben ( borderedProminent ) 
und bleibt ausgegraut, solange 
das Namensfeld leer ist. Falls 
das Speichern fehlschlägt (z.B. 
UserDefaults voll), gibt’s keinen 
sichtbaren Fehlerdialog — das 
Preset würde dann beim nächs­
ten App-Start einfach fehlen.
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I5 Export…-Button

WO

Inspector → Presets-Sektion → Action-Leiste → Ex
port…-Button.

T E C H N I S C H

Exportiert das aktuell ausgewählte Preset als 
.radiancepreset -Datei (intern JSON). Disabled, 

wenn kein Preset selektiert ist. Beim Klick öffnet die 
App einen Save-Dialog mit vorgegebenem Dateina
men (Preset-Name + .radiancepreset -Extension). 
Das gespeicherte Format enthält die komplette Trai
ningConfig plus Metadaten (Name, Kategorie, ID, 
Built-in-Flag). Doppelklick im Finder öffnet die App 
— aber nicht automatisch den Import; der Anwen
der muss den Import-Button (I6) verwenden.

E I N FAC H  G E S AG T

Wähle ein Preset in der Liste an 
und klick Export — dann kannst 
du es als .radiancepreset
-Datei speichern und z.B. ei­
nem Kollegen schicken oder auf 
einen zweiten Mac übertragen. 
Der Empfänger lädt’s drüben mit 
dem Import…-Button (I6) wie­
der ein. Funktioniert für Built-ins 
und für deine eigenen Custom-
Presets gleich gut. Der Button ist 
ausgegraut, solange in der Liste 
nichts angeklickt ist. Tipp: Über 
das Kontextmenü (I8) geht’s 
noch schneller — da musst du 
das Preset nicht erst selektieren.

I6 Import…-Button

WO

Inspector → Presets-Sektion → Action-Leiste → Im
port…-Button.

T E C H N I S C H

Öffnet einen Datei-Dialog, der nur 
.radiancepreset -Dateien zulässt (Mehrfachaus

wahl deaktiviert). Beim Auswählen wird die JSON-
Datei geladen, validiert und in die Custom-Kategorie 
eingefügt — mit neuer interner ID, damit keine Kol
lisionen mit Built-ins entstehen. Der Import setzt 
automatisch die Kategorie auf Custom, selbst wenn 
das exportierte Preset ursprünglich z.B. ein Built-in 
war. Beschädigte oder mit einer älteren Schema-
Version inkompatible Dateien werden stillschwei
gend abgewiesen, ohne Fehlerdialog (Console-Log 
gibt aber Auskunft).

E I N FAC H  G E S AG T

Eine .radiancepreset -Datei 
von Festplatte einlesen. Nützlich, 
wenn dir jemand ein erprobtes 
Setup schickt oder du selbst dei­
ne Lieblings-Presets über meh­
rere Macs synchron halten willst. 
Importierte Presets landen im­
mer in der Custom-Kategorie 
— auch wenn sie ursprünglich 
aus den Built-ins exportiert wur­
den. Beschädigte oder veraltete 
Dateien werden stillschweigend 
ignoriert; im Konsolen-Log steht 
dann der Grund. Mehrfachaus­
wahl im Dialog ist deaktiviert, al­
so pro Klick nur eine Datei.
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I7 Preset-Zeile (Klick-Aktivierung)

WO

Inspector → Presets-Sektion → jede Preset-Zeile in 
jeder Kategorie.

T E C H N I S C H

Klick auf eine Preset-Zeile ersetzt alle Felder der 
TrainingConfig durch die Werte aus dem Preset, 
merkt sich die ID des aktiven Presets und setzt 
den Modified-Status zurück. Das Aktiv-Häkchen vor 
der Zeile erscheint nur, wenn das Preset ausge
wählt UND unmodifiziert ist. Sobald ein Wert in der 
TrainingConfig geändert wird (Slider, Stepper, Togg
le in den anderen Inspector-Sektionen), erscheint 
ein orangenes „Modified„-Badge hinter dem Namen. 
Eingebaute Presets können nicht überschrieben 
werden — bei Modifikation muss via Save-Button 
(I1) eine eigene Kopie angelegt werden.

E I N FAC H  G E S AG T

Klick auf eine Zeile aktiviert das 
Preset und übernimmt alle dort 
gespeicherten Werte in die ak­
tuellen Trainings-Einstellungen. 
Das Häkchen vor dem Namen 
zeigt, welches Preset gerade ak­
tiv ist. Sobald du danach irgend­
einen Slider, Stepper oder Toggle 
in den anderen Sektionen ver­
stellst, erscheint hinter dem Na­
men ein orangenes „Modified„-
Badge — weil dein Setup jetzt 
vom Preset abweicht. Built-in-
Presets lassen sich nicht über­
schreiben; wenn du Änderungen 
behalten willst, leg via Save…-
Button (I1) eine eigene Kopie an 
oder dupliziere das Preset (I9).

I8 Context-Menü „Export…„

WO

Rechtsklick auf jede Preset-Zeile → erster Eintrag 
„Export…„.

T E C H N I S C H

Identische Funktionalität wie I5 (Export…-Button), 
aber bequemer erreichbar — ohne dass das Preset 
vorher selektiert sein muss. Exportiert direkt das 
in der Zeile angeklickte Preset. Funktioniert für al
le Preset-Kategorien gleich (Built-in oder Custom), 
keine Einschränkung. Der Export enthält das Built-
in-Flag und die Original- Kategorie, aber beim Re-
Import wird die Kategorie wie unter I6 beschrieben 
auf Custom gemappt.

E I N FAC H  G E S AG T

Schneller Weg zum Exportie­
ren — Rechtsklick auf das ge­
wünschte Preset und „Export…
„ auswählen. Spart den Umweg 
über Vorher-Anklicken und dann 
den Export…-Button drücken. 
Funktioniert für alle Kategorien 
gleich, auch für Built-ins. Die er­
zeugte .radiancepreset -Da­
tei ist identisch zu der von I5; 
beim späteren Re-Import landet 
sie automatisch in der Custom-
Kategorie.
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I9 Context-Menü „Duplicate„

WO

Rechtsklick auf jede Preset-Zeile → zweiter Eintrag 
„Duplicate„.

T E C H N I S C H

Klont das Preset in die Custom-Kategorie. Erzeugt 
eine neue interne ID, hängt „ Copy„ an den Na
men an und speichert die Kopie. Funktioniert auch 
für Built-in-Presets — der Klon ist dann editierbar. 
Das Original bleibt unangetastet. Die TrainingCon
fig wird Wert-für-Wert kopiert (JSON-Roundtrip), 
sodass keine Referenz-Bindungen zwischen Original 
und Kopie bestehen.

E I N FAC H  G E S AG T

Erzeugt eine bearbeitbare Kopie 
eines Presets in der Custom-
Kategorie. Praktisch, wenn du 
z.B. das Built-in „Quality„-Pre­
set als Ausgangspunkt willst und 
dann nur den SSIM-Slider ein 
wenig verschieben magst. Work­
flow: Duplizieren, neu benennen 
(Kontextmenü oder neuer Save…-
Lauf), anpassen, fertig. Das Ori­
ginal bleibt unangetastet — du 
kannst jederzeit darauf zurück. 
Funktioniert auch für Built-ins, 
was der einzige Weg ist, deren 
Werte als Basis zu übernehmen 
und gleichzeitig editierbar zu 
machen.

I10 Context-Menü „Delete„

WO

Rechtsklick auf eigene Preset-Zeilen → letzter Ein
trag „Delete„ (rot, destructive).

T E C H N I S C H

Nur sichtbar für Custom-Presets. Built-ins lassen 
sich nicht löschen. Der Eintrag ist als destruktiv 
markiert, erscheint im Kontextmenü rot und wird 
hinter einem Divider abgesetzt, damit man ihn nicht 
versehentlich klickt. Es gibt keinen Confirmation- 
Dialog — ein Klick löscht das Preset sofort. Das 
gelöschte Preset ist nicht wiederherstellbar (Cmd-Z 
funktioniert hier nicht — Undo gibt es im aktuellen 
Build nur für die Bild-Liste, nicht für Preset- Ope
rationen). War das gelöschte Preset gerade aktiv, 
bleibt die aktuelle TrainingConfig unverändert, nur 
die aktive Preset-Auswahl wird genullt.

E I N FAC H  G E S AG T

Eigene Presets löschen. Bei den 
Built-ins (Quick, Preview, Balan­
ced, Quality, Ultra Detail, Drone / 
Aerial, 360° Walkaround, Photo / 
Object usw.) ist „Delete„ gar 
nicht sichtbar — die kannst du 
nicht versehentlich killen. Ach­
tung: Es gibt keine Sicherheits­
abfrage und kein Undo, ein Klick 
und das Preset ist weg. Wenn du 
dir nicht sicher bist, vorher per 
Export… (I5/I8) eine Sicherheits­
kopie auf Platte ziehen — die 
kannst du jederzeit wieder im­
portieren. War das Preset gerade 
aktiv, bleibt deine TrainingCon­
fig unverändert, nur das Häkchen 
verschwindet.
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I11 Kategorie-Header (Aufklappen/Einklappen)

WO

Inspector → Presets-Sektion → jeder Kategorie-
Header (Capture Class, Classic, MCMC, Hybrid, 
Custom).

T E C H N I S C H

Klapp-Status pro Kategorie mit unterschiedlichem 
Default: die kuratierte Gruppe Capture Class startet 
aufgeklappt, Classic, MCMC, Hybrid und Custom 
starten zugeklappt. Der Status wird nicht persis
tiert — bei App-Neustart sind alle Kategorien wieder 
im Default-Zustand. Der Chevron-Pfeil rotiert ani
miert. Die Zahl rechts im Header zeigt die Anzahl 
der Presets in dieser Kategorie. Die Klick-Hit-Area 
umfasst den ganzen Header-Bereich.

E I N FAC H  G E S AG T

Kategorien ein- und ausklappen, 
um die Preset-Liste übersichtlich 
zu halten. Beim App-Start ist 
die Capture-Class-Gruppe offen, 
Classic, MCMC, Hybrid und Cus­
tom sind zu. Klick auf den Header 
(kompletter Bereich ist klickbar) 
und die Liste fährt mit kurzer 
Chevron-Animation auf oder zu. 
Die kleine Zahl rechts zeigt, wie 
viele Presets in der Kategorie lie­
gen. Nach Neustart der App ist 
wieder der Default-Zustand da — 
die App speichert diese Klapp-
Einstellung bewusst nicht.

Trainingskonfiguration-Sektion (I12–I22)

Abbildung 11:  Crop nur Trainingskonfiguration-Sektion — Camera Alignment (Apple Photo
grammetry aktiv, Native (Beta) inaktiv), Densification (Classic aktiv), Max Iterations 5,000 / 

Densify Until 3,500 mit Link-Symbol, SSIM Weight Slider 0.20, Render Scale Slider auf 100 % 
(1,536×2,048 = 3.1 MP)

Hier landen die zentralen Hebel: welches SfM-Backend rechnen soll, wie die Densifica
tion arbeitet, wieviele Iterationen, wie groß die SSIM-Gewichtung. Bei MCMC-Strategie 
tauchen zwei zusätzliche Toggles auf („MCMC Quality„ und „Auto-scale by scene“), 
die im Classic-Modus ausgeblendet werden. Bei Native-SfM-Backend kommt das FOV-
Override-Feld dazu, das nur für Video-Frames ohne EXIF-Brennweite gebraucht wird.
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I12 Camera Alignment-Picker

WO

Inspector → Trainingskonfiguration → Camera Ali
gnment (segmentierter Picker oben).

T E C H N I S C H

Segmentierter Picker mit zwei Optionen: Apple 
Photogrammetry und Native (Beta). Die Aus
wahl bestimmt das verwendete SfM-Backend bei 
der nächsten Kamera-Rekonstruktion. Sie beein
flusst zugleich, welche weiteren Inspector-Elemente 
sichtbar sind: Native zeigt zusätzlich das FOV-Over
ride (I13), das nur bei EXIF-losen Video- Frames 
gebraucht wird. Hinweis: für sehr große Outdoor-
Aufnahmen kannst du das Ergebnis eines externen 
Tools (Metashape oder COLMAP) per Workspace-
Import einspielen — siehe Kapitel 1 (M5) und Kapitel 
9 (Q3, Q6).

E I N FAC H  G E S AG T

Hier wählst du, wie die Kame­
ra-Positionen rekonstruiert wer­
den — der wichtigste Schalter 
für die Endqualität. Apple Photo­
grammetry ist der schnelle Stan­
dard und reicht für die meisten 
Objekt-Scans völlig aus. Native 
(Beta) ist die App-Store-konfor­
me Eigenentwicklung, gut für Or­
bits und Turntable-Szenen, und 
braucht bei EXIF-losen Video-
Frames das FOV-Override (I13). 
Bei sehr großen Outdoor- Sets 
kannst du die Kameras alternativ 
in Metashape oder COLMAP rech­
nen und das Ergebnis über den 
Workspace-Import laden. Details 
und Empfehlungen pro Szenen­
typ findest du in Kapitel 9.

I13 FOV Override-Feld (Native SfM)

WO

Inspector → Trainingskonfiguration → FOV Override 
(nur sichtbar bei Camera Alignment = Native).

T E C H N I S C H

Numerisches Textfeld (Range 0-170°), Default 0 = 
automatische Bestimmung aus EXIF oder Heuristik. 
Die manuelle Eingabe ist nötig, wenn die Eingabe-
Bilder aus einem Video extrahiert wurden, das kei
ne Brennweiten-Metadaten enthält. Typische Werte: 
iPhone Wide ≈ 73°, DJI Mavic Wide-Crop ≈ 70°, 
Drohne mit Vollformatsensor ≈ 84°. Der Wert wird 
auf [0, 170] geclampt — Werte außerhalb werden 
direkt zurückgestaucht. Wirkt sich nur auf die native 
SfM-Pipeline aus (Q4/Q5); Apple Photogrammetry 
ignoriert diesen Wert komplett.

E I N FAC H  G E S AG T

Wenn deine Bilder kein EXIF ha­
ben (typisch bei extrahierten Vi­
deo-Frames), trägst du hier die 
horizontale Sichtweite der Kame­
ra in Grad ein. Faustwerte: iPho­
ne Wide ≈ 73°, DJI Mavic Wide- 
Crop ≈ 70°, Drohne mit Vollfor­
matsensor ≈ 84°. Eine 0 lässt 
die App selbst raten — das geht 
oft gut, kann aber bei seltenen 
Objektiven schiefgehen. Werte 
über 170° werden automatisch 
zurückgestaucht. Das Feld ist nur 
sichtbar und nur wirksam, wenn 
du Native als Camera Alignment 
(I12) gewählt hast — Apple Pho­
togrammetry ignoriert es kom­
plett.
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I15 Densification-Picker

WO

Inspector → Trainingskonfiguration → Densification 
(segmentierter Picker, immer sichtbar).

T E C H N I S C H

Schaltet zwischen den beiden Densification-Strate
gien: Classic (Original-3DGS-Verfahren mit Clone/
Split/Prune und Gradienten-Threshold) und MCMC 
(Stochastic Gradient Langevin Dynamics mit Relo
cation, NeurIPS 2024). Beim Wechsel von Classic 
auf MCMC setzt die App die MCMC-spezifischen 
Felder automatisch auf erprobte Default-Werte 
(Reg-Weights = 0, MCMC-Cap- Multiplier 3.0, Sam
ple-/Noise-Schedule). Ohne diese automatische In
itialisierung litten Sessions mit alten Presets unter 
dem 1.4.4-MCMC-Collapse-Bug (460K→5 Gaussi
ans, Watchdog-Kill). Die Picker- Auswahl bestimmt 
zusätzlich, welche Inspector-Elemente sichtbar sind 
— bei MCMC tauchen I16/I17 auf. Detaillierte Feld-
Wirkung in Kapitel 6, T11–T16 (Classic) und T61–
T73 (MCMC).

E I N FAC H  G E S AG T

Die zentrale Strategiewahl für 
das Wachsen der Gaussian-An­
zahl. Classic ist gut getunet 
aus 459 Experimenten, erzeugt 
schnelle und hochwertige Ergeb­
nisse und braucht keine MCMC-
Felder zu kennen. MCMC ist der 
neuere Ansatz (NeurIPS 2024), 
reproduzierbarer und verzichtet 
auf manuelle Threshold-Justage 
— dafür rechnet er etwa 6× 
länger bei vergleichbarer Quali­
tät. Beim Umschalten auf MCMC 
setzt die App automatisch si­
chere Defaults, damit das Trai­
ning nicht in den 1.4.4-Collapse 
läuft. Details zu den Strategiefel­
dern stehen in Kapitel 6 (T11–T16 
Classic, T61–T73 MCMC).

I16 MCMC Quality-Toggle

WO

Inspector → Trainingskonfiguration → MCMC Quality 
(nur bei Densification = MCMC).

T E C H N I S C H

Schaltet die Gradient-Accumulation auf 2 Schrit
te (aktiv) bzw. 1 Schritt (inaktiv). Akkumuliert die 
Gradienten aus zwei aufeinanderfolgenden Kamera-
Views, bevor der Optimizer-Step ausgeführt wird. 
Empirisch (Session 33, V544a) reduziert das den 
finalen L1-Fehler um ca. 6% (0.0246 mit Quality 
vs 0.0261 ohne, bei 3-Trial-Average auf Horse-Full-
MCMC). Der Preis: verdoppelte Trainingszeit. Bei 
sehr langen Trainings (200K Iterationen) führt das 
zu zusätzlichen 10+ Minuten Wartezeit — also nur 
dann lohnt, wenn die letzten paar Prozent Qualität 
wirklich gebraucht werden. Wirkt sich nur auf das 
Training aus, nicht auf das Export-Format oder die 
Viewport-Darstellung.

E I N FAC H  G E S AG T

Quality-Mode für MCMC mit Gra­
dient-Accumulation über zwei 
Views. Macht das Endergebnis 
empirisch etwa 6% besser (L1 
0.0246 statt 0.0261 im Horse-
Test), kostet dafür doppelt so 
lange. Wenn du sowieso schon 
ein 200K-MCMC-Training fährst 
(gerne mal 2 Stunden), kommt 
nochmal eine knappe Stunde 
drauf. Lohnt sich bei finalen 
Showcase-Renderings oder zum 
Ende einer Quality-Sweep-Sessi­
on, im Daily-Workflow eher nicht. 
Nur sichtbar, wenn Densification 
auf MCMC steht (I15).
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I17 Auto-scale by scene-Toggle

WO

Inspector → Trainingskonfiguration → Auto-scale by 
scene (nur bei MCMC).

T E C H N I S C H

Wenn aktiv, skaliert die effektive Max-Gaussians- 
Obergrenze mit der SfM-Init-Point-Count × MCMC-
Cap-Multiplier (Default 3.0). Beispiel: SfM liefert 
250K Initpunkte, Basis-Cap = 150K, Multiplier 3.0 
→ effektive Obergrenze = max(150K, 750K) = 750K. 
Wenn deaktiviert, gilt strikt nur die Basis. War für 
v1.4.5 eingeführt, weil große Outdoor-Aufnahmen 
mit über 1000 Frames und entsprechend hoher 
SfM-Punkt-Dichte mit der starren 150K-Cap-Default 
die Densification ausgehungert haben — überflüssi
ge Punkte blieben, neue durften nicht entstehen. 
Default OFF in Custom-Presets, ON in MCMC-Built-
ins. Wirkt sich nur zur Trainingszeit aus, nicht im 
Export.

E I N FAC H  G E S AG T

Lässt die Maximalzahl der Gaus­
sians mit der Szenengröße mit­
wachsen (genauer: mit der An­
zahl der SfM-Initpunkte). Bei 
kleinen Szenen merkst du kaum 
einen Unterschied, bei großen 
Outdoor-Szenen ist es oft ent­
scheidend für die Qualität — 
sonst „erstickt„ das Training, 
weil die Default-Obergrenze von 
150K für die Szene viel zu niedrig 
ist. War extra für v1.4.5 einge­
führt, nachdem sehr große Out­
door-Sets (über 1000 Frames) 
sichtbar an der Cap hingen. 
Bei den MCMC-Built-in-Presets 
schon vorab eingeschaltet; in ei­
genen Presets defaultmäßig aus.

I18 Max Iterations-Stepper

WO

Inspector → Trainingskonfiguration → GroupBox → 
Max Iterations.

T E C H N I S C H

Stepper mit Range 1 000–100 000, Schrittweite 1 
000. Bestimmt die Gesamtzahl der Optimizer-Itera
tionen. Linear korreliert mit der Trainingszeit (Hal
bierung = ca. 50% Zeit). Empirische Sweet-Spots: 
20K (Classic Balanced, L1≈0.028), 40K (Classic 
Quality, L1≈0.023), 200K (MCMC Full, L1≈0.0246). 
Über 40K bei Classic bringt im Mittel kaum Ver
besserung — Diminishing Returns. Beim Verändern 
wird, falls die Link-Funktion (I19) aktiv ist, Densify 
Until proportional mitgezogen (Default-Ratio: 0.5, 
d.h. Densify-Until = Max/2).

E I N FAC H  G E S AG T

Wie viele Trainingsschritte ge­
fahren werden — mehr ist bes­
ser, kostet aber auch linear mehr 
Zeit. Faustregel: 20 000 für gu­
te Qualität, 40 000 für das Op­
timum bei Classic-Strategie (dar­
über bringt’s im Mittel kaum 
noch was). MCMC braucht deut­
lich mehr, 200 000 ist hier Stan­
dard. Verdoppeln der Iterationen 
verdoppelt grob die Trainings­
zeit. Bei aktivem Link-Button 
(I19) wird Densify Until propor­
tional mitgezogen — praktisch 
immer das, was du willst.
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I19 Link/Unlink-Button (Densify ↔ Iterations)

WO

Inspector → Trainingskonfiguration → GroupBox → 
kleiner Link-Button zwischen Max Iterations und 
Densify Until.

T E C H N I S C H

Toggle-Button, der das Verhältnis von Densify Until 
zu Max Iterations einfriert. Bei Aktiv (Link-Icon her
vorgehoben) wird bei jeder Änderung von Max Itera
tions das Densify Until proportional nachgezogen. 
Beim Unlink (Link-Plus-Icon) bleiben die Werte un
abhängig. Default ist linked, weil das die typische 
Korrelation widerspiegelt — wenn du das Training 
auf doppelte Iterationen ziehst, willst du meistens 
auch die Densification proportional länger laufen 
lassen. Das Verhältnis wird beim Setzen des Link-
Buttons aus dem aktuellen Wert berechnet; ein typi
sches Verhältnis ist 0.5 (Densify-Until = halbe Itera
tions-Zahl).

E I N FAC H  G E S AG T

Kleine Klammer-Schaltfläche 
zwischen Max Iterations und 
Densify Until. Wenn aktiv (Link-
Icon hervorgehoben), wandern 
die beiden Werte gemeinsam — 
verdoppelst du die Iterations, 
verdoppelt sich auch Densify Un­
til im selben Verhältnis. Wenn 
nicht ( link.badge.plus -
Icon), kannst du sie unabhängig 
setzen. Standard ist verlinkt, weil 
das die typische Korrelation wi­
derspiegelt — längeres Training 
will meist auch längere Densifi­
cation-Phase. Für 99% der Fälle 
lass es eingerastet.

I20 Densify Until-Stepper

WO

Inspector → Trainingskonfiguration → GroupBox → 
Densify Until.

T E C H N I S C H

Stepper mit Range 500–50 000, Schrittweite 500. 
Bestimmt den Iterations-Index, ab dem keine neuen 
Gaussians mehr durch Clone/Split (Classic) oder 
Relocation (MCMC) hinzukommen. Nach Erreichen 
werden nur noch Position und Farbe verfeinert. 
Höhere Werte = mehr Gaussians = größere Datei, 
längere Pro-Iteration-Zeit (+30-60% GPU-Time pro 
Schritt). Typische Werte: 15K (für 30K Max-Iter), 
20K (für 40K), 100K (für 200K MCMC). Bei aktivem 
Link (I19) automatisch mitskaliert. Wirkt sich anders 
bei Classic vs MCMC aus: Classic stoppt komplett 
das Wachstum, MCMC stoppt die Relocation-Logik, 
aber Sample-/Noise-Adaption läuft weiter.

E I N FAC H  G E S AG T

Bis zu welcher Iteration neue 
Gaussians hinzugefügt werden 
dürfen — bei Classic durch Clo­
ne/Split, bei MCMC durch Reloca­
tion. Danach geht es nur noch 
um die Farb- und Form- Verfei­
nerung der bestehenden Punkte. 
Höher = mehr Detail, aber auch 
größere Datei und +30-60% GPU-
Zeit pro Schritt. Typische Werte: 
15K (für 30K Max-Iter), 20K (für 
40K), 100K (für 200K MCMC). 
Hängt normalerweise via Link 
(I19) an Max Iterations — selten 
sinnvoll, das manuell zu entkop­
peln.
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I21 SSIM Weight-Slider

WO

Inspector → Trainingskonfiguration → GroupBox → 
SSIM Weight.

T E C H N I S C H

Slider 0.0–1.0 in 0.05-Schritten, Anzeige als „0.20″. 
Mischt L1-Loss (0.0) und SSIM-Loss (1.0). L1 strafft 
die Helligkeit pro Pixel, SSIM die strukturelle Ähn
lichkeit (Kanten, lokale Statistiken). Default 0.2 
ist der Wert aus dem Original-3DGS-Paper (Kerbl 
2023) und reverse-engineered als robuster Kom
promiss in zahlreichen Sessions. Höhere Werte 
(0.5+) bevorzugen Detailerhalt, können aber lokale 
Helligkeitsfehler ignorieren. Niedrigere Werte (< 0.1) 
führen zu Detail-Verlust an scharfen Kanten. Die 
SSIM- Berechnung läuft im Shader mit einem 11×11-
Gaussian-Window. Performance: Bei 0.0 (nur L1) ist 
das Training ca. 8-12% schneller, weil die SSIM-Be
rechnung im Shader übersprungen wird.

E I N FAC H  G E S AG T

Wie stark die strukturelle Bild­
ähnlichkeit (Kanten, lokale Mus­
ter) gegenüber dem reinen Hel­
ligkeitsvergleich gewichtet wird. 
0.2 ist der Standard aus dem 
Original-3DGS-Paper und reicht 
für fast alle Szenen aus. Höher 
(0.5+) bei feinen Strukturen wie 
Haaren, Fell oder Vegetation — 
da hilft mehr Strukturgewicht. 
Niedriger (0.0) macht das Trai­
ning etwa 8-12% schneller, weil 
die SSIM- Berechnung im Shader 
übersprungen wird, kostet aber 
Detail an scharfen Kanten. Wer 
keinen guten Grund für eine Än­
derung hat, lässt 0.2 stehen.

I22 Render Scale-Slider

WO

Inspector → Trainingskonfiguration → GroupBox → 
Render Scale.

T E C H N I S C H

Slider 0.25–1.0 in 0.25-Schritten, Anzeige als 
„100%„. Skaliert die Trainings-Rendering-Auflösung 
relativ zur Quellbild-Größe. Größter Hebel auf die 
Performance: 50% reduziert GPU-Zeit um ca. 75% 
(weil 4× weniger Pixel), 25% um ca. 94%. Der Gra
dient-Threshold wird automatisch mitskaliert. Unter 
dem Slider erscheint eine Live-Resolutions-Anzeige 
in MP (z.B. „2304×1296 (3.0 MP)“). Falls der aktuel
le Wert vom empfohlenen abweicht, wird in oranger 
Schrift „— recommended: 50%„ eingeblendet. Die 
Empfehlung zielt auf ~3 MP effektive Auflösung — 
der von Apple Silicon GPUs am effizientesten ver
arbeitbare Bereich. 4K-Quellbilder bekommen z.B. 
automatisch 25% empfohlen, FullHD-Bilder 100%. 
Eine Änderung triggert zusätzlich die Buffer-Reallo
kation.

E I N FAC H  G E S AG T

Mit welcher Auflösung das Trai­
ning rendert — einer der größten 
Performance-Hebel. Voll (100%) 
gibt die beste Qualität, kostet 
aber bei großen Bildern viel GPU-
Zeit. Halb (50%) spart ungefähr 
75% GPU-Zeit, weil viermal we­
niger Pixel berechnet werden 
— perfekt für 4K-Quellen. Unter 
dem Slider siehst du die effekti­
ve Auflösung in Megapixeln; die 
App zielt auf rund 3 MP, weil das 
auf Apple Silicon am effizientes­
ten läuft. Wenn dein Wert davon 
abweicht, blendet die App einen 
orangenen „recommended„-Hin­
weis ein — meistens lohnt es, 
dem zu folgen.
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Enhancements-Sektion (I26–I29, I42–I44)

Abbildung 12:  Crop nur Enhancements-Sektion — drei Reihen: Post-Training Compactifica
tion (Toggle an), Viewport Scaling (segmentierter Picker Off/MetalFX/Lanczos), Perceptual 

Loss (Slider auf „Off„). Jede Reihe mit Subtitle erklärt Funktion

Die Enhancements-Sektion gruppiert drei Features, die Bildqualität verbessern, ohne 
den Kern-Trainings-Loop selbst zu verändern. Die ersten beiden (I26-I27) sind Post-
Training- bzw. Viewport-Stufen: Compactification räumt nach Trainingsende auf, das 
Viewport-Scaling ist ein reiner Viewport-Renderer, der das laufende Training nicht 
beeinflusst. Die Perceptual Loss (I29) ist trotz der Sektions-Zugehörigkeit ein Trainings-
Bestandteil — sie wird während des Trainings als zusätzlicher Loss-Term aktiviert, 
deshalb die Trennung von den Viewport-Reglern über einen Divider. Seit v1.6 enthält die 
Sektion zusätzlich eine Outdoor-Gruppe (I42–I44: Sky Masking, Mid-Training Floater 
Cleanup, Reconstruct Sky Dome) — Trainings-Optionen gegen Himmels-Floater, die 
früher im Einstellungs-Fenster lagen und jetzt pro Projekt hier sitzen.
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I26 Post-Training Compactification-Toggle

WO

Inspector → Enhancements → Post-Training Com
pactification.

T E C H N I S C H

Aktiviert das V443-Post-Processing: Nach Ab
schluss der Trainings-Iterationen werden Gaussi
ans mit Opacity unter 0.01 (1% Sichtbarkeit) ge
löscht. Empirisch reduziert das die Datei-Größe um 
~55-58% bei null sichtbarem Qualitätsverlust — weil 
diese Gaussians visuell ohnehin nicht beitragen. Die 
Compactification läuft als GPU-Compact-Pass und 
dauert je nach Gaussian-Count Sekundenbruchteile 
bis wenige Sekunden. Beeinflusst die Trainings-Per
formance nicht. Wenn dieser Toggle aus ist, werden 
auch invisible Gaussians exportiert — relevant nur, 
wenn du das Format für ein weiteres Training-Stage 
gebrauchen willst (Continue Training), sonst Ver
schwendung von Speicher.

E I N FAC H  G E S AG T

Räumt nach dem Training Gaus­
sians auf, die du sowieso nicht 
sehen kannst (Opacity unter 1%). 
Macht die Export-Dateien etwa 
zur Hälfte kleiner ( 55-58% Grö­
ßenreduktion) ohne sichtbaren 
Qualitätsverlust. Läuft als kur­
zer GPU-Pass nach der letzten 
Iteration, dauert nur Sekunden­
bruchteile bis wenige Sekunden. 
Sollte praktisch immer an sein 
— der einzige Grund, das aus­
zuschalten, ist wenn du das Trai­
ning später per Continue Trai­
ning fortsetzen willst und auch 
unsichtbare Gaussians behalten 
musst. Bei normalen Export-
Workflows einfach anlassen.
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I27 Viewport Scaling-Picker

WO

Inspector → Enhancements → Viewport Scaling 
(segmentierter Picker mit drei Optionen: Off, Metal
FX, Lanczos).

T E C H N I S C H

Ein einziger segmentierter Picker, der den Viewport-
Upscaler wählt — die drei Optionen sind gegensei
tig ausschließend. Wenn die Trainings-Auflösung 
(durch I22 Render Scale) niedriger ist als die View
port-Größe, skaliert der gewählte Modus das geren
derte Frame auf die Anzeigegröße hoch. Off = 
schlichtes bilineares Strecken. MetalFX = Apples 
ML-basierter Spatial Upscaler, die schärfste Option 
(das ML-Modell ist auf scharfe Kanten optimiert), 
Overhead ca. 1-2ms pro Frame auf M3-GPUs. Lan
czos = Apples Metal Performance Shaders mit 8-
Tap-Sinc-Resampling, klassisch ohne ML, Minimal-
Overhead (< 0.5ms), Qualität unter MetalFX, aber 
ohne ML-typisches „Weichbügeln„ feiner Linien-
Strukturen. Die Renderer- Pipeline wird beim Um
schalten live umkonfiguriert — sichtbar sofort, ohne 
Neustart. Hintergrund: Früher waren das zwei se
parate Toggles (MetalFX + Lanczos), die gleichzeitig 
an sein konnten — ein widersprüchlicher Zustand, in 
dem MetalFX still über Lanczos hinwegging. Der Pi
cker entfernt diesen Zustand; ein eventuell aus älte
ren Sessions geerbter „beide-an“-Zustand heilt sich 
beim nächsten Wechsel selbst zu MetalFX. Wirkt 
nur auf das Live-Viewport, nicht auf gerenderte Ex
porte (Orbit-Video, Screenshots) — die werden in 
voller Quell-Auflösung gerendert.

E I N FAC H  G E S AG T

Schärft das Live-Bild im View­
port hoch — besonders nützlich, 
wenn du mit reduzierter Trai­
nings-Auflösung (Render Scale 
50%, siehe I22) arbeitest. Drei 
Stufen, von denen immer nur 
eine aktiv ist: „Off„ streckt ein­
fach die Pixel, „MetalFX“ nutzt 
Apples Machine-Learning für die 
schärfsten Kanten (praktisch im­
mer die beste Wahl), „Lanc­
zos„ ist der klassische Filter oh­
ne ML — nimm den als Fallback, 
falls MetalFX dir in einer Sze­
ne Linien glättet oder Artefakte 
zeigt. Greift live, ohne Neustart. 
Wirkt nur im Live-Viewport, nicht 
auf exportierte Orbit-Videos oder 
Screenshots — die werden in 
voller Quell-Auflösung gerendert. 
Anders als früher kannst du nicht 
mehr aus Versehen zwei Modi 
gleichzeitig wählen.
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I29 Perceptual Loss-Slider

WO

Inspector → Enhancements → Perceptual Loss.

T E C H N I S C H

Slider 0.0–0.2 in 0.01-Schritten, Anzeige bei 0.0 
als „Off„, sonst als „0.05“ usw. Aktiviert einen 
zusätzlichen Loss-Term, der multi-skalierten Gaus
sian-Blur des Renderings mit dem Ground-Truth-
Bild vergleicht (3 Blur-Skalen). Fängt strukturelle 
Unterschiede ein, die L1+SSIM allein nicht erken
nen. V460-Implementierung. Empirisch verbessert 
ein Wert von 0.05-0.1 den L1-Score in Sessions 
um ein paar Prozent, kostet aber ~5% Trainings
zeit (zusätzlicher Forward-Pass durch die Blur-Ker
nel). Über 0.15 wird das Training instabil und L1 
verschlechtert sich wieder (Loss-Term dominiert 
die Optimierung). Wirkt während des Trainings, 
nicht im Post-Processing — trotz Position in der 
„Enhancements„-Sektion ist das also keine reine 
Aufwertung im Nachgang.

E I N FAC H  G E S AG T

Ein zusätzlicher Loss-Anteil, der 
strukturelle Bildähnlichkeit über 
drei verschiedene Unschärfe-
Stufen prüft. Hilft besonders bei 
Szenen mit feinen Strukturen 
wie Haaren, Stoff oder Vegetati­
on, weil er Muster einfängt, die 
L1+SSIM allein nicht sehen. Klei­
nere Werte sind sicherer — 0.05 
bis 0.1 ist der sweet spot, über 
0.15 wird das Training instabil 
und der Loss verschlechtert sich 
wieder. Auf 0 (Off) ist die Funk­
tion komplett aus und kostet 
nichts; aktiv schluckt sie etwa 
5% Trainingszeit für den extra 
Forward-Pass durch die Blur-Ker­
nel. Wirkt trotz „Enhancements„-
Sektion direkt während des Trai­
nings, nicht erst im Post-Proces­
sing.
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I42 Sky Masking

WO

Inspector → Enhancements (Outdoor-Grup
pe) → Toggle „Sky Masking„. Bound: 
AppState.trainingConfig.skyMaskingEnabled (pro 
Projekt, @DefaultFalse ). Default: false .

T E C H N I S C H

Aktiviert pre-training Apple-Vision-basierte Sky-Pi
xel-Segmentation. Vor Trainings-Start wird für jede 
Eingabe-Kamera die Sky-Region per Apple-Vision-
Foreground-Mask extrahiert (Sky = Background) 
und als Pro-Pixel-Maske der jeweiligen Kamera zu
geordnet. Während des Trainings wird der Loss-Bei
trag pro Pixel mit dem Komplement der Sky-Maske 
multipliziert — Sky-Pixel tragen 0 zum Gradient 
bei, sodass Gaussians, die in den Himmel projizie
ren, keine Optimierungs-Signale erhalten und damit 
nicht „dichter„ oder „heller“ werden. Reduziert Floa
ter (dunkle Klümpchen im Himmel) bei Outdoor-/
Drohnen-Szenen signifikant. Kostet ~3% L1-Regres
sion bei klassischem 40K-Training (siehe memory/​dev_​
outdoor-floater-reduction.md). Nur sinnvoll bei 
Outdoor-Szenen mit klar erkennbarem Himmel; bei 
Innenraum-Szenen oder weißem Hintergrund identi
fiziert die Sky-Segmentierung falsche Bereiche und 
blockt valide Loss-Signale. Der Wert wird pro Pro
jekt gespeichert (nicht mehr app-global) und folgt 
dem Preset bzw. der Szenendatei.

E I N FAC H  G E S AG T

Bei Outdoor-Aufnahmen mit 
Himmel im Bild entstehen oft 
schwarze oder bunte Klümp­
chen im Himmel — sogenann­
te „Floater„. Diese Option er­
kennt automatisch, wo der Him­
mel ist, und sagt dem Trai­
ning: „Lass den Himmel in 
Ruhe.“ Funktioniert sehr gut 
bei Drohnenflügen und Land­
schafts-Szenen. Bei Innenräu­
men oder dunklen Hintergründen 
kann es das Bild verschlechtern 
— also nur einschalten, wenn 
echter Himmel zu sehen ist. 
Details: memory/​dev_​outdoor-
floater-reduction.md.
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I43 Mid-Training Floater Cleanup

WO

Inspector → Enhancements (Outdoor-Gruppe) → 
Toggle „Mid-Training Floater Cleanup„. Bound: 
AppState.trainingConfig.floaterCleanupEnabled 
(pro Projekt, @DefaultFalse ). Default: false .

T E C H N I S C H

Schaltet bei Classic-40K-Training (Preset „P4 Qua
lity„) zwei zusätzliche Density-Control-Passes ein: 
bei Iteration 20,000 und bei Iteration 30,000. Beide 
Passes durchsuchen alle Gaussians nach drei Krite
rien: (a) sehr niedrige Opacity (Standard 0.005), 
(b) winzige Screen-Space-Größe, (c) keine Loss-
Beiträge in den letzten 1000 Iterationen. Gaussians, 
die alle drei Bedingungen erfüllen, werden gepur
ged. Effekt: ~5–15% weniger Gaussians am Ende 
des Trainings, sichtbar weniger dunkle Klümpchen 
im Himmel bei Drohnen-/Outdoor-Szenen. Kostet 
~1–3% L1-Regression bei Close-Up-Indoor-Szenen, 
daher nicht als Default aktiviert. Der Wert wird über 
Neustarts gemerkt (im Gegensatz zu S7). Die zwei 
Cleanup-Iterationen (20K, 30K) sind hart definiert 
und können aktuell nicht per UI verändert werden; 
bei kürzeren Trainings (z.B. P2 Preview 5K) hat 
der Toggle keinen Effekt, weil er die Iterationsmar
ken nie erreicht. Neu: Der Toggle ist nur noch 
dann bedienbar, wenn das aktive Preset den Clas
sic-Densifier verwendet (densificationStrategy 
== .classic). Bei MCMC oder Hybrid wird er dis
abled und ein Inline-Hinweis erscheint, weil diese 
Strategien tote Gaussians ohnehin selbst behandeln 
(MCMC via Relocation, Hybrid via kombinierter Re
loc-/Noise-Logik) — die manuellen Cleanup- Passes 
wären dort wirkungslos bzw. kontraproduktiv. Code-
Referenz: RadianceKitApp.swift, General-Tab. De
tails: memory/​dev_​outdoor-floater-reduction.md.

E I N FAC H  G E S AG T

Während des Trainings entste­
hen manchmal „tote„ Gauß-
Punkte, die nichts mehr zur 
Bildqualität beitragen, aber Spei­
cher belegen. Diese Option räumt 
zweimal während eines langen 
Trainings (bei 20K und 30K Ite­
rationen) auf und entfernt die­
se Leichen. Bei Outdoor-Szenen 
mit Himmel ist das besonders 
sinnvoll, weil sich dort die meis­
ten Floater sammeln. Bei kleinen 
Trainings oder nahaufnahmen 
von Möbeln eher nicht nötig. Der 
Schalter lässt sich nur einschal­
ten, wenn dein Preset den Clas­
sic-Densifier nutzt — bei MCMC- 
oder Hybrid-Presets ist er aus­
gegraut (samt kurzer Erklärung), 
weil die ihre toten Punkte selbst 
aufräumen.
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I44 Reconstruct Sky Dome

WO

Inspector → Enhancements (Outdoor-Gruppe) 
→ Toggle „Reconstruct Sky Dome„. Bound: 
AppState.trainingConfig.skyDomeEnabled (pro Pro
jekt, @DefaultFalse ). Default: false .

T E C H N I S C H

Aktiviert die Pre-Training-Sky-Dome-Projektion 
(V549e MVP). Nach SfM und vor Trainings-Start 
wird für jede Eingabe-Kamera die in S7 gemeinsam 
genutzte Apple-Vision-Sky-Maske aus dem Bild ex
trahiert, die Sky-Pixel werden mit den Kamera-In
trinsics ent-projiziert auf eine virtuelle Kugel-Ober
fläche (Standard-Radius 8× Szenen-Radius). Auf 
dieser Kugel werden ~5000 neue Gaussians initia
lisiert mit Farb-Mittelwerten aus den projizierten 
Sky-Pixeln, sehr großer Skalierung (1.0 in Szenen-
Einheiten) und Anfangs-Opacity 0.95. Diese 5000 
Gaussians sind kein Sky-Mask im klassischen Sinn 
— sie werden trainiert wie alle anderen, aber 
durch die hohe Anfangs-Opacity in einer dünnen 
Schale belassen. Ergebnis: bei 360°-Novel-Views 
in Outdoor-/Drohnen-Szenen erscheinen statt dunk
ler Confetti-Klümpchen tatsächliche Himmels-Farbe 
und Wolken-Strukturen. Der Wert wird über Neu
starts gemerkt. Sinnvoll nur bei Outdoor-Szenen 
mit zumindest 360°-Kamera-Abdeckung; bei reinen 
Object-Captures ohne Himmel-Sicht hat es keinen 
Effekt. Status: experimentell, breitere A/B-Validie
rung über weitere Outdoor-Sets steht noch aus.

E I N FAC H  G E S AG T

Statt dass das Training versucht, 
den Himmel aus den paar sicht­
baren Pixeln zu „erraten„ (was 
zu Floatern führt), projiziert Ra­
dianceKit die Himmel-Pixel di­
rekt auf eine virtuelle Kugel 
um die Szene, bevor das Trai­
ning startet. Wenn du dann die 
fertige Szene in 360° drehst, 
siehst du echten Himmel statt 
schwarzer Klümpchen. Funktio­
niert nur bei Outdoor-Aufnah­
men, bei denen tatsächlich Him­
mel im Bild ist. Bei Wohnzimmer-
Scans oder Studio-Aufnahmen 
bringt es nichts.
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Metriken-Sektion (I30–I38)

Abbildung 13:  Crop nur Training Metrics-Sektion nach abgeschlossenem Training auf Bou
quet (5K Iterationen, 2 991 Gaussians final) — Tabelle mit Trainings-Metriken (Iteration, Loss, 

SSIM Loss, Combined Loss, Gaussian Count, Learning Rate, Elapsed, ETA)

Während ein Training läuft, zeigt die Metriken-Sektion neun Live-Werte aus dem Trai
nings-Loop. Vor Start eines Trainings ist die Sektion leer („Start training to see live 
metrics„). Alle Werte werden alle ~30 Iterationen aktualisiert (Update-Frequenz des -
Streams). Die Sektion ist read-only — kein Element ist anklickbar oder veränderbar. Für 
tiefere Analyse die JSONL-Trainings-Logs unter ~/​Documents/​RadianceKit/​Logs/​ heran
ziehen (Skript python3 scripts/​analyze_​logs.py best 5).
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I30 Iteration

WO

Inspector → Metriken → Iteration. Read-only.

T E C H N I S C H

Anzeige im Format „4523 / 40000″ — aktuelle Itera
tion über totale geplante Iterationen. Zählt synchron 
mit dem Trainings-Loop, der die Werte alle ~30 Iter 
pushed. Die zweite Zahl entspricht dem Max-Iterati
ons-Wert zum Start-Zeitpunkt; sie ändert sich nicht 
mehr, auch wenn der Anwender den Stepper danach 
verstellt — der laufende Lauf nutzt seine eigene 
Snapshot-Kopie. Wenn die App über das Training-
Menü Iterationen draufschiebt (Continue Training 
+5K/+10K/+20K), erhöht sich der Nenner.

E I N FAC H  G E S AG T

Wo das Training gerade steht. 
„4523 / 40000″ heißt: 4523 von 
40 000 Schritten sind durch, 
also etwa 11% fertig. Die lin­
ke Zahl zählt im Sekundentakt 
hoch; wenn sie minutenlang ste­
hen bleibt, hängt das Training 
fest — meistens ein Hinweis auf 
GPU- Throttling oder eine kon­
kurrierende App. Die rechte Zahl 
entspricht dem Max-Iterations-
Wert (I18) beim Trainings-Start 
und ändert sich nicht mehr, auch 
wenn du den Stepper später 
verstellst. Bei Continue Training 
(+5K/+10K/+20K) wächst sie um 
die zusätzlichen Schritte mit.

I31 Loss

WO

Inspector → Metriken → Loss. Read-only.

T E C H N I S C H

Float-Wert mit sechs Nachkommastellen (z.B. 
„0.024385″). Misst den kombinierten L1+SSIM-Loss 
(Mix kontrolliert über I21 SSIM Weight) plus optional 
Perceptual Loss (I29) und andere Regularizer. Skala 
ist nicht absolut, sondern szenenabhängig — ver
langt für die meisten Vergleiche denselben Daten
satz. Typische Endwerte bei guten Konfigurationen: 
- Classic Quality 40K iters: 0.022–0.025 (Horse, 
Truck, Garden) - MCMC Full 200K iters: 0.024–
0.028 - Outdoor Drohne 30K: 0.030–0.060 (geo
metrie-bedingt schlechter) - Indoor Apartments: 
0.018–0.025

Werte über 0.10 nach 5K Iterationen deuten auf 
SfM-Probleme (schlechte Kamera-Posen) hin — ab
brechen und SfM neu rechnen.

E I N FAC H  G E S AG T

Wie weit das gerenderte Bild 
noch vom Original abweicht — 
kombiniert aus L1, SSIM und ggf. 
Perceptual Loss. Kleiner ist bes­
ser. Unter 0.03 ist meistens rich­
tig gut, unter 0.05 noch okay, 
Outdoor-Szenen liegen geome­
trie-bedingt eher bei 0.03-0.06. 
Über 0.10 nach mehreren Tau­
send Iterationen ist ein Warn­
signal — meist liegt’s an der 
Kamera-Rekonstruktion (SfM hat 
nicht sauber geklappt). Die Ska­
la ist nicht absolut, sondern 
szenenabhängig; Vergleiche nur 
innerhalb desselben Datensat­
zes machen. Wenn die Zahl 
plötzlich nach oben springt, ist 
meistens ein Gradient-Explosi­
on-Event passiert.

57 / 233



R A D I A N C E K I T Kapitel 2 — Inspector (Expert View)

I32 Learning Rate

WO

Inspector → Metriken → Learning Rate. Read-only.

T E C H N I S C H

Scientific-Notation-Anzeige (z.B. „1.60e-04″). Aktu
elle Lernrate für die Position-Parameter (3DGS hat 
sechs unabhängige LRs für Position, SH-DC, SH-
Rest, Opacity, Scale, Rotation — angezeigt wird hier 
die Position-LR als repräsentative Größe). Default-
Anfangswert 1.6e-4, der über einen Exponential-De
cay bis ~1.6e-6 am Trainingsende absinkt. Der Ver
fall ist über das LR-Schedule-Feld in der Trainings- 
Konfiguration (T-Feld in Kap. 6) anpassbar. Wenn 
die LR ungewöhnlich hoch bleibt (z.B. 1e-3 oder 
mehr nach 10K Iterationen), könnte das auf eine 
fehlerhaft geladene Konfiguration hinweisen.

E I N FAC H  G E S AG T

Wie groß die Optimierungs-
Schritte gerade sind — konkret 
die Lernrate für die Gaussian-
Positionen. Startet bei 1.60e-04 
und sinkt exponentiell auf et­
wa 1.60e-06 zum Trainingsen­
de („1.60e-06″ = 0.0000016). 
Der Verlauf läuft automatisch, 
du musst hier nichts justieren. 
Wenn der Wert nach 10 000+ 
Iterationen noch immer größer 
als 1e-3 ist, wurde wahrschein­
lich eine fehlerhafte Config gela­
den — Training abbrechen und 
Preset neu wählen. Intern hat 
3DGS sechs unabhängige Lern­
raten (Position, SH-DC, SH-Rest, 
Opacity, Scale, Rotation); hier 
siehst du nur die Position-LR als 
Stellvertreter.

I33 SH Degree

WO

Inspector → Metriken → SH Degree. Read-only.

T E C H N I S C H

Ganzzahl 0-3. Spherical-Harmonics-Grad für die 
Farb-Repräsentation. Beginnt bei 0 (nur die DC-
Komponente, d.h. richtungs-unabhängige Farbe pro 
Gaussian — also nur eine RGB-Konstante) und 
steigt im Verlauf des Trainings progressiv auf 3 
an. Der Standard-Schedule hebt den Grad bei 
1000/2000/3000 Iterationen um je 1. SH-3 ent
spricht 48 Farb-Koeffizienten pro Gaussian (3 
RGB-Channels × 16 SH-Basisfunktionen). Höherer 
SH-Grad = mehr richtungs-abhängige Reflexion 
(glänzende Oberflächen sehen unter verschiedenen 
Blickwinkeln korrekt unterschiedlich aus), aber auch 
mehr Speicher und langsameres Training.

E I N FAC H  G E S AG T

Wie komplex die Farbdarstellung 
pro Gaussian gerade ist. Startet 
bei 0 (nur eine richtungs-unab­
hängige Farbe pro Punkt) und 
wird stufenweise auf 3 hochge­
zogen — typisch bei Iteration 
1000, 2000 und 3000. Stufe 3 
bedeutet 48 Farb-Koeffizienten 
pro Gaussian und erlaubt rich­
tungs-abhängige Reflexionen, al­
so dass glänzende Oberflächen 
aus verschiedenen Blickwinkeln 
korrekt unterschiedlich ausse­
hen. Brauchst du nicht aktiv an­
zufassen, der Schedule läuft au­
tomatisch. Höherer Grad kostet 
mehr Speicher und verlangsamt 
das Training leicht — aber das ist 
der Preis für realistische Glanz­
lichter.
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I34 Gaussians

WO

Inspector → Metriken → Gaussians. Read-only.

T E C H N I S C H

Aktuelle Anzahl der Gaussians im Modell, formatiert 
mit Locale-Separator (z.B. „524.318″). Wachstum: - 
Classic: startet bei den SfM-Init-Punkten (typisch 
50K-300K), wächst durch Clone/Split bis kurz vor 
Densify Until, dann statisch bis Trainingsende (mo
dulo Pruning) - MCMC: Sample-Punkte werden hin
zugefügt bis zum MCMC-Cap, dann nur noch Relo
cation

Healthy Endwerte: - Classic Quality: 400K-700K 
(Horse 524K, Garden 800K) - MCMC Full: exakt auf 
dem Cap (Default 150K, mit Auto-Scale Multiplier × 
SfM-Count je nach Szene 500K-1.5M)

Bei MCMC fällt die Zahl auf < 60% des Caps → An
omalie (Collapse-Indikator, deutet auf zu aggressive 
Regularizer hin).

E I N FAC H  G E S AG T

Wie viele Gaussian-Punkte das 
3D-Modell gerade hat. Wächst 
während des Trainings, bis Den­
sify Until (I20) erreicht ist; da­
nach bleibt die Zahl praktisch 
konstant. Mehr Punkte = mehr 
Detail, aber auch größere Datei 
und langsameres Rendering im 
Viewport. 500.000 Gaussians ist 
ein typischer Mittelwert für Clas­
sic-Quality auf einer mittleren 
Szene; MCMC Full landet je nach 
Auto-Scale (I17) bei 500K bis 
1.5M. Wenn die Zahl bei MCMC 
plötzlich unter 60% des Caps 
fällt, ist das ein Collapse-Indika­
tor — meist zu aggressive Regu­
larizer.

I35 GPU Memory

WO

Inspector → Metriken → GPU Memory. Read-only.

T E C H N I S C H

Schätzung des Gaussian-Buffer-Speicherver
brauchs als Gaussian-Count × 616 Bytes (formatiert 
im Memory-Style). 616 Bytes ist die empirische 
Größe eines voll ausgestatteten Gaussians (Positi
on, Skalierung, Rotation, Opacity, SH-Koeffizienten 
Grad 3, Gradient- Akkumulator). Die Anzeige erfasst 
nicht den Renderer-Overhead (Tile-Buffer, Sort-
Buffer, Backward-Buffer) — der reale GPU- Spei
cherbedarf liegt typisch 2-3× über diesem Wert. Bei 
500K Gaussians: angezeigt ~290 MB, real ~700 MB. 
Bei 1.5M Gaussians: angezeigt ~880 MB, real ~2.5 
GB. Auf M3 Max mit 64+ GB Unified Memory unkri
tisch, auf M3 Pro mit 18 GB schon ein Limit.

E I N FAC H  G E S AG T

Eine Schätzung, wie viel GPU-
Speicher die Gaussians selbst 
belegen — rund 616 Bytes pro 
Punkt. Der tatsächliche GPU-Ver­
brauch ist 2-3× höher als ange­
zeigt, weil der Renderer noch ei­
gene Tile-, Sort- und Backward-
Buffer dazulegt. Bei einem Mac­
Book mit 16-18 GB Unified Memo­
ry solltest du unter 500K Gaussi­
ans bleiben; mit M3 Max oder 
Studio (64+ GB) kannst du locker 
1.5M und mehr fahren. Wenn das 
Training plötzlich crasht oder das 
System swappt, ist meistens hier 
die Grenze erreicht — Render 
Scale (I22) runter oder Densify 
Until (I20) reduzieren.
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I36 Speed

WO

Inspector → Metriken → Speed. Read-only.

T E C H N I S C H

Iterations-pro-Sekunde mit einer Nachkommastelle 
(„24.3 it/s„). Berechnet vom Trainer als gleitender 
Durchschnitt über die letzten ~100 Iterationen. Ty
pische Werte: - Quick Preset (1K iters): 80-120 it/s 
(kurz, kein steady-state) - Classic 20K @ 1.0 Render 
Scale (Truck-Szene, M3 Max): 25-35 it/s - Classic 
20K @ 0.5 Render Scale: 80-120 it/s - MCMC 200K 
@ 0.5 Render Scale: 25-50 it/s (langsamer wegen 
Relocation) - Bei 1M+ Gaussians und voller Auflö
sung: < 10 it/s

Sinkende Speed im Verlauf des Trainings ist normal 
— mehr Gaussians = mehr Compute pro Iterati
on. Plötzliche Einbrüche (z.B. von 30 → 5 it/s) 
deuten auf GPU-Thermal-Throttling oder konkurrie
rende Apps hin.

E I N FAC H  G E S AG T

Wie schnell das Training läuft, 
in Iterationen pro Sekunde. Steht 
typischerweise bei 20-50 it/s, bei 
reduzierter Render Scale (50%) 
und kleinen Szenen auch mal 
80-120 it/s. Sinkt im Verlauf des 
Trainings ganz natürlich, weil 
mehr Gaussians = mehr Arbeit 
pro Iteration. Plötzliche Einbrü­
che (z.B. 30 → 5 it/s) deu­
ten auf GPU- Thermal-Throttling 
oder konkurrierende Apps hin — 
Browser-Tabs mit Video, Time-
Machine-Backup, Photos-Index­
ing. App im Vordergrund hal­
ten und Hintergrund-Programme 
schließen hilft oft. Bei 1M+ Gaus­
sians und voller Auflösung sind 
unter 10 it/s normal.

I37 Elapsed

WO

Inspector → Metriken → Elapsed. Read-only.

T E C H N I S C H

Bereits vergangene Zeit als „4:23″ (m:ss) oder 
„1:23:45″ (h:mm:ss). Format-Switch ab 1 Stunde. 
Misst nur die reine Trainings-Zeit, nicht die vorgela
gerten Phasen (SfM-Berechnung, Bild- Import). Bei 
Pause/Resume läuft die Uhr weiter — ist also wall-
clock, nicht CPU-Zeit.

E I N FAC H  G E S AG T

Wie lange das Training schon 
läuft, als reine Stoppuhr (Wall-
Clock-Zeit). Format ist „m:ss„ bis 
eine Stunde, danach „h:mm:ss“. 
Nicht „CPU-Zeit„, sondern „wie 
lange warten wir schon“ — al­
so auch Pause-Zeiten zählen mit. 
Misst nur die reine Trainings-
Phase, nicht die vorgelagerte 
SfM-Berechnung oder den Bild-
Import. Hilfreich zum Vergleich 
mit der ETA (I38) — wenn Elapsed 
deutlich über die ursprüngliche 
ETA hinaus schießt, ist das Trai­
ning irgendwo langsamer gewor­
den als geplant.

60 / 233



R A D I A N C E K I T Kapitel 2 — Inspector (Expert View)

I38 ETA

WO

Inspector → Metriken → ETA. Read-only.

T E C H N I S C H

Geschätzte Restzeit als „17:42″ oder „1:12:35″. Be
rechnung: (Max Iterations − aktuelle Iteration) / Ite
rationen-pro- Sekunde. Zeigt „–„, wenn die Speed 
gerade null ist (ganz am Anfang oder bei Pause). 
Die Schätzung wird nicht an die typische Verlang
samung gegen Trainingsende angepasst — gerade 
bei MCMC und Classic mit großen Densify-Until-
Werten neigt das Training dazu, langsamer zu wer
den, weil immer mehr Gaussians ins Bild kommen. 
Real bleibt es typischerweise 10-20% über der An
fangs-ETA.

E I N FAC H  G E S AG T

Wie lange voraussichtlich noch 
zu warten ist — berechnet aus 
den verbleibenden Iterationen 
und der aktuellen Speed (I36). Ei­
ne grobe Schätzung: Wenn der 
Mac plötzlich langsamer wird 
(mehr Gaussians ab Densify-
Phase, Thermal-Throttling, ande­
re Apps), kann’s länger dauern 
als angezeigt. Die App rechnet 
die typische Verlangsamung ge­
gen Trainingsende nicht ein, des­
halb landet das echte Ende meist 
10-20% über der Anfangs-ETA. 
Plus 15% einkalkulieren, dann 
passt es meistens. Zeigt „–„, 
wenn die Speed gerade 0 ist 
(Trainings-Anfang oder Pause).
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Verlust-Diagramm-Sektion (I39–I41)

Abbildung 14:  Crop nur Loss History-Sektion nach abgeschlossenem Training — Current 
0.0064, Min 0.0035 (grün), blauer Verlauf von 0.027 (Iteration 1) zu 0.0035 (Iteration 5K) mit 

charakteristischem Knick um Iter 200, darunter Gaussian Count-Chart orange

Die Verlust-Diagramm-Sektion visualisiert den Trainings-Verlauf über die Zeit. Sie 
besteht aus zwei Charts: einem Loss-Curve-Chart (groß, oben, blau) und einem Gaus
sian-Count-Chart (kleiner, unten, orange). Beide werden live während des Trainings 
aufgebaut und persistieren bis zum nächsten Trainings-Start. Vor dem ersten Training 
ist der Bereich leer („Loss curve will appear during training„). Die Charts sind reine 
SwiftUI-Path-Drawings (kein Swift-Charts-Framework), damit sie auch bei 100K+ Punk
ten flüssig rendern.
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I39 Current Loss (Anzeige)

WO

Inspector → Verlust-Diagramm → linker Label-Be
reich „Current: 0.0287″. Read-only.

T E C H N I S C H

Float-Wert des letzten Loss-Sample-Punkts, forma
tiert mit vier Nachkommastellen. Identisch mit I31 
(Loss in der Metrics-Sektion), nur hier kompakter 
formatiert. Quelle ist die Loss- History — eine Liste, 
die pro ~30 Iterationen einen Eintrag bekommt. Nur 
endliche Werte werden in die Liste aufgenommen 
— NaN/Infinity (sehr selten, im Falle eines Gradient-
Explosion-Bugs) werden gefiltert.

E I N FAC H  G E S AG T

Der aktuelle Loss-Wert in kürze­
rer Schreibweise als in der Me­
trics-Sektion (vier Nachkomma­
stellen). Inhaltlich identisch mit 
I31, aber hier sitzt die Anzeige 
direkt am Loss-Chart und gibt 
dir beim Beobachten der Kurve 
den exakten Zahlenwert. Wird 
wie alle Live-Metriken alle  30 Ite­
rationen aktualisiert. NaN- oder 
Infinity- Werte (extrem selten 
bei Gradient-Explosion-Bugs) fil­
tert die App automatisch heraus. 
Nützlich, um beim Schauen aufs 
Diagramm nicht in die andere 
Sektion springen zu müssen.

I40 Min Loss (Anzeige)

WO

Inspector → Verlust-Diagramm → rechter Label-Be
reich „Min: 0.0245″ (grün). Read-only.

T E C H N I S C H

Minimum aller jemals gesehenen Loss-Werte des 
aktuellen Trainings-Laufs. Wird live aus der Loss-
History rekomputiert — keine separate Persistenz. 
Wird mit grüner Schrift dargestellt, weil „Min„ = 
„Best so far“. Die gestrichelte grüne Linie am unte
ren Chart-Rand markiert diese Y-Position visuell. Bei 
Continue-Training- Sessions startet die Mindest-
Verfolgung neu — die alte History wird in der UI 
durch die neue ersetzt (nicht angehängt). Wenn das 
aktuelle Training schlechter als das vorhergehende 
läuft, kann die Min-Anzeige also größer sein als das 
vorherige Endergebnis.

E I N FAC H  G E S AG T

Der niedrigste Loss-Wert, den 
dieses Training bisher gesehen 
hat — grün dargestellt, weil 
„best so far„. Die gestrichelte 
grüne Linie am unteren Chart-
Rand markiert diese Position 
auch visuell. Wenn die aktuelle 
Kurve gerade deutlich darüber 
liegt, gibt’s mit Glück noch eine 
Verbesserung; meistens ist Min 
aber das Endergebnis-Indiz, das 
dich später interessiert. Bei Con­
tinue-Training- Sessions startet 
die Min-Verfolgung neu, weil die 
alte History in der UI durch die 
neue ersetzt wird — der Min-
Wert kann dadurch schlechter 
aussehen als das vorherige End­
ergebnis.
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I41 Gaussian Count Chart

WO

Inspector → Verlust-Diagramm → zweites Chart 
darunter (orange). Read-only.

T E C H N I S C H

Linien-Diagramm der Gaussian-Anzahl über die 
Trainings-Iterationen. Quelle: die Gaussian-Count-
History (Liste von (Iter, Count)-Paaren, gefüllt vom 
Trainer alle ~30 Iter). Y-Skala dynamisch zwischen 
Minimum und Maximum der History. Bei Classic- 
Strategie sieht die Kurve typischerweise so aus: 
stetig steigend bis Densify Until, dann flach (mit 
kleinen Pruning-Schwankungen). Bei MCMC: steiler 
Anstieg bis Cap, dann horizontale Linie (Relocation 
hält die Zahl konstant). Wenn die Kurve fällt trotz 
aktivem Training, prunt die Densification zu aggres
siv — Indiz für falsche Defaults oder ein bekannter 
MCMC-Collapse-Bug (v1.4.4-Hotfix-Thema).

E I N FAC H  G E S AG T

Wie sich die Anzahl der Gaus­
sians über die Trainings-Zeit ent­
wickelt — das kleinere orange 
Chart unter der Loss-Kurve. Bei 
Classic-Strategie steigt die Li­
nie stetig an, bis Densify Un­
til (I20) erreicht ist, danach 
bleibt sie flach mit kleinen Pr­
uning-Schwankungen. Bei MCMC 
schnellt sie steil auf den Cap 
hoch und bleibt dann horizon­
tal, weil Relocation die Zahl kon­
stant hält. Wenn die Kurve trotz 
aktivem Training plötzlich nach 
unten knickt, ist die Densifica­
tion zu aggressiv beim Prunen 
— klassisches Anzeichen für den 
MCMC-Collapse-Bug aus v1.4.4. 
Dann hilft App-Update oder ein 
Wechsel zurück auf Classic.

Wie liest man die Loss-Kurve?

Das Loss-Chart ist das wichtigste Diagnose-Tool im Inspector — kein anderer Indikator 
zeigt so direkt, ob das Training nützlich vorangeht oder festhängt. Die typische gesun
de Form ist ein schneller Abfall in den ersten 1000-3000 Iterationen (von ~0.15 auf 
~0.05), gefolgt von einem langsamen, gleichmäßigen Abfall bis zum Trainingsende (auf 
0.020-0.030). Logarithmisch wirkt die Kurve dabei wie eine glatte Diagonale.

Was bedeutet ein Plateau bei der Loss? Wenn die Kurve über mehrere Tausend 
Iterationen flach bleibt, gibt’s zwei mögliche Lesarten: (a) Training ist „konvergiert„ — 
der Loss kann nicht mehr signifikant sinken, weil das Modell so gut ist, wie es mit 
den gegebenen Daten und Settings sein kann. Das ist erwünscht; das ist „fertig“. (b) 
Training „hängt„ — der Loss kann eigentlich noch sinken, aber Optimierung stagniert 
(lokales Minimum, Lernrate zu klein, Densification aus). Unterscheiden: Wenn der Loss-
Wert in einem typisch guten Bereich liegt (0.020-0.030 bei Indoor/Object, 0.040-0.060 
bei Outdoor) und die Kurve seit 5K Iterationen flach ist, ist’s konvergiert. Wenn der Wert 
deutlich höher ist als bei vergleichbaren Szenen (z.B. 0.08), hängt es.

Achtung Gaussian-Plateau ≠ Loss-Plateau. Ein Plateau in der Gaussian-Anzahl be
deutet nicht „Training ist fertig„. Es bedeutet nur, dass die Densification aufgehört hat, 
neue Punkte hinzuzufügen — entweder weil erreicht ist (Classic) oder weil das MCMC-
Cap voll ist. Das Training läuft danach weiter und verfeinert nur noch die bestehenden 
Punkte. Das eigentliche „fertig“-Signal liest du an der Loss-Kurve und an der Iteration-
Anzeige (I30), nicht hier.
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Faustregel zum Abbrechen: Wenn die Loss-Kurve nach 5000+ Iterationen über 0.08 
liegt und kaum noch sinkt, ist mit hoher Wahrscheinlichkeit die SfM-Rekonstruktion 
schief. Training abbrechen, in Kapitel 9 nachschauen, ob das gewählte SfM-Backend 
zur Szene passt, ggf. auf COLMAP/Native umstellen, dann neu starten. Lieber 10 
Minuten in besseres SfM investieren als 2 Stunden Training mit schlechter Kamera-
Ausrichtung.

Wann nach Inspector greifen?

Schnell-Referenz: Welche Sektion + welche Controls für welchen typischen Use-Case?
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Common-Task Sektion Control-IDs

Farben des fertigen Splats ent
sättigen

Look L1 (Saturation)

Nadel-/Konfetti-Splats runden Look L2 (Splat length)

Löchrige Wolke füllen / Splats 
vergrößern

Look L3 (Splat size)

Ferne „Far-Konfetti„ bei Orbits 
ausblenden

Look L4 (Fade far region)

Look-Anpassungen verwerfen Look L5 (Reset finishing)

Vorgefertigtes Setup laden Presets I7 (Zeile anklicken)

Eigenes Setup speichern Presets I1 → I2 → I4

Setup mit Kollegen teilen Presets I5 (Export) bzw. I6 (Import)

SfM-Backend wechseln (z.B. 
weil Apple-PG zu instabil)

Trainingskonfigurati
on

I12 (siehe Kap. 9)

Video-Frames ohne EXIF-
Brennweite verarbeiten

Trainingskonfigurati
on

I13 (FOV Override)

COLMAP-Performance: GLO
MAP statt Klassisch

Trainingskonfigurati
on

I14

Von Classic auf MCMC um
schalten

Trainingskonfigurati
on

I15

Training länger laufen lassen Trainingskonfigurati
on

I18 (Max Iter) + I20 (Densify 
Until) — gekoppelt via I19

GPU-Zeit halbieren Trainingskonfigurati
on

I22 (Render Scale auf 50%)

Trainings-Qualität +6% 
(MCMC)

Trainingskonfigurati
on

I16 (MCMC Quality)

Outdoor-Szene mit vielen SfM-
Punkten

Trainingskonfigurati
on

I17 (Auto-scale by scene)

COLMAP-Pfad einrichten / 
wechseln

Trainingskonfigurati
on

I23 / I24 / I25

Export-Dateien kleiner machen Enhancements I26 (immer an lassen)

Viewport schärfer ohne mehr 
Trainingszeit

Enhancements I27 (Viewport Scaling → Metal
FX)

MetalFX glättet zu sehr → Al
ternative

Enhancements I27 (Viewport Scaling → Lanc
zos)

Letztes Quäntchen Detail bei 
feinen Strukturen

Enhancements I29 (Perceptual Loss 0.05-0.1)

Training überwachen Metriken I30 (Fortschritt), I36 (Tempo), 
I38 (Restzeit)

Qualität früh einschätzen Metriken I31 (Loss < 0.05 nach 5K = gut)Verdacht auf SfM-Problem Metriken + Loss-
Chart

I31 + I39 (Loss > 0.08 nach 5K 
→ SfM neu)

Convergence vs Stuck unter
scheiden

Verlust-Diagramm I39 + I40 (Loss-Plateau lesen)Densification-Problem erken
nen

Verlust-Diagramm I41 (Gaussian-Kurve fällt → 
Bug)66 / 233
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K A P I T E L

Kapitel 3 — Einstellungen

Das Einstellungs-Fenster öffnet sich über RadianceKit → Einstellungen… oder die 
Standard-Tastenkombination ⌘, . Es enthält zwei Tabs: General und AI Helpers. 
Anders als die Inspector-Werte aus Kapitel 2 wirken die Einstellungen aus diesem 
Fenster app-global (über alle Projekte hinweg) — sie werden in persistiert und überle
ben App-Neustarts. Der General-Tab gruppiert drei inhaltliche Abschnitte: Interface, 
Viewport und Training. (Die früher hier angesiedelten Outdoor-Floater-Toggles — Sky 
Masking, Mid-Training Floater Cleanup und Reconstruct Sky Dome — sind seit v1.6 
in die Enhancements-Sektion des Expert-Inspectors gewandert, wo sie pro Projekt ge
speichert werden; siehe Kapitel 2, I42–I44.) Der AI-Helpers-Tab schaltet die On-Device-
Machine-Learning-Helfer (Vision, CoreML) für SfM- und Trainings-Vorverarbeitung an.

Frühere Bedienelemente zum gesammelten Aktivieren oder Deaktivieren aller AI-Hel
pers existieren in der aktuellen Version nicht mehr — entsprechend werden sie hier 
nicht dokumentiert. Auch der frühere „Coming Soon„-Bereich für noch nicht ausgelie
ferte Helfer wurde entfernt und ist hier nicht referenziert.
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General-Tab

Abbildung 15:  Einstellungen → General-Tab mit Benutzeroberfläche, Ansichtsfenster, Trai
ning und Experimental-Sektion
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S1 Default Mode

WO

Settings → General → Interface → Default Mode-
Picker. Bound:. Default: .simple .

T E C H N I S C H

Steuert, in welchem von zwei UI-Modi die App nach 
dem nächsten Start öffnet. „Simple Mode„ ist der 
geführte Wizard-Workflow in 4 Schritten (Import → 
Processing → Preview → Export, dokumentiert in 
Kapitel 10 unter Z1–Z4), „Expert Mode“ das klassi
sche Drei-Panel-Layout mit Navigator, 3D-Viewport 
und Expert-Inspector aus Kapitel 2. Der Wert wird 
über Neustarts gemerkt. Identische Wirkung wie 
das Menü Mode → Simple Mode (⌘1) / Mode → 
Expert Mode (⌘2), nur dass das Menü die laufen
de Sitzung umschaltet, während dieser Picker den 
Default für künftige Sitzungen setzt. Beide Modi 
greifen auf denselben Projekt-State zu — Projekte, 
Kameras und Trainingskonfiguration bleiben beim 
Modus-Wechsel erhalten. Mode-spezifische Tool
bar-Buttons werden sofort neu gerendert.

E I N FAC H  G E S AG T

Hier wählst du, mit welcher Ober­
fläche RadianceKit beim nächs­
ten Start hochfährt. „Simple 
Mode„ ist der Anfänger-Modus: 
vier klare Schritte, vorgegebe­
ne Voreinstellungen, kaum Op­
tionen. „Expert Mode“ ist das 
volle Werkzeugkasten-Layout mit 
allen Reglern, die du in Kapi­
tel 2 siehst. Du kannst jederzeit 
über das Menü „Mode„ hin- und 
herwechseln, ohne dass Bilder 
oder Trainings-Fortschritt verlo­
ren gehen.

S2 Language

WO

Settings → General → Interface → Language-Picker. 
Bound:. Default: .system  (folgt der macOS-Spra
che).

T E C H N I S C H

Wählt die Anzeigesprache der gesamten App-UI, 
unabhängig von der macOS-System-Sprache. Radi
anceKit ist in 17 Sprachen lokalisiert ( de , en , pl , 
en-AU , ar-SA , plus 12 weitere). Bei „System„ folgt 

die App der macOS-Sprache. Bei einer expliziten 
Wahl wird die Spracheinstellung über Neustarts ge
merkt; vollständige Wirkung braucht in der Regel ei
nen App-Neustart, weil Lokalisierungs-Bundles nur 
beim Start geladen werden. Die 298 dokumentierten 
Lokalisierungs-Schlüssel im Projekt werden alle be
rücksichtigt, einschließlich aller Texte in Sub-Views 
und Hilfe-Tooltips.

E I N FAC H  G E S AG T

Falls dein Mac auf Englisch läuft, 
du aber lieber die deutsche Ra­
dianceKit-Oberfläche möchtest 
(oder umgekehrt), stellst du das 
hier ein. Die meisten Texte tau­
schen sofort. Manche Dialoge er­
scheinen erst nach einem App-
Neustart in der neuen Sprache.
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S3 Viewport Background

WO

Settings → General → Viewport → Background-
Picker. Bound:. Default: .darkGray  (RGB 0.1, 0.1, 
0.1).

T E C H N I S C H

Setzt die Standard-Hintergrundfarbe für den 3D-
Viewport. Drei Optionen: „Dark Gray„ (RGB 0.1, 0.1, 
0.1 — Default), „Black“ (0, 0, 0) und „White„ (1, 1, 
1). Das Setting persistiert den Default für neue Pro
jekte und Sitzungen über Neustarts und aktualisiert 
gleichzeitig den laufenden Metal-Renderer sofort. 
Identische Optionen finden sich im Menü Viewport 
→ Background (M21, M22, M23), aber der Settings-
Picker setzt den Default, während das Menü die lau
fende Anzeige umschaltet. Wichtig für Screenshots 
und Demo-Videos: weiße Hintergründe heben grü
ne/blaue Floater stärker hervor, dunkle Hintergründe 
sind besser für saubere Render-Aufnahmen.

E I N FAC H  G E S AG T

Die Farbe hinter deinen 3D-Mo­
dellen im Vorschaufenster. Dun­
kelgrau ist Standard und passt 
für die meisten Szenen. Weiß 
ist gut für Screenshots, schwarz 
wirkt edler bei Render-Aufnah­
men. Du kannst die Farbe jeder­
zeit über das Menü „Viewport 
→ Background„ für die laufen­
de Szene umschalten — diese 
Einstellung legt nur fest, welche 
Farbe beim nächsten Öffnen wie­
der aktiv sein soll.

S4 Auto-Rotate After Training

WO

Settings → General → Viewport → Toggle „Auto-
Rotate After Training„. Bound:. Default: false .

T E C H N I S C H

Startet unmittelbar nach Trainings-Ende eine konti
nuierliche Turntable-Rotation der Viewport-Kamera 
um den Szenen-Schwerpunkt (Standard-Drehrate 
~0.3 rad/s). Praktisch nützlich für Demo-Sessions, 
A/B-Vergleiche und um aus 360°-Sicht direkt zu be
urteilen, ob „Floater„ am Szenen-Rand entstanden 
sind. Effekt ist visuell identisch zum Menü Viewport 
→ Toggle Auto-Rotation (M16, ⌘⌥T), nur dass der 
Toggle hier das Verhalten automatisch nach Trai
nings-Ende auslöst statt manuell. Lässt sich später 
jederzeit über das Menü oder durch Klick in den 
Viewport (was die Rotation pausiert) unterbrechen. 
Hat keinen Einfluss auf Trainings-Performance — 
die Rotation läuft erst, wenn das Training fertig ist.

E I N FAC H  G E S AG T

Wenn aktiviert, dreht sich die 3D-
Szene automatisch, sobald das 
Training fertig ist — wie ein Ka­
russell. Schön, wenn du beim 
nächtlichen Training morgens 
das Ergebnis schon in Bewegung 
siehst, ohne selbst klicken zu 
müssen. Bei langen Sitzungen, in 
denen du das Training nur über­
wachst, lass es lieber aus.
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S5 Live Preview Interval

WO

Settings → General → Trai
ning → Live Preview-Picker. Bound: 
AppState.trainingConfig.livePreviewInterval. 
Default: 0  (Off).

T E C H N I S C H

Bestimmt, in welchem Iterations-Abstand der lau
fende Trainings-Snapshot in den 3D-Viewport ger
endert wird. Vier diskrete Werte: 0 („Off„), 50, 
250, 1000 Iterationen. Bei aktivem Live Preview 
kopiert der Trainer den Gaussian-Buffer aus der 
GPU in einen separaten Render-Buffer und triggert 
einen Viewport-Redraw. Bei „Off“ wird der Viewport 
erst nach Trainings-Abschluss aktualisiert. Perfor
mance-Kosten: alle 50 Iterationen ~5–10% langsa
mer auf M3 Ultra, alle 250 Iterationen ~1–2% lang
samer, alle 1000 Iterationen unmessbar. Memory-
Overhead konstant ~2 GB für den Snapshot-Buffer, 
unabhängig vom Intervall. Der Wert dient als De
fault für neue Trainings; nach Trainings-Start zeigt 
der Trainings-Inspector den realen Live-Wert dieses 
Trainings an. Bei Intervall 50 ist der Visual-Eindruck 
ein flüssiges „Aufwachsen„ der Punktwolke, bei 
1000 wirkt es stockend.

E I N FAC H  G E S AG T

Während das Training läuft, 
kannst du wählen, wie oft 
die 3D-Ansicht aktualisiert wird. 
„Off„ heißt: keine Aktualisie­
rung während des Trainings (am 
schnellsten). „Every 50 Itera­
tions“ zeigt fast in Echtzeit, 
wie deine Szene entsteht (etwas 
langsamer). Für gemütliches Zu­
schauen bei kleinen Trainings ist 
„Every 250″ ein guter Kompro­
miss.
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S6 Throttle Delay

WO

Settings → General → Training → Throttle-Picker. 
Bound: AppState.trainingConfig.throttleDelayMs. 
Default: 0  (Off).

T E C H N I S C H

Fügt zwischen Trainings-Iterationen eine artifiziel
le Verzögerung in Millisekunden ein. Vier diskrete 
Werte: 0 („Off„), 2 („Light“), 5 („Moderate„), 10 
(„Eco“). Sinn: bei längeren Trainings (mehrere Stun
den) wird die GPU sonst zu 100% ausgelastet, was 
zu spürbar langsamer System-UI führt (Mauszeiger 
ruckelt, andere Apps werden träge). Die Throttle-
Verzögerung gibt der GPU Pausen, in denen ande
re Tasks ausgeführt werden können. Performance-
Kosten sind erheblich: bei 5 ms Throttle dauert ein 
typisches 40K-Training etwa 50–80% länger als oh
ne Throttle. Im Performance-Modus „Eco„ (10 ms) 
ist die Verzögerung pro Iteration länger als die Itera
tion selbst — Faktor 2–3× langsamer. Bei aktivem 
Throttle erscheint unter dem Picker ein Hinweis: 
„Throttle is on. Training will be slower than usual.“ 
Die App selbst reagiert nicht spürbar besser — nur 
andere Apps profitieren.

E I N FAC H  G E S AG T

Wenn dein Mac während eines 
langen Trainings zu heiß läuft 
oder andere Programme zu zäh 
werden, schalte hier eine Bremse 
ein. „Off„ gibt der GPU Vollgas 
(am schnellsten). „Light“ macht 
eine kleine Pause zwischen je­
dem Schritt (etwas langsamer, 
aber System reagiert besser). 
„Eco„ ist die stärkste Bremse — 
gut für Nacht-Trainings auf ei­
nem MacBook, die nicht zu heiß 
werden sollen.
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AI-Helpers-Tab

Abbildung 16:  Einstellungen → KI-Helfer-Tab mit Master-Schalter und Sub-Toggles
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S11 AI Helpers enabled (Master)

WO

Settings → AI Helpers → erste Section → Toggle „AI 
Helpers enabled„. Bound:. Default: true .

T E C H N I S C H

Master-Schalter über sämtliche AI-Helpers-Fea
tures in der Pipeline. Wenn aus, überspringt die 
Import- und SfM-Pipeline alle ML-basierten Vorver
arbeitungs-Stages komplett — kein Apple-Vision-
Aufruf, kein CoreML-Model-Load, keine NPU-Auf
weckung. Wenn an, werden die individuellen Sub-
Toggles (S12–S13) konsultiert. Der Wert wird über 
Neustarts gemerkt. Wirkt sich auf folgende Stages 
aus: (a) Frame-Quality-Pre-Check vor SfM (S12), 
(b) Loop-Closure-Erkennung (S13). Wichtig: bei aus 
sind die zwei Sub-Toggles deaktiviert und visu
ell ausgegraut. Footer-Hinweis betont, dass alle 
AI-Helpers strikt on-device laufen — kein Bild-
Upload, keine Cloud-Verarbeitung. Datenschutz-Ga
rantie kommt durch die Verwendung von aus
schließlich Apple-Vision-Framework (lokal auf der 
Neural Engine) und CoreML-Models, die direkt im 
App-Bundle liegen.

E I N FAC H  G E S AG T

Der Hauptschalter für alle Funk­
tionen, die KI/Machine-Learning 
intern benutzen. Standard ist 
„an„, weil die Helper viel Zeit 
sparen, ohne dass deine Bilder 
den Mac verlassen. Wenn du sie 
komplett aus haben willst (z.B. 
um Strom zu sparen oder weil 
dein Mac kein NPU hat), schal­
te sie hier aus — dann werden 
die zwei Unter-Optionen unten 
automatisch grau und tun nichts 
mehr.

74 / 233



R A D I A N C E K I T Kapitel 3 — Einstellungen

S12 Frame quality check

WO

Settings → AI Helpers → Available-Section → Toggle 
„Frame quality check„. Bound:. Default: true .

T E C H N I S C H

Aktiviert den Frame-Quality-Screener (Phase 3.11), 
der vor dem SfM-Aufruf jeden importierten Frame 
analysiert. Pipeline-Schritte pro Frame: (a) Laplaci
an-Variance-Filter aus Apple Vision (Blur-Erkennung 
— Schwellwert ~150), (b) Histogramm-basiertes 
Over/Under-Exposure-Check (Schwellwert: >5% Pi
xel bei 0 oder 255), (c) Blank-Frame-Detect (Stan
dardabweichung < 5 über alle Pixel). Frames, die 
alle drei Checks bestehen, gehen direkt durch. 
Frames, die mindestens einen Check failen, lösen 
einen modalen Confirmation-Dialog aus, der jeden 
problematischen Frame mit Thumbnail und Begrün
dung listet und fragt, ob er entfernt werden soll. 
Wichtig: keine automatische Löschung — der Dialog 
ist immer erforderlich, der Nutzer behält die letzte 
Entscheidung. Performance: ~50 ms pro Frame auf 
M3 Ultra, läuft parallel. Bei aus werden alle Frames 
ungeprüft an SfM weitergereicht. Bei deaktiviertem 
Master (S11) ist dieser Toggle visuell ausgegraut 
und ohne Wirkung. Geshippter Status laut Memory: 
SHIPPED 2026-05-23.

E I N FAC H  G E S AG T

Vor dem eigentlichen Training 
schaut die App jedes Foto an: ist 
es verwackelt? komplett dunkel 
oder weiß? leer? Wenn ja, fragt 
sie dich nach, ob du das Bild 
rausschmeißen willst — sie ent­
fernt nie automatisch etwas. Das 
spart später viele Stunden, weil 
ein einziges total verwackeltes 
Bild manchmal das ganze Trai­
ning kaputt machen kann. Stan­
dard ist „an„, weil der Aufwand 
fast null ist und der Nutzen groß.
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S13 Loop closure detection

WO

Settings → AI Helpers → Available-Section → Toggle 
„Loop closure detection„. Bound:. Default: true .

T E C H N I S C H

Aktiviert die Apple-Vision-Feature-Print-basierte 
Loop-Closure-Erkennung. Für jeden importierten 
Frame wird ein ~768-dimensionaler Feature-Vektor 
berechnet, der ein neuronales Embedding des Bild
inhalts darstellt. Anschließend werden alle Feature-
Prints paarweise per Cosine-Similarity verglichen. 
Paare mit Similarity > 0.85 und Distanz im Frame-
Index > 50 (also nicht-benachbarte Frames) wer
den als „Loop-Closure-Kandidaten„ identifiziert und 
in eine Sidecar-JSONL-Datei im Projekt-Ordner ge
schrieben. Informational only — die importierte Bil
der-Sequenz wird nicht modifiziert. Sinn: gibt dem 
SfM-Solver (insbesondere COLMAP) einen Hinweis, 
dass diese Frames im 3D-Raum zusammen-cluster 
gehören. Für native SfM ist die Sidecar-Informati
on aktuell nur dokumentierend; COLMAP nutzt die 
Hints intern via custom matches-file (manuelle Inte
gration möglich, nicht automatisch verknüpft). Per
formance: ~200 ms pro Frame auf M3 Ultra, läuft 
parallel. Bei aus werden keine Feature-Prints gene
riert. Bei deaktiviertem Master (S11) visuell ausge
graut.

E I N FAC H  G E S AG T

Wenn du beim Fotografieren um 
ein Objekt herumgehst und am 
Ende wieder am Anfangspunkt 
landest, hilft es dem Compu­
ter enorm, das zu wissen. Diese 
Option erkennt automatisch, wel­
che deiner Fotos „nahezu vom 
selben Standort„ aufgenommen 
wurden, und schreibt das in eine 
kleine Hilfsdatei. SfM-Tools (vor 
allem COLMAP) können diese In­
formation nutzen, um eine sau­
berere 3D-Rekonstruktion zu lie­
fern. Standard ist „an“, weil es 
ohne dein Zutun läuft und nichts 
an deinen Bildern ändert.

Inspector-Spiegel-Settings

Die übrigen Settings-Einträge (S17–S33) aus der Inventar-Tabelle sind Spiegelungen 
aus dem Expert-Inspector und in Kapitel 2 (Inspector-Controls I12–I29) dokumentiert. 
Sie erscheinen nicht physisch im Settings-Fenster, sondern wurden im Inventar nur 
deshalb gelistet, weil sie über TrainingConfig -Properties laufen, die per persistiert 
werden und insofern formal Settings-Charakter haben. Für inhaltliche Erläuterungen 
siehe dort.
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Wann was?

Setting Geltungsbereich Persistenz

S1 Default Mode App-Global App-Neustart

S2 Language App-Global App-Neustart

S3 Viewport Back
ground

App-Global (Default) + Runtime App-Neustart

S4 Auto-Rotate Af
ter Training

App-Global App-Neustart

S5 Live Preview In
terval

Default für neue Trainings App-Neustart

S6 Throttle Delay Default für neue Trainings App-Neustart

S11 AI Helpers 
Master

App-Global App-Neustart

S12 Frame quality 
check

App-Global App-Neustart

S13 Loop closure 
detection

App-Global App-Neustart

App-Global = wirkt auf alle Projekte. Default für neue Trainings = wirkt nur auf das 
nächste angelegte Training, laufende Sitzungen bleiben unverändert. Aktuelles Training 
= wirkt sofort auf die laufende Trainings-Konfiguration, persistiert aber nicht ohne expli
ziten Reimport.
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K A P I T E L

Kapitel 4 — Aux-Fenster

Neben dem Hauptfenster (3D-Viewport plus Inspector) verwaltet RadianceKit sieben 
weitere Fenster, die alle über das Help-Menü geöffnet werden. Die Liste ist von oben 
nach unten: User Guide (⌘?), Keyboard Shortcuts (⌘/), Open Training Logs… (öffnet 
keinen App-Fenster, sondern den Finder; deshalb hier nicht weiter behandelt), Manage 
Storage…, Pareto Dashboard… (⇧⌘D), Holdout Analysis… (⇧⌘H), BayesOpt Console… 
(⇧⌘B). Drei davon — Dashboard, Holdout, BayesOpt — sind eigenständige Analyse-
Werkzeuge. Sie haben jeweils einen eigenen View-Model-Stack, lesen oder schreiben 
JSON-Dateien auf der Platte, und es gibt für jedes ein CLI-Argument, mit dem du 
das Fenster gleich beim App-Start auf eine bestimmte Datei zeigen lassen kannst 
( --dashboard-dir , --holdout-file , --bayesopt-autorun ).

Die vier einfachen Fenster (User Guide, Keyboard Shortcuts, Manage Storage, plus die 
Untermenüpunkte Open Training Logs / Open Exports Folder) bekommen pro Steuerele
ment einen kurzen Eintrag. Die drei Analyse-Fenster sind ausführlicher dokumentiert — 
jeweils mit einer Einleitung, die erklärt was du im Fenster siehst, wann du es öffnen 
solltest und wie du das angezeigte Bild interpretierst.

Am Ende des Kapitels gibt es einen Querverweis-Abschnitt zum Inspector des Haupt
fensters: was du im Live-Loss-Chart und in der Gaussian-Count-Anzeige während eines 
laufenden Trainings sinnvoll ablesen kannst.
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User Guide (W1–W4)

Abbildung 17:  User-Guide-Fenster mit Sidebar links und gerendertem Markdown-Inhalt 
rechts

Was es ist: Ein eingebautes Hilfefenster, das die bei der App mitgelieferte 
guide_<sprache>.md  rendert. Die Sprache wird aus den Settings (Tab General → Lan

guage) oder, wenn dort „System„ steht, aus den macOS-Sprachpräferenzen abgeleitet. 
Layout ist klassisch: links Sidebar mit allen Überschriften, rechts der Fließtext.

WANN ÖFFNEN  Wenn du eine schnelle Erinnerung an einen einzelnen Punkt brauchst — 
also als Stichwort-Ersatz. Die ausführliche Referenz ist dieses Manual; das eingebaute 
Hilfefenster ist eher das, was eine --help  auf der Kommandozeile wäre. Es wird bei 
jedem App-Release mit aktualisiert, aber inhaltlich oberflächlicher gehalten.
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W1 NavigationSplitView (Sidebar + Detail)

WO

Help → User Guide (⌘?)..

T E C H N I S C H

Zweispalt-Layout mit schmaler Sidebar (mindestens 
180 pt breit) für den Inhaltsbaum und einem scroll
baren Detail-Bereich für den eigentlichen Mark
down-Inhalt. Das Fenster hat eine Mindestgröße 
von 700 × 500 pt. Beim ersten Öffnen lädt das 
Fenster die passende guide_<lang>.md  aus dem 
App-Bundle (Fallback guide_en.md ), parst sie in 
Block-Records (Überschriften H1–H4, Absätze, Lis
ten, Tabellen, Trennlinien) und extrahiert separat 
die Überschriften-Struktur für die Sidebar. Inline-
Formatierung (Bold, Italic, Code-Span) wird über die 
eingebaute Markdown-Engine gerendert. Die Spra
che wird aus den App-Einstellungen gelesen, mit 
dem Spezialfall Chinesisch ( zh-Hans ) und Brasilia
nisches Portugiesisch ( pt-BR ), die als volle Locale-
Tags behalten werden, weil sich diese Varianten von 
zh bzw. pt unterscheiden.

E I N FAC H  G E S AG T

Der eingebaute Hilfetext, links 
die Themenliste, rechts der In­
halt. Sprache stellt sich automa­
tisch nach deinen System-Set­
tings ein. Funktioniert offline, ist 
aber bewusst nur eine Kurzversi­
on — die vollständige Referenz 
ist dieses Manual.

W2 List (Heading-Sidebar)

WO

Linke Spalte im User-Guide-Fenster..

T E C H N I S C H

Liste über alle H2- und H3-Überschriften des ak
tuellen Markdown-Dokuments. H2-Einträge erschei
nen ohne Einrückung mit Medium-Schriftgewicht, 
H3-Einträge mit 16 pt Einrückung links und redu
ziertem Foreground-Style. H4 und tiefer werden 
ignoriert, weil die Tiefe sonst die Sidebar unüber
sichtlich macht. Anker-IDs werden aus dem Hea
ding-Text per Slugifizierung erzeugt (lowercase + 
Spaces zu Dashes + Filterung auf Letters/Numbers/
Dashes — derselbe Algorithmus, den GitHub für 
seine Markdown-Anker verwendet, sodass auch ex
terne URLs zur Doku potenziell auf denselben Anker 
landen würden). Die Liste verwendet den nativen 
macOS-Stil.

E I N FAC H  G E S AG T

Die Navigationsleiste auf der lin­
ken Seite. Tippe einen Eintrag 
und du springst zum Abschnitt.
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W3 Button (Heading → Anchor-Sprung)

WO

Pro Sidebar-Zeile ein Button..

T E C H N I S C H

Jeder Sidebar-Eintrag ist ein Button, der den aktuel
len Anker setzt, optisch aber wie ein Listeneintrag 
aussieht. Eine Beobachter-Variable triggert dann 
den Scroll-Sprung zum entsprechenden Anker mit 
einer weichen Animation über 0,3 s. Nach dem 
Sprung wird der Anker-Wert zurückgesetzt, damit 
der nächste Klick auf denselben Anker wieder feuert 
(sonst würde der Beobachter nicht erneut auslösen, 
weil sich der Wert nicht geändert hat).

E I N FAC H  G E S AG T

Klick führt dich an die passende 
Stelle im Text rechts.

W4 ScrollView (Detail-Inhalt)

WO

Rechte Spalte..

T E C H N I S C H

Scrollbarer, vertikal-stapelnder Inhaltsbereich mit 
Lazy-Rendering, weil längere Guides leicht über 
200 Markdown-Blöcke haben können — eine nicht-
lazy Variante würde alle gleichzeitig instanziieren. 
Jeder Block bekommt eine eigene ID, entweder den 
Heading-Anker (für sprungbare H1–H3) oder einen 
Index-Platzhalter. Maximalbreite ist 720 pt, Padding 
32 horizontal / 24 vertikal, sodass lange Zeilen 
ein gut lesbares Layout behalten. Tabellen werden 
zellenweise mit horizontalen Stacks und Trennlinien 
gerendert; Inline- Code durch die eingebaute Mark
down-Engine. Echte Codeblöcke werden aktuell als 
Paragraph behandelt — eine bekannte Einschrän
kung des Help-Fensters.

E I N FAC H  G E S AG T

Der eigentliche Hilfetext. Scroll­
bar, gut lesbare Breite, klare Ty­
po.
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Keyboard Shortcuts (W5–W6)

Abbildung 18:  Keyboard Shortcuts Fenster — fünf Gruppen Navigation/Views/Capture/
Editor/Training mit Hotkey-Spalte links und Beschreibung rechts

WAS IM BILD ZU SEHEN IST  Statische Referenz-Liste in fünf Sektionen. Navigation: Mouse 
Drag (Orbit/Fly), Shift+Drag/Right-Drag (Pan), Scroll (Zoom), WASD (Fly-Through-Be
wegung), Q/E (Up/Down), F (Toggle Orbit/Fly), Double-click (Re-center), Cmd+Scroll 
(FoV-Adjust). Views: R (Reset Camera), T (Auto-Rotation), P (Camera Playback), B 
(Background-Cycle), 0–9 (Springe zu Training-Cam 1=10%/5=50%/0=last), Left/Right 
Arrow (Prev/Next Cam). Capture: S (Screenshot to Desktop), V (Turntable-Video), C 
(Copy Camera Info). Editor: Tab (Edit-Modus), Click/Drag (Paint-Select), Option+Click 
(Deselect), X / Delete (Selektion löschen), Cmd-Z (Letzte Löschung rückgängig), [ / ] 
(Pinselgröße kleiner/größer), Esc (Selektion aufheben). Training: Start, Pause/Resume, 
Cancel, Continue +5K/+10K/+20K über die Menü-Shortcuts in M9–M14.

Was es ist: Eine simple statische Übersicht aller Tastenkürzel — Navigation, Views, 
Capture, Editor, Training. Inhalt ist hartkodiert in, kein Markdown-Loading.

82 / 233



R A D I A N C E K I T Kapitel 4 — Aux-Fenster

WANN ÖFFNEN  Wenn du nach dem schnellsten Weg suchst, etwas im Viewport zu tun. 
WASD-Fly-Through, R für Camera-Reset, B fürs Background-Cycling — alle stehen hier.

W5 ScrollView (Inhaltsbereich)

WO

Help → Keyboard Shortcuts (⌘/)..

T E C H N I S C H

Ein einfacher Scroll-Bereich mit einer vertikalen 
Liste drin. Padding 20 rundherum, kein Sidebar-
Navigations-Tree (die Liste ist kurz genug). Inhalte 
sind in fünf Sektionen gruppiert (Navigation, Views, 
Capture, Editor, Training). Pro Tastenkombination ei
ne Zeile mit übersetzbarem Text in beiden Spalten. 
Linke Spalte (Tastencode) fixiert auf 180 pt Breite, 
sodass die Beschreibungen rechts vertikal aligned 
bleiben. Keine Interaktion außer Scrollen — Klicken 
auf eine Zeile löst nichts aus, die Tastenkürzel sind 
echte Tastatur-Modifier im Menü und auf dem View
port.

E I N FAC H  G E S AG T

Tabelle aller Shortcut-Tasten. 
Statisches Cheat-Sheet zum kur­
zen Nachschauen.

W6 VStack (Shortcut-Sektionen)

WO

Innerhalb des ScrollView..

T E C H N I S C H

Linksbündig gestapelte Sektionen mit 16 pt Ab
stand. Innerhalb der fünf Sektionen jeweils Heading 
+ Zeilen-Folge. Headings nutzen einen sekundären 
Subheadline-Stil — bewusst kein Title-Format, weil 
die Sektionen nicht navigierbar sein müssen. Inhalt 
ist bewusst flach (kein Disclosure, kein Search, kein 
Filter), damit die Komponente auf jeder macOS-Ver
sion unverändert läuft und die Datei lesbar bleibt.

E I N FAC H  G E S AG T

Die Gruppierung der Tasten nach 
Funktion (Navigation, Views, Edi­
tor und so weiter).
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Manage Storage (W7–W12)

Abbildung 19:  Manage Storage Fenster — Header zeigt „693 items · 16.74 GB total„, Tabelle 
mit Export-PLY-Dateien sortiert nach Datum, jeweils Format-Pill + Dateiname + Größe + 

Datum

WAS IM BILD ZU SEHEN IST  Tabellen-Ansicht aller von RadianceKit verwalteten Files. Hea
der zählt 693 Items, 16.74 GB Gesamtgröße. Toolbar oben: „Show in Finder„ + 
„Refresh“. Jede Zeile: PLY-Icon, Dateiname (z.B. training_​20260527T211321Z.ply), Ex
port-Datum, Größe (variiert 7 KB bis 218 MB), Lupen-Icon (Reveal) und Papierkorb-Icon 
(Move to Trash). Files sind nach Datum sortiert, neueste oben. In dieser Demo-Aufnah
me dominieren PLY-Exports, weil viel mit --benchmark  gearbeitet wurde.

Was es ist: Eine Disk-Usage-Übersicht für alles, was RadianceKit unter ~/​Documents/​
RadianceKit/​ ablegt — Logs, Exports, Scenes, Capture-Bundles (vom iOS-Begleiter), 
Imports (Staging-Kopien der Eingabe-Bilder). Pro Eintrag eine Größe in Bytes und zwei 
Buttons: „im Finder anzeigen„ und „in den Papierkorb verschieben“. Ist KEIN automati
sches Aufräumen — die App löscht selbst nichts; du entscheidest pro Eintrag.

WANN ÖFFNEN  Wenn die Platte voll wird. Vor allem die Logs sammeln sich (eine JSONL 
pro Trainingsversuch, plus die _​qualityMetrics.json); die Exports natürlich auch (PLY 
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100% rohe Daten, einer pro Export). Auch nützlich nach einem Crash, wenn das Im
ports-Staging-Verzeichnis noch alte Kopien der Eingangsbilder herumliegen hat (siehe 
„Disk-pressure incident„ in dev_​v549f-needle-reduction.md).

W7 Button „Show in Finder„

WO

Header oben rechts im Storage-Browser-Fenster..

T E C H N I S C H

Öffnet das gesamte RadianceKit-Verzeichnis (~/​
Documents/​RadianceKit/​) im Finder, sodass du die 
Ordnerstruktur direkt sehen und auch mit dem 
Finder selbst manipulieren kannst. Die Aktion öff
net ein neues Finder-Fenster und wechselt nicht 
in den App-Sandbox-Container — ~/​Documents/​
RadianceKit/​ ist die regulär für Apps zugäng
liche Documents-Domain, kein Sandboxed-Contai
ner-Pfad.

E I N FAC H  G E S AG T

Öffnet das Verzeichnis im Finder, 
damit du selbst mit den Dateien 
hantieren kannst.

W8 Button „Refresh„

WO

Header, neben dem Finder-Button..

T E C H N I S C H

Triggert einen Hintergrund-Scan, der auf einem nut
zer-initiierten asynchronen Task läuft, damit das 
Scannen großer Verzeichnisbäume die UI nicht blo
ckiert. Das eigentliche Walken geht jeden bekannten 
Unterordner (Logs, Exports, Scenes, Captures, Im
ports) durch und erzeugt pro direktem Kind einen 
Storage-Eintrag. Pro Eintrag wird die rekursive Grö
ße ermittelt — bevorzugt der tatsächliche Platten
verbrauch (inklusive APFS-Hardlinks-Sharing) mit 
Fallback auf die logische Dateigröße.

E I N FAC H  G E S AG T

Liest die Liste neu, falls du zwi­
schendurch im Finder etwas ge­
löscht oder hinzugefügt hast.
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W9 List (Storage-Einträge)

WO

Hauptinhalt unter dem Header..

T E C H N I S C H

Liste mit pro Zeile diesem Layout: kategorie- 
spezifisches SF-Symbol-Icon (Dokument für Logs, 
Upload-Pfeil für Exports, Würfel für Scenes, Tray für 
Imports), Name + Untertitel (Kind-Label + forma
tiertes Modifications-Datum), Bytes-Counter rechts 
(rechtsbündig, monospaced), Reveal-Button (Lupe-
Symbol), Trash-Button (Papierkorb). Sortierung: pri
mär nach Kind (Scenes zuerst, dann Exports, Logs, 
Captures, Imports, Other), sekundär nach Modifika
tionsdatum absteigend (neueste oben). Wenn der 
Scan noch läuft, zeigt die Stelle stattdessen ei
nen „Scanning…„-Fortschritt. Wenn nichts gefunden 
wurde, eine Empty-State-Anzeige mit Tray-Icon.

E I N FAC H  G E S AG T

Liste aller deiner RadianceKit-
Daten, sortiert nach Typ und Ak­
tualität. Pro Eintrag siehst du 
Größe und kannst direkt löschen.

W10 Row-Button „Reveal in Finder„

WO

Pro Zeile, Lupe-Symbol rechts..

T E C H N I S C H

Öffnet den Finder und selektiert das spezifische 
Item (Datei oder Ordner). Unterschied zu W7: W7 
öffnet das Root-Verzeichnis; W10 markiert genau 
diesen einen Eintrag. Praktischer Workflow: identi
fiziere einen großen Eintrag, klick auf die Lupe, 
kopiere ihn dann zum Beispiel auf ein externes Volu
me.

E I N FAC H  G E S AG T

Springt im Finder direkt auf die­
sen Eintrag, damit du ihn schnell 
findest.
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W11 Row-Button „Move to Trash„

WO

Pro Zeile, Papierkorb-Symbol rechts neben der Lu
pe..

T E C H N I S C H

Löst die Bestätigungs-Dialog-Box (W12) aus. Erst 
nach Bestätigung läuft die macOS-Standard-Ope
ration „in den Papierkorb verschieben„ (also rever
sibel, kein direktes Löschen). Nach erfolgreichem 
Trash wird der Eintrag aus der Liste entfernt und der 
Gesamtbyte-Counter aktualisiert. Bei Fehlern wird 
ein modaler Fehler-Dialog eingeblendet.

E I N FAC H  G E S AG T

Verschiebt den Eintrag in den 
Papierkorb. Dialog fragt vorher 
nach.

W12 ConfirmationDialog (Lösch-Bestätigung)

WO

Wird durch W11 ausgelöst, dargestellt als macOS-
Sheet..

T E C H N I S C H

Standard-Bestätigungsdialog mit dynamischem Ti
tel „Delete <name>?„ und einer Message-Zeile, die 
explizit darauf hinweist, dass der Eintrag im Papier
korb landet und von dort wiederherstellbar ist (bis 
der Papierkorb geleert wird). Zwei Buttons: „Move 
to Trash“ als destruktive Aktion (rot dargestellt) und 
„Cancel„ mit automatischer Esc-Bindung. Der Dia
log ist non-modal in dem Sinne, dass er nur dieses 
Fenster blockiert, nicht die ganze App — das ist 
macOS-Standard für reversible Löschungen.

E I N FAC H  G E S AG T

Sicherheitsfrage vor dem Lö­
schen. „Move to Trash„ ist rever­
sibel — solang der Papierkorb 
nicht geleert ist.
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Pareto Dashboard (W13–W22)

Abbildung 20:  Pareto Dashboard — leerer Zustand vor Report-Import

Leerer Zustand (nach erstem Öffnen) — Empty-State mit Call-to-Action „Open Reports 
Folder…„. Die Datenpunkte erscheinen, sobald Trainings-Reports geladen sind, siehe 
nächster Shot.

Abbildung 21:  Pareto Dashboard mit 129 geladenen Benchmark-Reports — Gaussians vs 
PSNR mit Pareto-Front, Scene/Strategy/Mip-Filter

WAS IM BILD ZU SEHEN IST  Header-Toolbar zeigt „129 reports of 129″ (alle Reports im 
gewählten Ordner erfolgreich geparst — 21 zusätzliche Files konnten wegen älterem 
Format nicht geparst werden, siehe Hinweis-Liste rechts). Achsen: X-Axis-Picker auf 
Gaussians , Y-Axis-Picker auf PSNR (dB) . Scatter-Plot: grüne Punkte = Classic-Stra

tegy, blaue Punkte = MCMC. Die gestrichelte Pareto-Front-Linie verläuft entlang der 
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best-erreichten PSNR-Werte und plateaut um PSNR≈30 dB ab ca. 500K Gaussians. 
Filter-Chips rechts: 7 Scenes (bicycle, bonsai, family, flowers, kitchen, stump, truck), 
2 Strategies (classic, mcmc), 3 Mip-Splatting-Optionen (All, On, Off). Aktuell sind alle 
Filter offen, deshalb der dichte Punkte-Cluster.

Was es ist: Ein Multi-Run-Vergleichs-Werkzeug. Trainiert hast du in der Vergangenheit 
mehrere Szenen oder dieselbe Szene mit unterschiedlichen Presets — jeder dieser Trai
ningsläufe produziert (wenn du --benchmark  mitgegeben oder über die Benchmark-
Funktion aufgerufen hast) eine JSON-Report-Datei, die unter anderem Final-PSNR, 
SSIM, LPIPS, Gaussian-Count und Wallclock-Zeit enthält. Das Dashboard liest einen 
ganzen Ordner solcher Reports gleichzeitig ein und plottet sie als 2D-Scatter mit selek
tierbaren Achsen. Zusätzlich wird die Pareto-Front (die Menge der nicht-dominierten 
Punkte) als gestrichelte Linie eingezeichnet.

WANN ÖFFNEN  Nachdem du mindestens drei oder vier Trainings-Reports angelegt hast. 
Mit weniger Punkten ist die Frontier-Linie nicht aussagekräftig. Typischer Use-Case: 
du hast versucht, eine Outdoor-Szene zu rekonstruieren, und hast nacheinander P3 Ba
lanced (Classic), P4 Quality (Classic), P7 MCMC Quality und P9 Outdoor (tuned) durch
gespielt — jetzt willst du wissen, welche Konfiguration die beste PSNR pro Sekunde 
Trainingszeit liefert oder welche die wenigsten Gaussians braucht für gegebene PSNR.

WIE DEUTEN  Beide Achsen sind frei wählbar (X-Achse:,, psnr , ssim , lpips , …; Y-
Achse genauso). Die Pareto-Front-Logik in ParetoFront2D.indices weiß für jede Metrik, 
ob „kleiner = besser„ (z.B. LPIPS, Loss, Time) oder „größer = besser“ (PSNR, SSIM) — 
die Linie verläuft also je nach Achsen-Wahl von links unten nach rechts oben oder von 
links oben nach rechts unten, immer entlang der besten erreichten Kombination. Ein 
Punkt ist Pareto-optimal, wenn KEIN anderer Punkt in BEIDEN Dimensionen mindestens 
gleich gut ist (also kein anderer dominiert ihn). Pareto-optimale Punkte liegen auf der 
Linie, andere Punkte rechts/oberhalb (je nach Achsenorientierung) davon. Punkte AUF 
der Linie sind die echten Kandidaten für „bestes Preset„; Punkte WEIT von der Linie 
sind verschwendete Trainingszeit.

FILTER-CHIPS  Du kannst die Auswahl auf eine bestimmte Szene einschränken (wenn du 
z.B. nur Outdoor-Runs vergleichen willst), auf eine bestimmte Strategie (Classic oder 
MCMC), oder auf Mip-Splatting an/aus (relevant nach Phase Q1.5, wo Mip als opt-in 
Advanced Flag bleibt).

 Du hast drei Reports für „truck„-Szene unter ~/​Documents/​RadianceKit/​Reports/​: 
Run A (P4 Quality, 40K iter, 524K Gs, 105 s, PSNR 23.4), Run B (P7 MCMC, 200K iter, 
150K Gs, 693 s, PSNR 24.6), Run C (P9 Outdoor, 100K iter, 1.25M Gs, 312 s, PSNR 
25.8). Setze X-Achse auf trainingTime, Y-Achse auf PSNR. Run B liegt rechts oben, Run 
C noch weiter rechts oben, Run A links unten. Die Pareto-Front verbindet A und C — 
beide nicht-dominiert. Run B ist „lost“ (C ist besser in Time UND PSNR). Erkenntnis: für 
„truck„ lohnt sich der MCMC-Default nicht; entweder schnell+ok (A) oder lang+sehr gut 
(C). Konfiguration aus C als eigenes Preset speichern (Inspector → I1 Save Preset).

Nächste Aktion: Beste Konfiguration als Preset abspeichern. Konkret: schau dir die 
Pareto-Punkte an (Hover zeigt PSNR/SSIM/LPIPS/Gs/Time im Tooltip), entscheide wel
cher dir vom Time-vs-Quality-Trade-off am besten passt, öffne den zugehörigen Report 
(Dateiname enthält Run-Timestamp), kopiere dessen Trainingskonfiguration in einem 
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neuen Run oder speichere sie nach der nächsten Trainings-Session als Preset über den 
Inspector.

W13 Button „Open Reports Folder…„

WO

Toolbar oben links..

T E C H N I S C H

Öffnet einen Ordner-Auswahldialog mit der Auffor
derung „Select a folder containing benchmark .json 
reports„. Nach Bestätigung läuft ein Hintergrund-
Task, der alle .json -Dateien im Ordner sequentiell 
parst. Fehlerhafte Reports (kaputtes JSON, falsches 
Schema) werden gesammelt und unten in der Side
bar als „N file failed to parse“ angezeigt — kein 
Crash. Wenn ein zweiter Klick erfolgt, während ein 
erster Load noch läuft, wird der vorherige Task 
abgebrochen, sodass nicht zwei Ergebnisse gleich
zeitig in den State schreiben.

Auch über CLI: --dashboard-dir /​pfad/​zu/​reports 
lädt den Ordner gleich beim App-Start.

E I N FAC H  G E S AG T

Wählt den Ordner, in dem dei­
ne Benchmark-Reports liegen. 
Standardpfad ist ~/​Documents/​
RadianceKit/​Reports/​. Lädt 
dann alle JSONs auf einmal.

W14 Picker „X-Axis„

WO

Über dem Chart, links..

T E C H N I S C H

Menü-Picker mit allen verfügbaren Metrik-Achsen 
des Dashboard-Moduls (PSNR, SSIM, LPIPS, Gaus
sian-Count, Trainingszeit und so weiter). Default ist 
Gaussian-Count. Beim Wechsel wird der gehoverte 
Punkt zurückgesetzt, weil eine bisher gehighlightete 
Position im alten Achsen-Koordinatensystem nach 
Achsenwechsel keinen Sinn mehr macht. Picker ist 
auf Inhaltsbreite begrenzt, damit er nicht über die 
ganze Breite zieht.

E I N FAC H  G E S AG T

Welche Metrik auf der waage­
rechten Achse stehen soll. Üb­
licherweise „Trainingszeit„ oder 
„Gaussian-Anzahl“, weil das die 
„Kosten„ sind, die du vergleichen 
willst.
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W15 Picker „Y-Axis„

WO

Über dem Chart, neben X-Axis..

T E C H N I S C H

Identisch zu W14, nur dass das Default PSNR ist. 
Die Achsenwahl wird unabhängig gespeichert, also 
kann der Nutzer auch Unsinns-Kombinationen wäh
len (X=PSNR, Y=PSNR — würde alle Punkte auf eine 
Diagonale werfen). Solche Kombinationen werden 
aber nicht abgefangen; bewusste Entscheidung, 
weil ein Vergleich „SSIM vs PSNR„ durchaus inter
essant ist, um zu sehen wie konsistent die Metriken 
sich verhalten.

E I N FAC H  G E S AG T

Was auf der senkrechten 
Achse steht. Normalerweise 
„PSNR„ oder „SSIM“ als Quali­
tätsmaß.

W16 Toggle „Show Pareto Front„

WO

Rechts neben den Achsen-Pickern..

T E C H N I S C H

Standard-macOS-Toggle. Wenn aktiv, wird im Pare
to-Chart zusätzlich zur Punktwolke eine Linie mit 
der errechneten 2D-Pareto-Front gezeichnet. Stil: 
gestrichelt (Strichmuster 4–4), grau halbtranspa
rent, Linienstärke 1,5 pt. Die Pareto-Berechnung 
läuft auf dem Hauptthread — bei der typischen 
Anzahl Reports (≤ ~50) ist das problemlos schnell. 
Wenn der Toggle aus ist, wird die Linie weggelas
sen, sodass nur die nackten Punkte stehen.

E I N FAC H  G E S AG T

Zeigt die Linie an, die durch 
die „bisher besten„ Punkte führt. 
Wenn dir die Linie im Weg ist 
(z.B. weil du nur die einzelnen 
Trades vergleichen willst), schal­
te sie aus.
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W17 Chips „Scene„-Filter

WO

Rechte Sidebar im Dashboard-Fenster..

T E C H N I S C H

Filter-Chips für jede in den geladenen Reports vor
kommende Szene. Eigenes Flow-Layout, das Chips 
in mehrere Zeilen automatisch umpackt, sobald die 
Breite ausgereizt ist. Aktive Chips bekommen den 
Akzent-Hintergrund, inaktive einen neutralen Stan
dard-Material-Hintergrund. Mehrfach-Auswahl ist 
möglich (Set-Semantik); wenn keine Chip selektiert 
ist, gelten alle Szenen als „durchgelassen„ — d.h. 
die Set-Logik ist „leere Selektion = alles“, nicht „lee
re Selektion = nichts„.

E I N FAC H  G E S AG T

Klick auf einen Szenen-Namen 
filtert die Punkte auf nur diese 
Szene. Mehrfachauswahl mög­
lich. Leer = alle Szenen.

W18 Chips „Strategy„-Filter

WO

Unter Scene-Filter in der Sidebar..

T E C H N I S C H

Genau wie W17, aber für Trainings-Strategien — ty
pischerweise die zwei Werte „classic„ und „mcmc“, 
abgeleitet aus dem Strategy-Feld der Benchmark-
Report-JSONs. Hilfreich, wenn du Reports beider 
Strategien gemischt hast und nur eine Sorte sehen 
willst (z.B. „nur MCMC-Runs zeigen, weil ich Classic 
schon ausgeschlossen habe„).

E I N FAC H  G E S AG T

Filter nach Klassisch oder MCMC. 
Standardmäßig sind beide aktiv.
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W19 Chips „Mip-Splatting„-Filter

WO

Unter Strategy-Filter in der Sidebar..

T E C H N I S C H

Dreiwertiger Filter (statt Set wie W17/W18): „All„ / 
„On“ / „Off„. Hintergrund: Mip-Splatting wurde in 
Phase Q1.5 als experimentelle Multi-Skalen-Verbes
serung evaluiert und der finale Verdict war „kein 
netter Win durchgehend; behalten als opt-in Flag“. 
Wenn du Mip-on/off-Vergleiche machst, willst du 
oft sehr scharf trennen können. Daher der dedi
zierte ternäre Filter mit den Zuständen „alles durch
lassen„, „nur Mip an“, „nur Mip aus„. Die Sidebar-
Section wird nur eingeblendet, wenn mindestens ein 
Mip-Report UND mindestens ein Nicht-Mip-Report 
in der Daten-Menge ist (sonst macht die Filterung 
keinen Sinn).

E I N FAC H  G E S AG T

Wenn du Mip-Splatting an/aus 
vergleichen willst, hier dreige­
teilter Filter. Sonst ignorieren.

W20 ChipButton (Filter-Toggle, all/on/off)

WO

Helper-Component, wird in W17/W18/W19 verwen
det..

T E C H N I S C H

Minimalistischer Button-Wrapper. Inhalt: Label- Text 
mit Caption-Schriftgrad und Padding 10 horizontal / 
5 vertikal. Hintergrund konditional: wenn aktiv → 
App-Akzentfarbe mit weißem Text; sonst neutraler 
Standard-Material-Hintergrund mit schwarzem Text. 
Form ist eine Capsule (pillenartig). Plain-Button
style, damit das Capsule- Material nicht von einem 
System-Border überlagert wird.

E I N FAC H  G E S AG T

Die runden Filter-Knöpfe selbst. 
Optisch wie ein iOS-Tag.
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W21 Chart (Pareto-Scatter)

WO

Mittelfläche des Dashboards..

T E C H N I S C H

Swift-Charts-Diagramm mit zwei Layern: 1. ein 
Punkt pro Report — Position aus den gewählten X- 
und Y-Metriken, Farbe nach Strategy, Symbol nach 
Mip-Status. Symbol-Größe normal 80, gehighligh
ted 200 (wenn die ID dem aktuell gehoverten Report 
entspricht).
2. eine Linie für die Pareto-Front, nur wenn der 

Toggle an ist.

Chart-Overlay: ein transparentes Rechteck regis
triert Maus-Bewegung; pro Frame wird die eukli
disch nächste Punktposition im Plot-Frame ermittelt 
und der gehoverte Report aktualisiert, falls die Di
stanz unter 24 px liegt (sonst zurückgesetzt). So 
bekommst du den Tooltip ohne Klicken — Hovern 
reicht.

E I N FAC H  G E S AG T

Das eigentliche Streudiagramm. 
Jeder Punkt ist ein Trainingslauf. 
Hover für Detail-Tooltip.

W22 Tooltip (Hover-Detail)

WO

Unter dem Chart, eingeblendet bei Hover..

T E C H N I S C H

Horizontaler Stack: Szene-Name (Headline), Stra
tegy-Tag (Caption), Trennlinie, dann PSNR/SSIM/
LPIPS/Gs/Time-Metriken in jeweils einer kleinen ver
tikalen Gruppe (Label + monospaced Wert). Falls 
Mip aktiviert war, zusätzlich ein „Mip„-Capsule-Tag 
in Akzentfarbe. Hintergrund halbtransparenter Blur, 
abgerundetes Rechteck mit 8 pt Radius. Wird nur 
eingeblendet, wenn die Maus tatsächlich über ei
nem Punkt ist. Verschwindet automatisch beim Ver
lassen.

E I N FAC H  G E S AG T

Die Detail-Karte unten, wenn du 
mit der Maus über einen Punkt 
gehst. Zeigt alle Qualitätsmetri­
ken und die Run-Konfiguration 
auf einmal.
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Holdout Analysis (W23–W29)

Abbildung 22:  Holdout Analysis — leerer Zustand vor dem Laden einer transforms.json

Leerer Zustand mit Empty-State und Call-to-Action „Open transforms.json…„. Akzep
tiert NeRF-Studio- und Instant-NGP-Format.

Leerer Zustand (nach erstem Öffnen) — die Kamera-Marker erscheinen, sobald eine 
transforms.json  geladen ist, siehe nächster Shot.

Abbildung 23:  Holdout-Globe mit 100 NeRF-Blender-Mic-Kameras, 5 Folds à 20 Kameras, 
Angular-Strategy aktiv

WAS IM BILD ZU SEHEN IST  Header zeigt geladene Datei (transforms_​train.json) und 
Cam-Count („100 cameras„). Linke Sidebar: Strategy-Picker mit zwei Optionen — 
Angular (longitudinal) aktiv (richtet Folds nach Längen-/Breiten-Sektoren auf der 
Sphäre aus, sodass jeder Test-Fold geometrisch dicht ist) vs Linear (round-robin) 
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(Reihenfolge-basiert, alle k-ten Frames als Test-Set). k-Folds-Slider steht auf 5, Test-
Fold-Picker auf Fold 1. Export-Button erzeugt eine fold-assignment.json für Nerfstu
dio/Instant-NGP. Mittel-Panel: 3D-Globe-Projektion aller 100 Kameras — grüne Punkte = 
Train, rote Punkte = aktueller Test-Fold (Fold 1 mit 20 Kameras). Rechte Sidebar (Angu
lar Correlation): pro Fold 20 Cams + Mean Nearest Angle (Fold 1: 7.9°, Fold 2: 7.8°, Fold 
3: 7.7°, Fold 4: 7.0°, Fold 5: 6.3°) — kleinerer Wert bedeutet, dass die Kameras innerhalb 
dieses Folds eng beieinander liegen, also der Holdout-Split räumlich kohärent ist.

Was es ist: Ein 3D-Visualisierer für deine Kamera-Anordnung mit Cross-Validation-Lo
gik. Du lädst eine transforms.json  (das Standardformat von Nerfstudio / Instant-NGP 
für Kamera-Posen), die App liest alle Kameras, projiziert ihre Blickrichtungen auf eine 
Einheitskugel und zeigt sie als kleine Kugel-Marker auf einem virtuellen Globus. Dann 
teilt sie die Kameras in k  Folds auf (per gewählter Strategie: angular oder linear), 
markiert grün den Trainings-Anteil und rot den Test-Anteil (Holdout), und berechnet 
pro Fold einen Angular-Correlation-Score, der dir sagt wie weit der Test-Fold im Blick
winkel-Raum vom Trainings-Fold entfernt liegt.

WANN ÖFFNEN  Wenn du Holdout-Evaluation machen willst — also: wie gut generalisiert 
dein Modell auf ungesehene Blickwinkel? Standard im Training ist „every-8th view als 
Holdout„ (Mip-NeRF360-Konvention), aber das ist eine sehr lineare Aufteilung. Wenn 
deine Bilder zum Beispiel zeitlich geclustert sind (erst eine Seite des Objekts, dann 
die andere), dann ist „every-8th“ nicht repräsentativ — eine zufällige Sequenz-Position 
landet im Test, aber alle ihre Nachbarn sind im Training, das ist zu einfach. Mit 
„angular„ stratifiziert man stattdessen über den Blickwinkel-Raum: jeder Fold enthält 
Kameras aus allen Bereichen des Orbits, sodass der Test wirklich Generalisierungs-
Lücken testet.

WIE DEUTEN  Angular vs Linear: - Angular (Standard): teilt die Kameras nach Longitudi
nalwinkel (φ-Koordinate um die Y-Achse) in k  gleiche Sektoren. Fold 0 sind Kameras 
mit φ ∈ [0°, 360/k°), Fold 1 die nächsten, und so weiter. Vorteil: jeder Fold deckt einen 
Teilausschnitt des Orbits ab; der Test-Fold ist räumlich kompakt aber breit über den 
Welt-Datensatz verteilt. Gut für klassische Orbit-Aufnahmen. - Linear (Round-Robin): 
Fold-Index = (image_index modulo k). Das ist die simple „every-k-th„-Aufteilung. Funk
tioniert, wenn die Bildreihenfolge KEINEN spatialen Bias hat (z.B. zufällig sortierte 
Drohnenaufnahmen). Funktioniert schlecht, wenn die Bilder zeitlich clustern.

Im 3D-Globus siehst du sofort: grüne Punkte (Training) und rote Punkte (Test). Wenn 
die roten Punkte alle in einer Ecke clustern, ist der Holdout schlecht (kein guter Gene
ralisierungs-Test). Wenn sie gleichmäßig zwischen den grünen liegen, ist er gut. Der 
Angular-Correlation-Score pro Fold (rechte Sidebar, in Grad) sagt zusätzlich: kleinerer 
Wert = der Test ist nah am Training (jede Test-Kamera hat eine nahe Trainings-Kamera, 
leichter Test); größerer Wert = der Test ist weit weg vom Training (härtere Generalisie
rung).

 Du hast deine Truck-Szene mit 251 Bildern aufgenommen, exportierst per Menü-
Item M33 (Export SfM transforms.json) ein nerfstudio-File. Öffne das Holdout-Window 
(⇧⌘H), lade die JSON via „Open transforms.json…„, schau dir den Globus an. k=5 
(Default) gibt dir 5 Folds. Klick auf „Fold 3“ — siehe ob die roten Marker einigermaßen 
gleichmäßig sind. Falls ja: „Export fold-assignment.json„, lege die exportierte Datei 
in den Reports-Ordner, und beim nächsten Training-Run mit --benchmark  (oder den 
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entsprechenden Inspector-Einstellungen) wird genau diese Fold-Aufteilung als Test-
Holdout verwendet — anstelle des Standards „every-8th“.

W23 Button „Open transforms.json…„

WO

Toolbar oben links..

T E C H N I S C H

Öffnet einen Datei-Auswahldialog, der auf JSON- 
Dateien beschränkt ist. Nach Bestätigung lädt das 
Holdout-Modul die Datei. Der Loader parst sowohl 
das nerfstudio-Format (Kamera-Intrinsics plus Liste 
von Frames mit Bildpfad und Transform-Matrix) als 
auch das instant-ngp-Format (gleicher Aufbau). Pro 
Frame wird die Blickrichtung aus der Transform-Ma
trix extrahiert (z-Achse der Kamera-Lokalbasis) und 
gespeichert. Wenn das Parsen fehlschlägt, wird eine 
Fehlermeldung im Status-Bereich angezeigt.

Auch via CLI: --holdout-file /​pfad/​zu/​
transforms.json startet das Fenster direkt mit gela
dener Datei.

E I N FAC H  G E S AG T

Lädt deine Kamera-Posen-JSON. 
Standard sind Nerfstudio- und 
Instant-NGP-Exports. Radiance­
Kit selbst kann transforms.json 
via Menü → Export → SfM expor­
tieren.

W24 Picker „Strategy„ (angular/linear)

WO

Linke Sidebar, oben..

T E C H N I S C H

Radio-Picker mit zwei Optionen: Angular und Linear. 
Strategy-Wechsel triggert automatisch eine Neube
rechnung der Folds. Die Blickrichtungen sind eine 
Liste von 3D-Einheitsvektoren auf der Sphäre; die 
Angular-Strategie projiziert sie auf den Longitudi
nalwinkel φ und sortiert, die Linear-Strategie macht 
einfach eine Modulo-Aufteilung über den Frame-In
dex.

E I N FAC H  G E S AG T

Angular für gleichmäßige Orbit-
Aufnahmen (Standard, sicher), 
Linear nur wenn deine Bilder 
nicht räumlich clustern.
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W25 Slider „k Folds„

WO

Linke Sidebar, mittig..

T E C H N I S C H

Slider von 3 bis 10, Schrittweite 1. Bei Änderung 
wird die Fold-Berechnung automatisch neu ange
stoßen, sodass die Folds-Liste, die Trainings/Test-
Indices und der pro-Fold-Score sofort neu berech
net werden. Der gewählte Wert wird als monospa
ced-Digit-Text rechts neben dem Label angezeigt.

Faustregel: k=5 ist Standard (gibt dir 20% Test pro 
Fold, das ist üblich für Cross-Validation). k=10 wenn 
du sehr viel Daten hast und mehr Folds für statis
tische Aussagekraft brauchst. k=3 wenn du wenig 
Daten hast.

E I N FAC H  G E S AG T

Wie viele Folds in die Aufteilung. 
5 ist Standard und passt fast im­
mer.

W26 Picker „Test Fold„

WO

Linke Sidebar, unter dem k-Slider..

T E C H N I S C H

Menü-Picker. Optionen sind dynamisch 0..<k, Label 
„Fold 1″ bis „Fold N„ (also 1-indexed in der UI, 0-
indexed intern). Wenn der vorher gewählte Index ≥ k 
ist (z.B. weil du k von 10 auf 5 reduziert hast), wird 
er automatisch auf 0 zurückgesetzt. Der gewählte 
Test-Fold wird im Globus rot dargestellt, alle ande
ren grün.

E I N FAC H  G E S AG T

Welcher Fold gerade der Test-
Fold ist. Du kannst durchklicken 
und siehst, wie jeder einzelne 
Fold im Globus aussieht.
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W27 Button „Export fold-assignment.json„

WO

Linke Sidebar, unten..

T E C H N I S C H

Öffnet einen Speichern-Dialog mit Default- Datei
name fold-assignment.json. Nach Bestätigung ko
diert das Holdout- Modul die aktuelle Aufteilung 
in ein JSON-Schema (per-Frame Fold- Zuordnung 
plus Strategy-Meta-Block). Diese Datei kann dann 
beim nächsten Training mit --benchmark  mit über
geben werden, sodass derselbe Holdout für die 
finale Metrik-Auswertung verwendet wird. Schreib-
Fehler werden als Fehlertext angezeigt; Erfolg in 
grünem Text als „Saved to (filename)„.

E I N FAC H  G E S AG T

Speichert die aktuelle Train/Test-
Aufteilung als JSON. Diese Datei 
kannst du dann beim Training di­
rekt mitgeben, sodass dasselbe 
Test-Set wieder verwendet wird.

W28 SCNView (3D Camera Globe)

WO

Mittelpanel im Holdout-Fenster..

T E C H N I S C H

SceneKit-Globus-View. Die Szene besteht aus: einer 
Wireframe-Kugel (Radius 1.0, 36 Segmente, dunkel
grau), drei farbigen Achsenstummeln (rot/grün/blau 
für X/Y/Z, je 1.2 lang), und pro Kamera einer kleinen 
Markerkugel (Radius 0.03) an der entsprechenden 
Blickrichtungs-Position auf der Einheitskugel (leicht 
außerhalb, damit sie nicht IN der Wireframe-Kugel 
verschwindet). Die Marker werden bei jeder Fold-
Änderung NICHT neu gebaut — Rebuild ist nur 
dann nötig, wenn sich die Frame-Liste ändert (also 
eine neue JSON geladen wird). Stattdessen läuft 
pro Update eine in-place-Aktualisierung der Materi
al- Farben: rot für Test-Indices, grün für Training, 
hellgrau wenn weder noch. So bleiben Slider-Ticks 
performant auch bei N > 1000 Kameras.

Die Kamera-Kontrolle ist aktiviert — du kannst mit 
der Maus den Globus drehen, zoomen, pannen. Be
leuchtung sorgt dafür, dass die Marker nicht flach 
aussehen. Hintergrund ist dunkelgrau.

E I N FAC H  G E S AG T

Der 3D-Globus mit den Kamera-
Positionen. Grün = Training, Rot = 
Test, Hellgrau = nicht zugeordnet 
(kommt nicht vor, alle Kameras 
gehören irgendwohin). Mit der 
Maus kannst du den Globus ro­
tieren und zoomen.
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W29 FoldCard (Tap to Select Fold)

WO

Rechte Sidebar, „Angular Correlation„-Sektion..

T E C H N I S C H

Pro Fold eine Karten-View — abgerundetes Recht
eck mit 6 pt Radius, Padding 10, vertikales Layout 
mit zwei Zeilen (oben „Fold N„ + Kamera-Anzahl, 
unten „Mean nearest angle:“ + Wert in Grad). Hin
tergrundfarbe konditional: aktiver Fold = Akzentfar
be halbtransparent, inaktive = neutrales Standard-
Material. Tippen wählt den Fold, und der Globus 
färbt sich live um.

Der „Mean nearest angle„-Score ist der mittlere 
kleinste Winkel pro Test-Kamera zur nächsten Trai
nings-Kamera (in Radiant intern berechnet, in Grad 
in der UI angezeigt).

E I N FAC H  G E S AG T

Pro Fold eine kleine Karte 
rechts mit Anzahl der Kameras 
und dem Durchschnitts-Abstand 
zur nächsten Trainings-Kamera. 
Klick darauf wählt diesen Fold als 
Test.

BayesOpt Console (W30–W39)

Abbildung 24:  BayesOpt-Konsole — leerer Zustand vor Trial-Start

Leerer Zustand mit Search-Space-Picker (RadianceKit defaults (6-dim)), Trial-Bud
get-Slider (default 40), Random-Seed (42) und drei Empty-Panels für Convergence-
Chart, Trial Log und Search-Space-Parameter-Liste.

Leerer Zustand (nach erstem Öffnen) — Convergence-Chart und Trial-Tabelle füllen 
sich, sobald ein Run gestartet wurde, siehe nächster Shot.
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Abbildung 25:  BayesOpt-Konsole nach 40 Trials — Convergence-Chart steigt steil bis Trial 
15, Best Value 0.9943, Trial Log mit init/bo/restart-Tags

WAS IM BILD ZU SEHEN IST  Status oben rechts „Finished — best 0.9943 after 40 trials„. 
Linke Sidebar: Search-Space-Picker auf RadianceKit defaults (6-dim), Trial-Budget 
40, Random Seed 42. Parameter-Liste zeigt die sechs zu tunenden Hyperparameter mit 
ihren Wertebereichen: mipSmoothing3DScale [0.05, 0.5], mipFilter2DVariance [0.1, 
0.6], densifyGradThreshold [5e-07, 5e-06], ssimWeight [0.05, 0.5], mcmcNoiseScale 
[1e-05, 0.0001], mcmcRelocationInterval [50, 200]. Mitte: Convergence-Chart (X = 
Trial-Index 1–40, Y = Objective Value 0–1) — graue Punkte = Initial-Samples (LHS), 
blaue Punkte = BayesOpt-Acquisition, orange Punkte = Restart-Trials (#22 und #31). 
Beste-Wert-Linie steigt steil bis Trial ~7, dann nur noch marginale Verbesserung bis Trial 
15, ab dort flacher Plateau bei 0.99+. Rechte Sidebar: Trial-Log #1–#34 mit Score + Tag 
(init/bo/restart). Save-Best-Config-Button oben rechts schreibt bayesopt-best.json .

Was es ist: Eine Bayes-Optimierungs-Konsole für Hyperparameter-Suche. Bayes-Opt 
ist ein automatisches Verfahren, das versucht, mit möglichst wenig Experimenten den 
optimalen Punkt einer unbekannten Funktion zu finden — typischerweise: „welche Kom
bination aus mcmcMaxGaussians, capMultiplier, ssimWeight und gradThreshold liefert 
die beste PSNR für meine Szenenklasse?„ Statt eines Grids von 6^4 = 1296 Trials pro
biert Bayes-Opt etwa 40–100 informierte Trials und kommt damit nahe ans Optimum.

Wichtig: Die aktuelle in der App ausgelieferte Version führt die Optimierung nicht 
gegen echte Trainings-Runs aus (das würde Tage dauern), sondern gegen eine synthe
tische Demo-Objektive — eine multi-modale Landschaft mit Hill-Climbing-Charakter 
plus leichtem Noise. Das ist mit Absicht so: das Fenster soll dir das Verhalten des Opti
mierers zeigen (Konvergenz-Verlauf, Sample-Punkte, Best-So-Far) und dich die Search-
Space-Definitionen verstehen lassen. Für echte Trainings-getriebene BayesOpt-Läufe 
(wie in Phase Q7 für die Scene-Class-Presets durchgeführt) wird ein separater offline 
CLI-Workflow benutzt; das Fenster ist die Live-UI-Variante.

WANN ÖFFNEN  Drei Anwendungsfälle: 1. Du willst verstehen, wie BayesOpt arbeitet — 
dann starte einen Demo-Run und beobachte den Convergence-Chart. 2. Du planst eine 
neue Szenenklasse (etwa „Aquarien„ oder „Antike Möbel“), für die die eingebauten 10 
Presets nicht perfekt passen. Definiere mental einen Suchraum, prüfe ihn hier mit dem 
„Bowl demo„ oder „Densify“-Preset, exportiere dann die Best-Config als JSON und 
nutze sie als Startpunkt für einen echten Trainings-Run. 3. Du willst die im RKBayesOpt-
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Package definierten Default-Search-Spaces (Mip-Subset, RadianceKit Defaults) inspi
zieren — die werden im Parameter-Panel der linken Sidebar aufgelistet.

WIE DEUTEN  - Convergence-Chart (mittlere Spalte): Y = beste bisher erreichte Objec
tive-Funktion-Wert. X = Trial-Index. Anfangs steil ansteigend (BayesOpt probiert die 
Initial-Samples zufällig, einige davon sind glücklich), dann zunehmend flach, weil die 
nahen-Optimum-Region ausgeschöpft ist. Wenn die Linie für 20+ Trials flach bleibt, 
kannst du den Run stoppen — weitere Trials bringen nichts mehr. Die einzelnen Punkte 
im Chart sind die individuellen Trial-Werte (also nicht „best so far„), gefärbt nach 
Phase: grau = initial sample, blau = bayesopt acquisition, orange = restart. - Trial-
Tabelle (rechte Spalte): #1, #2, #3, … mit jeweils Wert und Phase-Tag. Der bisher beste 
Trial ist mit einem gelben Stern markiert. Aus der Tabelle kannst du den Best-Trial iden
tifizieren und seine Parameter-Werte später beim Export anschauen. - Search-Space-
Inspektor (linke Sidebar): zeigt für das gewählte Preset alle Parameter-Namen und ihre 
Suchbereiche [lo, hi] . Wenn du beim Preset „RadianceKit defaults (6-dim)“ stehst, 
siehst du z.B. „densifyGradThreshold [5e-7, 5e-6]„ — also log-uniform zwischen diesen 
beiden Werten.

 Wähle Preset „RadianceKit defaults (6-dim)„, Trial-Budget 40, Seed 42. Klick 
„Start“. Beobachte: die ersten 8 Trials sind grau (initial samples, LHS-Latin-Hypercube), 
die folgenden blau (BayesOpt-akquiriert). Der Convergence-Chart wird steil bis Trial 
~15, danach flacht er ab. Bei Trial ~30–40 stabilisiert sich der beste Wert. Klick „Save 
Best Config„ — eine bayesopt-best.json  wird gespeichert mit dem Preset-Namen, 
Trial-Index, Wert und den dekodierten Parameter-Werten. Diese JSON kannst du dann 
manuell in deine Preset-Definition übernehmen.
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W30 Button „Start„

WO

Toolbar links, im Idle/Finished-State..

T E C H N I S C H

Setzt die Trial-Liste zurück, wechselt in den Run
ning-State, generiert eine neue Run-ID (für Stale-
Detection bei mehrfachen Start-Clicks) und erzeugt 
ein frisches Pause-Gate. Dann startet ein Hinter
grund-Task, der den Optimierer als asynchronen 
Stream ausführt. Initial-Samples-Größe ergibt sich 
aus min(8, budget /​ 4 + 1) — also typisch 8 Latin-
Hypercube-Samples bei Budget ≥ 28, weniger bei 
kleinem Budget. Trial-Updates werden inkrementell 
empfangen und in die Liste angehängt. Stale-Run-
Protection: wenn währenddessen ein zweiter Start-
Klick die Run-ID neu setzt, werden Updates aus 
dem alten Run verworfen.

Primary-Action-Style für den prominenten Knopf-
Look.

E I N FAC H  G E S AG T

Startet einen frischen Optimie­
rungs-Lauf mit dem aktuellen 
Suchraum, Budget und Seed.

W31 Button „Pause„

WO

Toolbar links, im Running-State..

T E C H N I S C H

Setzt das Pause-Gate aktiv und wechselt in den 
Paused-State. Der eigentliche Effekt: der Runner 
wartet in einem 50-ms-Polling-Loop bevor er die 
nächste Objective-Funktion auswertet. Das bedeu
tet, ein gerade laufendes Trial wird zu Ende geführt 
(es ist ja synthetisch und dauert nur Mikrosekun
den), aber kein weiteres Trial wird angestoßen. 
Sobald Resume läuft, geht es weiter wo aufgehört 
wurde.

E I N FAC H  G E S AG T

Hält den Lauf an. Aktuelle Be­
rechnung läuft noch zu Ende, 
dann pausiert es.
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W32 Button „Stop„

WO

Toolbar links, im Running- und Paused-State..

T E C H N I S C H

Bricht den Runner-Task ab, nullt die Referenz, löst 
das Pause-Gate (falls noch paused war), und wech
selt in den Finished-State (wenn Trials existieren) 
oder Idle-State (wenn keine). Die bereits berechne
ten Trials bleiben in der Liste sichtbar — Stop löscht 
sie nicht. Destruktive Button-Rolle zeigt den Knopf 
in Rot, weil er den Run abbricht.

E I N FAC H  G E S AG T

Bricht den Lauf endgültig ab. Tri­
als bleiben sichtbar, du kannst 
die Best-Config trotzdem expor­
tieren.

W33 Button „Resume„

WO

Toolbar links, im Paused-State..

T E C H N I S C H

Löst das Pause-Gate und wechselt in den Running-
State zurück. Der Runner-Task läuft schon (er war
tet ja im Polling-Loop); sobald der Loop merkt, dass 
die Pause aufgehoben ist, läuft er weiter und startet 
das nächste Trial.

E I N FAC H  G E S AG T

Setzt einen pausierten Lauf fort.
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W34 Button „Save Best Config„

WO

Toolbar rechts, immer sichtbar (aber disabled wenn 
kein bestTrial vorhanden)..

T E C H N I S C H

Öffnet einen Speichern-Dialog mit Default- Datei
name bayesopt-best.json , auf JSON beschränkt. 
Nach Bestätigung wird ein Payload-Dictionary ge
baut: Preset-Name, Trial-Index, Wert (Objective-
Score), Parameter (Dictionary der dekodierten Para
meter- Namen → Werte). Die Decodierung projiziert 
die normalisierten Suchraum-Koordinaten in [0,1]^d 
zurück in den Original-Wertebereich (mit log-
uniform/linear/integer-Skalen entsprechend). JSON-
Output ist pretty-printed und mit sortierten Keys. 
Bei Schreib-Fehler wird (in der aktuellen Demo-Ver
sion) still ignoriert — keine Error-UI, weil das ein 
Demo-Path ist.

Der Button bleibt grau, solange kein Trial gelaufen 
ist.

E I N FAC H  G E S AG T

Speichert die Parameter-Werte 
des bisher besten Trials als 
JSON. Du kannst diese Werte 
dann manuell in deine Preset-
Konfiguration übernehmen.
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W35 Picker „Search Space„-Preset

WO

Linke Sidebar, oben..

T E C H N I S C H

Menü-Picker mit vier Preset-Optionen: - „Radi
anceKit defaults (6-dim)„ — der vollständige Stan
dard-Suchraum mit allen Q7-Hyperparametern. - 
„Mip subset (2-dim)“ — nur mipSmoothing3DScale 
[0.05, 0.5] log-uniform und mipFilter2DVariance 
[0.1, 0.6] linear. Nützlich wenn du Mip-Splatting für 
eine Szenenklasse tunen willst. - „densify-until + 
ssim-weight + grad-thresh„ — drei Densify-relevan
te Parameter (densifyGradThreshold log-uniform, 
ssimWeight  linear, densifyUntilIter  integer). - 

„Bowl demo (1-dim)“ — pädagogischer Single-Para
meter-Suchraum für „so funktioniert BayesOpt„-De
mos.

Während ein Lauf aktiv ist, kann der Suchraum 
nicht gewechselt werden (würde den Optimizer ver
wirren).

E I N FAC H  G E S AG T

Welchen Hyperparameter-Such­
raum BayesOpt durchsucht. 
Standard ist „RadianceKit de­
faults„. Für gezielte Mip-Tuning-
Versuche „Mip subset“. Zum Ver­
stehen wie BayesOpt arbeitet 
„Bowl demo„.

W36 Slider „Trial Budget„

WO

Linke Sidebar, unter dem Search-Space-Picker..

T E C H N I S C H

Slider von 10 bis 200, Schrittweite 5. Default
40. Das bedeutet: BayesOpt darf maximal N Trials 

machen. Davon sind die

ersten paar initiale Samples (Latin-Hypercube), der 
Rest sind echte BayesOpt-Trials. Faustregeln für die 
Praxis: ein Suchraum mit d Dimensionen braucht 
etwa 10d bis 20d Trials für ein gutes Optimum. Bei 
6-dim Defaults also 60–120, bei 2-dim Mip-Subset 
20–40, bei 1-dim Bowl-Demo 10–20.

Während des Laufs ist der Slider deaktiviert.

E I N FAC H  G E S AG T

Wie viele Optimierungs-Versuche 
maximal. Mehr Versuche = bes­
sere Lösung, aber kostet mehr 
Zeit. 40 ist guter Default für die 
Demo-Objective.
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W37 Slider „Random Seed„

WO

Linke Sidebar, unter dem Budget-Slider..

T E C H N I S C H

Slider von 1 bis 100, Schrittweite 1. Default
42. Der Seed wird sowohl an die initialen Latin-Hy

percube-Samples als

auch an die Noise-Komponente der Demo-Objective 
weitergereicht. Reproduzierbarkeit: gleicher Seed + 
gleicher Suchraum + gleiches Budget ergibt exakt 
identische Trial-Sequenz. Nützlich für „bekommen 
alle deine Kollegen denselben Lauf wenn sie das 
Demo nachbauen?„. Während des Laufs deaktiviert.

E I N FAC H  G E S AG T

Steuert den Zufallsgenerator. 
Selber Seed = selber Lauf — zum 
Reproduzieren.

W38 Chart (Convergence)

WO

Mittlere Spalte des Fensters..

T E C H N I S C H

Swift-Charts-Diagramm mit zwei Layern: 1. eine Li
nie für „best-value-so-far„ pro Trial — eine monoton 
steigende oder gleichbleibende Kurve in Akzentfar
be. 2. ein Punkt pro Trial mit dem individuellen 
Objective-Wert, gefärbt nach Phase. Symbol-Größe 
40. Drei Phase-Labels: „init“ (grau), „bo„ (blau), „re
start“ (orange).

Eine kleine Legende zeigt die Phase-Farben oben 
links. Wenn die Trial- Liste leer ist (vor dem ersten 
Start), wird stattdessen eine Empty- State-Anzeige 
mit Chart-Icon und Hinweis „Press Start to begin a 
BayesOpt run.„ eingeblendet.

E I N FAC H  G E S AG T

Der Verlaufs-Chart. Die durchge­
zogene Linie ist „beste bisher 
gefundene Lösung„; die Punk­
te sind die einzelnen Versuche. 
Wenn die Linie für lange Zeit 
flach bleibt, hat BayesOpt das 
Optimum gefunden.
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W39 Table (Trial Log)

WO

Rechte Spalte des Fensters..

T E C H N I S C H

Scroll-Bereich mit lazy gestapelten Trial- Zeilen. Pro 
Zeile ein horizontaler Stack: Trial-Nummer (3-stellig 
monospaced, links), Wert (monospaced, rechtsbün
dig, 70 pt breit), Phase- Tag (Capsule, gefüllt mit 
Phase-Farbe bei 25% Opacity), optional ein gelber 
Stern wenn dieser Trial der aktuell beste ist. Ein 
Auto-Scroll-Mechanismus springt automatisch ans 
Ende, sobald ein neuer Trial dazukommt — sodass 
du den Live-Verlauf am Bildschirm-Boden mitlesen 
kannst, ohne selbst zu scrollen.

E I N FAC H  G E S AG T

Die Tabelle aller Versuche. Wert, 
Phase, Stern für den besten. 
Scrollt automatisch mit, neue Tri­
als erscheinen unten.

Hauptfenster: Verlustverlauf und Gaussian-Count (I39–I41, 
Querverweis)

Drei der Inspector-Anzeigen im Hauptfenster verdienen eine eigene Erklärung, weil sie 
während eines laufenden Trainings ständig zu sehen sind und es wichtige Faustregeln 
gibt, wann der Verlauf gesund aussieht. Die Anzeigen sind im Inspector unter der „Loss 
Chart„-Sektion (siehe Kapitel 2 — Inspector) und ergänzen die Holdout-Analyse aus 
dem Aux-Fenster oben.

Wann ist die Loss-Kurve gesund? Eine gesunde Loss-Kurve zeigt drei Phasen: (1) 
Warmup — die ersten 200–500 Iterationen fällt der Loss steil von hoch (typisch 
0.15–0.25 für L1+SSIM-kombiniert je nach Szene) auf etwa die Hälfte. Wenn der Loss 
in dieser Phase NICHT fällt, ist meist die Eingabe falsch (Bilder kaputt, SfM-Posen 
schlecht, Anzahl Initial-Gaussians zu klein). (2) Densification — zwischen ~500 und 
densifyUntilIteration (klassisch 15K, MCMC bis 20K oder 25K) fällt der Loss weiter, oft 
mit kleinen Sprüngen nach unten wenn Densify-Operationen neue Gaussians einfügen 
und der Optimizer sie ausnutzt. Der Gaussian-Count steigt in dieser Phase. (3) Refine
ment — danach läuft der Loss in einen flacher werdenden Tail. Typische End-Werte: 
Tanks-&-Temples Truck mit P4 Quality landet bei L1 ≈ 0.023, Horse mit Full Classic 
V546 bei L1 ≈ 0.0230, Outdoor-Mip-NeRF360-Szenen oft schlechter (0.04–0.07).

Was bedeutet ein Plateau? Ein Plateau (Loss-Kurve verläuft horizontal über mehrere 
Tausend Iterationen) hat zwei Interpretationen: (a) das Modell hat konvergiert, weiteres 
Training bringt nichts mehr — das ist der gute Fall. (b) das Modell ist stuck (lokales 
Minimum, schlechte Gradient-Information, ein Cap am Buffer-Limit) — der schlechte 
Fall. Beide sehen im Chart identisch aus. Unterscheidung: schau dir den Gaussian-
Count an. Wenn er auch flach ist UND dem MCMC-Cap nahe (z.B. 150K von 150K bei 
.fullMCMC ), bist du am Limit — entweder Cap erhöhen oder Plateau akzeptieren. Wenn 

der Gaussian-Count noch wächst, aber der Loss nicht fällt, ist das stuck.
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Wann abbrechen vs weitertrainieren? Faustregel: 10K Iterationen lang keine Verbes
serung des Min-Loss → abbrechen, weitere Iterationen sind verschwendet. Davor: 
kannst du via Cmd+T (Training-Menü → Continue Training → +5K iterations) noch 
eine Verlängerung anhängen, falls du grenzwertige Verbesserung siehst. Achtung: bei 
MCMC ist das Plateau oft echt — das Cap ist die natürliche Grenze.

Gaussian-Count-Plateau ist KEIN „fertig„-Signal. Es bedeutet nur, dass MCMC das 
Cap erreicht hat oder dass Classic Densification ausgereizt ist. Die echte „fertig“-Frage 
stellt erst die Holdout-Analyse — PSNR/SSIM/LPIPS auf einem unabhängigen Test-Set, 
ausgewertet im Holdout-Window (W23–W29) oder via --benchmark -Flag.

PSNR/Holdout ist die Wahrheit, Loss nur Proxy. Der Loss ist eine relative Metrik: er 
fällt während dein Modell sich an die Trainings-Views anpasst. Ein niedriger Loss heißt 
aber nicht automatisch gutes Modell — wenn das Modell die Trainings-Bilder auswendig 
gelernt hat (Overfitting), wäre der Loss klein, aber die PSNR auf ungesehenen Views 
(Holdout) wäre schlecht. Deshalb: für die finale Qualitätsbewertung immer auf Holdout-
Metriken schauen, nicht auf End-Loss allein.

Faustregel-Box

• User Guide und Keyboard Shortcuts sind statische Hilfe — bei Stichwort-Fragen 
schnell, für Tiefe das hier vorliegende Manual nutzen.

• Manage Storage öffnen, sobald die Platte unter 10% freien Speicher fällt. Logs und 
Imports-Staging sind die üblichen Sünder.

• Pareto Dashboard erst nach mindestens drei oder vier Trainings-Reports sinnvoll. X-
Achse = Kosten (Time / Gs), Y-Achse = Qualität (PSNR / SSIM). Pareto-Front zeigt die 
effizienten Kombinationen.

• Holdout Analysis nutzen, bevor du PSNR-Benchmarks mit anderen veröffentlichst — 
sichert dir, dass dein Test-Set wirklich repräsentativ ist.

• BayesOpt Console ist primär ein Lern- und Inspektions-Werkzeug für Suchraum-
Definitionen. Für echte Trainings-getriebene Hyperparameter-Tuning den offline CLI-
Workflow nutzen.

• Loss-Plateau und Gaussian-Count-Plateau sind getrennt zu interpretieren. Cap-Limit 
ist kein „fertig„-Signal. Echte Qualität misst nur Holdout-PSNR.

• 10K Iterationen ohne Min-Loss-Verbesserung → Training stoppen.
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K A P I T E L

Kapitel 6 — Trainings-Konfiguration

Abbildung 26:  Preview-Preset als JSON exportiert + in TextEdit angezeigt — Felder id/na
me/category/version/createdAt/description, trainingConfig mit allen relevanten Parametern 

(maxIterations 5000, densifyUntilIteration 3500, ssimWeight 0.20, renderScale 0.50, strategy 
classic, cameraAlignment applePhotogrammetry, densifyGradThreshold 2.0e-06, opacityRe

setInterval 3000, minOpacity 0.005, sechs Bool-Toggles)

WAS IM BILD ZU SEHEN IST  Ein typischer Preset-JSON-Export. Top-Level-Felder: id  
(UUID), name , (classic | mcmc | sceneClass | custom), (Schema-Version), (Timestamp), 
(Free-Text). Verschachteltes -Objekt enthält die für Reproduzierbarkeit kritischen Para
meter — beim Import wird der gesamte Block in die TrainingConfig -Struktur deseria
lisiert, und Defaults aus der App-Version füllen die Felder, die in der JSON fehlen (z. 
B. nach App-Update). Wer ein Preset an einen anderen Mac übergibt, schickt einfach 
diese JSON-Datei rüber.

Die TrainingConfig -Struktur ist das Herzstück jedes Trainingslaufs in RadianceKit. Sie 
versammelt jeden Parameter, der das Training beeinflusst — von der maximalen Iterati
onszahl über die acht Lernraten bis hin zu den Spezialfeldern für MCMC, Mip-Splatting, 
das Curriculum und die scene-aware Cap-Logik. Du bearbeitest sie in der Sidebar im 
Bereich Trainings-Konfigurations-Sektion (Expert View), speicherst sie als Preset oder 
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reichst sie als JSON-Export an einen anderen Mac weiter. Beim Training wird genau 
dieses Objekt eingefroren und ans GPU-Backend gegeben.

Dieses Kapitel ist Referenz-Material für Power-User und Skript-Autoren. Es listet alle 81 
öffentlichen Felder, die 9 statischen Presets und die eine öffentliche Methode. Quellda
tei ist TrainingConfig.swift — bei Zweifeln gilt der dort hinterlegte Doc-Comment und 
der Initializer-Default als Source-of-Truth.

H I N W E I S  ·  U I  V S .  P R E S E T/ C L I

Nur 12 der 81 Felder haben einen direkten Schieberegler, Toggle oder Picker im 
Inspector (sandboxed App-Store-Build): T1, T2, T17, T20, T22, T38, T56–T58, 
T60, T61, T73. Die restlichen 69 Felder werden über das gewählte Preset (Kapitel 
7) gesetzt und lassen sich nur per CLI-Flag (siehe Kapitel 5) direkt überschreiben. 
Diese Trennung ist Absicht: Defaults bleiben stabil und produktionserprobt, Power-
User haben dennoch eine Escape-Luke. Wenn ein Feld dich besonders interessiert: 
schau zuerst in Kapitel 2 (Inspector) und Kapitel 5 (CLI) nach, ob du es ohne 
JSON-Bastelei erreichst.

Inhaltsverzeichnis:

1. Iteration (T1–T2)
2. Learning Rates (T3–T10)
3. Densification — Classic (T11–T16)
4. Loss (T17–T20)
5. SH-Degree-Progression (T21)
6. Performance (T22–T25)
7. Diagnose und Punktwolken-Vorbereitung (T26–T30)
8. Regularisierung (T31–T37)
9. Refinement (T38–T44)

10. Sky-Dome (T45–T48)
11. Adam + LR-Schedule (T49–T55)
12. Post-Processing + Apple AI (T56–T60)
13. MCMC-Densification (T61–T73)
14. Mip-Splatting (Q1.5) (T74–T76)
15. Adaptive Densification (Q5) (T77–T79)
16. Curriculum (Q6) (T80–T81)
17. Statische Presets (TP1–TP9)
18. Methode:
19. Welches Feld wofür? (Cheat-Sheet)
20. Gefährliche Felder

111 / 233



R A D I A N C E K I T Kapitel 6 — Trainings-Konfiguration

Iteration (T1–T2)

T1 maxIterations

D E TA I L S

Default: 30 000 (Initializer), 35 000 ( .full ), 200 
000 ( .fullMCMC ) Range: 1 000 – 500 000 (UI-
Slider), keine harte obere Grenze in der Logik Defi
ned in:

T E C H N I S C H

Gesamtzahl der Trainings-Iterationen, die das Ba
ckend durchläuft. Eine Iteration bezeichnet ein 
Forward-Render einer einzelnen Trainingskamera, 
einen Backward-Pass über alle Loss-Komponen
ten (L1 + SSIM + optionale Regularisierungen + 
Sky-Mask) und einen Adam-Optimizer-Schritt. Die
se Zahl wirkt direkt auf die anderen Schedules: 
Position-Lernrate folgt einer Cosine-Annealing-Kur
ve von 0 bis entweder T1  selbst oder bis 
T49 positionLRScheduleEndIteration; Densification 
stoppt bei T2 densifyUntilIteration; MCMC-Noi
se-Decay endet bei T69 mcmcNoiseDecayEnd; SH-
Degree-Upgrades passieren an den drei in T21  de
finierten Marken. Bei klassischer Densification liegt 
der empirisch ermittelte sweet spot bei 20 000–
35 000 Iterationen (Sessions 1–32, V546-Tests), 
bei MCMC bei 60 000–200 000 (V534). Eine dras
tische Erhöhung über die in Preset hinterlegten 
Werte hinaus bringt selten zusätzliche Qualität — 
Adam-Momentum sättigt, und ohne LR-Decay-Ende 
stagniert der Loss. Umgekehrt führt Unterschrei
tung von ~5 000 zu unvollständig konvergierten 
Geometrien (Density-Control hat zu wenig Zeit zum 
Klonen/Splitten).

E I N FAC H  G E S AG T

Wie lange die App rechnet. Mehr 
Iterationen = besseres Ergeb­
nis, aber irgendwann nicht mehr 
spürbar besser, dafür viel länger. 
Die Presets sind so gewählt, dass 
du ohne nachzudenken einen gu­
ten Wert hast: Quick 1 000, Pre­
view 5 000, Balanced 20 000, 
Quality 35 000, MCMC Quality 
200 000. Wenn du selbst dran 
drehst, gilt: bei MCMC darfst du 
gerne hoch (100 000–200 000), 
bei Classic nicht über 40 000 — 
bringt dann nichts mehr.
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T2 densifyUntilIteration

D E TA I L S

Default: 15 000 (Initializer), 5 000 ( .full ), 160 
000 ( .fullMCMC ) Range: 0 – Defined in:

T E C H N I S C H

Iteration, ab der die Densification aufhört. Bis 
hierhin werden Gaussians über die in T11–T16  
(Classic) oder T67–T70  (MCMC) parametrisierten 
Regeln geklont, gesplittet und geprunt; danach 
bleibt die Gaussian-Anzahl konstant und nur noch 
Positionen, Rotationen, Skalen, Opazitäten und SH-
Koeffizienten werden optimiert (Refinement-Phase). 
Im 3DGS-Originalpaper liegt der Wert bei 50 % 
von T1 , in RadianceKits .full -Preset bei nur ~14 
% (5 000 von 35 000) — Folge der V310/V338-
Experimente, die zeigten, dass nach 5 000 Itera
tionen weitere Densifizierung das Resultat eher ver
schlechtert (mehr Floaters, mehr Speicherbedarf, 
kein Qualitätsgewinn). MCMC dagegen läuft die Re
location bis 80 % von T1  (V504b), weil MCMC 
keine schädlichen Floaters produziert. Wird T2  zu 
klein gewählt (< 1 000), entstehen zu wenige Gaus
sians; zu groß bei Classic (> 50 % von T1 ) führt 
zu Overgrowth und RGB-Saturation-Outliers (siehe 
Outdoor-Overtraining-Findings).

E I N FAC H  G E S AG T

Bis wann die App neue Gaussians 
erzeugen darf. Danach wird nur 
noch verfeinert, was schon da 
ist. Bei klassischem Training mit 
35 000 Iterationen ist hier 5 000 
der richtige Wert — alles darüber 
macht die Szene matschiger. Bei 
MCMC ist es 80 % der Gesamtite­
rationen (also 160 000 bei 200 
000-Lauf). Wenn du Quality-Pre­
set änderst, lass dieses Feld lie­
ber in Ruhe.
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Learning Rates (T3–T10)

T3 positionLearningRate

D E TA I L S

Default: 0.00016 Range: 1e-7 – 1e-3 (empfohlen) 
Defined in:

T E C H N I S C H

Adam-Lernrate für die XYZ-Position jeder Gaussian 
zu Beginn des Trainings (Iteration 0). Folgt einer 
Cosine-Annealing-Kurve und sinkt im Laufe des 
Trainings auf T4 positionLearningRateFinal. Der 
Default 0.00016 stammt aus dem 3DGS-Originalpa
per (Kerbl et al. 2023) und ist in RadianceKit auch 
bei Erhöhung der Bildauflösung nicht zu skalieren 
— die Position bewegt sich im Welt-Koordinatensys
tem, nicht im Pixelraum. Eine deutliche Erhöhung 
(> 0.0005) bewirkt, dass Gaussians über lange Di
stanzen springen und der Loss instabil wird; Werte 
deutlich darunter (< 0.00005) führen dazu, dass 
falsch initialisierte Punktwolken nie ihren Platz fin
den. V414 testete eine Verdopplung des Init-Werts 
→ 16.8 % schlechterer L1-Loss; die V544a-Tunings 
bestätigten den Paper-Default als optimal. Beachte: 
bei .fullMCMC  lassen wir diesen Wert bewusst 
beim Default — MCMC braucht konstante Lernraten 
für seine Relocation-Logik, daher bringt das Tunen 
hier nichts.

E I N FAC H  G E S AG T

Wie schnell sich die Splatt-Punk­
te im Raum bewegen dürfen. 
Der Standardwert ist sehr gut 
justiert und braucht eigentlich 
keine Änderung. Nur wenn dir 
Splats im Bild „herumeiern„ oder 
eine ganze Ecke fehlt, weil sich 
nichts hinbewegt, wäre die Lern­
rate ein Punkt zum Drehen — 
aber dann passt typischerwei­
se vorher schon etwas ande­
res nicht (Kameraposen, Initial­
punktwolke).
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T4 positionLearningRateFinal

D E TA I L S

Default: 0.0000016 (Initializer + Paper), 0.000016 
( .full , .fullMCMC  — 10× höher) Range: 0 – De
fined in:

T E C H N I S C H

Endwert der Position-LR-Cosine-Annealing-Kur
ve. Erreicht wird er entweder bei 
T1 maxIterations  oder, falls gesetzt, bei T49 
positionLRScheduleEndIteration. Der RadianceKit-
.full -Preset verwendet 0.000016 — also 10× 

höher als der Paper-Default 0.0000016. V420-
Experimente zeigten, dass 0.5× des Final-Werts 
(0.000008) den Loss um 6.4 % verschlechtert; V414 
zeigte, dass 2× Init-Wert ihn um 16.8 % verschlech
tert. Der hohe Final-Wert ist nicht Trade-off, son
dern bewusste Wahl: bei zu starkem Decay verlieren 
die Gaussians während der Refinement-Phase ihre 
Fähigkeit, sich auf neu hinzugekommene Densifica
tion-Kandidaten einzustellen. Über die V431/V433-
Erweiterung kann die Schedule-Phase verkürzt wer
den ( T49 < T1 ), sodass T4  bereits vor Training
sende erreicht wird und der Rest des Trainings bei 
konstanter Mini-LR läuft — typische Konfiguration: 
T49 = 20 000 , T1 = 35 000 , Refinement also bei 

0.000016 für 15 000 Iterationen.

E I N FAC H  G E S AG T

Wie langsam die Position-Lernra­
te am Ende des Trainings wird. 
Wir haben das bewusst weniger 
aggressiv eingestellt als das Ori­
ginalpaper — Splats können bis 
zum Schluss noch ein bisschen 
wackeln, das macht sie schärfer. 
Wenn du daran drehst: höher = 
unruhigere Splats am Ende, nied­
riger = Splats können sich nicht 
mehr anpassen, wenn neue auf­
tauchen.
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T5 shDCLearningRate

D E TA I L S

Default: 0.0025 (Initializer + Paper), 0.005 ( .full  
und alle MCMC-Presets — 2×) Range: 0.0001 – 
0.05 Defined in:

T E C H N I S C H

Adam-Lernrate für den DC-Anteil (degree 0, al
so konstantes Albedo) der spherical-harmonic-Far
be. SH-DC entspricht dem direktionsunabhängigen 
Grundton einer Gaussian, gewissermaßen die „Ba
sisfarbe„. Die V176- und V188-Experimente fanden 
2× höher als der Paper-Default optimal — schnellere 
Farb-Konvergenz, gerade weil bei kurzem Training (, 
5 000 Iterationen) die SH-DC sonst nicht in Form 
kommt. Anders als die geometrischen LRs hat SH-
DC keinen Decay; die Lernrate bleibt über alle Itera
tionen konstant (oder folgt nur dem optionalen ex
tended-phase-Decay aus T51 ). V416 testete eine 
Vervierfachung auf 0.01 → 6.4 % schlechterer Loss 
bei beta2=0.99-Adam.

E I N FAC H  G E S AG T

Wie schnell sich die Grundfarbe 
jedes Splats anpasst. Den Wert 
ändert man fast nie selbst — 
die Presets haben den richti­
gen Wert. Höher ginge schneller, 
kann aber zu instabilen Farben 
führen.
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T6 shRestLearningRate

D E TA I L S

Default: 0.000125 (Initializer + Paper), 0.00025 
( .full  und MCMC — 2×) Range: 0.000001 – 
0.005 Defined in:

T E C H N I S C H

Adam-Lernrate für die SH-Koeffizienten höherer 
Ordnung (Degree 1, 2, 3 — also die view-direc
tion-abhängigen Farbanteile, die für Glanzlichter, 
Spiegelungen und sanfte Schattierung sorgen). 20× 
kleiner als T5  per Paper-Konvention, weil diese 
Koeffizienten quadratisch in Anzahl wachsen (3 für 
Degree 1, 5 für Degree 2, 7 für Degree 3 → insge
samt 15 Floats pro Gaussian) und ohne kleinere 
Lernrate das Bild übersättigen würden. Wird in zwei 
Schritten freigeschaltet — bis zur ersten Marke in 
T21 shDegreeUpgradeIterations ist nur Degree 0 
aktiv (also nur T5 ), danach 1, später 2, schließlich 
3. Niedrige Werte hier sind besonders wichtig auf 
Szenen mit viel diffuser Beleuchtung; bei sehr glän
zenden Oberflächen (Auto-Lack, Wasser) lohnt sich 
kein Drehen — die SH-Repräsentation an sich ist 
begrenzt.

E I N FAC H  G E S AG T

Wie schnell die richtungsabhän­
gigen Farb-Effekte (Spiegelun­
gen, Glanz) lernen. Standardmä­
ßig sehr klein, weil sonst al­
les glänzt. Den Wert lässt man 
besser stehen — wer Glanzlich­
ter besser hinbekommen will, ist 
eher bei MCMC und längerer Trai­
ningszeit besser bedient als bei 
dieser LR.
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T7 opacityLearningRate

D E TA I L S

Default: 0.05 (Initializer + Paper), 0.1 ( .full , 
MCMC — 2×) Range: 0.001 – 1.0 Defined in:

T E C H N I S C H

Adam-Lernrate für die logit-Opazität jeder Gaussi
an. Die App speichert Opazität als unbeschränkten 
Float-Wert und transformiert ihn mit Sigmoid in [0, 
1]; die LR wirkt im Logit-Space. Der Paper-Default 
0.05 ist nach V50-Tests (Best Single-Run L1 0.1664) 
wiederhergestellt, V71 revertete V67s 0.025. Die 
V188-Verdopplung auf 0.1 macht das Pruning effizi
enter — tote Gaussians fallen schneller unter den 
T14 pruneOpacityThreshold ab. V418 zeigte: 0.05 
mit beta2=0.99-Adam ist 7.1 % schlechter als 0.1 — 
die Wechselwirkung mit der Adam-Konfiguration ist 
nicht trivial. Niedrige Werte (< 0.01) führen dazu, 
dass „dead„ Gaussians ewig herumliegen und Spei
cher verbrauchen; zu hohe Werte (> 0.5) können zu 
Opacity-Explosion führen, daher wird der Logit-Wert 
im Optimizer auf [−15, 3] geclampt (siehe Notiz 
„Opacity Explosion Prevention“ in CLAUDE.md).

E I N FAC H  G E S AG T

Wie schnell Splats durchsich­
tig oder undurchsichtig wer­
den. Wichtig fürs Aufräumen 
— Splats, die nichts beitragen, 
müssen schnell verschwinden, 
damit kein Schleier entsteht. 
Standardwert passt, nur Profis 
ändern ihn.
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T8 opacityLearningRateFinal

D E TA I L S

Default: 0.0 (= „kein Decay„) Range: 0 oder 0.001 – 
Defined in:

T E C H N I S C H

Optionaler Cosine-Decay-Endwert für die Opacity-
LR (V427). Wenn 0.0, ist Decay deaktiviert und 
die Opacity-LR bleibt über das gesamte Training 
konstant bei T7 . V427 testete einen Decay 0.1 → 
0.01 — Ergebnis 11.5 % schlechterer Loss; reverted, 
daher der Default „aus„. Die Hypothese hinter dem 
Feld: in der Refinement-Phase könnte konstante 
Opacity-LR zu Oszillation führen, sodass Splats, die 
schon das richtige Maß an Transparenz erreicht ha
ben, durch zufällige Gradient-Schwankungen wieder 
verschoben werden. Empirisch bestätigt sich das 
nicht — die Logit-Clamping-Logik fängt das ohnehin 
ab. Das Feld bleibt verfügbar für zukünftige Experi
mente; auch sehr lange MCMC-Läufe (> 500K Itera
tionen) könnten davon profitieren.

E I N FAC H  G E S AG T

Ob die Opacity-Lernrate gegen 
Ende kleiner werden soll. Stan­
dard: nein. Wir haben es pro­
biert, war schlechter, lassen es 
deaktiviert. Bleib bei 0.

T9 scaleLearningRate

D E TA I L S

Default: 0.005 (Initializer + Paper), 0.01 ( .full , 
MCMC — 2×) Range: 0.0001 – 0.1 Defined in:

T E C H N I S C H

Adam-Lernrate für die drei Skalen-Komponenten je
der Gaussian im log-Space (RadianceKit speichert 
log(scale), damit Skalen positiv bleiben). Der Paper-
Default 0.005, in RadianceKit verdoppelt auf 0.01 
für besseren Scale-Konvergenz bei den optimierten 
Lernraten-Konfigurationen. V423-Experiment: 0.005 
mit beta2=0.99-Adam → 18.7 % schlechterer Loss 
und sichtbar zu wenige Gaussians (Density-Control 
konnte nicht klonen, weil die Skalen-Updates zu 
lahm waren). Skala kontrolliert die Ausdehnung je
der Gaussian — zu schnelles Lernen führt zu „need
le„-Gaussians (extrem lange dünne Splats, siehe 
T34 scaleRatioPruneThreshold), zu langsames Ler
nen lässt Splats zu kompakt bleiben und Density-
Control muss zu oft splitten.

E I N FAC H  G E S AG T

Wie schnell die Form der Splats 
sich anpasst. Standard ist gut. 
Wenn du das hochdrehst, be­
kommst du gerne „Nadel„-Splats 
— extreme lange dünne Tropfen, 
die das Bild floaten lassen.
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T10 rotationLearningRate

D E TA I L S

Default: 0.001 (Initializer + Paper), 0.002 ( .full , 
MCMC — 2×) Range: 0.0001 – 0.05 Defined in:

T E C H N I S C H

Adam-Lernrate für die vier Quaternion-Komponen
ten jeder Gaussian. Die Quaternion wird in jedem 
Optimizer-Schritt nach der Adam-Update wieder 
normalisiert (L2-Norm = 1) — andernfalls würde 
die Kovarianzmatrix entartet. RadianceKit verdop
pelt den Paper-Default in den Quality-Presets, weil 
Rotation gegenüber Skala / Position kleinere absolu
te Gradient-Magnituden hat (auf der Einheitssphäre 
bleibt jeder Schritt kurz) und ohne 2× wäre die Ro
tation im 35 000-Iterations-Window deutlich unter-
konvergiert. V188 dokumentiert. Auf NeRF-Blender-
Szenen (Lego, Chair) wirkt sich Rotation besonders 
aus — die Kanten der Objekte richten sich erst nach 
5 000–10 000 Iterationen richtig aus.

E I N FAC H  G E S AG T

Wie schnell sich die Splats dre­
hen lernen — also auf der Ober­
fläche eines Objekts in die rich­
tige Ausrichtung kommen. Stan­
dard passt. Anders ausgedrückt: 
wenn Splats wie schief liegen­
de Klötze aussehen statt sich an 
die Oberfläche anzuschmiegen, 
ist eher die Trainingszeit zu kurz, 
nicht diese Lernrate zu niedrig.
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Densification — Classic (T11–T16)

T11 densifyGradThreshold

D E TA I L S

Default: 0.000002 (Initializer, kalibriert für 0.5× 
Auflösung), 0.0000011 ( .full , kalibriert für 1.0×), 
0.000004 ( .quickTest , kalibriert für 0.25×), 2e-7 
( .fullClassicPaper ) Range: 1e-8 – 1e-3 (auflö
sungsabhängig) Defined in:

T E C H N I S C H

Schwellwert für die L2-Norm des bildschirm
raum-projizierten Gradienten dMean2D , oberhalb 
dessen eine Gaussian für Klonen oder Splitten 
markiert wird. Der absolute Wert hängt direkt 
von der Trainingsauflösung ab — dMean2D  ska
liert ungefähr wie 1/Auflösung² (mehr Pixel = 
kleinere Per-Pixel-Gradienten). Daher braucht je
de T22 trainingRenderScale-Stufe einen kalibrier
ten Schwellwert: 0.25× → 4e-6, 0.5× → 2e-6, 
1.0× → 5e-8 … 1.1e-6 ( .full ). Der Paper-
Default 0.0002 ist NDC-normalisiert und in Ra
dianceKits Welt-Raum-Pipeline nicht direkt ver
gleichbar. Mit dem in V440 zugeschalteten T52 
adaptiveDensifyThreshold-Flag lässt sich der Wert 
in Laufzeit aus dem p98 der aktuellen Gradient-
Verteilung berechnen — aber V440 testete das auf 
realen Szenen und produzierte 63 K Gaussians (ka
tastrophaler Pruning-Verlust); das Flag bleibt aus. 
Q5 (T77–T79) liefert eine alternative Adaptive-Logik 
via rolling median. Gefahrlos ist dieses Feld nicht 
— Halbierung erzeugt 2–4× mehr Gaussians (Spei
cher-Druck, OOM-Risiko); Verdopplung kann die 
Szene unter-densifizieren.

E I N FAC H  G E S AG T

Wie empfindlich die App ist, 
wenn sie entscheiden soll, ob ein 
Splat zu wenig dargestellt wird 
und vervielfältigt werden muss. 
Niedriger Wert = empfindlicher 
= mehr Splats. Höher = weni­
ger Splats. Das ist einer der ge­
fährlichsten Werte überhaupt: zu 
niedrig und der Mac läuft mit Mil­
lionen Splats voll Speicher und 
stürzt eventuell ab. Lass das Feld 
in Ruhe, oder ändere es nur in 
Schritten von 10 %.
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T12 densifyFromIteration

D E TA I L S

Default: 500 Range: 100 – 5 000 Defined in:

T E C H N I S C H

Erste Iteration, ab der Densification aktiv wird. 
Vorher passiert nur „nacktes„ Lernen auf der in
itialen SfM-Punktwolke, ohne dass neue Gaussians 
erzeugt werden. Der Default 500 stammt aus dem 
3DGS-Paper und gibt der Initialisierung Zeit, sich 
zu stabilisieren — wenn schon ab Iteration 0 den
sifiziert wird, klonen sich falsch positionierte SfM-
Punkte vielfach, bevor sie überhaupt ihren richtigen 
Platz finden. V349 testete 1000 → leicht schlechter 
Loss; der Default ist optimal.

E I N FAC H  G E S AG T

Wann die App das erste Mal an­
fängt, Splats zu klonen. Vorher 
lernt sie nur die schon vorhan­
denen Punkte. 500 ist der Stan­
dardwert — gibt der App genug 
Zeit, sich erst mal zu orientieren, 
bevor sie vervielfacht.

T13 densifyInterval

D E TA I L S

Default: 100 (Initializer, MCMC), 200 ( .full ) Ran
ge: 50 – 1 000 Defined in:

T E C H N I S C H

Wie viele Iterationen zwischen zwei Densification-
Schritten liegen. Im Paper-Default 100 — alle 100 
Iterationen wird die Liste der densify-Kandidaten 
ausgewertet, geklont/gesplittet und gleichzeitig die 
Liste der prune-Kandidaten (sigmoid(opacity) < T14 
pruneOpacityThreshold) entfernt. V112-Tests fan
den 200 als optimal für .full  — das entlastet 
die GPU, weil weniger Reorganisations-Passes lau
fen, und gibt jeder Gaussian mehr Zeit, sich nach 
einer Klone-Aktion einzupendeln. V417 testete 100 
mit beta2=0.99 → 5.8 % schlechter (957 K Gaussi
ans, Überdensifizierung). Bei MCMC wird dasselbe 
Feld als Relocation-Interval interpretiert; siehe T67 
mcmcRelocationInterval für die MCMC-spezifische 
Logik.

E I N FAC H  G E S AG T

Wie oft die App nach neuen 
Splats schaut. 100 = oft, 200 = 
mittel. Höher heißt: jeder Splat 
hat länger Zeit sich einzurich­
ten, bevor wieder vervielfältigt 
wird. Das ist gut. Auf 50 zu 
senken kann den GPU dauerhaft 
beschäftigen, ohne dass es nen­
nenswert besser wird.
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T14 pruneOpacityThreshold

D E TA I L S

Default: 0.005 (Initializer, Paper, MCMC), 0.001 
( .full ) Range: 0.0001 – 0.1 Defined in:

T E C H N I S C H

Sigmoid-Opazitäts-Schwelle, unter der eine Gaussi
an beim nächsten Densification-Step gelöscht wird. 
Wirkt zusammen mit T7 opacityLearningRate und 
der Logit-Clamp-Logik im Optimizer. V393 senkte 
den Default von 0.005 auf 0.001 in .full  — 
Folge: Splats die nur unter exotischen Blickwin
keln eine Rolle spielen, bleiben länger erhalten und 
tragen zur SH-Detail bei. V394 testete 0.0001 → 
leicht schlechter (zu wenig gepruntet, Speicher ver
schwendet). Wichtig: Density-Control muss IMMER 
prunen, auch wenn die Buffer-Kapazität durch an
dere Maßnahmen schon voll ist (siehe „Density 
Control Must Always Prune„ in CLAUDE.md) — 
sonst akkumulieren tote Gaussians und der Count 
friert ein.

E I N FAC H  G E S AG T

Wann ein Splat als „durchsichtig 
genug„ gilt, um gelöscht zu wer­
den. 0.005 ist der Paper-Stan­
dard, wir haben in Quality 0.001 
— also wir geben Splats län­
ger eine Chance. Das macht wei­
ches Licht und schwache Schat­
ten besser darstellbar. Höher zu 
setzen (über 0.01) lässt die Splat-
Anzahl schnell sinken — kann 
sinnvoll sein bei Speicherknapp­
heit, kostet aber Detail.
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T15 opacityResetInterval

D E TA I L S

Default: 3 000 (Initializer + Paper), 100 
000 ( .full  = effektiv deaktiviert), 200 000 
( .fullMCMC  = deaktiviert) Range: 1 000 – 100 
000+ Defined in:

T E C H N I S C H

Alle wie viele Iterationen wird die Opazität aller 
Gaussians auf einen niedrigen Wert (~0.01) zurück
gesetzt — eine Maßnahme aus dem 3DGS-Paper, 
um „eingefrorene„ Splats neu zu beurteilen. V194 
zeigte, dass mit RadianceKits Warmup + Stochastic-
Trainings-Setup + 2× Lernraten der Opacity-Reset 
5.5 % Qualität kostet und der Logit-Clamp die 
Reset-Funktion bereits abdeckt. Daher in .full  
praktisch deaktiviert (100 000 > 35 000 = nie 
ausgelöst). V421 testete Reset alle 3 000 mit 
beta2=0.99 → 4.9 % schlechter; reverted. Bei 
.fullClassicPaper  (Q1.5-A, Paper-treuer Test) ist 

es bewusst wieder auf 3 000 gesetzt — das war 
eines der Lever, mit denen die Paper-Magnitude-
Gaussian-Budgets erreicht werden sollten.

E I N FAC H  G E S AG T

Alle wie viele Iterationen die App 
die Sichtbarkeit aller Splats auf 
„fast unsichtbar„ zurücksetzt — 
eine Art Reset-Knopf für die Opa­
city. Bei uns deaktiviert (Wert so 
hoch, dass es nie passiert), weil 
andere Mechanismen das über­
flüssig machen. Nur bei Paper-
getreuen Experimenten anschal­
ten.
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T16 maxScreenSize

D E TA I L S

Default: 0.0 (= deaktiviert) Range: 0 (off) oder > 0 
Defined in:

T E C H N I S C H

Maximale Bildschirmraum-Größe (in projizierten Pi
xeln), die eine Gaussian erreichen darf, bevor sie 
zwangsweise gesplittet wird. Der Wert ist auf 0 
gesetzt (V48 testete und reverted) — RadianceKits 
Density-Control verwendet stattdessen den Welt-
Raum-Skala-Schwellwert aus der dMean2D -Logik. 
Bleibt im Feldkatalog enthalten, weil künftige Expe
rimente mit Mip-Splatting (T74–T76) oder szenen
spezifischen Splatting-Strategien davon profitieren 
könnten. Aktivierung (Wert > 0, z.B. 20) würde sehr 
groß gewordene Splats im Bildschirm zwingen, sich 
aufzuteilen — relevant bei großen, glatten Wandflä
chen, wo ein einzelnes Riesensplat zu wenig Detail 
bietet.

E I N FAC H  G E S AG T

Begrenzung, wie groß ein ein­
zelner Splat auf dem Bildschirm 
werden darf. Bei uns aus. Einge­
schaltet würde es bewirken, dass 
riesige flache Splats (z.B. auf ei­
ner Wand) zwangsweise in meh­
rere kleine zerlegt werden. Lass 
es aus, falls nicht ausdrücklich 
Experimente damit.
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Loss (T17–T20)

T17 ssimWeight

D E TA I L S

Default: 0.2 (Initializer + Paper + .full ), 0.05 (alle 
MCMC-Presets) Range: 0.0 – 1.0 Defined in:

T E C H N I S C H

Gewicht des D-SSIM-Anteils in der kombinierten 
Loss-Funktion loss = (1 - λ) * L1 + λ * 
D-SSIM, wobei λ = T17 . Der 3DGS-Paper-Default 
0.2 ist für Classic-Densification optimal — V383 
testete 0.3 → 28.9 % schlechter, V373b bestätigte 
0.2 als sweet spot. Für MCMC wurde in V521b/
V534 unabhängig festgestellt: 0.05 ist optimal, weil 
MCMC durch seine stochastische Exploration einen 
stärkeren L1-Signal-Anteil braucht — höhere SSIM-
Gewichte würden die Relocation-Entscheidungen 
verwässern. SSIM ist deutlich teurer zu rechnen als 
L1 (lokale 11×11-Fenster über das ganze Bild); Radi
anceKit nutzt eine MPS-beschleunigte Implementie
rung, die unter 1 ms pro 1080p-Bild bleibt. Q7-
BayesOpt-Sweeps fanden szenenspezifische Opti
ma zwischen 0.05 ( .outdoorPreset : 0.082) und 
0.171 ( .indoorPreset ).

E I N FAC H  G E S AG T

Wie wichtig die App neben „jeder 
Pixel stimmt„ auch „Strukturen 
sind ähnlich“ findet. 0.2 ist der 
Standard und liefert ein gutes 
Bild. Niedriger = pixel-genauer, 
aber kann weichere Übergänge 
bekommen. Höher = strukturähn­
licher, aber Details werden wei­
cher. Lass die Presets entschei­
den.
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T18 ssimWeightRefinement

D E TA I L S

Default: 0.0 (= „kein Wechsel, behalte ssimWeight„) 
Range: 0 oder 0 – 1.0 Defined in:

T E C H N I S C H

Optionaler SSIM-Wert für die Refinement-Phase 
nach T2 densifyUntilIteration. V428 testete 0.2 
→ 0.3 im Refinement → 16 % schlechterer Loss 
(sowohl L1 als auch SSIM verschlechterten sich); 
revertet, daher Default 0.0. Die Hypothese hinter 
dem Feld war, dass nach der Densification — wenn 
keine neuen Gaussians mehr entstehen — ein stär
kerer SSIM-Anteil die strukturelle Schärfe maximie
ren würde. Empirisch falsch: SSIM-Gewicht zu erhö
hen heißt indirekt L1-Gewicht zu senken, und L1 ist 
das deutlich aussagekräftigere Signal in der Final-
Refinement-Phase. Das Feld bleibt verfügbar für 
künftige Experimente mit perceptueller Loss (T60) 
oder Edge-Loss (T19), wo eine Refinement-spezifi
sche Loss-Komposition sinnvoll sein könnte.

E I N FAC H  G E S AG T

Spezial-Einstellung für die zwei­
te Trainingsphase (Verfeinerung 
nach Splat-Vervielfältigung). Bei 
0.0: dieselbe SSIM-Gewichtung 
wie davor. Drehen bringt empi­
risch nichts, daher aus.
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T19 edgeLossWeight

D E TA I L S

Default: 0.0 (= deaktiviert) Range: 0 oder 0.001 – 
1.0 Defined in:

T E C H N I S C H

V437-Experimental-Loss: Gewicht eines Sobel-Gra
dient-Domain-L1-Loss, der die Bildkanten direkt 
vergleicht (Ground-Truth-Sobel vs Render-Sobel) 
zusätzlich zu L1+SSIM. Hypothese: Kanten-Informa
tion ist ein perceptueller Eckpfeiler von Bildqualität 
und ein expliziter Term sollte Gaussians ermutigen, 
Kanten besser zu treffen. Test-Ergebnisse: Gewicht 
0.1 → 11 % schlechterer Loss, 0.01 → quality-neu
tral aber 10 % langsamer. Der Sobel-Pass kostet 
einen zusätzlichen MPS-Forward auf Ground-Truth 
und Render. Daher dauerhaft deaktiviert. Künftiger 
Use-Case: Szenen mit harten künstlichen Kanten 
(Architektur, Möbel, Renderings) könnten profitieren 
— Q7-Scene-Class-Presets haben das aber nicht 
gepickt, sondern stattdessen das SSIM-Gewicht 
skaliert.

E I N FAC H  G E S AG T

Experimenteller Zusatz, der Kan­
ten extra wichtig nimmt. Bringt 
empirisch nichts. Bleibt aus.
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T20 skyMaskingEnabled

D E TA I L S

Default: false (Initializer und alle Presets) Range: 
boolean Defined in:

T E C H N I S C H

Schaltet Sky Masking ein. Dabei wird 
in jedem Bild via Apple Vision Frame
work (VNGenerateForegroundInstanceMaskRequest) 
die Sky-Region ausmaskiert, und der Loss in die
sem Bereich auf null gesetzt. Sinn: Outdoor-Szenen 
leiden oft daran, dass blaue/graue/weiße Sky-Pixel 
die App dazu bringen, Gaussians genau dort zu 
plazieren — was als „floater„ wahrgenommen wird. 
Ohne Sky-Mask wäre der Loss in diesem Bereich 
nie null, weil der Himmel im Bild leicht variiert und 
die App ewig versucht, das mit Splats nachzubauen. 
Die Vision-Maske wird einmal pro Kamera vor dem 
Training berechnet und im RAM gehalten. Wird ty
pischerweise zusammen mit T45 skyDomeEnabled  
aktiviert (UI-Logik in der Settings-View). Bei Innen-
Szenen oder synthetischen Renderings deaktiviert 
lassen — die Maske würde dort fälschlicherweise 
Decken oder Wände als „Sky“ erkennen.

E I N FAC H  G E S AG T

Schaltet einen Spezialmodus für 
Außen-Aufnahmen an: der Him­
mel wird beim Training ignoriert, 
damit nicht versucht wird, ihn 
mit Splats nachzubauen. Emp­
fohlen für jede Außen-Szene. Bei 
Innen oder bei 3D-Renderings 
aus Blender aus lassen.
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SH-Degree-Progression (T21)

T21 shDegreeUpgradeIterations

D E TA I L S

Default: [1_​000, 2_​000, 3_​000] (Initializer), 
[2_​000, 5_​000, 8_​000] ( .full , MCMC), 
[1_000, 2_000]  ( .preview  — Degree 3 über

sprungen) Range: [Int] , jeder Wert in 
[0, maxIterations] , monoton steigend Defined 

in:

T E C H N I S C H

Iterationen, an denen der aktive SH-Degree von 
0→1, 1→2, 2→3 hochgeschaltet wird. Vor der ersten 
Marke sind nur die DC-Komponenten aktiv (also T5 
shDCLearningRate), nach der ersten Marke die DC + 
3 Degree-1-Koeffizienten, nach der zweiten Marke 
+ 5 Degree-2-Koeffizienten, nach der dritten Marke 
alle 15 Koeffizienten. Der Speicherbedarf pro Gaus
sian wächst dabei in Stufen — 4 Floats → 16 Floats 
→ 36 Floats → 64 Floats. Die Quality-Presets ver
zögern die Aufstufungen gegenüber Initializer De
faults (V228), weil die Geometrie zuerst stabilisieren 
soll, bevor die Farbdetails mit ihrer höheren Fre
quenz draufkommen. V384 testete [1K, 2K, 3K]  
für .full  → 9.3 % schlechter — bestätigt das De
lay. .preview  kappt bei Degree 2, weil Degree 3 in 
5 000 Iterationen nicht konvergiert und nur Optimi
zer-Kapazität verbraucht. Q6 (T80–T81) bietet eine 
alternative Curriculum-Logik, die diese Liste dyna
misch überschreibt.

E I N FAC H  G E S AG T

An welchen Punkten im Training 
die App lernt, dass Farben aus 
verschiedenen Blickwinkeln un­
terschiedlich aussehen können 
(Glanzlichter, Spiegelungen). Erst 
spät — damit erst die Form 
stimmt, dann die Farbe. Die Wer­
te in den Presets sind so einge­
stellt, dass das gut funktioniert. 
Nichts dran ändern, außer du 
weißt genau warum.
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Performance (T22–T25)

T22 trainingRenderScale

D E TA I L S

Default: 1.0 (Initializer, .full , MCMC, Scene-
Class), 0.5 ( .preview ), 0.25 ( .quickTest ) Range: 
0.05 – 2.0 (typisch 0.25, 0.5, 1.0) Defined in:

T E C H N I S C H

Render-Auflösung beim Training relativ zur Original
auflösung der Trainingsbilder. Bei 0.5 wird jedes Bild 
auf 50 % Breite × 50 % Höhe heruntergerechnet 
(also 25 % der Pixel) und das Gaussian-Rende
ring erfolgt in dieser kleineren Auflösung. Reduziert 
sowohl Speicher- als auch Rechenaufwand qua
dratisch. Wichtig: T11 densifyGradThreshold muss 
zur gewählten Auflösung passen — die Gradient-
Magnituden skalieren mit 1/Auflösung², daher hat 
.quickTest  (0.25×) einen viel höheren Threshold 

(4e-6) als .full  (1.0×, 1.1e-6). RadianceKit warnt 
bei sehr großen Bildern und passt automatisch an — 
3-MP-Ziel-Auflösung. Bei extremen 4K-Eingangsbil
dern wäre 0.5 oder sogar 0.25 sinnvoll, sonst läuft 
jeder Mac auch nur in CPU-Compaction.

E I N FAC H  G E S AG T

Wie groß die Bilder beim Trai­
ning sind. 1.0 = original, 0.5 = 
halb so groß. Halbe Größe = vier 
mal schneller, aber feinste De­
tails fehlen. Die Presets wählen 
den richtigen Wert; bei extrem 
großen Eingangsbildern (über 12 
Megapixel) schaltet die App au­
tomatisch runter.

T23 resolutionWarmupScale

D E TA I L S

Default: 0.0 (= deaktiviert) Range: 0 oder 0.1 – De
fined in:

T E C H N I S C H

V133-Optimierung: Trainiere die Densification-Pha
se (Iter 0 bis T2 ) in einer niedrigeren Auflösung als 
die Refinement-Phase. V308 hat sie für .full  wie
der ausgeschaltet, weil bei T22 = 1.0  und Cosine-
Annealing der Time-Win marginal war und Qualität 
minimal litt. Bleibt im Feldkatalog, weil sie bei 4K-
Eingaben und langen Trainingsläufen wieder sinnvoll 
werden könnte — Q6 Curriculum (T80) hat eine 
ähnliche Logik aufgegriffen, dort ist sie aber an 
die LR-Schedule gekoppelt. Wenn aktiviert und T80 
curriculumResolutionRamp ebenfalls true, gewinnt 
Q6 und überschreibt diesen Wert.

E I N FAC H  G E S AG T

Spezial-Feature: in der ersten 
Trainingshälfte mit kleineren Bil­
dern lernen, in der zweiten mit 
großen. Spart Zeit. Aus, weil die 
neuere Q6-Variante das besser 
löst.
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T24 tileSize

D E TA I L S

Default: 16 Range: 8, 16, 32 Defined in:

T E C H N I S C H

Größe der Rasterisierungs-Tiles in Pixeln. Das Gaus
sian-Splatting-Rendering ist tile-basiert: das Bild 
wird in 16×16-Pixel-Kacheln zerlegt, jede Kachel 
sammelt die für sie relevanten Gaussians, sortiert 
sie nach Tiefe und blendet sie ein. 16 ist der von 
praktisch allen 3DGS-Implementierungen verwen
dete Standard und in den RadianceKit-Metal-Ker
nels hartkodiert; eine Änderung dieses Werts würde 
Re-Compilation der Shader bedingen und ist im ak
tuellen Stand nicht effektiv. Bleibt als Feld, falls eine 
künftige Engine-Version Tile-Size dynamisch unter
stützt.

E I N FAC H  G E S AG T

Interner Render-Parameter. 
Standard 16, nicht ändern.

T25 throttleDelayMs

D E TA I L S

Default: 0 (Initializer, .full , MCMC, Scene-
Class), 0 ( .preview ) Range: 0 – 100 Defined in:

T E C H N I S C H

Künstliche Verzögerung zwischen Trainings-Itera
tionen in Millisekunden. 0 = volle Geschwindigkeit 
(Standard). Höhere Werte machen den Mac wäh
rend des Trainings „benutzbarer„, indem GPU/CPU 
regelmäßig Atempausen bekommen — die Bedien
freundlichkeit anderer Apps steigt, die Trainingszeit 
aber linear mit dem Delay. Typische Werte: 1–2 
ms („leichtes“ Throttling, +5 % Trainingszeit, Mac 
fühlt sich responsiver an), 5 ms („Mittelschwer„, +15 
% Trainingszeit), 10+ ms („Eco“, potentiell doppel
te Trainingszeit). Wird im Inspector unter „Perfor
mance„ geboten, ist aber nicht in der Standardan
sicht — siehe Backlog dev_ux-backlog.md , der 
vorschlägt, ihn aus dem Expert View zu entfernen, 
weil falsch verstanden er die Trainingszeit drama
tisch verlängert.

E I N FAC H  G E S AG T

Wie viele Millisekunden Pau­
se die App zwischen Trainings­
schritten macht. 0 = keine Pause, 
schnellstmöglich. Höhere Werte 
machen den Mac während des 
Trainings besser benutzbar — 
aber das Training dauert dann 
auch länger. Auf einem M3 Ultra 
oder Mac Studio kannst du das 
auf 0 lassen; auf einem MacBook 
Air wäre 2 oder 5 ein guter Wert.
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Diagnose und Punktwolken-Vorbereitung (T26–T30)

T26 depthDistortionWeight

D E TA I L S

Default: 0.0 (= deaktiviert) Range: 0 oder 0.0001 – 
0.05 Defined in:

T E C H N I S C H

V366-Experimental: Gewicht eines Depth-Distorti
on-Regularisierungs-Loss. Bestraft Gaussians, die 
entlang eines Render-Strahls zwar tief gestaffelt 
sind, aber konzeptuell zur selben Oberfläche ge
hören — das encouraged konzentrierte Tiefenvertei
lungen und reduziert Floaters. Tests: 0.01 → 4.5 % 
schlechter, 0.001 → 8.1 % schlechter. Der theore
tische Vorteil — Multi-View-Konsistenz verbessern 
— schlägt sich nicht im L1-Loss nieder, weil die Hy
pothese implizit annimmt, dass die SfM-Geometrie 
korrekt ist und die Gaussians nur „gestapelt„ wer
den müssen. In der Praxis ist die SfM-Punktwolke 
meist die schwächste Komponente, nicht die Stape
lung. Bleibt verfügbar für Multi-View-Datensätze mit 
besonders sauberen Posen (Synthetic, Mip-NeRF 
360 mit Ground Truth).

E I N FAC H  G E S AG T

Experimentelles Feature zur Ver­
meidung mehrerer Splats hin­
tereinander an derselben Stelle. 
Nicht aktiviert, weil die Tests 
nichts gebracht haben.

T27 singleViewOverfit

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

Diagnose-Flag: wenn true, wird in jeder Trainingsi
teration zwingend Kamera-Index 0 verwendet statt 
einer zufällig aus dem Camera-Pool. Sinn: Wenn 
das Modell nicht mal eine einzige View überfitten 
kann (sprich, der Loss auf View 0 auch nach 10 
000 Iterationen nicht gegen Null geht), ist im For
ward/Backward-Pass ein fundamentaler Bug. Dieser 
Schalter wurde während der Entwicklung der Metal-
Shader und der Differentiable-Rasterizer-Kernels in
tensiv genutzt — V42–V47 Phase. Heute nur noch 
als Sanity-Check verfügbar, wenn jemand Backend-
Code modifiziert hat und ein Regression Test ma
chen will. Per CLI mit --single-view .

E I N FAC H  G E S AG T

Test-Modus für Entwickler. Sie 
können damit prüfen, ob die App 
überhaupt aus EINEM Bild lernen 
kann. Für normale Benutzer ir­
relevant, immer aus lassen.

133 / 233



R A D I A N C E K I T Kapitel 6 — Trainings-Konfiguration

T28 maxCameras

D E TA I L S

Default: 0 (= „alle Kameras verwenden„) Range: 0 
oder 1 – N Defined in:

T E C H N I S C H

Diagnose-Limit aus V43: trainiere nur mit den ersten 
N Kameras, ignoriere alle weiteren. Sinn ursprüng
lich: Hypothese testen, dass zu viele Kameras Gra
dient-Konflikte erzeugen (zu viele widersprüchliche 
Loss-Signale für dieselbe Gaussian). Test-Ergebnis: 
kein systematischer Vorteil bei künstlicher Begren
zung — Mehr-Frames bringen praktisch immer mehr 
Qualität. Bleibt als CLI-Flag ( --max-cameras N ) für 
gezielte Experimente, z.B. „funktioniert das Training 
auf den ersten 100 Bildern eines 1 500-Bild-Droh
nenflugs?„ Im UI nicht exponiert.

E I N FAC H  G E S AG T

Diagnose-Feld für Entwickler — 
nur die ersten N Bilder verwen­
den, Rest ignorieren. Normaler 
Benutzer braucht nicht, Wert auf 
0 = alle Bilder. Mehr Bilder = bes­
seres Ergebnis (siehe feedback_​
more-frames-better.md).

T29 maxInitialPoints

D E TA I L S

Default: 0 (= „alle SfM-Punkte verwenden„) Range: 
0 oder 1 000 – 200 000+ Defined in:

T E C H N I S C H

V54-Sicherung: limitiert die Anzahl der initialen 
SfM-Punkte, mit denen das Training startet. Dich
te COLMAP-Rekonstruktionen können > 60 000 
Punkte produzieren, was bei großen Initial-Skalen 
zu 200–300 Gaussians pro Pixel-Überlapp führt — 
das macht ein „Nebelfeld„ aus, in dem das Trai
ning nicht konvergiert. Subsampling auf ~16 000 
Punkte (Hard-cap-Logik in der Trainings-Engine) 
bringt die Initial-Dichte auf das Niveau, das das 
Referenz-3DGS verwendet, und reduziert Overlap 
dramatisch. Wird bei sehr dichten SfMs automatisch 
gesetzt; per CLI mit --max-points N .

E I N FAC H  G E S AG T

Wie viele Anfangs-Punkte aus 
der Kamera-Rekonstruktion ver­
wendet werden. Bei sehr dichten 
Rekonstruktionen (mehr als 60 
000) limitiert die App automa­
tisch auf 16 000 — sonst gibt 
es zu viel Nebel am Anfang. Du 
brauchst das nicht zu setzen; die 
App regelt es.
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T30 cameraClusterOutlierMultiplier

D E TA I L S

Default: 10.0 (alle Presets — niemals überschrie
ben) Range: 1.0 – 100.0 Defined in:

T E C H N I S C H

Multiplikator für den Camera-Cluster-Outlier-Filter, 
eingeführt in Phase 3.10 A.1. Vor dem Training 
berechnet die Trainings-Engine das Centroid aller 
Kamera-Positionen und die maximale Distanz einer 
Kamera vom Centroid. SfM-Punkte, deren Distanz 
vom Centroid multiplier × maxCameraDistance 
überschreitet, werden als Outlier verworfen. Default 
10× bewahrt das Verhalten vor Phase 3.10. Ein sub
tiler Bug: Tighter SfM (Kameras enger zusammen) 
→ kleinerer → kleinerer Schwellwert → mehr Punk
te werden als Outlier verworfen. Looser SfM → 
größerer Schwellwert → weniger Punkte verworfen. 
Dies ist eine der Ursachen für die Phase-3.9-Fun
nel-vs-Training-Anti-Korrelation: bessere SfM kann 
downstream zu schlechterem Training führen, weil 
zu viele Initialpunkte gekillt werden. Das Feld 
liegt als CLI-Override (--camera-cluster-outlier-
multiplier) für die A.3-Sweeps; im UI nicht expo
niert. Werte unter 5 sind in der Regel zu restriktiv, 
über 20 wirkungslos.

E I N FAC H  G E S AG T

Spezial-Filter, der Punkte aus der 
Rekonstruktion verwirft, die weit 
weg von der Kamera-Wolke lie­
gen. 10 = die App ist großzügig, 
behält fast alles. Erhöhen kann 
sinnvoll sein, wenn weit entfern­
te Punkte (Berge in der Ferne) im 
Bild aussehen wie schwebende 
Klümpchen. Niedriger setzen nur 
in Notfall — verlierst dabei Detail 
in der Ferne.
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Regularisierung (T31–T37)

T31 coarseToFineBlurRadius

D E TA I L S

Default: 0 (= deaktiviert) Range: 0 oder 1 – 10 De
fined in:

T E C H N I S C H

V369-Experimental: Box-Blur-Radius, der zu Beginn 
der Densification-Phase auf das Ground-Truth-Bild 
angewendet und linear bis zum Ende der Densifica
tion ( T2 ) auf 0 reduziert wird. Hypothese: Coarse-
to-Fine-Training — erst grobe Strukturen lernen, 
dann Details — sollte stabilere Geometrie liefern. 
Tests: r=3 → 9.6 % schlechter, r=1 → 5.1 % schlech
ter. Der Grund für das Fehlschlagen: die Densifica
tion entscheidet basierend auf bilddomänen-Gradi
enten, und Bluren reduziert genau die Signale, die 
für „hier muss klone werden„ wichtig sind. Bleibt im 
Feld-Katalog für künftige Tests mit anderem Densi
ty-Control-Schema.

E I N FAC H  G E S AG T

Experimenteller „Erst-grob-
dann-detailliert„-Modus. Hat 
nichts gebracht, bleibt aus.

T32 scaleRegWeight

D E TA I L S

Default: 0.0 (= deaktiviert) Range: 0 oder 0.0001 – 
0.05 Defined in:

T E C H N I S C H

V370-Experimental: L1-Regularisierung auf welt-
räumliche Skala. Bestraft Gaussians, die zu groß 
werden — verhindert „Mega-Splatts„, die ganze 
Wandflächen mit einer Gaussian abdecken. Tests: 
0.01 → 200 % schlechterer Loss (2 M Gaussians, 
totale Explosion), 0.001 → 214 % schlechter. Der 
Grund: Skala-Regularisierung kommt mit Density-
Control in Konflikt — kleinere Skalen heißen, mehr 
Gaussians werden gebraucht, also splittet Density-
Control häufiger, was wiederum mehr Gradient-Auf
wand bedeutet. Disabled, aber dokumentiert für 
Mip-Splatting-Experimente (T74): in diesem Kontext 
könnte eine Skalen-Untergrenze sinnvoll sein.

E I N FAC H  G E S AG T

Regularisierung, die Splats 
zwingt, klein zu bleiben. Hat in 
Tests Splat-Explosionen ausge­
löst (Millionen Splats). Nicht akti­
vieren.
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T33 anisotropyRegWeight

D E TA I L S

Default: 0.0 (= deaktiviert) Range: 0 oder 0.0001 – 
0.05 Defined in:

T E C H N I S C H

V445-Experimental: Penalty auf das max(sca
le)/min(scale)-Verhältnis, soll extrem langgezoge
ne „Needle„-Gaussians verhindern, die als floa
ter wahrgenommen werden. Tests: 0.01 → 69 
% schlechter, 0.001 → 15 % schlechter. Der 
Grund: Regularisierung zwingt Splats in Richtung 
„runde“ Form, was auf einer flachen Oberfläche 
(Wand, Tisch, Boden) genau falsch ist — dort 
ist eine flache, breite Gaussian effizienter als ei
ne kugelförmige. Disabled. V549f bot mit T34 
scaleRatioPruneThreshold einen alternativen, ge
zielteren Ansatz, der ebenfalls revertet wurde.

E I N FAC H  G E S AG T

Regularisierung, die zu lange 
dünne Splats bestraft. Klingt 
sinnvoll, war in Tests aber 
schlechter. Aus.

T34 scaleRatioPruneThreshold

D E TA I L S

Default: 0.0 (= deaktiviert) Range: 0 oder 5.0 – 
100.0 (typisch 10.0 – 30.0) Defined in:

T E C H N I S C H

Experimentelles post-Training-Pruning, das jede 
Gaussian löscht, deren max(scale)/min(scale)-Ver
hältnis den hier gesetzten linearen Schwellwert 
überschreitet. Zielt auf extrem langgezogene 
„Needle/Disc„-Floaters ab, die durch Regularisie
rung allein nicht eliminiert werden können. Im Test 
entfernte das Pruning Floaters wie erhofft, aber 
gleichzeitig auch sinnvolle flache Splats auf Wänden 
und Böden — das Bild wurde löchriger. Daher per 
Default aus, das CLI-Flag (--scale-ratio-prune N) 
bleibt für gezielte Experimente verfügbar. Empfoh
lene Werte falls man trotzdem testen will: 30 (sehr 
konservativ, entfernt nur extreme Outlier), 10 (ag
gressiv, kostet Detail).

E I N FAC H  G E S AG T

Versuch, ganz langgezogene 
Splatts nach dem Training raus­
zufiltern. War in Tests netto-ne­
gativ — Floater weg, aber auch 
Detail weg. Aus.

137 / 233



R A D I A N C E K I T Kapitel 6 — Trainings-Konfiguration

T35 opacityRegWeight

D E TA I L S

Default: 0.0 (= deaktiviert) Range: 0 oder 0.0001 – 
0.05 Defined in:

T E C H N I S C H

V446-Experimental: Binary-Cross-Entropy-Penalty, 
der Opazität gegen 0 oder 1 zieht (also weg 
von „halb-transparent„). Hypothese: scharfere Opa
zitätsverteilung würde Bildklarheit verbessern. Test 
mit T33 kombiniert → Regularisierung kostet Quali
tät, beide deaktiviert. Disabled. Achtung: in 1.4.3-
Beta tauchte ein Bug auf, der genau dieses Feld 
in einer Default-Wert-Veränderung (Initializer = 0.01) 
hatte, was zu Mass-Extinction des Gaussian-Counts 
(460 K → 5 in einer Iteration) führte. Seit 1.4.4 fest 
auf 0.0 als Default verankert.

E I N FAC H  G E S AG T

Regularisierung, die Splats ent­
weder ganz transparent oder 
ganz solid macht. Bringt nichts, 
kann sogar gefährlich werden 
(1.4.3-Bug Mass-Extinction). Lass 
auf 0.

T36 opacityDecayFactor

D E TA I L S

Default: 0.0 (Initializer = deaktiviert), 0.9995 
( .full , .classicBalanced  — HTGS-Standard) 
Range: 0 (off) oder 0.95 – 1.0 Defined in:

T E C H N I S C H

V546-Implementation des HTGS-Schemas (Hierar
chical Time-Gating, Eurographics 2025): alle T37 
opacityDecayInterval Iterationen wird die sigmoid-
Opazität jeder Gaussian mit diesem Faktor multi
pliziert. 0.9995 × 100 Anwendungen ergibt ~95 
%-Verbleib pro Densification-Phase — ein leichter 
aber stetiger Abwärts-Druck auf alle Opacities, der 
schwach beigetragende Gaussians verlässlich ge
gen den T14 pruneOpacityThreshold sinken lässt. 
Das Resultat: 14 % besserer L1-Loss auf Horse Full 
(3-Trial-Avg V546) gegenüber V438 ohne Decay. 
Nur während Densification-Phase aktiv (bis T2 ), 
danach läuft das Training ohne Decay weiter, damit 
die im Refinement etablierten Opacities stabil blei
ben. Bei MCMC nicht verwendet (MCMC hat eigene 
Mechanismen via T67 mcmcRelocationInterval + 
T68 mcmcDeadOpacityThreshold).

E I N FAC H  G E S AG T

„Sanftes Verblassen„ aller Splats 
über die Trainingszeit. Macht in­
aktiv gewordene Splats schnel­
ler transparent, sodass sie beim 
Aufräumen weggehen. War der 
wichtigste Quality-Hebel des 
V546-Updates: 14 % besser. In 
Quality-Preset eingebaut. Selbst 
zum Drehen nicht empfohlen, 
weil exakt austariert.
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T37 opacityDecayInterval

D E TA I L S

Default: 50 Range: 10 – 500 Defined in:

T E C H N I S C H

Iterations-Intervall, in dem T36 opacityDecayFactor 
angewendet wird. HTGS-Paper-Default 50, in 
.full  belassen. Lange Intervalle (>200) heben 

den Effekt teilweise auf, weil zwischen zwei Anwen
dungen genug Gradient-Updates passieren, dass 
Opacity wieder steigt. Kürzere Intervalle (<20) ma
chen Decay zu aggressiv. Nur in Densification-Pha
se aktiv.

E I N FAC H  G E S AG T

Wie oft das „Verblassen„ ange­
wendet wird. 50 = alle 50 Ite­
rationen ein bisschen verblasse-
Schritt. Passt.

Refinement (T38–T44)

T38 gradientAccumulationSteps

D E TA I L S

Default: 1 (= „eine View pro Adam-Schritt„) Range: 
1 – 8 Defined in:

T E C H N I S C H

V424-Feature: Anzahl der Views, deren Gradienten 
akkumuliert werden, bevor ein Adam-Update ausge
führt wird. Bei > 1  läuft die App auf einem separa
ten, „unfused„ Backward-Project-Pfad, der die Gra
dienten in einem separaten Buffer summiert; die 
finale Anwendung skaliert mit 1/N, um die Magnitude 
konstant zu halten. V424 testete 2-View → quality-
neutral, aber 10 % langsamer (weil unfused-Pfad 
teurer ist als fused-Pfad). Reverted für .full , aber 
für MCMC bewusst verwendet — .fullMCMC  läuft 
mit, aber V544a-Tests zeigten, dass mit der Quality-
Gap zu Classic auf 5 % schrumpft (statt 11 %). Im 
Initializer-Default 1, im aktuellen Preset 1, bleibt CLI-
Flag ( --accum-steps N ).

E I N FAC H  G E S AG T

Wie viele Bilder die App betrach­
tet, bevor sie die Splats anpasst. 
1 = jedes Bild einzeln. Höher = 
mehrere Bilder gleichzeitig an­
schauen und dann einen Mittel­
wert anwenden. Bringt im Stan­
dardfall nichts; bei MCMC kann 2 
ein bisschen helfen.
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T39 testViewIndices

D E TA I L S

Default: []  (= leer, alle Views werden zum Trai
ning verwendet) Range: Set<Int> , beliebige Un
termenge der Camera-Indices Defined in:

T E C H N I S C H

V546-Feature: Set von Camera-Indices, die NICHT 
zum Training verwendet, sondern als Holdout 
für PSNR/SSIM/LPIPS-Auswertung gespart werden. 
Wird automatisch gesetzt, wenn der --benchmark -
CLI-Flag aktiv ist: dann jede achte View, beginnend 
bei Index 0 (LLFF-Standard, identisch mit den Mip-
NeRF-360- und 3DGS-Paper-Konventionen). Ohne 
benchmark leer — das Training nutzt alle Views. 
Vorsicht: das manuelle Setzen dieses Feldes ohne 
Verständnis der Indizes kann den Benchmark un
brauchbar machen (z.B. wenn alle Indices über N 
gesetzt werden, während es nur N-50 Views gibt → 
keine Holdouts → keine Auswertung). Beim eigenen 
Preset-Export wird testViewIndices nicht persistiert, 
weil es szenenabhängig ist und sonst zwischen 
verschiedenen Datensätzen sinnlose Werte hinter
lassen würde.

E I N FAC H  G E S AG T

Welche Bilder beim Training 
„ausgespart„ werden, um sie 
später für Qualitätsmessung zu 
nutzen. Du setzt das nicht selbst; 
das --benchmark -Flag macht 
das automatisch (jedes achte 
Bild ist Test). Wenn du eigene In­
dices setzt: gefährlich, kann den 
Benchmark verfälschen.
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T40 refinementPruneInterval

D E TA I L S

Default: 0 (= deaktiviert) Range: 0 oder 100 – 5 
000 Defined in:

T E C H N I S C H

V425-Feature: alle N Iterationen während 
der Refinement-Phase (nach T2 ) wird 
ein zusätzlicher Prune-Pass laufen gelassen, 
der Gaussians mit sigmoid(opacity) < T41 
refinementPruneOpacityThreshold entfernt. Sinn: 
während Densification gibt es regelmäßige Densi
ty-Control-Calls, danach nicht mehr — Gaussians, 
deren Opacity weiter sinkt, bleiben aber im Buffer. 
V425 testete und reverted: das zusätzliche Pru
ning korrelierte mit V426 (Two-Phase Densification, 
ebenfalls in 0 Gaussians cascade failure abgebro
chen). Disabled. CLI-Flag verfügbar für Experimen
te; falls aktiviert, sind 1 000 oder 2 000 sinnvolle 
Werte.

E I N FAC H  G E S AG T

Zusätzliches Aufräumen wäh­
rend der Verfeinerungsphase. 
Bringt nichts, bleibt aus.

T41 refinementPruneOpacityThreshold

D E TA I L S

Default: 0.0 (= „verwende T14 „) Range: 0 oder 
0.001 – 0.1 Defined in:

T E C H N I S C H

V425b: separater Opacity-Schwellwert für Refi
nement-Pruning. Nach Densification haben die 
meisten Gaussians eine deutlich höhere Opaci
ty erreicht (> 0.001), sodass der Standard-T14 
pruneOpacityThreshold zu lasch wäre. Wenn T40  
aktiv, bestimmt dieses Feld den eigenen Schwell
wert. Bei 0.0 wird T14  weiterverwendet. Nur rele
vant wenn T40 > 0.

E I N FAC H  G E S AG T

Schwellwert für das zusätzli­
che Refinement-Aufräumen (sie­
he T40). Beide Felder nicht aktiv, 
also irrelevant.
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T42 midTrainingCompactificationIterations

D E TA I L S

Default: []  (= deaktiviert) Range: [Int] , Werte 
in (densifyUntilIteration, maxIterations) Defi
ned in:

T E C H N I S C H

V549-Feature: explizite Iteration-Punkte während 
der Refinement-Phase, an denen ein Compactifica
tion-Pass läuft (entfernt sigmoid(opacity) < 0.01 
+ Outlier-Scale-Gaussians, dieselbe Logik wie T56 
postTrainingCompactification). Sinn: lange Refi
nement-Phasen können Confetti-/Floater-Akkumu
lation zeigen, deren SH dann auf view-spezifi
sche Artefakte überfitten. Typische Konfiguration 
falls aktiviert: [10000, 20000, 30000] für 40K 
Classic. ABER: V549-A/B-Tests auf Family-Dataset 
zeigten in allen Konfigurationen schlechteres L1: 
[10K,20K,30K]@0.01  → −48 % Count aber +36 

% L1; [20K,30K]@0.005  → −44 % Count aber 
+45 % L1; [20K,30K]@0.001  → −17 % Count aber 
+87 % L1. Daher disabled. CLI-Flag --mid-compact 
"10000,20000" verfügbar, falls man den visuellen 
Floater-Tradeoff (weniger Confetti im Viewport) ge
genüber dem Loss-Regression bevorzugt.

E I N FAC H  G E S AG T

Zwischendurch-Aufräumaktio­
nen während des Trainings. In 
Tests hat das Aufräumen das 
Endergebnis schlechter gemacht 
(zwar weniger Floater, aber auch 
weniger Detail). Aus, kann via CLI 
eingeschaltet werden, falls Floa­
ter dich mehr stören als ein et­
was matschigeres Bild.
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T43 frustumCullEnabled

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

V549b-Feature: nach Training werden alle Gaussi
ans entfernt, die außerhalb der Vereinigung aller 
Trainings-Kamera-Frusta liegen. Solche Gaussians 
wurden nie vom Loss-Signal eingeschränkt und sind 
immer Floater. Besonders effektiv für Szenen, in 
denen die Novel-View hinter oder neben dem Ka
merapfad liegt (z.B. Rückseite eines linearen Droh
nenflugs) — die Floater dort werden in der Trai
ningsphase nie sichtbar, beim späteren Bewegen 
im 3D-Viewer aber sehr wohl. V549b A/B auf Droh
nenflügen positive Ergebnisse, daher als Opt-In ver
fügbar. Default false, weil bei Object-Captures mit 
voller Orbit-Coverage die Frustum-Union die ganze 
Szene umfasst und das Feature nichts entfernt — 
wird in Settings unter „Floater Reduction„ angebo
ten und auch in Q9 Outdoor-Preset implizit über 
T44 frustumCullExpansion getestet (Q7-BayesOpt 
hat es aber nicht aktiviert, weil Outdoor-Sky-Dome 
dasselbe Problem besser löst).

E I N FAC H  G E S AG T

Spezial-Filter für Drohnenflüge 
oder lineare Aufnahmen: nach 
dem Training werden Splats ge­
löscht, die in keiner Kame­
ra „gesehen„ wurden. Optional 
einschaltbar in den Settings. 
Bei einfachen Objekt-Aufnahmen 
unnötig.

T44 frustumCullExpansion

D E TA I L S

Default: 1.1 Range: 1.0 – 2.0 Defined in:

T E C H N I S C H

NDC-Margin für T43 frustumCullEnabled. 1.0 würde 
exakt am Bildrand schneiden, was wackelige Splatts 
am Bildrand zu sehr kürzen würde. 1.1 = 10 % Pad
ding über die exakte Kamera-Framing hinaus — gibt 
etwas Toleranz für Randpixel, die in einer leicht ver
setzten Novel-View doch sichtbar werden könnten. 
Werte > 1.2 machen den Cull praktisch unwirksam, 
weil das erweiterte Frustum sehr viel mehr Raum 
umfasst.

E I N FAC H  G E S AG T

Wie streng der oben beschrie­
bene Filter zuschneidet. 1.1 = 
ein bisschen Sicherheitsabstand 
zum Bildrand. Lass den Wert.
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Sky-Dome (T45–T48)

T45 skyDomeEnabled

D E TA I L S

Default: false (Initializer + alle Presets außer P9 
Outdoor) Range: boolean Defined in:

T E C H N I S C H

V549e-Feature: vor Training-Start wird eine kugel
förmige Punktwolke generiert (Fibonacci-sphere mit 
T46  Sample-Points), in einem Radius von T47 
skyDomeRadiusMultiplier × scene_​extent um den 
Szenen-Mittelpunkt platziert und mit den Farben 
aus den sky-maskierten Pixeln aller Trainings-Ka
meras (siehe T20 skyMaskingEnabled) initialisiert. 
Diese Sky-Dome-Gaussians werden am Anfang des 
Gaussian-Buffers eingefügt und während Training 
„eingefroren„ (Position/Skala/Rotation-Gradienten = 
0, nur SH und Opacity bleiben optimierbar). Effekt: 
statt schwarzer „Confetti“-Bereiche in der Ferne 
sieht der User in Novel-Views einen echten Himmel. 
V549e-MVP funktioniert auf Drohnen- und Land
schaftsszenen sehr gut; in P9 Outdoor-Preset De
fault-on. Bei Innen-Szenen aus lassen — die Sphere 
würde sinnlos außerhalb des Raums hängen.

E I N FAC H  G E S AG T

Schaltet eine künstliche „Him­
melskuppel„ um die Szene 
ein. Macht Außenaufnahmen viel 
schöner: statt schwarzer Klümp­
chen am Bildrand zeigt die App 
den echten Himmel. Pflicht für 
Drohnenflüge und Landschaften, 
sinnlos für Innenräume.
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T46 skyDomeSampleCount

D E TA I L S

Default: 5 000 Range: 1 000 – 50 000 (typisch 2 
000 – 10 000) Defined in:

T E C H N I S C H

Anzahl der Fibonacci-Sphere-Sample-Punkte auf 
der Sky-Dome-Sphere. Höhere Werte → dichteres 
Sky-Dome (besser bei großen Auflösungen und viel 
sichtbarem Himmel), aber mehr Speicherbedarf. 5 
000 ist sweet spot für 4K-Renderings; bei niedrige
ren Auflösungen reicht 2 000–3 000. Die Punkte 
werden nach Cosine-Distance zu jedem Trainings-
Kamera-View-Vektor mit den entsprechenden sky-
maskierten Pixeln initialisiert — Sample-Points, de
ren View-Cone keine Kamera sieht, bleiben mit 
niedrigem Opazitäts-Initialwert hinten, werden aber 
im Training nicht verändert (eingefroren).

E I N FAC H  G E S AG T

Wie dicht der künstliche Himmel 
ist. 5 000 Punkte reichen norma­
lerweise. Mehr = besserer Über­
gang aus der Ferne, aber kostet 
etwas Speicher.

T47 skyDomeRadiusMultiplier

D E TA I L S

Default: 30.0 (Initializer + meisten Presets), 59.0 
(P9 Outdoor, Q7-BayesOpt-Optimum) Range: 5.0 – 
200.0 Defined in:

T E C H N I S C H

Radius der Sky-Dome-Sphere relativ zur Szenen-
Ausdehnung (= mittlere Distanz zwischen Kamera-
Positionen). 30 = die Kugel hat den 30-fachen 
Durchmesser der Kamera-Wolke. Zu klein (< 5) → 
Sky-Dome interferiert mit der Szene selbst (z.B. 
ein Sky-Dome-Splatt landet im Vordergrund); zu 
groß (> 100) → float32-Präzisionsverlust an den 
Sky-Dome-Positionen, was Render-Glitches in der 
Ferne auslöst. Q7-BayesOpt auf Bicycle (Mip-NeRF 
360) fand 59.0 als szenenspezifisches Optimum für 
outdoor — das deutet darauf hin, dass die Stan
dard-30.0 für tiefe Landschaften zu klein ist und die 
Sky-Dome-Pixel in den Bildrand-Bereichen sichtbar 
als „Wand„ rendern.

E I N FAC H  G E S AG T

Wie weit weg die künstliche Him­
melskuppel sein soll. 30 = ziem­
lich weit. Bei großen Landschaf­
ten ist 50–60 besser (Outdoor-
Preset macht das automatisch). 
Zu klein wäre, als hätte man 
Klümpchen direkt vor der Linse.
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T48 frozenGaussianCount

D E TA I L S

Default: 0 (= keine eingefrorenen Gaussians) Ran
ge: 0 oder 1 – T46  Defined in:

T E C H N I S C H

Anzahl der Gaussians am Anfang des Buffers, de
ren Position/Skala/Rotation-Gradienten im Optimizer 
auf null gesetzt werden — sie bleiben über das 
gesamte Training räumlich starr. Density-Control 
darf sie nicht klonen, splitten oder prunen. Genutzt 
für Sky-Dome-Injection (siehe T45 ): wenn Sky-
Dome an ist, wird dieses Feld automatisch auf T46 
skyDomeSampleCount gesetzt. Manuelles Setzen ist 
möglich (z.B. um eine vor-platzierte Punktwolke aus 
einem LiDAR-Scan einzufrieren), aber im UI nicht di
rekt zugänglich. Wichtig: die ersten N Gaussians im 
Buffer sind immer die frozen — die Reihenfolge im 
Buffer entscheidet, nicht ein expliziter Index.

E I N FAC H  G E S AG T

Wie viele Splats am Anfang fest 
sind und sich nicht bewegen dür­
fen. Wird automatisch auf die 
Sky-Dome-Anzahl gesetzt, wenn 
Sky-Dome an ist. Selbst dran 
drehen brauchst du nicht.

Adam + LR-Schedule (T49–T55)

T49 adamResetIteration

D E TA I L S

Default: 0 (= deaktiviert) Range: 0 oder 100 – De
fined in:

T E C H N I S C H

V430-Feature: Iteration, an der die Adam-Optimi
zer-Momentum-Akkumulatoren (m1, m2) auf null 
zurückgesetzt werden. Bias-Korrektur danach läuft 
mit (iter - adamResetIteration) statt mit iter . 
V430 testete Reset bei 5 000 (nach Densificati
on-Ende) → 12.8 % schlechter Loss. Grund: das 
Adam-Momentum, das sich während Densification 
aufgebaut hat, trägt Information über die typischen 
Gradient-Magnituden bei und beschleunigt die Refi
nement-Phase. Es wegzuwerfen kostet die ersten 
~500 Iterationen Refinement an Konvergenz. Disab
led. Bleibt CLI-Flag für Forschungsexperimente.

E I N FAC H  G E S AG T

Reset-Knopf für das interne 
Adam-Optimierer-„Gedächtnis„. 
Hat in Tests geschadet, bleibt 
aus.
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T50 positionLRScheduleEndIteration

D E TA I L S

Default: 0 (Initializer = „verwende maxIterations„), 
20 000 ( .full  — Cosine endet bei 20K trotz maxI
ter=35K), 30 000 ( .fullClassicPaper ) Range: 0 
oder 1 000 – Defined in:

T E C H N I S C H

V431-Feature: Iteration, an der die Cosine-
Annealing-Kurve für Position-LR ihr Minimum 
erreicht. Wenn 0, ist das identisch mit 
T1 maxIterations . Wenn > 0, läuft die Schedu

le bis zu diesem Wert und bleibt danach bei T4 
positionLearningRateFinal konstant. Das erlaubt 
eine „extended refinement phase„ mit minimaler 
aber konstanter Lernrate — verfeinert Positionen 
langsam ohne erneuten Decay. .full  macht das 
(Schedule-Ende bei 20K, Training läuft bis 35K), 
V434c/V434d bestätigten: 15K und 25K beide etwa 
gleich, 20K minimal optimal. Wird in Verbindung mit 
T51  weiterverwendet, um auch die Nicht-Position-

LRs in der extended phase zu modifizieren.

E I N FAC H  G E S AG T

Wann die App aufhört, die Posi­
tion-Lernrate weiter zu senken. 
Wenn niedriger als die maximale 
Iteration, läuft danach mit kon­
stanter Mini-Rate — das verfei­
nert sehr langsam aber sehr sta­
bil. In Quality-Preset eingebaut, 
brauchst nicht zu drehen.

T51 extendedPhaseLRDecay

D E TA I L S

Default: 0.0 (= deaktiviert, konstante LRs) Range: 0 
oder 0.01 – 1.0 Defined in:

T E C H N I S C H

V433-Feature: minimaler Multiplikator für die Nicht-
Position-LRs (Skala, Rotation, Opacity, SH) in der 
„extended phase„ — sprich: nachdem T50  erreicht 
ist und Position-LR bereits bei T4  ist. Wenn 0.1, 
werden Skala/Rotation/Opacity/SH ihrerseits cosine-
decayed von 1.0 (= ihr Standard-LR) auf 0.1× ihres 
Standards. Wenn 0.0 (Default), bleiben sie konstant. 
V457 testete vollen Decay (0.0 = decay-bis-null) 
gegen kein-Decay und fand: avg 0.0400 (2 Runs) = 
gleicher Loss wie V438 ohne Decay. Behavior clea
ner mit Decay, aber nicht messbar besser. Daher 
disabled. Bleibt im CLI als --nonpos-lr-scale F.

E I N FAC H  G E S AG T

In der späten Verfeinerungspha­
se auch Farb- und Form-Lernra­
ten kleiner machen. Macht das 
Training „stabiler„, aber empi­
risch nicht besser. Aus.
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T52 adaptiveDensifyThreshold

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

V440-Experimental: wenn true, berechnet die App 
in jedem Densification-Schritt das p98 der aktu
ellen Gradient-Verteilung und nutzt es als dynami
schen Schwellwert (geclamped auf mindestens 0.5× 
des konfigurierten Werts aus T11 , damit es nicht 
zu sehr ausreißt). Hypothese: Automatische Anpas
sung an aktuelle Szenen-Phase würde Density-Con
trol robuster machen — z.B. zu Anfang strenger pr
uning, später lasser, oder umgekehrt. V440 testete 
und revertete: katastrophaler Drop auf 63 K Gaus
sians (Mass-Pruning, weil das p98 in den ersten 
Iterationen extrem hoch ist und dann fast nichts den 
Threshold überschreitet). Der fixe Threshold ist be
reits gut kalibriert, dynamische Anpassung schadet 
mehr als sie nutzt. Q5 (T77) bietet eine alternative 
Adaptive-Logik via rolling median, die das Problem 
umgeht.

E I N FAC H  G E S AG T

Adaptive Versions des Densify-
Schwellwerts. In Tests katastro­
phal (Splat-Anzahl auf 63K abge­
stürzt). Aus. Q5 hat eine bessere 
Variante davon.

T53 mergeAfterDensification

D E TA I L S

Default: false (Initializer), true ( .full , 
.classicBalanced , .fullClassicPaper ) Range: 

boolean Defined in:

T E C H N I S C H

V438-Feature: am Ende der Densification-Phase 
(Iter T2 ) wird ein einmaliger Merge-Pass durchge
führt, der nahe beieinanderliegende Gaussians mit 
ähnlicher Skala und Farbe zusammenfasst. Redu
ziert die Gaussian-Anzahl um typisch 5–15 % ohne 
sichtbaren Qualitätsverlust. Sinn: nach intensivem 
Klonen entstehen Cluster von quasi-identischen 
Gaussians, die nichts Neues beitragen — das Mer
ging gibt Optimizer-Kapazität für andere Bereiche 
frei. Standard in Classic-Quality-Presets. Bei MCMC 
nicht verwendet, weil MCMC durch seine Reloca
tion-Logik solche Cluster gar nicht erst entstehen 
lässt.

E I N FAC H  G E S AG T

Am Ende der Splat-Vervielfäl­
tigungs-Phase Klone, die fast 
identisch sind, zusammenfas­
sen. Reduziert Datenmenge ohne 
sichtbaren Effekt. Standardmä­
ßig in Quality-Preset an.
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T54 densifyPhase2FromIteration

D E TA I L S

Default: 0 (= deaktiviert) Range: 0 oder T2  – T1  
Defined in:

T E C H N I S C H

V426-Experimental: ermöglicht eine zweite Densifi
cation-Phase, die nach der Refinement-Pause bei 
dieser Iteration startet und bis T55  läuft. Hy
pothese: nach einer Refinement-Phase haben die 
Gradient-Akkumulatoren stabilere Magnitudes und 
können präziser sagen, welche Bereiche noch zu
sätzliche Gaussians brauchen. V426 testete und 
revertete: Two-Phase Densification fiel in 0-Gaussi
ans-Cascade-Failure (mit V425 Refinement-Pruning 
kombiniert zerstörte es den Buffer). Disabled. CLI-
Flag verfügbar für Experimente.

E I N FAC H  G E S AG T

Zweite Vervielfältigungsrunde 
nach Pause. Hat in Tests den 
Splat-Bestand vernichtet. Aus.

T55 densifyPhase2UntilIteration

D E TA I L S

Default: 0 Range: 0 oder T54  – T1  Defined in:

T E C H N I S C H

Ende der V426-Two-Phase-Densification. Nur rele
vant wenn T54 > 0 . Beide Felder zusammen dis
abled.

E I N FAC H  G E S AG T

Ende der zweiten Vervielfälti­
gungsrunde (siehe T54). Beide 
aus.
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Post-Processing + Apple AI (T56–T60)

T56 postTrainingCompactification

D E TA I L S

Default: true (in allen Production-Presets), false 
( .quickTest , .preview ) Range: boolean Defined 
in:

T E C H N I S C H

V443-Feature: nach Trainingsende werden Gaussi
ans mit sigmoid(opacity) < 0.01 hart entfernt (sie 
tragen praktisch nicht mehr zum Bild bei). Redu
ziert Gaussian-Count um typisch 58 % und Export-
Dateigröße um 55 % ohne sichtbaren Qualitätsver
lust. Standardmäßig in Production-Presets aktiv — 
das Endresultat soll möglichst kompakt ausgeliefert 
werden können. In .quickTest  aus, weil ein Dia
gnose-Lauf sowieso nicht exportiert wird. Anders 
als T42 midTrainingCompactificationIterations 
(V549) findet die Compactification erst am Ende 
statt — Refinement kann bis dahin alle Gaussians 
benutzen.

E I N FAC H  G E S AG T

Aufräumen nach dem Training: 
nahezu unsichtbare Splats wer­
den entfernt. Macht die Export-
Datei rund halb so groß ohne 
Qualitätsverlust. Pflicht-Feature, 
aus lassen nur in Diagnose-Läu­
fen.

T57 metalFXUpscaling

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

V444-Feature: aktiviert Apples MetalFX Spatial 
Upscaler statt bilineare Interpolation im 3D-View
er-Output. Wenn Trainingsauflösung < Viewport-
Größe (z.B. Training auf 0.5×, Viewport-Anzeige 
in voller Auflösung), kann MetalFX ein deutlich 
schärferes Bild liefern. Ändert sich live im View
port, kein Re-Training nötig. Schließt sich mit T58 
mpsLanczosScaling aus — MetalFX hat Vorrang. 
Empfehlung: einschalten, wenn das Bild im Viewer 
„verwaschen„ wirkt im Vergleich zum erwarteten 
Detail.

E I N FAC H  G E S AG T

Apple-ML-basierte Bild-Schär­
fung im 3D-Viewer. Hilft, wenn du 
in einem niedrigerer Auflösung 
trainiert hast und das Ergebnis 
im Vollbild zeigst. Live-Toggle, 
probier aus.

150 / 233



R A D I A N C E K I T Kapitel 6 — Trainings-Konfiguration

T58 mpsLanczosScaling

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

V444-Feature: MPSImageLanczosScale für View
port-Skalierung statt bilineare Interpolation. Lanc
zos ist ein klassisches Sinc-basiertes Resampling-
Verfahren, das deutlich schärfere Ergebnisse als Bi
linear liefert mit minimalem Overhead. Live-Toggle. 
Wird von T57  überschrieben, wenn beide an.

E I N FAC H  G E S AG T

Klassisches Schärfungsverfah­
ren für den 3D-Viewer (Lanczos). 
MetalFX (T57) ist ML-basiert und 
meist besser; Lanczos ist eine 
weniger aggressive Alternative.

T59 livePreviewInterval

D E TA I L S

Default: 50 (Initializer und meisten Presets) Range: 
0 (off) oder 10 – 5 000 Defined in:

T E C H N I S C H

Wie oft während des Trainings der 3D-Viewer mit 
den aktuellen Gaussians aktualisiert wird. 50 = alle 
50 Iterationen ein neues Render im Viewer — gut 
genug, um den Fortschritt zu beobachten, ohne das 
Training zu verlangsamen. 0 = Viewer wird gar nicht 
aktualisiert (Hintergrund-Training, max Geschwin
digkeit). Typische Anpassung: bei .quickTest  run
ter auf 10 (man will jeden Schritt sehen), bei langen 
MCMC-Läufen hoch auf 500–2000 (Update-Over
head in Summe spürbar).

E I N FAC H  G E S AG T

Wie oft die 3D-Vorschau während 
des Trainings aktualisiert wird. 
50 = alle 50 Iterationen. Höher 
= weniger oft = etwas schnel­
ler, aber du siehst seltener Fort­
schritt. 0 = keine Vorschau (für 
maximales Tempo).
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T60 perceptualLossWeight

D E TA I L S

Default: 0.0 (= deaktiviert) Range: 0 oder 0.001 – 
0.5 Defined in:

T E C H N I S C H

V444-Future-Feature: Gewicht eines perceptuellen 
Loss-Terms via MPSGraph (VGG-ähnliches kleines 
Netzwerk). Würde strukturelle und texturelle Ähn
lichkeit auf einer höheren semantischen Ebene 
als L1+SSIM erfassen — typisch in Forschungs-
Pipelines, wo „pixel-perfect„ weniger wichtig ist 
als „sieht realistisch aus“. Implementation noch 
ausstehend (Code-Stub vorhanden, aber Forward-
Pass nicht implementiert). Default 0.0. Bleibt 
im Feldkatalog für künftige Aktivierung; CLI-Flag 
--percep-weight F  reserviert.

E I N FAC H  G E S AG T

Geplantes Feature, das mit KI-
Hilfe „natürlich aussehend„ an­
strebt statt „pixelgenau“. Noch 
nicht fertig implementiert.

MCMC-Densification (T61–T73)

T61 densificationStrategy

D E TA I L S

Default: .classic  (Initializer + Classic-Presets), 
.mcmc  (alle MCMC-Presets + Scene-Class) Range: 
.classic  oder .mcmc  Defined in:

T E C H N I S C H

Wählt zwischen Classic-Densification (Klon/Split/
Prune, Kerbl et al. 2023) und MCMC-Densifica
tion (Stochastic Gradient Langevin Dynamics mit 
Relocation, Kheradmand et al. NeurIPS 2024). 
Bei .classic  werden T11–T16  ausgewertet, bei 
.mcmc  die T62–T73 . Achtung beim Wechsel: Clas

sic Defaults und MCMC Defaults sind völlig anders 
kalibriert — wer den Picker im Expert View flippt, 
ohne ein passendes Preset zu laden, riskiert 1.4.3-
Bug-Style Mass-Extinction (460 K → 5 in einer 
Iteration, weil MCMC-OpacityReg auf 0.01 die Clas
sic-Opacities killt). Daher die MCMC-Init Defaults 
absichtlich „weichgespült„ (alle Reg-Werte 0.0).

E I N FAC H  G E S AG T

Welcher Algorithmus zum Ver­
mehren der Splats verwendet 
wird. Classic = ursprüngliche 
Methode (schnell, viele Splats). 
MCMC = neuere Methode (lang­
samer, viel weniger Splats, dafür 
kompakter). Die Presets wählen 
das richtige. Selbst nur umschal­
ten, wenn du auch das passen­
de Preset (P5–P7 oder P8–P10) 
lädst.
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T62 mcmcMaxGaussians

D E TA I L S

Default: 150 000 (Initializer + .fullMCMC  + 
.mcmcBalanced ), 100 000 ( .mcmcPreview ), 1 500 

000 ( .fullMCMCMip  — Mip-Splatting-Variante mit 
10× Budget), 1.19 M ( .renderPreset ), 1.25 M 
( .outdoorPreset ), 670 K ( .indoorPreset ) Ran
ge: 0 (= „verwende Buffer-Kapazität„) oder 10 000 
– 5 000 000 Defined in:

T E C H N I S C H

Harte Obergrenze für die Anzahl der Gaussians bei 
MCMC-Strategie. Die Anzahl wächst graduell um 
T70 mcmcGrowthRate  (typisch 5 %) pro Relocation-

Step bis zu diesem Cap. V473/V531 fanden 150 K 
als sweet spot — über 200 K dilutet die Splat-
Qualität (zu viele kleine, redundante Gaussians), 
unter 100 K bleibt die Szene unter-densifiziert. Bei 
sehr großen Szenen (z.B. 1 545-Foto-Drohnenflug 
mit 158 K SfM-init) ist 150 K zu niedrig — daher 
die 1.4.5-Erweiterung T72 mcmcCapMultiplier + T73 
mcmcAutoScaleByScene. Q7-BayesOpt fand szenen
spezifische Optima zwischen 670 K (Indoor) und 
1.25 M (Outdoor). Bei Wert 0 verwendet die Engine 
die volle Buffer-Kapazität als Cap.

E I N FAC H  G E S AG T

Maximale Anzahl Splats bei 
MCMC. 150 000 ist der Stan­
dard und reicht für die meisten 
Szenen. Outdoor- und Render-
Presets (P8, P9) gehen auf 1+ Mil­
lion für Detail-reichere Szenen. 
Hochsetzen kann Detail bringen, 
kostet Speicher; runter ist eher 
eine Notbremse.

T63 mcmcNoiseScale

D E TA I L S

Default: 0.00005 (5e-5 = Paper-Default) Range: 
1e-6 – 1e-3 Defined in:

T E C H N I S C H

Multiplikator für das Gauss’sche Rauschen, das in 
jeder MCMC-Iteration zur Position jeder Gaussian 
addiert wird (SGLD-Logik). Höher = mehr Explorati
on (Gaussians wandern mehr, finden potenziell bes
sere Plätze), niedriger = mehr Exploitation (Gaussi
ans bleiben da, wo sie schon gut sind). V467 und 
V536 bestätigten 5e-5 als optimal — 1e-5/2e-5 zu 
wenig Exploration, 1e-4 zu viel (Splats zerlaufen). 
Wird über die Trainingszeit cosine-decayed bis T69 
mcmcNoiseDecayEnd — am Ende des Decay-Bereichs 
ist Noise effektiv 0 und die Gaussians konvergieren.

E I N FAC H  G E S AG T

Wie viel zufälliges „Wackeln„ die 
App den Splats erlaubt, damit sie 
selber den besten Platz finden. 
Standardwert ist optimal getes­
tet. Wenn du das hochdrehst, 
werden die Splats unruhig.
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T64 mcmcOpacityRegWeight

D E TA I L S

Default: 0.0 (= deaktiviert in den RadianceKit De
faults, Paper: 0.01) Range: 0 oder 0.001 – 0.05 
Defined in:

T E C H N I S C H

MCMC-spezifische L1-Penalty auf Opacity. Paper-
Default 0.01 (drückt unbenutzte Gaussians gegen 
Null, macht sie für Relocation verfügbar). V464b 
zeigte aber: ohne Reg ist es in RadianceKit mess
bar besser (Session 28 bestätigt). Grund: Das mit 
T68 mcmcDeadOpacityThreshold definierte Pruning-
Kriterium reicht alleine — eine zusätzliche L1-Penal
ty zwingt auch wertvolle, niedrig-Opacity-Gaussians 
zum Sterben. Daher Default 0. Achtung: in 1.4.3-
Beta-Build war der Initializer-Default fälschlich 0.01, 
was im Mass-Extinction-Bug resultierte (siehe T61-
Erläuterung); seit 1.4.4 auf 0.0 fixiert.

E I N FAC H  G E S AG T

MCMC-Spezialregularisierung. 
Aus, weil der andere MCMC-Me­
chanismus (Schwellwert in T68) 
das schon abdeckt. Auf 0 lassen.

T65 mcmcScaleRegWeight

D E TA I L S

Default: 0.0 (= deaktiviert, Paper: 0.01) Range: 0 
oder 0.001 – 0.05 Defined in:

T E C H N I S C H

MCMC-spezifische L1-Penalty auf die Skala-Eigen
werte. Paper-Default 0.01. V464b: ohne Reg besser, 
gleiche Begründung wie T64. Disabled in allen 
RadianceKit-MCMC-Presets. Achtung wie bei T64: 
1.4.3-Bug.

E I N FAC H  G E S AG T

Wie T64, aber für Splat-Größe. 
Aus.
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T66 mcmcRelocationInterval

D E TA I L S

Default: 100 (Initializer + alle MCMC-Presets, Pa
per-Standard), 155 (P9 Outdoor — Q7-BayesOpt-
Optimum) Range: 50 – 500 Defined in:

T E C H N I S C H

Iterations-Intervall, in dem MCMC tote Gaussians 
(sigmoid(opacity) < T68 mcmcDeadOpacityThreshold) 
zu neuen Positionen relociert. V537 testete 50 
(zu disruptiv, Loss schwankt) und 200 (marginal 
schlechter, MCMC verliert Reaktionsfähigkeit). 100 
ist optimal. Q7-BayesOpt auf Bicycle fand 155 als 
szenenspezifisches Optimum für outdoor — die et
was längeren Intervalle geben Adam mehr Zeit, 
neu plazierte Gaussians zu integrieren, bevor das 
nächste Reloc-Event sie unter Druck setzt.

E I N FAC H  G E S AG T

Alle wie viele Iterationen MCMC 
die toten Splats irgendwo anders 
hin verschiebt. 100 ist Standard. 
Selbst dran drehen brauchst 
du nicht — Outdoor-Preset hat 
schon den optimalen Wert.

T67 mcmcWarmupIterations

D E TA I L S

Default: 500 Range: 100 – 5 000 Defined in:

T E C H N I S C H

Anzahl der Initial-Iterationen, in denen noch keine 
MCMC-Relocation passiert. Erst nach diesem War
mup beginnt die Reloc-Logik. Sinn: in den ersten 
Iterationen sind die Opacity-Werte noch nicht ein
geschwungen — würde direkt mit Reloc gestartet, 
würden Gaussians an den falschen Stellen plaziert 
und müssten gleich wieder bewegt werden, was 
Adam-Momentum zerstört. Paper-Default 500. Ra
dianceKit übernimmt diesen Wert, weil V464b zeig
te dass es robust ist.

E I N FAC H  G E S AG T

Wie viele Iterationen MCMC erst 
„ankommen„ darf, bevor es an­
fängt, Splats umzustellen. 500 
ist Standard und passt.
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T68 mcmcDeadOpacityThreshold

D E TA I L S

Default: 0.005 (Initializer, Paper-Standard), 0.01 
( .fullMCMC  und alle MCMC-Presets — V535-Opti
mum) Range: 0.001 – 0.05 Defined in:

T E C H N I S C H

sigmoid(Opacity)-Schwellwert, unter dem eine 
Gaussian als „tot„ gilt und für Relocation in Frage 
kommt. V535 fand 0.01 als optimal (0.005 margi
nal, 0.02 schlechter). Höher = aggressiveres Reloc 
(mehr Gaussians werden bewegt), niedriger = vor
sichtiger. 0.01 entspricht ungefähr „0.5 % visuelle 
Sichtbarkeit“. P10 Indoor verwendet via Q7-Bayes
Opt 0.0142 als Optimum.

E I N FAC H  G E S AG T

Ab welcher Durchsichtigkeit ein 
Splat als „tot„ gilt, sodass MCMC 
ihn woanders hinschiebt. 0.01 ist 
optimal in unseren Tests. Selbst 
dran drehen brauchst du nicht.

T69 mcmcNoiseDecayEnd

D E TA I L S

Default: 0 (Initializer = „kein Decay„), 160 
000 ( .fullMCMC  = 80 % von 200K), 96 000 
( .mcmcBalanced  = 80 % von 120K), 40 000 
( .mcmcPreview ) Range: 0 oder 1 000 – Defined in:

T E C H N I S C H

Iteration, an der das T63 mcmcNoiseScale -Rau
schen vollständig auf null gedämpft wird (Cosine-
Decay von Iter 0 bis hier). V497c/V502 fanden 80 % 
der maxIterations optimal — gibt MCMC genug Ex
ploration-Zeit, lässt aber die letzten 20 % zur Kon
vergenz ohne Rauschen. 0 = konstantes Rauschen 
über alle Iterationen (selten sinnvoll, MCMC kann 
dann nicht konvergieren).

E I N FAC H  G E S AG T

Wann das zufällige „Wa­
ckeln„ der Splats aufhört. In den 
MCMC-Presets bei 80 % der Ge­
samtiterationen — erst Explora­
tion, dann Konvergenz. Lass den 
Wert.
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T70 mcmcGrowthRate

D E TA I L S

Default: 0.05 (Paper-Standard = 5 %) Range: 0.01 
– 0.2 Defined in:

T E C H N I S C H

Wachstumsrate des MCMC-Populations-Targets 
pro Relocation-Step. Die Logik: bei je
dem Reloc-Event wird das Ziel-Populations-Grö
ße um (1 + growthRate)  erhöht, bis T62 
mcmcMaxGaussians (oder die per T72/​T73 skalierte 
Variante) erreicht ist. V512/V522 fanden 0.05 als 
optimal — höhere Werte führen zu zu schnellem 
Wachstum (Gaussians werden eingefügt, bevor das 
Adam-Momentum sie integrieren kann), niedrigere 
zu unter-densifizierten Szenen am Ende.

E I N FAC H  G E S AG T

Wie schnell die Splat-Anzahl bei 
MCMC wächst. 5 % pro Schritt ist 
optimal. Lass den Wert.

T71 mcmcSigmoidK

D E TA I L S

Default: 100.0 Range: 10.0 – 500.0 Defined in:

T E C H N I S C H

Sigmoid-Sharpness-Parameter für die MCMC-Noi
se-Attenuation. Im SGLD-Schritt wird das pro-
Gaussian-Rauschen durch gedämpft — hoch-opake 
Gaussians (deren Logit positiv ist) bekommen ex
ponentiell weniger Rauschen als niedrig-opake. K 
= 100 ist scharf, sprich der Übergang von „voll-
Noise„ zu „kein-Noise“ passiert sehr schnell um 
Opacity 0.5. V484–V487 fanden K = 100 optimal 
— kleinere Werte (10–50) lassen auch hoch-opake 
Gaussians mit-Wackeln (zerstört konvergierte Gaus
sians), größere (> 500) machen den Übergang 
künstlich hart und tote Gaussians werden gar nicht 
mehr bewegt.

E I N FAC H  G E S AG T

Spezialparameter, der bestimmt, 
wie scharf MCMC zwischen 
„durchsichtig genug zum Ver­
schieben„ und „solid, nicht 
anrühren“ unterscheidet. Stan­
dardwert ist optimal. Nicht dran 
drehen.
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T72 mcmcCapMultiplier

D E TA I L S

Default: 3.0 (Initializer + .fullMCMC ), 2.0 
( .mcmcPreview ), 2.5 ( .mcmcBalanced ), 2.98 (P8 
Render), 5.32 (P9 Outdoor), 1.76 (P10 Indoor) Ran
ge: 0 (= deaktiviert) oder 1.0 – 10.0 Defined in:

T E C H N I S C H

1.4.5-Feature: szenen-adaptive Cap-Skalierung. 
Wenn T73 mcmcAutoScaleByScene true ist, wird der 
effektive Cap als berechnet (geclamped an Buffer-
Kapazität). Hintergrund: bei großen Szenen (z.B. 
1 545-Foto-Drohnenflug → 158 K SfM-init) ist 
T62 = 150 000  zu niedrig — Density-Control wür

de gar nicht wachsen können. Mit Multiplier 3.0 wird 
der Cap bei diesem Beispiel auf 474 K skaliert (158 
K × 3.0). Q7-BayesOpt fand szenenspezifische Op
tima: Outdoor profitiert von hohem Multiplier (5.32 
→ ~830 K Cap bei 156 K bicycle-init), Indoor 
begnügt sich mit 1.76 (Wände sättigen schneller). 
Komplette Auflösung des Caps siehe -Methode.

E I N FAC H  G E S AG T

Multiplikator, der den Splat-Cap 
automatisch an die Szenen-Grö­
ße anpasst. Große Szene = mehr 
Anfangspunkte = höherer Cap. 
Standard 3× passt für die meis­
ten Szenen; Outdoor-Preset geht 
auf 5× (große Tiefenbereiche), 
Indoor auf 1.76× (Wände begren­
zen ohnehin).

T73 mcmcAutoScaleByScene

D E TA I L S

Default: true (Initializer + alle MCMC-Presets) Ran
ge: boolean Defined in:

T E C H N I S C H

1.4.5-Feature: Master-Switch für die scene-aware 
Cap-Logik (siehe T72 +). Wenn false, wird aus
schließlich T62 mcmcMaxGaussians als Cap verwen
det (zurück zu 1.4.4-Verhalten). Standardmäßig an, 
weil die Mass-Extinction-Probleme bei großen Sze
nen aus 1.4.3 sonst wiederkehren. Manuell deakti
vieren nur, wenn du explizit ein hartes Cap setzen 
willst — z.B. um eine 150 K-Variante zu trainieren, 
deren Endgröße planbar ist.

E I N FAC H  G E S AG T

Schaltet die automatische An­
passung des Splat-Caps an die 
Szenen-Größe an. Standardmä­
ßig an. Aus lassen nur, wenn 
du selbst genau eine bestimmte 
Splat-Anzahl haben willst.
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Mip-Splatting (Q1.5) (T74–T76)

Status: Q1.5 wurde am 2026-05-25 nach 14 autonomen Iterationen + Over
night-1.5M-Confidence-Check als „closed no-win„ verworfen (max Δ@2× = +0.27 
dB, Original-Gate verlangte ≥ +1.5 dB Mittelwert über 0.5×/2×, FAILT auf 0/11 
Pair-Scenes). Die Felder bleiben opt-in für Forschungs-Experimente; alle Pro
duction-Presets haben. Siehe Verdict: docs/​plans/​2026-05-25-phase-q1.5-final-
verdict.md.

T74 useMipSplatting

D E TA I L S

Default: false (alle Production-Presets), true 
( .fullMCMCMip  — Forschungs-Sibling) Range: 
boolean Defined in:

T E C H N I S C H

Aktiviert Mip-Splatting (Yu et al. CVPR 2024): 3D-
Smoothing-Filter + 2D-Filter + α-Kompensation, der 
die per-Gaussian-Frequenz auf die Nyquist-Gren
ze der dichtesten Trainingskamera-Sampling-Rate 
begrenzt. Theoretisches Ziel: Eliminierung von Ali
asing bei Rendering in off-training-Skalen (0.5× 
oder 2× der Trainingsauflösung). In den Prepro
cess- und Backward-Projection-Shadern aktiviert, 
funktional korrekt verifiziert in Q1.5-D-Test. Aber: 
der Original-Akzeptanz-Gate (Δ@1× ≥ +0.3 dB UND 
avg(Δ@0.5×, Δ@2×) ≥ +1.5 dB) wurde auf keinem 
von 11 Pair-Scenes erreicht. Maximal beobachtet: 
family 750K classic Δ@2× = +0.270 dB. Outdoor-
Szenen (Truck, Flowers) zeigten sogar Verschlech
terung 1× und 0.5×. Hypothese: 3D-Smoothing kon
kurriert mit MCMC-Relocation bei high-Gs. Feld 
bleibt für künftige Multi-Scale-Re-Eval mit korrekter 
Mip-NeRF-360-Methodology (siehe O3-Backlog im 
Benchmark-Pfad).

E I N FAC H  G E S AG T

Aliasing-Filter aus einem 2024er-
Paper. Theoretisch toll, praktisch 
hat er in unseren Tests nichts ge­
bracht und manchmal sogar ge­
schadet. Bleibt verfügbar für Ex­
perimentierer, aber wir empfeh­
len ihn nicht. Aus lassen.
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T75 mipSmoothing3DScale

D E TA I L S

Default: 0.2 (Paper-Default) Range: 0.05 – 1.0 De
fined in:

T E C H N I S C H

3D-Smoothing-Skala-Parameter (Yu et al. §3.3, Pa
per-Default 0.2). Größer = mehr Welt-Raum-Glät
tung pro Gaussian (= mehr Anti-Aliasing, aber auch 
mehr blur in der Default-Skala), kleiner = schärfer 
aber anfälliger für Aliasing. Wird nur konsultiert, 
wenn T74 useMipSplatting = true. In Q1.5-Tests 
nicht weiter optimiert — die A/B-Gate hat schon mit 
Paper-Default 0.2 verloren, weitere Sweeps wären 
zwecklos.

E I N FAC H  G E S AG T

. Wenn du Mip nicht eingeschal­
tet hast, irrelevant.

T76 mipFilter2DVariance

D E TA I L S

Default: 0.3 (= exakt das V242-Legacy-Verhalten) 
Range: 0.1 – 1.0 Defined in:

T E C H N I S C H

2D-Mip-Filter-Varianz, die zur Σ_2D-Diagonale ad
diert wird (Varianz direkt, nicht quadriert). 0.3 
ist exakt der V242-Legacy-Wert, der vor Mip-
Splatting hardcoded im Kernel war. Wenn T74 
useMipSplatting = false, ignoriert der Kernel die
sen Wert komplett und schreibt das hartkodierte 0.3 
— sodass die Baseline nicht regredieren kann (Co
dex-Round-1-S3-1-Garantie). Wenn, wird der hier 
gesetzte Wert verwendet. Bleibt im Feld-Katalog für 
Mip-Sweeps.

E I N FAC H  G E S AG T

Weiterer Mip-Splatting-Parame­
ter. Bei Mip-aus: irrelevant.
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Adaptive Densification (Q5) (T77–T79)

T77 adaptiveDensification

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

Q5-Feature: rolling-median-Tracker als Alternative 
zum fixen T11 densifyGradThreshold. Wenn true, 
wird in jedem Densify-Step der aktuelle Schwell
wert mit median(letzte N avgGrad-Samples) × 
T79 adaptiveDensifyMultiplier überschrieben. N 
= T78 adaptiveWindow . Strikter als V440 p98 (die 
katastrophale 63 K-Pruning-Falle), median + 2× 
sitzt etwa beim p70–p80 der Gradient-Verteilung 
in steady state. Q5-Tests: alleinstehend FAIL 0/3 
Szenen, aber gemeinsam mit Q6 (siehe T80/T81) 
PASS 1/3 Szenen — das Bundle Q5+Q6 wurde 
2026-05-25 als opt-in gepasst und ist via CLI 
--adaptive-densify  aktivierbar. Q6 ist dabei der 

„Carrier„ des Quality-Gewinns, Q5 trägt eher zur 
Stabilität bei.

E I N FAC H  G E S AG T

Selbstlernender Densify-
Schwellwert. Statt einer fest ein­
gestellten Empfindlichkeit passt 
die App sich der Szene an. Al­
leine getestet nicht besser, mit 
dem Curriculum aus Q6 zusam­
men aber ja. Beide gemeinsam 
einschalten oder beide aus.

T78 adaptiveWindow

D E TA I L S

Default: 1 000 Range: 100 – 10 000 Defined in:

T E C H N I S C H

Rolling-Median-Window in Densification-Events 
(NICHT Iterationen — jeder T13 densifyInterval-
Step liefert ein Sample). Default 1 000 — bei 
heißt das die letzten 100 000 Trainings-Iterationen 
tragen zum Median bei, also typisch die gesamte 
Trainingshistorie bis hierhin. Frühe Phase (vor T78  
Samples): Tracker returns nil → Fallback auf fixen 
Threshold T11 . Nur relevant wenn.

E I N FAC H  G E S AG T

Wie viele alte Densify-Schritte in 
den Median für T77 einfließen. 
Standard 1000 ist gut. Nur rele­
vant wenn Q5-Adaptive an.
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T79 adaptiveDensifyMultiplier

D E TA I L S

Default: 2.0 Range: 1.0 – 4.0 Defined in:

T E C H N I S C H

Multiplikator auf den Rolling-Median für den adap
tiven Schwellwert. Default 2.0 entspricht ungefähr 
p70–p80 der typischen Gradient-Verteilung. Niedri
ger = aggressiveres Wachstum (mehr Klone), höher 
= strenger (weniger Klone). Q5-Tests in Range 1.5–
3.0 — 2.0 bestes Default. Nur relevant wenn.

E I N FAC H  G E S AG T

Faktor für T77/T78. Standard 2.0 
= strenger als der typische Medi­
an. Nicht dran drehen.

Curriculum (Q6) (T80–T81)

T80 curriculumResolutionRamp

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

Q6-Feature: Trainings-Auflösung startet 
bei 0.5× und wechselt bei T50 
positionLRScheduleEndIteration /​ 2 (oder T1 
maxIterations /​ 2, falls T50 nicht gesetzt) auf T22 
trainingRenderScale. Verwendet die in Q1.5.1 ent
wickelte resize/​restoreImageBuffers-Infrastruktur. 
Überschreibt T23 resolutionWarmupScale, wenn ak
tiviert. Q6 ist als „Carrier des Quality-Gewinns„ im 
Q5+Q6-Bundle gepasst (siehe T77) — die schritt
weise Auflösungserhöhung gibt der App Zeit, grobe 
Geometrie auf der niedrigeren Auflösung zu finden, 
bevor sie zur feinen Detailarbeit übergeht. Über CLI: 
--curriculum-resolution.

E I N FAC H  G E S AG T

„Erst grob, dann fein„ für die 
Trainingsauflösung. Halbe Auf­
lösung in der ersten Hälfte, 
dann volle Auflösung. Hilft in 
bestimmten Szenen, in anderen 
nicht — am besten mit T81 zu­
sammen einschalten.
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T81 curriculumSHProgression

D E TA I L S

Default: false Range: boolean Defined in:

T E C H N I S C H

Q6-Feature: überschreibt 
T21 shDegreeUpgradeIterations mit [maxIter/​4, 
maxIter/​2, maxIter*3/​4], verteilt also die SH-Auf
stufungen gleichmäßig über die Trainingszeit statt 
sie front-zu-loaden. Hypothese: stabile Geometrie 
wird vor Color-Detail-Explosion etabliert, was die 
View-Direction-abhängigen Glanz-Effekte präziser 
positioniert. Q5+Q6 zusammen PASS 1/3 Szenen, 
Q6 als Carrier des Gewinns (Q5 alone FAIL). Via CLI: 
--curriculum-sh .

E I N FAC H  G E S AG T

„Erst Form, dann Farbe„ — die 
Glanz-Effekte werden erst spät 
im Training freigeschaltet, so­
dass die Splats zuerst ihre Posi­
tion und Größe finden. Mit T80 
zusammen einschaltbar; alleine 
bringt es nicht ganz so viel.

Statische Presets (TP1–TP9)

Hier nur die strukturellen Unterschiede zum Initializer-Default. Die volle Marketing-
Beschreibung der elf UI-Presets P1–P11 findest du in Kapitel 7.

TP1 .preview

D E TA I L S

Diagnose-/Vorschau-Preset für Systeme ≥ 10 GB 
RAM. Overrides gegenüber Initializer: - 30 000 → 
5 000 - 15 000 → 3 500 (70 % von maxIter) - 
1.6e-6 → 1.6e-5 (10× höher, weniger aggressiver 
Decay) -,,,, jeweils 2× (V176) - 3 000 → 100 000 
(effektiv aus, V172: Reset zerstört kurze Trainings) - 
[1K, 2K, 3K]  → [1K, 2K]  (V182: Degree 3 kon

vergiert in 2K Iter nicht) - 1.0 → 0.5

E I N FAC H  G E S AG T

jede beliebige Initial-Begutach­
tung einer neu importierten Bild­
reihe — 2–3 min Wartezeit, an­
schließend reicht das Ergebnis 
für eine binäre Frage „lohnt sich 
Quality-Lauf?„.
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TP2 .full

D E TA I L S

Production-Quality Classic. Overrides: - 30 000 → 
35 000 (V550: 40K-Tests Truck-Overtraining +10.7 
% Gs bei −1.3 % L1) - 15 000 → 5 000 (V310 
sweet spot, V338 7K worse) - Alle LRs 2× (V188) - 
1.6e-6 → 1.6e-5 (V45 10×) - 2e-6 → 1.1e-6 (V335) 
- 100 → 200 (V112) - 0.005 → 0.001 (V393) - 3 
000 → 100 000 (V194 disabled, V421 confirmed) - 
[1K, 2K, 3K]  → [2K, 5K, 8K]  (V228 delayed) - 

0.0 → 0.9995 (V546 HTGS, 14 % Verbesserung) - 
50 (unverändert, V546) - false → true (V438) - 0 
→ 20 000 (V431) - true (V443, schon Initializer-De
fault für .full )

E I N FAC H  G E S AG T

jede Standard-Foto-Aufnahme 
(Objekt, kleiner Raum, Skulptur) 
mit < 500 Bildern. Die in V546 
angekündigte 14 % Loss-Verbes­
serung gegen V438 wurde 3-Tri­
al-gemittelt auf Horse Full bestä­
tigt.

TP3 .fullClassicPaper

D E TA I L S

Q1.5-A-Test-Sibling von TP2, paper-treuer Classic. 
Overrides gegenüber TP2: - 35 000 → 30 000 
(Paper-Standard) - 5 000 → 15 000 (Paper: 50 % 
von maxIter) - 1.6e-5 → 1.6e-6 (Paper-Default) -,, 
zurück auf Paper Defaults (0.05, 0.005, 0.001) - 
1.1e-6 → 2e-7 (kalibriert für ~1-2M Gs auf Bicycle) - 
200 → 100 (Paper) - 0.001 → 0.005 (Paper-Default) 
- 100 000 → 3 000 (Paper §5.2, riskant — kann 
V194-Regression auslösen) - 0.9995 → 0.0 (Paper 
hat keinen Decay) - 20 000 → 30 000 (cosine läuft 
auf 100 % von maxIter)

E I N FAC H  G E S AG T

Q1.5-Forschungs-Experimente, 
die Paper-Magnitude-Gaussian-
Budgets (1–2 M) für Mip-Splatt­
ing-Tests brauchen. Nach Q1.5-
„closed no-win„-Verdict bleibt 
das Preset für advanced users 
zugänglich, ist aber nicht Pro­
duction-empfohlen.
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TP4 .fullMCMC

D E TA I L S

Production-Quality MCMC. Overrides gegenüber In
itializer: - 30 000 → 200 000 (V534, MCMC braucht 
5× mehr Iter als Classic) - 15 000 → 160 000 
(V504b 80 % von maxIter) - 1.6e-6 → 1.6e-5 
- LR-Schedule wie TP2 (alle 2×) - 0.2 → 0.05 
(V521b/V534: MCMC braucht stärkeres L1-Signal) 
- [1K, 2K, 3K]  → [2K, 5K, 8K]  - .classic  → 
.mcmc  - 150 000 (im Initializer schon, im Preset 

bestätigt) - 5e-5 (V467/V536 optimal) - 0.005 → 
0.01 (V535 optimal) - 0 → 160 000 (80 % von ma
xIter, V497c/V502) - 3.0 (im Initializer schon) - true 
(im Initializer schon) - 3 000 → 200 000 (effektiv 
aus, MCMC nutzt Reloc statt Reset)

E I N FAC H  G E S AG T

Web-Auslieferung, Object-Cap­
tures mit Detail-Anspruch, Droh­
nenflüge (auch wenn dann P9 
Outdoor noch besser ist). 71 % 
weniger Gaussians als Classic 
bei vergleichbarer L1.

TP5 .fullMCMCMip

D E TA I L S

Q1.5-D-Test-Sibling von TP4, mit Mip-Splatting + 
Paper-Magnitude-MCMC-Budget. Overrides gegen
über TP4:
• mcmcMaxGaussians 150 000 → 1 500 000 (10×, 

Paper-Magnitude)
• useMipSplatting false → true (Mip-on)

E I N FAC H  G E S AG T

Alle anderen Felder identisch zu 
TP4. Q1.5 D-PASS auf Bicycle 
2026-05-24 (bricht 12-Iter-Mul­
ti-Scale-FAIL-Streak). Q1.5-End­
urteil 2026-05-25 trotzdem clo­
sed-no-win — Mip-Splatting-Ge­
winn nicht reproduzierbar über 
11 Pair-Scenes. Preset bleibt opt-
in.

TP6 .classicBalanced

D E TA I L S

Mid-Tier Classic. Overrides gegenüber TP2: - 35 
000 → 20 000 (V149: 20K = 30K bei 33 % weniger 
Zeit) - 20 000 → 0 (Cosine läuft auf maxIter = 20K, 
kein extended phase)

E I N FAC H  G E S AG T

Standardfälle mit kürzerer War­
tezeit. V149 als sweet spot iden­
tifiziert.

165 / 233



R A D I A N C E K I T Kapitel 6 — Trainings-Konfiguration

TP7 .mcmcPreview

D E TA I L S

MCMC-Diagnose. Overrides gegenüber TP4: - 200 
000 → 60 000 (V494b) - 160 000 → 48 000 (80 
%) - 150 000 → 100 000 (V473b) - 160 000 → 40 
000 (V494b) - 3.0 → 2.0 (1.4.5: Preview = lighter 
scaling)

E I N FAC H  G E S AG T

schnell ein MCMC-Resultat se­
hen, um zu beurteilen, ob 
TP4 oder ein Scene-Class-Preset 
lohnt.

TP8 .mcmcBalanced

D E TA I L S

Mid-Tier MCMC. Overrides gegenüber TP4: - 200 
000 → 120 000 (V518) - 160 000 → 96 000 (80 %) 
- 160 000 → 96 000 (80 %) - 3.0 → 2.5 (zwischen 
Preview 2.0 und Full 3.0)

E I N FAC H  G E S AG T

MCMC ohne den vollen 200K-
Lauf. ~120 K Iterationen sind ein 
guter Kompromiss aus Qualität 
und Wartezeit.

TP9 .quickTest

D E TA I L S

Reiner Funktionstest. Overrides gegenüber Initiali
zer: - 30 000 → 1 000 - 15 000 → 500 - 2e-6 → 
4e-6 (kalibriert für 0.25× Auflösung) - 100 → 50 - 3 
000 → 100 000 (aus, da viel zu kurz) - 1.0 → 0.25

E I N FAC H  G E S AG T

Sanity-Check „startet das Trai­
ning überhaupt sinnvoll?„. Dauer 
< 30 s auf M3 Ultra. Sieht garan­
tiert matschig aus.

Methode:

Signature: public func resolveMcmcMaxGaussians(initialPointCount: Int, 
bufferCapacity: Int) -> Int Defined in:

 Einzige Source-of-Truth für die Frage „wie viele Gaussians darf MCMC maxi

mal wachsen lassen?„. Berechnet sich aus drei Eingaben: dem konfigurierten T62 
mcmcMaxGaussians (mit Mass-Extinction-Floor 150 000, falls 0), dem (Anzahl der SfM-
Init-Punkte) und der (vorallozierte Gaussian-Buffer-Größe). Logik:

1. base = T62 > 0 ? T62: 150_​000 (der Mass-Extinction-Floor schützt gegen Initia
lizer-Default-Bugs wie den 1.4.3-Mass-Extinction-Vorfall)

2. Falls T73 mcmcAutoScaleByScene && initialPointCount > 0 && T72 
mcmcCapMultiplier > 0:
• scaled = max(base, ceil(initialPointCount × T72)) sonst

3. Falls bufferCapacity > 0 : return min(scaled, bufferCapacity)
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4. Sonst return scaled

Beispiel: Bicycle (Mip-NeRF 360, 194 Foto-Frames) → SfM-init ~156 K Punkte, 
T62 = 150 000 , T72 = 5.32 ,, Buffer-Kapazität 8 M. Resolved Cap = min(8M, 
max(150K, ceil(156K × 5.32))) = min(8M, 830K) = 830 K. Das ist der effektive 
Wachstums-Cap, an den die MCMC-Relocation-Logik sich hält.

 Berechnet die wirkliche maximale Splat-Anzahl bei MCMC. Nimmt deine Einstellung, 

schaut sich an, wie viele Punkte deine Szene anfangs hat, und skaliert mit dem 
Multiplier , falls die automatische Anpassung an ist. So passt sich der Cap an die 

Szene an, statt für eine kleine und eine riesige Szene den gleichen Wert zu erzwingen. 
Du musst die Methode nicht selbst aufrufen — das Training nutzt sie intern.

Welches Feld wofür? (Cheat-Sheet)

Ziel Felder zum Drehen

Mehr Detail in der 
Ferne

T62 mcmcMaxGaussians hoch, T72 mcmcCapMultiplier 5+

Mehr Detail allge
mein (Classic)

T1 maxIterations  hoch (≤ 40K), T2 densifyUntilIteration ≤ 
14 % von T1

Floater in Droh
nenflügen reduzie

ren

T43 frustumCullEnabled an, T20 skyMaskingEnabled an, 
T45 skyDomeEnabled  an

Schöner Himmel in 
Außen-Szenen

T45 skyDomeEnabled  an, T47 skyDomeRadiusMultiplier 30–60

Kleinere Export-
Datei

Strategie .mcmc  (T61), T56 postTrainingCompactification an, 
T62 mcmcMaxGaussians ≤ 200K

Schnelleres Trai
ning

T22 trainingRenderScale 0.5, T1 maxIterations  halbieren — 
aber nicht beides!

Bessere Glanzlich
ter

T21 shDegreeUpgradeIterations mit [2K, 5K, 8K]  (kein early-
front-load), MCMC + 200K iter

Mac responsiv hal
ten

T25 throttleDelayMs 5–10 (kostet ~15 % Trainingszeit)

Live-Vorschau 
häufiger

T59 livePreviewInterval runter auf 10–20

Sanftere Übergän
ge an Schatten

T17 ssimWeight  etwas hoch (0.15–0.25), aber nicht über 0.3

Innenräume kom
pakt halten

P10 Indoor-Preset (, T72 = 1.76 )
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Gefährliche Felder

Diese Felder können bei Falsch-Konfiguration zu OOM, App-Crash, Mass-Extinction der 
Gaussians oder unbrauchbaren Benchmark-Daten führen. Mit Vorsicht zu behandeln:

• T11 densifyGradThreshold — eine Halbierung kann 2–4× so viele Gaussians erzeu
gen, was schnell den GPU-Speicher sprengt. Auch zu beachten: muss zur T22 
trainingRenderScale passen (1.0× → 1e-6, 0.5× → 2e-6, 0.25× → 4e-6).

• T72 mcmcCapMultiplier — bei großen Szenen mit > 200 K SfM-init-Punkten und Mul
tiplier > 5 entsteht ein Resolved-Cap von Millionen Gaussians. Auf 36-GB-RAM-Macs 
OOM möglich. Outdoor-Preset 5.32 funktioniert nur, weil Mip-NeRF-360-Bicycle 156 
K init-Punkte hat → 830 K Cap.

• T39 testViewIndices — manuelles Setzen kann den Benchmark unbrauchbar machen 
(alle Indices > N → keine Holdouts). Lass das --benchmark -Flag das setzen.

• T64 mcmcOpacityRegWeight und T65 mcmcScaleRegWeight — In 1.4.3-Beta auf 0.01 
gesetzt, was zu Mass-Extinction führte (460 K → 5 Gaussians in einer Iteration). Seit 
1.4.4 auf 0.0 fixiert, aber manuelles Erhöhen kann das Problem reproduzieren.

• T15 opacityResetInterval — wenn nicht 100 000+ (effektiv aus) und das Training 
kürzer als 10 000 Iterationen ist, zerstört der Reset die Konvergenz. .preview  hat es 
deshalb auf 100 000 trotz maxIterations = 5 000.

• T54/​T55 densifyPhase2* — Two-Phase Densification ist in Tests in 0-Gaussians-Cas
cade abgebrochen. Lass beide auf 0.

• T74 useMipSplatting — Q1.5 closed-no-win 2026-05-25, kann auf manchen Out
door-Szenen sogar PSNR verschlechtern. Default off, opt-in nur für Forschung.

Wenn ein Feld auf dieser Liste steht und du es ändern willst, mache vorher eine 
Sicherung deines aktuellen Presets (Export als JSON) und überlege, ob du das Resultat 
reproduzierbar messen kannst — sonst weißt du hinterher nicht, ob du eine Verbesse
rung oder Verschlechterung herbeigeführt hast.
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K A P I T E L

Kapitel 7 — Eingebaute Qualitäts-
Presets

Abbildung 27:  Vorlagen-Sektion mit allen vier Gruppen ausgeklappt — CAPTURE CLASS 
(4 Presets: Drone/Aerial, 360° Walkaround, 360° Walkaround (High Detail), Photo/Object), 
CLASSIC (5 Presets: Quick/Preview/Balanced/Quality/Ultra Detail), MCMC (3 Presets, Hin

weis „No threshold tuning„), HYBRID (1 Preset: Balanced (Hybrid))

WAS IM BILD ZU SEHEN IST  Presets-Sektion im Inspector, alle vier Gruppen ausgeklappt. 
CAPTURE CLASS mit den vier kuratierten Real-World-Presets (Drone / Aerial, 360° Wal
karound, 360° Walkaround (High Detail), Photo / Object) — das ist die primäre Gruppe 
und im Simple-Mode die einzige sichtbare. CLASSIC mit Quick (1K iters), Preview (5K 
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iters, aktive Auswahl mit blauem Häkchen), Balanced (20K iters), Quality (35K iters) und 
Ultra Detail (35K iters). MCMC mit Untertitel „No threshold tuning„ — MCMC braucht 
keinen Densify-Until-Threshold: Preview (60K iters, 100K Gaussians), Balanced (120K, 
150K), Quality (200K, 150K). HYBRID mit dem Balanced (Hybrid) (20K iters, 150K Gaus
sians). Footer-Action-Row: Save…, Export…, Import…

Ein Preset ist eine vorbereitete Konfiguration für das Training. RadianceKit liefert drei
zehn eingebaute Presets in vier Gruppen aus: vier Capture-Class-Presets (P9–P12) 
— kuratierte, an echtem Community-Material per Auge validierte Rezepte für reale 
Aufnahme-Arten (Drohne, 360°-Rundgang, Foto-Objekt) und die primäre Achse seit 
v1.6 —, fünf Classic-Presets (P1–P5: Quick/Preview/Balanced/Quality/Ultra Detail), drei 
MCMC-Presets (P6–P8) und ein Hybrid-Preset (P13), das die Classic- und MCMC-Stra
tegien kombiniert. Die früheren „Scene-Class„-Presets (Render/3D, Outdoor, Indoor, 
in Phase Q7 akademisch gegen Mip-NeRF-360- und NeRF-Blender-Szenen getuned) 
wurden in v1.6 als sichtbare Gruppe zurückgezogen — die per Auge an echtem Footage 
validierte Capture-Class ist jetzt die primäre Achse; die Q7-getunten Konfigurationen 
bleiben nur noch intern erhalten. Du wählst die Presets in der Sidebar im Bereich 
Presets oder im Simple-Mode beim Import. Die + -Buttons öffnen Dialoge, um eigene 
Presets daneben anzulegen — die dreizehn eingebauten lassen sich nicht löschen, aber 
duplizieren.

Im Expert-View erscheinen die Presets gruppiert nach Aufnahme-Art und Strategie 
(Capture Class / Classic / MCMC / Hybrid). Ein Klick auf einen Eintrag schreibt die hin
terlegte Trainingskonfiguration in den aktuellen Zustand. Das ist kein Snapshot — wenn 
du danach an Schiebereglern drehst, ändert sich der Zustand, aber das Preset selbst 
bleibt unverändert; ein farbiger Hinweis zeigt dann „modified„.

Welches Preset wann das richtige ist, hängt vor allem von Szenen-Typ und Hardware 
ab. Die drei tabellarischen Übersichten am Kapitel-Ende fassen das zusammen.
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P1 — Quick

WO

Inspector → Presets-Sektion → Gruppe „Classic„ → 
Eintrag „Quick“. UUID-Suffix …001 .

T E C H N I S C H

Diagnose-Preset mit 1 000 Iterationen, klassischer 
(adaptiver) Densification-Strategie und einer Trai
nings-Auflösungs-Skalierung von 0.25× (Eingabe
bild wird vor dem Training auf 25 % verkleinert). 
Soll nicht zur Auslieferung einer Szene dienen, 
sondern schnell feststellen, ob das Setup (Kame
raposen, Punktwolke, Bildreihe) überhaupt sinnvolle 
Bewegung in den Loss-Werten zeigt. Auf einem M3 
Ultra typischerweise unter 30 Sekunden auf 50–
200 Bildern. Die kleine Auflösung verschleiert echte 
Bildqualität, hält aber Speicherbedarf und Render-
Aufwand sehr gering. Wird auch automatisch als 
Default beim ersten Start gewählt, wenn das System 
weniger als 10 GB RAM hat.

E I N FAC H  G E S AG T

Schneller Funktionstest. Bilder 
rein, eine knappe halbe Minute 
warten, gucken ob der Rohum­
riss der Szene erscheint. Wenn 
das Bild im Viewer wie ein mat­
schiger Klecks aussieht — passt, 
das soll so sein. Wenn du dage­
gen nur dunkle Punkte oder eine 
total verzerrte Form siehst, sind 
wahrscheinlich die Kameraposen 
falsch (siehe Kapitel 9). Für ein 
zeigbares Ergebnis brauchst du 
danach mindestens P2 oder P3.

P2 — Preview (Classic)

WO

Inspector → Presets-Sektion → Gruppe „Classic„ → 
Eintrag „Preview“. UUID-Suffix …002 .

T E C H N I S C H

5 000 Iterationen Classic-Densification, 0.5× Auf
lösungs-Skalierung, doppelte Lernraten gegenüber 
Standard. Densification (Klonen + Splitten) ist über 
die ersten 2 500 Iterationen aktiv, danach nur noch 
Pruning. Default-Preset für Systeme mit ≥ 10 GB 
RAM. Auf einem M3 Ultra typischerweise 90 Sekun
den bis 3 Minuten für eine 200-Bild-Szene. Liefert 
einen brauchbaren Eindruck der Geometrie und der 
Kamera-Pose, aber Texturen sind sichtbar weichge
zeichnet — die 0.5× Render-Auflösung lässt sich 
danach durch erneutes Trainieren mit P3 oder P4 
nicht direkt umgehen, weil die Lernraten passend 
zur halben Auflösung kalibriert sind.

E I N FAC H  G E S AG T

Der Standard für „einmal kurz 
anschauen„. Wenn du gerade 
neue Bilder importiert hast und 
sehen willst, ob die Szene über­
haupt rekonstruierbar ist, ist das 
die richtige Stufe. Etwa 2–3 Mi­
nuten Wartezeit, danach kannst 
du im 3D-Viewer drehen und be­
urteilen, ob die Anschaffung wei­
terer Trainingsdurchgänge sinn­
voll ist. Erst wenn das Vorschau-
Ergebnis bereits gut aussieht, 
lohnt sich Balanced oder Quality.
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P3 — Balanced (Classic)

WO

Inspector → Presets-Sektion → Gruppe „Classic„ → 
Eintrag „Balanced“. UUID-Suffix …005 .

T E C H N I S C H

20 000 Iterationen Classic-Densification bei voller 
Bildauflösung. Densification läuft über die ersten 15 
000 Iterationen, ab Iter 3 000 mit einem Densify-
Intervall von 100. Empirisch der „sweet spot„ aus 
den dokumentierten Trainings-Sessions: bei klassi
scher Densification auf Horse Full und Truck stabili
siert sich der L1-Loss zwischen Iter 18 000 und 22 
000, ein längeres Training bringt unterhalb von Qua
lity (P4) keine signifikante Verbesserung mehr. Auf 
einem M3 Ultra typischerweise 30–60 Sekunden auf 
200 Bildern, 5–8 Minuten auf 1 000+ Bildern.

E I N FAC H  G E S AG T

Der „gute Kompromiss„. Die 
meisten Szenen sehen hiermit 
schon gut aus, ohne dass du eine 
Stunde warten musst. Wenn du 
das Endergebnis irgendwo zei­
gen willst (Social Media, Website, 
eine Kunden-Demo), reicht das 
oft. Erst wenn du in das Splat-
Modell hineinzoomen willst oder 
du Details der Oberflächentextur 
brauchst, lohnt sich der Sprung 
zu P4 Quality oder P7 MCMC.

P4 — Quality (Classic)

WO

Inspector → Presets-Sektion → Gruppe „Classic„ → 
Eintrag „Quality“. UUID-Suffix …003 .

T E C H N I S C H

35 000 Iterationen Classic-Densification mit V546-
„Opacity Decay„ (HTGS, Eurographics 2025): nach 
jedem Densify-Cycle multipliziert sich die Opacity 
aller existierenden Gaussians mit einem Faktor < 
1.0, was inaktiv gewordene Gaussians beim Pru
ning verlässlich entfernt und damit auf identischer 
Iter-Zahl 14 % besseren L1-Loss als der klassi
sche 35 000-Lauf erreicht. SSIM-Loss ist aktiviert 
( ssimWeight=0.05 ). Auf einem M3 Ultra typischer
weise 2–4 Minuten auf 200 Bildern. Liefert auf 
NeRF-Blender (Lego, Chair, Drums) finale L1 ≈ 0.023 
— beste Classic-Variante in den 560+ dokumentier
ten Experimenten. Beachte: braucht ~3–5 GB GPU-
Speicher; auf 8-GB-Systemen ist P3 die sichere 
Wahl.

E I N FAC H  G E S AG T

Die beste klassische Variante. 
Liefert scharfe Textur und feine 
Geometrie, gerade auf Objekt-
Aufnahmen (eine Skulptur, ein 
Stuhl, eine Vase). Bei großen 
Outdoor-Szenen oder Räumen 
merkst du dagegen kaum noch 
einen Unterschied zu Balanced 
— dort lohnt sich der Wechsel 
zu einem MCMC-Preset (P6–P8) 
oder einem Capture-Class-Preset 
(P9–P12) mehr als der Sprung 
von P3 auf P4. Wer das absolu­
te Maximum der Classic-Familie 
will, nimmt P5 Ultra Detail.
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P5 — Ultra Detail (Classic)

WO

Inspector → Presets-Sektion → Gruppe „Classic„ → 
Eintrag „Ultra Detail“. UUID-Suffix …008 .

T E C H N I S C H

Rund 35 000 Iterationen Classic-Densification — 
der Sieger des Held-out-Durchgangs der Quality-
Matrix (2026-06-10). Auf allen drei getesteten Mip-
NeRF-360-Szenen schlägt Ultra Detail das einge
baute MCMC-„Quality„-Preset (P8) bei vergleichba
rer Wall-Clock-Zeit um rund +0.94 dB PSNR. Damit 
ist es das stärkste Quality-Preset der Classic-Grup
pe und die schärfste Classic-Variante, die Radi
anceKit ausliefert. Auf einem M3 Ultra typischerwei
se im selben Zeitrahmen wie P4 Quality (2–5 Minu
ten auf 200 Bildern), braucht aber etwas mehr GPU-
Speicher; auf 8-GB-Systemen bleibt P3 die sichere 
Wahl.

E I N FAC H  G E S AG T

Die schärfste Classic-Stufe und 
der Held-out-Sieger unserer 
Qualitäts-Tests: auf realen Sze­
nen rund ein Dezibel besser als 
die MCMC-„Quality„-Variante — 
bei ähnlicher Wartezeit. Wenn 
du maximale Detailtreue mit der 
bewährten klassischen Densifi­
cation willst und genug GPU-
Speicher hast, ist das die erste 
Wahl. Reicht der Speicher nicht 
oder brauchst du eine möglichst 
kleine Export-Datei, bleib bei P4 
Quality oder einem MCMC-Pre­
set.

P6 — Preview (MCMC)

WO

Inspector → Presets-Sektion → Gruppe „MCMC„ → 
Eintrag „Preview“. UUID-Suffix …006 .

T E C H N I S C H

60 000 Iterationen MCMC-Densification (3DGS-
MCMC, NeurIPS 2024) bei einem Cap von 100 
000 Gaussians. MCMC ersetzt die heuristische 
Klon/Split-Logik durch Markov-Chain-Monte-Carlo-
Relocation: tote Gaussians werden über Sigmoid-
gewichtete Sampling-Tiefen neu plaziert, was eine 
kontrollierte und reproduzierbare Anzahl Gaussians 
ergibt. Der Cap deckelt die maximale Anzahl hart 
bei 100K — das spart Speicher und Render-Zeit, 
kostet aber Detail. Auf einem M3 Ultra typischer
weise 5–8 Minuten auf 200 Bildern. Eignet sich als 
„MCMC-Funktionstest„ — Hilft zu beurteilen, ob ein 
Wechsel von Classic auf MCMC sinnvoll wäre, bevor 
du in P7 oder P8 mehr Zeit investierst.

E I N FAC H  G E S AG T

Wie P2 Preview, aber mit 
dem neueren MCMC-Verfahren. 
Liefert oft etwas kompaktere, 
gleichmäßiger verteilte Splat-
Wolken als die Classic-Variante. 
Für eine erste Begutachtung ei­
ner Szene reichen die 5–8 Mi­
nuten meist. Wenn dir das Vor­
schau-Ergebnis gefällt, ist der 
nächste Schritt P7 (Balanced) 
oder direkt P8 (Quality MCMC).
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P7 — Balanced (MCMC)

WO

Inspector → Presets-Sektion → Gruppe „MCMC„ → 
Eintrag „Balanced“. UUID-Suffix …007 .

T E C H N I S C H

120 000 Iterationen MCMC bei einem Cap von 150 
000 Gaussians. Die mittlere MCMC-Stufe — fast die 
finale Gaussian-Anzahl von P8 Quality, aber nur 60 
% der Iterationen. Empirisch liegt der L1-Loss in 
den dokumentierten Trainings-Sessions bei 0.026–
0.028 auf Horse Full, gegenüber P8 mit 0.0246 — 
also rund 7 % höher, dafür halbe Wartezeit. Auf ei
nem M3 Ultra typischerweise 8–15 Minuten auf 200 
Bildern. Verwendet ein Verfahren, das den effekti
ven Gaussian-Cap an die Punktdichte der Eingangs-
SfM-Punktwolke skaliert (siehe T75 in Kapitel 6).

E I N FAC H  G E S AG T

MCMC mit ordentlicher Detailtie­
fe, aber ohne den langen Voll-
Lauf von P8. Für die meisten Sze­
nen reicht das aus, gerade wenn 
du einen MCMC-Lauf in den Mit­
tagspausen-Zeitrahmen pressen 
willst. Wenn Speicher knapp ist 
(etwa auf M-Prozessoren mit nur 
16 GB), bleib hier — P8 braucht 
mehr GPU-Speicher.

P8 — Quality (MCMC)

WO

Inspector → Presets-Sektion → Gruppe „MCMC„ → 
Eintrag „Quality“. UUID-Suffix …004 .

T E C H N I S C H

200 000 Iterationen MCMC bei einem Cap von 
150 000 Gaussians, SSIM-Loss 0.05, MCMC-Noise-
Decay über 80 % der Iterationen. Best-Single-Run-
L1 in den 560+-Experimenten: 0.0238 auf Horse 
Full, gemittelt über 3 Trials 0.0246 (gegenüber P4 
0.0230 auf gleicher Szene). MCMC liefert dabei 71 
% weniger Gaussians (150K vs ~524K) — entschei
dend, wenn du das Ergebnis auf dem Web auslie
fern willst, weil die kleinere Wolke deutlich kleinere 
Export-Dateien produziert. Trainingszeit auf einem 
M3 Ultra typischerweise 20–35 Minuten auf 200 Bil
dern; auf 1 000+-Bild-Sets eher 1–2 Stunden. Beste 
Wahl wenn maximale Bildqualität bei minimaler End
größe gewünscht ist.

E I N FAC H  G E S AG T

Die beste MCMC-Variante. Liefert 
sehr saubere, kompakte Splat-
Wolken — ideal wenn du das Er­
gebnis später als Web-3D-View­
er einbetten oder als Datei ver­
schicken willst (die Datei ist klei­
ner als bei P4 Quality bei ver­
gleichbarer optischer Qualität). 
Brauchst dafür aber Geduld — 
auf großen Aufnahmen über eine 
Stunde Wartezeit. Plane das eher 
als „Schnitt-über-Nacht„-Lauf.
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Abbildung 28:  CAPTURE CLASS Gruppe ausgeklappt mit allen vier kuratierten Real-World-
Presets — Drone / Aerial (MCMC, 40K iters, Cap 1,5 M), 360° Walkaround (MCMC, 40K, Cap 
1,5 M), 360° Walkaround (High Detail) (Hybrid, 40K, Cap 1,5 M, opt-in) und Photo / Object 

(Hybrid, 40K, Cap 1,5 M). Diese Gruppe steht ganz oben und ist im Simple-Mode die einzige 
sichtbare.

WAS IM BILD ZU SEHEN IST  Inspector mit der CAPTURE CLASS-Gruppe ausgeklappt — 
die primäre Preset-Gruppe seit v1.6, im Simple-Mode die einzige angezeigte. Jeder 
Eintrag ist ein an echtem Community-Material per Auge validiertes Rezept für eine 
konkrete Aufnahme-Art (Drohne, 360°-Rundgang, Foto-Objekt), nicht ein gegen ein 
akademisches Test-Set optimierter Wert. Auswahl per Klick schreibt die hinterlegte 
Trainingskonfiguration in den aktuellen Zustand.
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P9 — Drone / Aerial

WO

Inspector → Presets-Sektion → Gruppe „Capture 
Class„ → Eintrag „Drone / Aerial“. UUID-Suffix 
…010 .

T E C H N I S C H

Capture-Class-Preset für Luft- und Drohnen-Orbits 
von Gebäuden und Landschaften. MCMC-Densifier, 
40 000 Iterationen, Cap 1,5 Mio. Gaussians, SSIM-
Loss 0.5 plus Edge-Aware-Term 0.1. Entscheidend 
ist die Anisotropie-Strafe mit Gewicht 0.003 bei 
einer Ratio-Schwelle von 6 — der „Spaghetti-Kil
ler„ gegen die typisch nadelförmigen Artefakte, die 
Drohnen-Footage erzeugt. Validiert an einem ech
ten DJI-4K-Drohnenflug über das Pensford-Viadukt 
(per Auge geprüft, nicht nur metrisch).

E I N FAC H  G E S AG T

Für Aufnahmen aus der Luft 
— Drohnenflüge um ein Gebäu­
de, über eine Landschaft, ent­
lang einer Fassade. Die kräftige 
Anisotropie-Strafe räumt die na­
del- bzw. spaghettiförmigen Ar­
tefakte weg, die Drohnen-Materi­
al gern produziert. Wenn dein 
Material vom Boden aus aufge­
nommen ist, passt eher Photo / 
Object oder ein Classic-Preset.

P10 — 360° Walkaround

WO

Inspector → Presets-Sektion → Gruppe „Capture 
Class„ → Eintrag „360° Walkaround“. UUID-Suffix 
…011 .

T E C H N I S C H

Capture-Class-Preset für 360°-Walkaround-Videos. 
MCMC-Densifier, 40 000 Iterationen, Cap 1,5 Mio. 
Gaussians, SSIM-Loss 0.5 plus Edge-Aware-Term 
0.1, sanfte Anisotropie-Strafe (Gewicht 0.001 bei 
Ratio-Schwelle 15). Personen- und Himmel-Maske 
sind aktiv. Das Preset erwartet ein 360°-Equirect-
Video, das intern auf rund 90° breite Perspektiv-
Crops reprojiziert wird, bevor das Training startet. 
Validiert an 8K-360°-Rundgängen mit Selfie-Stick 
(Monument-Szene, per Auge geprüft).

E I N FAC H  G E S AG T

Für 360°-Rundgang-Videos — du 
gehst mit einer 360°-Kamera 
oder Selfie-Stick durch einen 
Raum oder um ein Objekt her­
um. RadianceKit zerlegt das Ku­
gel-Panorama selbst in normale 
Blickwinkel und maskiert Pas­
santen und Himmel weg. Für ma­
ximale Schärfe auf demselben 
Material probiere zusätzlich die 
High-Detail-Variante (P11).
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P11 — 360° Walkaround (High Detail)

WO

Inspector → Presets-Sektion → Gruppe „Capture 
Class„ → Eintrag „360° Walkaround (High Detail)“. 
UUID-Suffix …013  (Opt-in).

T E C H N I S C H

Opt-in-Capture-Class-Preset für 360°-Walkaround-
Videos mit maximalem Detail. Hybrid-Densifier 
(klassisches Abs-Gradienten-Klonen/Splitten
1. MCMC-Noise + Relocation), 40 000 Iterationen, 

Cap 1,5 Mio. Gaussians,

Anisotropie-Strafe 0.0015 bei Ratio-Schwelle 15, 
SSIM-Loss 0.2 und Edge-Aware-Term 0 — das ge
lockte „r50″-Screen-Split-Rezept. Auf 360°-Materi
al schlägt es das Standard-MCMC-Preset „360° 
Walkaround„ (P10) bei PSNR, LPIPS und sichtbarem 
Konfetti, und das mit rund einem Drittel der Splat-
Anzahl. Steht bewusst opt-in neben dem Stan
dard-360-Preset, bis es an mehr Szenen validiert 
ist.

E I N FAC H  G E S AG T

Die schärfere Alternative zum 
Standard-360-Preset (P10): mehr 
Detail, weniger Konfetti, deutlich 
kleinere Datei. Steht bewusst da­
neben statt es zu ersetzen — 
bisher an einer Hand voll Sze­
nen bestätigt. Wenn dein 360°-
Rundgang sauber aufgenommen 
ist, probiere dieses Preset zuerst 
und vergleiche das Ergebnis mit 
P10.

P12 — Photo / Object

WO

Inspector → Presets-Sektion → Gruppe „Capture 
Class„ → Eintrag „Photo / Object“. UUID-Suffix 
…012 .

T E C H N I S C H

Capture-Class-Preset für Objekt-Orbits aus schar
fen Einzelfotos (kein Video). Hybrid-t1-Densifier 
(mit Relocation), 40 000 Iterationen, Cap 1,5 Mio. 
Gaussians, SSIM-Loss 0.5 plus Edge-Aware-Term 
0.1, sanfte Anisotropie-Strafe (Gewicht 0.001 bei 
Ratio-Schwelle 15), Opacity Decay 0.9995 alle 50 
Iterationen, kein Masking. Validiert an 163 hochauf
lösenden 41-MP-Fotos eines Skeletts (per Auge ge
prüft). Wenige Views (bis etwa 600) bleiben dabei 
unter der Hybrid-Collapse-Schwelle.

E I N FAC H  G E S AG T

Für Objekt-Aufnahmen aus 
scharfen Einzelfotos — du um­
rundest eine Skulptur, ein Mo­
dell, ein Produkt mit der Kamera 
und machst Fotos statt Video. 
Kein Masking, weil scharfe Fo­
tos meist sauberen Hintergrund 
haben. Für Video-Quellen nimm 
stattdessen ein 360°- oder Dro­
ne-Preset.
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P13 — Ausgewogen (Hybrid)

WO

Inspector → Presets-Sektion → Gruppe „Hybrid„ → 
Eintrag „Ausgewogen (Hybrid)“. UUID-Suffix …009 .

T E C H N I S C H

20 000 Iterationen mit der Hybrid-Densification-
Strategie: klassisches gradientengetriebenes Klo
nen/Splitten platziert Kapazität dort, wo der Loss sie 
braucht, MCMC-SGLD-Noise exploriert weiter, und 
tote Gaussians werden reloziert, statt beim Pruning 
verloren zu gehen. Opacity Decay (V546) ersetzt 
Opacity-Resets; eine Anisotropie-Strafe (Gewicht 
0.001, Ratio-Schwelle 15) hält nadelförmige Splats 
in Schach. Der Gaussian-Cap skaliert mit der Szene 
(150K Basis, scene-aware ×3.0). Auf fünf Szenen 
gegen reines MCMC bei gleichem Budget validiert: 
im Schnitt +0.45 dB PSNR bei 20–30 % weniger 
Gaussians (stonehenge +1.23, family +0.82, garden 
+0.47 dB). Auf einem M3 Ultra typisch 5–10 Minuten 
auf 200 Bildern.

E I N FAC H  G E S AG T

Eine starke erste Wahl für ein 
finales Ergebnis: schärfere De­
tails als die MCMC-Presets bei 
ähnlich kompakter Datei, in ei­
nem Bruchteil der P8-Trainings­
zeit. Wenn du nur Zeit für einen 
Quality-Lauf hast und keine der 
Capture-Klassen klar passt, star­
te hier. Die Classic-Presets blei­
ben für schnelle Tests besser, 
und die Capture-Class-Presets 
(P9–P12) sind erste Wahl, wenn 
deine Szene klar zu einer dieser 
Aufnahme-Arten passt.
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Wann welches Preset?

Szenario Erst-Test Hauptlauf

Funktionstest neuer Bil
der, < 30s

P1 Quick —

Objekt-Orbit aus scharfen 
Einzelfotos

P2 Preview P12 Photo / Object

Einzeln-Objekt-Scan (Vi
deo), < 500 Fotos

P2 Preview P4 Quality oder P8 Quality 
MCMC

360°-Walkaround-Video P6 Preview MCMC P10 360° Walkaround 
(scharf: P11 High Detail)

Luft-/Drohnen-Orbit, 
Landschaft

P6 Preview MCMC P9 Drone / Aerial

Web-Auslieferung (klein, 
kompakt)

P2 P8 Quality MCMC (kleinste 
Datei bei voller Qualität)

Scharfe Details in wenig 
Zeit, kompakter Export

P2 oder P6 P13 Ausgewogen (Hybrid)

Maximale Detailtreue, 
Classic-Strategie

P3 oder P6 P5 Ultra Detail

Print, Marketing, voller 
Detail

P3 oder P6 P4 Quality (Classic) oder 
P5 Ultra Detail
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Schnell-Vergleich
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Pre
set

Stra
tegie

Iters Max-
Gs

Render-
Skala

Typische Zeit (200 Bilder, M3 
Ultra)

Q-Sweep

P1 Quick Classic 1 000 ∞ 0.25× ~30 s —

P2 
Preview

Classic 5 000 ∞ 0.5× 2–3 min —

P3 
Ba
lan
ced

Classic20 000 ∞ 1.0× 30–60 s —

P4 Qua
lity

Classic35 000 ∞ 1.0× 2–4 min V546 
HTGS

P5 
Ul
tra 
De
tail

Classic ~35 
000

∞ 1.0× 2–5 min Ma
trix Δ+0.94 

dB

P6 
Preview 
MCMC

MCMC60 000 100 
K

1.0× 5–8 min —

P7 
Ba
lan

ced MCMC

MCMC 120 
000

150 
K

1.0× 8–15 min —

P8 Qua
lity MCMC

MCMC 200 
000

150 
K

1.0× 20–35 min V544a

P9 Dro
ne / 
Aeri

al

MCMC40 000 1.5 
M

1.0× 10–25 min Au
ge / 
Via
dukt

P10 360° 
Wal

karound

MCMC40 000 1.5 
M

1.0× 10–25 min Au
ge / 
Mo
nu

ment

P11 360° 
Wal

karound 
(High 
De
tail)

Hybrid40 000 1.5 
M

1.0× 10–25 min Auge 
(opt-
in)

P12 Pho
to / 
Ob
ject

Hybrid40 000 1.5 
M

1.0× 10–25 min Au
ge / 
Ske
lett

P13 Aus
ge
wo
gen 
(Hy
brid)

Hybrid 20 000 150 
K

1.0× 5–10 min Ma
trix Δ+0.45 

dB
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Eigene Presets

Über den Button Save… in der Presets-Sektion (I1 in Kapitel 2) speicherst du die aktu
elle Trainingskonfiguration als eigenes Preset. Eigene Presets sind nicht „Built-in„ und 
lassen sich umbenennen, exportieren (als JSON), per Drag-and-Drop teilen, duplizieren 
und löschen. Die dreizehn eingebauten Presets P1–P13 bleiben vom Lösch-Button un
berührt.

Faustregel: Wenn du an einem Preset etwas änderst, das du noch öfter brauchen willst 
— Sky-Dome an, höheres SSIM-Gewicht für eine bestimmte Szenen-Klasse, abweichen
de Iter-Zahlen — dann speichere die Variante als eigenes Preset. So weißt du beim 
nächsten Lauf gleich, dass es eine vom Standard abweichende Konfiguration ist.
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K A P I T E L

Kapitel 8 — Export-Formate

Abbildung 29:  Export-Format-Auswahl im Simple-Modus — sechs Format-Karten

Abbildung 30:  Export-Format-Grid live nach 5K-Iter-Training auf flowers-Bouquet — alle 
sechs Karten mit dynamischer Größenberechnung (PLY 742 KB ausgewählt, SPZ 74 KB, glTF 
708 KB, .splat 96 KB, Orbit Video ~Zero KB, Web Viewer 133 KB), Export History rechts mit 

bereits gespeichertem PLY

Was im Bild zu sehen ist (2 991 Gaussians, SH degree 3, Bjoerns synthetisches 
Blender-Bouquet als IP-clean Test-Set): Die Größenangaben unter jeder Format-
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Karte werden live aus aktuellem Gaussian-Count und Format-Overhead berechnet — 
nicht hartcodiert. Aus 2 991 Gaussians (SH degree 3) entstehen so 742 KB PLY, 74 
KB SPZ (Faktor ~10× kleiner durch Quantisierung), 708 KB glTF (mit KHR_​gaussian_​
splatting-Extension, daher fast PLY-äquivalent), 96 KB .splat (komprimiertes 24-Byte-
pro-Gaussian-Format). Orbit Video zeigt „~Zero KB„, weil die Größe erst nach dem 
MP4-Encoding bekannt ist. Web Viewer (133 KB) bündelt eine eigenständige HTML-
Datei mit eingebettetem WebGL-Viewer und komprimierten Splat-Daten — größer als 
reines .splat wegen Viewer-Overhead. Export-History rechts listet bereits abgeschlos
senen PLY-Export („training_20260527T211321Z.ply, 743 KB, 23:13“) mit Format-Pill 
und Reveal-im-Finder-Action.

Ein abgeschlossenes Training liefert eine Gaussian-Cloud — eine Sammlung von ein 
paar Hunderttausend bis Millionen 3D-Gaussverteilungen, die zusammen die Szene 
rekonstruieren. RadianceKit kennt zehn Wege, diese Cloud auf die Festplatte zu schrei
ben. Sechs davon sind reine 3D-Daten-Formate (PLY, Compressed PLY, SPZ, SOG, 
glTF, .splat), eines bündelt die Cloud zusammen mit einem fertigen HTML-Viewer (Web 
Viewer), eines rendert eine MP4-Datei aus einer Orbit-Kamerafahrt (Orbit Video), und 
zwei exportieren keinen Gaussian-Inhalt sondern lediglich das SfM-Ergebnis (Kamera-
Posen und grobe Punkt-Wolke) zur Wiederverwendung in anderen Trainings-Pipelines 
(transforms.json + COLMAP-Workspace).

Welches Format wann der richtige ist, hängt vom Ziel ab. Für die Archivierung der vollen 
Daten ohne Qualitätsverlust nimmt man PLY. Für Web-Viewer auf der eigenen Seite 
reicht meist .splat oder der eingebaute Web-Viewer. Wenn die Datei minimal sein muss, 
lohnt sich SPZ oder SOG. Für die Wiederverwendung des SfM-Resultats in Nerfstudio, 
Postshot oder Brush sind transforms.json und der COLMAP-Workspace die richtigen 
Wege.

Alle Export-Funktionen liegen im Menü „Export„ sowie im Simple-Mode auf der letzten 
Wizard-Stufe. Die meisten Formate sind vollständig sandbox-konform und funktionieren 
in der App-Store-Version. Nur SOG erfordert eine externe Binary ( cwebp ), die im App-
Store-Build nicht zwingend vorhanden ist — Details siehe E4.
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E1 — PLY (.ply)

WO

Menüleiste → Export → 3D Formats → Export PLY… 
(⌘E). Simple-Mode: Wizard-Schritt Export → For
mat-Karte „PLY„. Größe: typisch 100 % (Referenz
wert). Kompatibel mit: SuperSplat, PolyCam, alle 
3DGS-Viewer.

T E C H N I S C H

PLY ist das kanonische Speicherformat für 3D 
Gaussian Splatting. RadianceKit schreibt eine binäre 
Little-Endian-Datei mit dem standardisierten 3DGS-
Property-Layout: pro Gaussian dreikomponentige 
Position, drei stets auf Null gesetzte Normalen, drei 
DC-SH-Koeffizienten ( f_dc_0..2 ) für die Basis-
RGB-Farbe, anschließend bis zu 45 weitere SH-Ko
effizienten ( f_rest_0..44 ) in der vom Kerbl-2023-
Paper definierten transponierten Channel-Major-
Anordnung (erst alle R-Kanal-Koeffizienten, dann 
alle G, dann alle B), gefolgt von Logit-Opazität (ro
he pre-Sigmoid-Werte), drei Log-Space-Skalen und 
einer wxyz-Quaternion-Rotation. Der maximal ex
portierte SH-Grad wird auf das Minimum aus User-
Wunsch und tatsächlich gelerntem Grad geclampt; 
Default ist 3 (45 Rest-Koeffizienten). Vor dem 
Schreiben wird die Payload-Größe in 64-Bit-Integer 
berechnet, um Überlauf bei extrem großen Clouds 
zu fangen. Die Datei wird atomar geschrieben, was 
bei großen Clouds kurzzeitig den doppelten Platten
speicher belegt.

E I N FAC H  G E S AG T

Das ist die „Originaldatei„. Größ­
te Datei, höchste Kompatibilität, 
keine Verluste. Wenn du nicht 
weißt, welches Format du neh­
men sollst, nimm PLY — das öff­
net sich in fast jedem 3DGS-Tool. 
Für 1 Million Gaussians sind das 
je nach SH-Grad zwischen 200 
und 800 MB. Wenn die Datei zu 
groß wird, schau dir E2 (kompri­
miertes PLY) oder E3 (SPZ) an.
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E2 — Compressed PLY (.ply)

WO

Menüleiste → Export → 3D Formats → Export Com
pressed PLY…. Simple-Mode: Format-Karte „Com
pressed PLY„. Größe: ca. 10–20 % gegenüber PLY 
(5- bis 10-fache Kompression). Kompatibel mit: 
SuperSplat, PlayCanvas-Engine, web-basierte View
er.

T E C H N I S C H

Die PlayCanvas-Variante des PLY-Formats mit chun
ked Quantisierung. Die Gaussians werden in 256er-
Chunks gruppiert. Pro Chunk werden Min/Max-
Bounds für Position, Scale und Color separat im 
Header abgelegt; die einzelnen Gaussians referen
zieren ihre Werte relativ zu diesen Bounds und wer
den auf je 32 Bit komprimiert: Position und Skala mit 
11-10-11-Bit-Packing, Rotation als 2-10-10-10-Bit 
„Smallest-Three„-Quaternion, Farbe als 8-8-8-8-
RGBA. Höhere SH-Koeffizienten werden mit nur 8 
Bit pro Komponente quantisiert ( shCoeffCount * 3  
uchar pro Gaussian). Das Format selbst ist immer 
noch ASCII-Header-PLY und damit grundsätzlich 
validierbar mit PLY-Tools, aber die Vertex-Properties 
sind als uint -Felder deklariert. SH-Grad ist per 
Default 0 (keine Rest-Koeffizienten), um die Kom
pression zu maximieren — höhere SH-Grade können 
explizit gewählt werden.

E I N FAC H  G E S AG T

Die platzsparende PLY-Variante. 
Identische Engine-Kompatibilität 
wie das normale PLY, aber 5- 
bis 10-mal kleiner. SuperSplat 
und PlayCanvas lesen es nativ. 
Für Web-Deployment fast immer 
besser als normales PLY. Der 
Qualitätsverlust durch die Quan­
tisierung ist visuell meist nicht 
wahrnehmbar, solange die Szene 
nicht extrem hochfrequente De­
tails enthält.
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E3 — SPZ (.spz)

WO

Menüleiste → Export → 3D Formats → Export SPZ…. 
Simple-Mode: Format-Karte „SPZ„. Größe: ca. 10 
% gegenüber PLY (90 % kleiner). Kompatibel mit: 
Niantic Scaniverse, Niantic Spatial Fields, MetalS
platter.

T E C H N I S C H

Niantics SPZ-v2-Format. Positionen werden als 24-
Bit-Fixed-Point gepackt (das ergibt ca. 0,25 mm 
Auflösung), Skalen als 8-Bit-Quantisierung im Log-
Raum, Rotationen als 8-Bit-Smallest-Three (in v2 
werden nur xyz gespeichert, w wird im Decoder 
aus der Quaternion-Norm abgeleitet), Opazitäten 
als sigmoidisierte 8-Bit-Werte. DC-SH wird mit einer 
SPZ-spezifischen Pack-Formel (dc_​raw * 0.15 * 
255 + 0.5 * 255) gespeichert, höhere SH-Bands 
mit 5 Bit (Band 1) bzw. 4 Bit (Band 2-3) pro 
Koeffizient. Der gesamte gepackte Binärblob wird 
anschließend mit Standard-gzip (RFC 1952) kompri
miert, was ein gzipped-Container-Format mit Magic 
Bytes 1f 8b  ergibt. RadianceKit ruft hierfür das 
System- gzip  auf, weil Apples eingebaute zlib-API 
proprietäres Apple-Framing erzeugt, das nicht kom
patibel zu den SPZ-Readern in Spatial Fields oder 
MetalSplatter wäre. Das System- gzip  bleibt auch 
innerhalb der macOS-Sandbox spawnbar.

E I N FAC H  G E S AG T

Die kleinste Standard-Datei. 
Wenn du Scaniverse von Niantic 
kennst — das ist das Format, das 
die App benutzt. Sehr klein, sehr 
ladefreundlich für mobile Apps. 
In Niantics eigenem Cloud-View­
er (Spatial Fields) direkt nutzbar. 
Etwa 90 % kleiner als ein PLY mit 
denselben Daten, dabei für die 
meisten Szenen optisch kaum 
unterscheidbar.
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E4 — SOG (.sog)

WO

Menüleiste → Export → 3D Formats → Export 
SOG…. Simple-Mode: Format-Karte „SOG„. Größe: 
ca. 5–6 % gegenüber PLY (15- bis 20-fache Kom
pression — die kleinste Option). Kompatibel mit: 
PlayCanvas-Engine, SuperSplat-Editor.

T E C H N I S C H

„Spatially Ordered Gaussians„ — ein PlayCanvas-
Format, das die Cloud GPU-ready in mehreren 
Lossless-WebP-Bildern speichert. Erst werden alle 
Gaussians per 3D-Morton-Code (30-Bit Z-Order, je 
10 Bit pro Achse) räumlich sortiert, was den Bil
dern spätere Cache-Locality im Renderer beschert. 
Dann werden Positionen mit symmetrischer Log-
Transformation (für besseren Dynamikumfang) auf 
16-Bit-Werte quantisiert und in zwei RGBA-Bilder 
gesplittet ( means_l.webp  für die unteren 8 Bit, 
means_u.webp  für die oberen). Rotationen werden 

als Smallest-Three mit 3×8-Bit plus 2-Bit-Mode in 
einem RGBA-Bild kodiert (Mode landet in Alpha als 
252 + largest ). Skalen und DC-SH werden mit je 

einem 256-Eintrag-Codebook quantisiert (Perzentil-
basiert über alle Werte verteilt), die Indizes landen 
in scales.webp  und sh0.webp . Die fünf Bilder 
plus eine meta.json  mit Codebooks und Bounds 
werden in eine ZIP-Datei gepackt (Custom-Encoder, 
weil die Sandbox das System- zip  blockiert) und 
mit der Endung .sog  gespeichert.

Achtung Sandbox: SOG ist die einzige Format-
Option, die eine externe Binary erfordert. Die 
WebP-Encoder-Stufe ruft cwebp  aus /​usr/​local/​
bin/​cwebp oder /​opt/​homebrew/​bin/​cwebp auf. Falls 
keine cwebp-Binary gefunden wird, fällt der Code 
auf rohes PNG-Encoding zurück — aber: PNG-
Fallback funktioniert nicht in SuperSplat. In 
der App-Store-Version evaluiere die Verfügbarkeit 
anhand der Build-Variante; in der Developer-Vari
ante muss cwebp via Homebrew installiert sein 
( brew install webp ).

E I N FAC H  G E S AG T

Das kleinste 3DGS-Format über­
haupt, deutlich kleiner als SPZ. 
Aber: braucht das cwebp -Tool 
auf deinem Mac, weil Radiance­
Kit selbst nicht alle Bildformate 
erzeugen kann. Installier es ein­
mal mit Homebrew, dann läuft 
alles. In der App-Store-Version 
eventuell nicht voll funktionsfä­
hig — wenn beim Export PNG 
statt WebP rauskommt, kannst 
du die Datei nicht direkt in Su­
perSplat öffnen. Wer ohne Home­
brew arbeitet, nimmt stattdessen 
SPZ (E3).
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E5 — glTF (.glb)

WO

Menüleiste → Export → 3D Formats → Export glTF…. 
Simple-Mode: Format-Karte „glTF„. Größe: ver
gleichbar mit PLY. Kompatibel mit: glTF-Viewer mit 
KHR_​gaussian_​splatting-Extension (Khronos-Draft-
Standard).

T E C H N I S C H

Schreibt eine selbsterhaltende .glb -Binärdatei 
(kein separater Bin-File-Anhang) gemäß der KHR_​
gaussian_​splatting-Extension-Spezifikation. Posi
tionen werden als reguläre glTF- POSITION -Vertex-
Daten (float3) gespeichert, alle anderen Attribu
te (Rotation als float4, Scale als float3, Opacity 
als float, SH-Koeffizienten als float3 × shCoeff
Count) liegen in zusätzlichen Vertex-Attributen und 
werden über die Extension referenziert. Wichtig: 
glTF benutzt rechtshändiges Y-up-Koordinatensys
tem, COLMAP/3DGS arbeitet Y-down/Z-forward. Der 
Exporter wendet daher eine 180-Grad-Drehung 
um die X-Achse an — Positionen werden mit 
(x, -y, -z)  umgeschrieben, Quaternionen wer

den auf (w, x, -y, -z)  angepasst. Das ergibt 
eine geometrisch korrekte, händige (nicht spiegel
verkehrte) Darstellung in glTF-Viewern. JSON- und 
Binärchunks werden auf 4-Byte-Alignment gepad
det, wie vom GLB-Standard verlangt.

E I N FAC H  G E S AG T

Das offizielle Khronos-Standard­
format für 3D-Daten, in der fri­
schen Erweiterung für Gaussian 
Splats. Vorteil: glTF ist in al­
len großen 3D-Engines verbreitet 
(Babylon.js, Three.js, Unity, Un­
real). Nachteil: Die Erweiterung 
ist 2026 noch im Draft-Stadium, 
viele Viewer können sie noch 
nicht. Sinnvoll vor allem, wenn du 
Splat-Daten in eine bestehende 
glTF-Pipeline integrierst oder ei­
nen Viewer schreibst, der bereits 
glTF-fähig ist.
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E6 — Splat (.splat)

WO

Menüleiste → Export → 3D Formats → Ex
port .splat…. Simple-Mode: Format-Karte „.splat„. 
Größe: exakt 32 Bytes pro Gaussian. Kompatibel 
mit: gsplat.js, web-basierte Viewer (antimatter15-
Referenz), die meisten Browser-3DGS-Demos.

T E C H N I S C H

Das antimatter15- .splat -Format — 32 Bytes pro 
Gaussian, kein Header, keine Indirektion. Layout pro 
Eintrag: 3 × float32 Position (Welt-Koordinaten), 3 
× float32 Scale (exp-transformiert aus dem Log-
Space des internen Buffers), 4 × uint8 RGBA-Farbe 
(DC-SH-Koeffizient mit SH_C0 = 0.282...  skaliert 
und auf [0,255] geclampt), 4 × uint8 Quaternion 
(w,x,y,z, normalisiert und als 128 + 128*q  in den 
Byte-Bereich kodiert). Nur DC-SH wird gespeichert 
— höhere SH-Bänder werden verworfen. Das macht 
das Format extrem kompakt, kostet aber die View-
abhängigen Farbänderungen, die bei Spiegelungen 
oder spekularen Highlights auftreten. Die Schreib
reihenfolge ist exakt die Index-Reihenfolge der 
Cloud (keine räumliche Sortierung), Web-Viewer wie 
gsplat.js  rendern davon ausgehend.

E I N FAC H  G E S AG T

Das Format der Wahl, wenn du 
den Splat in einem eigenen 
Web-Viewer mit gsplat.js  
darstellen willst. Sehr kom­
pakt (32 Bytes/Gaussian), aber 
kein höherer SH-Grad — al­
so keine glänzenden Reflexionen 
oder feinen Farbveränderungen 
je nach Blickwinkel. Für die meis­
ten Web-Anwendungen kein Pro­
blem, weil DC-Farbe völlig aus­
reicht und die fehlende View-Ab­
hängigkeit kaum auffällt.
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Abbildung 31:  Web Viewer geöffnet im Firefox — Bjoerns Bouquet-Splat gerendert mit 
umgebenden Kamera-Marker-Sphären, Browser-Tab-Bar oben sichtbar, kein CDN-/Server-
Setup nötig. Eigenständige flowers-01.html  direkt aus dem Finder per Doppelklick 

im Default-Browser geöffnet — das eingebettete WebGL2-Programm rendert die Gaussian-
Cloud sofort, ohne Netz oder Server. Die schwarzen Marker um das Bouquet sind die 

Trainings-Kameras, optional einblendbar. Maus-Drag rotiert, Scroll zoomt.
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E7 — Web Viewer (.html)

WO

Menüleiste → Export → Media → Export Web 
Viewer…. Simple-Mode: Format-Karte „Web Viewer„. 
Größe: Splat-Daten base64-kodiert (≈ 4/3 Over
head) + ca. 5 KB HTML/JS-Shell. Kompatibel mit: 
jeder moderne Browser mit WebGL2 (alle Desktops, 
iOS 15+, Android 5+).

T E C H N I S C H

Bündelt die Gaussian-Cloud zusammen mit einem 
vollständig inline geschriebenen WebGL2-Renderer 
in eine einzelne .html -Datei. Es gibt keine CDN-
Abhängigkeiten, kein WASM, kein zweites File. Die 
Cloud wird intern erst als .splat -Binary kodiert 
(gleiche 32-Byte-Logik wie E6), dann base64-ein
gebettet, dann mit atob  im Browser dekodiert. 
Der eingebaute Renderer macht eigene WebGL2-
Sortierung, Maus-Orbit-Steuerung und CPU-Sortie
rung pro Frame; der gesamte JS-Code (Shader, 
Mathematik, Loop) ist im Output-HTML zu sehen. 
Die Achsen-Konvention an der Speicher-zu-Rende
rer-Grenze ist exakt dieselbe wie in E5: Position 
(x, -y, -z) , Quaternion (w, x, -y, -z) . Optio

nal kann ein Branding-Overlay eingeblendet werden 
(Free-Tier-Schalter). Da alles inline ist, funktioniert 
die Datei auch direkt aus dem file:/​/​-Protokoll — 
kein lokaler Webserver nötig zum Testen.

E I N FAC H  G E S AG T

Eine einzige HTML-Datei, die du 
jemandem per Mail schicken 
oder auf einer Webseite einbin­
den kannst. Doppelklick im Fin­
der, und der Browser zeigt deine 
Szene mit Maus-Drehung. Kein 
Upload zu einer Cloud nötig, kei­
ne zweite Datei, kein Server. Ideal 
für Kundenpräsentationen, Port­
folio, Mail-Anhänge. Nachteil: die 
Datei wird durch die base64-Ko­
dierung etwa ein Drittel größer 
als ein reines .splat  — für 
sehr große Szenen lohnt sich 
daher das separate Hosting der 
.splat -Datei zusammen mit 

einem Standard-Viewer.
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Abbildung 32:  Einzelframe extrahiert aus flowers-01.mp4 — Bjoerns Bouquet im Profil-
Render, weiße Plattform mit Kamera-Markern sichtbar, schwarzer Hintergrund (Default-
Viewport-Background, in Settings änderbar). Die Kamera umkreist die Szene auf einer 

parametrischen Bahn (Elevation + Distanz fest, Yaw rotiert), Dauer typisch 6–10 Sekunden 
bei 30 oder 60 fps. Frame-Auflösung skalierbar von 480p bis 8K via VideoPreset.
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E8 — Orbit Video (.mp4/.mov)

WO

Menüleiste → Viewport → Record Turntable Video 
ODER Menüleiste → Export → Media → Export 
Orbit Video…. Simple-Mode: Format-Karte „Orbit 
Video„ mit Dauer-Slider 3–30 s. Größe: abhängig 
von Dauer, Auflösung, Bitrate. Kompatibel mit: 
alle Plattformen (H.264 und HEVC sind Apple-Stan
dard).

T E C H N I S C H

Rendert die Gaussian-Cloud entlang einer para
metrischen Orbit-Kamerafahrt und encodiert jeden 
Frame über AVAssetWriter in eine MP4- oder 
MOV-Datei. Die Orbit-Konfiguration steuert Dreh
zahl (Umdrehungen), Distanz, Elevation, FOV, Dau
er und Ease-In/Out-Faktor. Der Orbit-Video-Export 
läuft über RadianceKits EIGENEN ForwardPass mit 
voller SH-Auswertung — pixelgleich mit dem In-
App-Viewport (WYSIWYG). Pro Frame wird die Welt-
Anpassungsmatrix (vom Renderer berechnet, um 
die internen Koordinaten in die Y-up-Orbit-Welt zu 
drehen) mit der Kamera multipliziert, anschließend 
eine Kamera-Konvertierungs-Spiegelung (camFlip: 
Orbit-Y-up → COLMAP-Y-down) angewendet. Das 
Offscreen-Render-Target wird via IOSurface zu ei
nem CVPixelBuffer für den Encoder gezogen. Der 
Encoder unterstützt H.264 und HEVC, konfigurier
bare Bitrate und Auflösung von 480p bis 8K. Vor 
dem ersten Frame wartet der Renderer 200 ms, da
mit die initiale Splat-Sortierung abgeschlossen ist. 
Dieser Export ist GPU-bound — bei 8K und Millionen 
Gaussians liegt die Render-Zeit pro Frame bei meh
reren Sekunden, also Gesamt-Renderzeiten von 10–
30 Minuten für 6 s Video möglich.

E I N FAC H  G E S AG T

Eine fertige MP4-Datei mit einer 
Drehung um deine Szene. Per­
fekt für Social Media, Marketing, 
Vorstellungen. Du kannst Dauer 
(3–30 Sekunden), Drehrichtung 
und Geschwindigkeit einstellen. 
Die Datei lässt sich auf You­
Tube, Instagram, in PowerPoint 
und überall sonst direkt einbin­
den. Geht teils langsam, weil die 
App jeden Frame komplett ren­
dern muss — für ein 8K-Video 
kannst du fünf bis dreißig Minu­
ten einplanen, je nach Anzahl der 
Gaussians.
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E9 — SfM Transforms (transforms.json)

WO

Menüleiste → Export → Photogrammetry → Export 
SfM (transforms.json)…. Größe: typisch 1–10 KB 
(nur Posen + Intrinsics, keine Bilder, keine Gaus
sians). Kompatibel mit: nerfstudio, Brush, gsplat, 
OpenSplat, Meshroom, alle modernen feed-forward 
3DGS-Trainer.

T E C H N I S C H

Schreibt das nerfstudio- transforms.json -Format 
mit einer Liste von Kamera-Posen plus geteilten 
Intrinsics. Pro Kamera wird die View-Matrix (Radi
anceKit-intern: World-to-Camera in COLMAP-Kon
vention) invertiert, anschließend werden die kame
ralokalen Y- und Z-Basisvektoren gespiegelt, um in 
die nerfstudio-Konvention (OpenGL-Style, Kamera 
schaut entlang -Z , +Y  ist oben) zu konvertieren. 
Die finale 4×4-Matrix landet als row-major nested 
array von Doubles im transform_matrix -Feld je
des Frames. Intrinsics werden auf der Top-Level 
gespeichert (Brennweite x/y, Hauptpunkt x/y, Bild
breite/-höhe, camera_​model = "OPENCV", plus die 
Distortion-Coefficients k1, k2, p1, p2 ) — außer 
wenn der Exporter mehrere unterschiedliche Intrin
sics-Sets erkennt, dann werden sie per Frame ge
schrieben. Bildpfade werden als images/​<filename> 
relativ zur JSON-Datei geschrieben; der User muss 
einen Sibling-images/​-Folder mit den Trainingsfotos 
anlegen.

E I N FAC H  G E S AG T

Diese JSON-Datei beschreibt für 
jedes Foto, wo die Kamera stand 
und wohin sie schaute. Die Datei 
alleine ist klein und nutzlos — sie 
wird zusammen mit den Original­
bildern in einem Ordner verwen­
det. Nerfstudio, Brush und ein 
paar andere Trainer lesen genau 
dieses Format, und du kannst 
damit deine RadianceKit-SfM-Er­
gebnisse in ein anderes Tool 
übergeben, ohne dass dort die 
Kamera-Rekonstruktion neu ge­
rechnet werden muss. Spart bei 
großen Szenen Stunden.
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E10 — COLMAP Workspace (sparse/0/)

WO

Menüleiste → Export → Photogrammetry → Export 
SfM (COLMAP Workspace)…. Größe: drei Binärda
teien zusammen typisch 4–8 MB — points3D.bin  
dominiert (eine Zeile pro 3D-Punkt der Sparse-
Cloud), images.bin  und cameras.bin  sind jeweils 
deutlich unter 100 KB. Kompatibel mit: COLMAP 
selbst, Nerfstudio, Postshot, Meshroom, alle Tools, 
die ein COLMAP-sparse/​-Verzeichnis erwarten.

T E C H N I S C H

Schreibt das Standard-COLMAP-sparse/​0/​-Lay
out mit drei binären Dateien: cameras.bin , 
images.bin , points3D.bin . Format-Referenz 

ist die offizielle COLMAP-Dokumentation. 
cameras.bin  enthält die deduplizierte Intrinsics-

Liste (Kameras mit identischen Intrinsics + Bildgrö
ße werden zu einem einzigen Eintrag zusammenge
fasst); das verwendete Camera-Model ist OPENCV  
(Model 4), mit fx/fy/cx/cy plus den vier Distortion-
Coefficients k1/k2/p1/p2. images.bin  listet pro Bild 
die Pose als wxyz -Quaternion plus Translation, 
gefolgt von der Kamera-ID und dem Dateinamen; 
keine 2D-3D-Korrespondenzen werden gespeichert. 
points3D.bin  enthält die SfM-Punktwolke mit Po

sition, Farbe (0-255 RGB) und Default-Werten für 
Reprojektion und Track-Length. Alles wird in Little-
Endian geschrieben. Re-Import in RadianceKit funk
tioniert über das File-Menü → „Import COLMAP/Me
tashape Workspace…„ (siehe Q3 im SfM-Backend-
Kapitel).

E I N FAC H  G E S AG T

Das offizielle COLMAP-Format. 
Wenn du dein Training in Post­
shot, Nerfstudio oder einer 
anderen COLMAP-fähigen Soft­
ware fortsetzen willst, ist das 
der Weg. Drei kleine Dateien 
plus deine Originalbilder, und 
das Zielprogramm akzeptiert es 
als wäre COLMAP selbst das 
Quellprogramm gewesen. Mehr 
Programme verstehen das als 
das transforms.json-Format (E9), 
gleichzeitig etwas weniger hand­
lich, weil binär statt textbasiert.
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Welches Format wann?

Ziel Format

Web-Viewer auf eigener Seite E7 Web Viewer (.html)

Web-Viewer mit gsplat.js E6 Splat (.splat)

Pipeline-Reuse in Postshot / Nerfstu
dio

E9 transforms.json + E10 COLMAP Workspace

SuperSplat-Edit E1 PLY oder E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

Maximale Kompression E4 SOG (cwebp erforderlich)

Marketing-/Social-Video E8 Orbit Video
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Schnell-Vergleich

Format Erweiterung Sandbox Größe (1M Gauss) Best-Use

E1 PLY .ply ja ~250 MB Archiv, 
höchste 

Kompatibili
tät

E2 Com
pressed 

PLY

.ply ja ~40 MB Web + Su
perSplat

E3 SPZ .spz ja (gzip-
Spawn)

~40 MB Niantic + 
Mobile

E4 SOG .sog bedingt 
(cwebp)

~20 MB Maximale 
Kompressi

on

E5 glTF .glb ja ~250 MB Khronos-
Pipeline

E6 Splat .splat ja ~32 MB gsplat.js 
Web-Viewer

E7 Web 
Viewer

.html ja ~45 MB Standalo
ne Browser-

Datei

E8 Orbit 
Video

.mp4 / .mov ja variabel Social/Mar
keting

E9 SfM 
Trans
forms

.json ja ~5 KB Posen-
Übergabe

E10 
COLMAP Workspace

Verzeichnis ja ~4–8 MB Posen-
Übergabe 

binär

Größen-Spalte sind grobe Richtwerte für 1 Mio. Gaussians mit SH-Grad 3. Reale Werte 
variieren je nach Komprimierbarkeit der Szene; SH-Grad 0 reduziert PLY/glTF um den 
Faktor 4.
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K A P I T E L

Kapitel 9 — SfM-Backends

Abbildung 33:  Expert-Modus mit Camera-Alignment-Picker im Inspector (Apple Photogram
metry / Native (Beta))

Abbildung 34:  Inspector mit aktivem Native (Beta) — Camera-Alignment-Picker zweite 
Option ausgewählt, alle anderen Trainingskonfigurations-Parameter unverändert

WAS IM BILD ZU SEHEN IST  Der Camera-Alignment-Picker im Inspector ist ein Segmented-
Control mit zwei Optionen — Apple Photogrammetry (Default für App-Store-Builds, voll 
sandbox-konform) und Native (Beta) (RadianceKit’s eigenes FAST+BRIEF+GLOMAP-
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Pipeline-Backend, Phase 3.8/3.9 entwickelt, Stand 2026-05). Native (Beta) ist orbit-
only validiert und schneller bei ≥1 000 Frames als Apple Photogrammetry, schließt aber 
das Phase-3-§5-Quality-Gate (finalLoss ≤ 0.0115) noch nicht ein — daher der Beta-Tag. 
Externe SfM-Ergebnisse aus Metashape, COLMAP oder einer anderen Photogramme
trie-Software können zusätzlich über das File-Menü importiert werden (Q3 COLMAP-
Text-Format, Q6 Workspace-Import) — der Picker wechselt nicht, aber die importierten 
Posen ersetzen das SfM-Resultat.

SfM steht für Structure from Motion. Aus einer Menge überlappender Fotos rekonstru
iert die Software für jedes Bild die Position und Blickrichtung der Kamera in einem 
gemeinsamen 3D-Koordinatensystem. Dazu wird eine grobe 3D-Punktwolke erzeugt, 
die das Training mit Gaussian Splatting initialisiert. Das SfM-Ergebnis ist die Eingabe für 
das eigentliche Training und entscheidet maßgeblich über die spätere Bildqualität.

RadianceKit bietet fünf SfM-Wege: zwei in der App eingebaute Backends (Q1 Apple 
Photogrammetry, Q4/Q5 Native), zwei Import-Pfade aus externen Tools (Q3 COLMAP-
Text-Format, Q6 binärer Workspace-Import) sowie Q2 COLMAP-Binary, das nur in 
Developer-Builds außerhalb des App Store verfügbar ist. Welcher der richtige ist, hängt 
vom Szenentyp ab (Orbit um ein Objekt, Innenraum, Drohnenflug) und davon, ob eine 
externe Software bereits eine Rekonstruktion liefert.

Q1 — Apple Photogrammetry

WO

Expert View → Inspector → Trainingskonfiguration 
→ Camera Alignment-Picker, Eintrag „Apple Photo
grammetry„.

T E C H N I S C H

Wrapt Apples eingebautes Photogrammetry-Frame
work, das ursprünglich für Object Capture entwi
ckelt wurde. Apple extrahiert intern Features mit 
einer proprietären Pipeline (Schritte sind nicht öf
fentlich dokumentiert), verifiziert sie über Multi-
View-Matching und löst Bundle-Adjustment auf der 
Apple-Silicon Neural Engine + GPU. Das Backend 
ist vollständig App-Store-konform (keine externe 
Binary, Sandbox=true, on-device), liefert aber nur 
Kamera-Posen plus eine grobe Punktwolke — keine 
Diagnose-Metriken wie Track-Länge oder Reprojek
tionsfehler. Skaliert nach Apples Empfehlung bis ein 
paar Hundert Bilder. Bei mehr als ~500 Frames in li
nearen Drohnenflügen oder großen Outdoor-Szenen 
wurden reproduzierbar Crashes oder stilles Verwer
fen einzelner Kameras beobachtet.

E I N FAC H  G E S AG T

Das ist der einfachste Weg. Bil­
der rein, App rechnet. Funktio­
niert sehr gut bei klassischen 
Objekt-Scans — wenn du um ein 
Möbelstück oder eine Skulptur 
herumläufst und 50–200 Fotos 
machst. Bei Drohnenflügen über 
Landschaften oder bei sehr vie­
len Bildern (über 500) wird App­
les Verfahren aber gerne instabil. 
Für solche Szenen das Native-
Backend (Q4/Q5) testen oder die 
Kameras in Metashape rechnen 
und über den Workspace-Import 
(Q6) einspielen.
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P OW E R - U S E R

Q2 COLMAP-Binary — spawnt das externe COLMAP-Programm als Sub-Prozess 
und ist deshalb in der App-Store-Version (Sandbox) nicht verfügbar. Funktioniert 
nur in Developer-Builds außerhalb des App Stores. Für die Qualität, die COLMAP 
liefert, gibt es in der App-Store-Version den Workspace-Import (Q3 oder Q6): 
rechne die SfM in COLMAP oder Metashape außerhalb und lade das Ergebnis ein.

Q3 — COLMAP-Text-Format (Metashape / ETH3D)

WO

Menü „File → Import COLMAP / Metashape 
Workspace…„ (Cmd+⇧+I) ODER Drag-and-Drop ei
nes Ordners mit sparse/​0/​cameras.txt.

T E C H N I S C H

Liest den standardisierten COLMAP-Text-Export 
— drei Textdateien cameras.txt , images.txt , 
points3D.txt  im sparse/​0/​-Unterordner — und 

konvertiert in das interne SfM-Ergebnis-Modell. 
Selbe Format-Definition wie der COLMAP-Binär-
Export, nur als ASCII statt Binär. Wird von Agis
oft Metashape, RealityCapture, PolyCam und dem 
ETH3D-Benchmark in genau diesem Layout aus
gegeben. Der Parser teilt die Camera-Model-Er
kennung mit dem Binary-Parser (alle gängigen 
Modelle: SIMPLE_PINHOLE, PINHOLE, OPENCV, 
OPENCV_FISHEYE, FULL_OPENCV). Robust gegen 
Kommentar-Zeilen und leere Zeilen. Skaliert in Tests 
bis ~1 400 Kameras (ETH3D Tunnel) ohne Proble
me.

E I N FAC H  G E S AG T

Wenn du schon mit Metashape, 
RealityCapture oder einer ande­
ren kommerziellen Foto-3D-Soft­
ware gearbeitet hast und das Er­
gebnis exportiert hast — diesen 
Export kannst du in RadianceKit 
direkt laden, ohne dass die App 
selbst neu rechnen muss. Das 
spart Stunden Wartezeit. Lade 
einfach den ganzen Ordner über 
das File-Menü oder zieh ihn ins 
Fenster.
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Q4 — Native SfM (inkrementell)

WO

Expert View → Inspector → Trainingskonfiguration → 
Camera Alignment-Picker, Eintrag „Native (Beta)„. 
Inkrementell ist der Default-Modus dieses Backends 
— es gibt im Inspector keinen separaten Mapper-
Picker. Per CLI lässt sich der Modus explizit setzen 
mit --native-sfm  oder --sfm-mapper incremental.

T E C H N I S C H

Eigene GPU-beschleunigte Implementierung der 
gesamten SfM-Pipeline: FAST+BRIEF-Features 
ODER SuperPoint+LightGlue über CoreML (mit 
--coreml-features ), gefolgt von Hamming-KNN-

Matching, RANSAC-Fundamentalmatrix, Track-
Building, Initial-Pair-Auswahl, Two-View-Bootstrap 
(F→E plus DLT), greedy inkrementellem Mapper 
mit PnP-Registrierung und Multi-View-Triangulation 
und finalem Bundle-Adjustment via Schur-reduzier
tem Levenberg-Marquardt mit Huber-Loss und ana
lytischen Jacobians über Cholesky-Solve. Komplett 
App-Store-konform: keine externe Binary, Sand
box=true. Mit dem in Phase 3.10 ausgelieferten R2-
Collapse-Detektor: registriert die App weniger als 
60 % der Eingabe-Frames oder fällt die Points-per-
Camera-Rate unter 13, wird automatisch auf den 
globalen Mapper (Q5) ausgewichen. Empirisch sau
ber auf Orbit-/Turntable-Szenen; auf allgemeineren 
Bewegungen (Drohnenflug, Innenräume mit komple
xer Geometrie) ist die Erfolgsrate niedriger — der 
Detektor fängt diese Fälle aber ab. Skaliert bis ~200 
Kameras zuverlässig, höher mit deutlich längerer 
Laufzeit.

E I N FAC H  G E S AG T

Apples Stärken (App-Store-Kom­
patibel, schnell für Orbits) 
mit zusätzlichen Diagnose-Wer­
ten. Funktioniert besonders gut, 
wenn du wie für einen Ob­
ject Capture um ein Motiv 
herumgehst. Bei komplizierteren 
Aufnahmen (Drohnenflug oder 
Wohnzimmer) erkennt Radiance­
Kit automatisch, dass das nichts 
wird, und springt auf das globa­
le Verfahren um. Markiert „Beta„, 
weil noch in Erprobung — die 
Standard-Empfehlung ist nach 
wie vor Apple Photogrammetry 
für einfache Object-Scans und 
der Workspace-Import (Q3 oder 
Q6) für anspruchsvolle Outdoor-
Sets.
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Q5 — Native SfM (global)

WO

Wird automatisch aufgerufen, wenn der inkremen
telle Mapper (Q4) den Collapse-Detektor auslöst 
(weniger als 60 % der Eingabe-Frames registriert 
oder Points-per-Camera-Rate unter 13). Manuell 
forcierbar nur via CLI --sfm-mapper global. Im 
Inspector ist das Globale Verfahren über keinen se
paraten Picker erreichbar — die App entscheidet 
selbst, wann sie umschaltet.

T E C H N I S C H

Globale Variante der nativen Pipeline. Erst Feature-
Extraktion + Matching wie Q4, dann Relativ-Pose-
Schätzung für alle verifizierten Paare, anschließend 
Rotation-Averaging (synchronisiert alle Kamera-Ro
tationen im Welt-Koordinatensystem) und Translati
on-Averaging (LSQR-basiert auf einer matrix-freien 
Sparse-Formulierung, um Integer-Overflow bei gro
ßen Kamera-Mengen zu vermeiden). Skaliert auf 
~5 000 Kameras im Prinzip, in der Praxis Quality-
degraded oberhalb einiger Hundert Kameras — die 
Phase-3.8-§5-Akzeptanz-Gate-Messung auf K-1351 
ergab finalLoss 0.07 statt der angestrebten 0.0115. 
Wird als „Fallback-Tier„ gehandhabt: kommt zum 
Einsatz, wenn der inkrementelle Mapper degene
riert, wird selbst aber nicht erneut auf Qualität 
geprüft.

E I N FAC H  G E S AG T

Der Plan-B-Pfad für die native 
Engine. Wird automatisch aufge­
rufen, wenn der schnellere in­
krementelle Pfad versagt. Lie­
fert ein brauchbares Ergebnis, 
ist aber bei sehr großen oder 
schwierigen Szenen meist nicht 
so präzise wie das, was du 
aus Metashape oder einer ex­
ternen COLMAP-Installation be­
kommst. Wenn Native dein Stan­
dard-Workflow wird, lohnt sich in 
solchen Fällen der Umweg über 
den Workspace-Import (Q3 oder 
Q6).
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Q6 — Metashape / COLMAP-Text-Workspace Import (Phase Q7)

WO

File-Menü → „Import COLMAP / Metasha
pe Workspace…„ (Cmd+⇧+I). Drag-and-Drop ei
nes Ordners mit sparse/​0/​cameras.{bin,txt} und 
images/​.

T E C H N I S C H

Erkennt automatisch, ob ein per Drag-and-
Drop oder Open-Panel ausgewählter Ordner einer 
der drei COLMAP-Workspace-Layouts entspricht 
(sparse/​0/​, sparse/​, oder Root) und ob die 
Reconstruction binär ( cameras.bin ) oder Text 
( cameras.txt ) vorliegt. Der binäre Pfad nutzt den 
COLMAP-Binär-Parser, der Text-Pfad den ETH3D-
Loader — beide produzieren dasselbe SfM-Ergeb
nis-Modell und der Rest der Pipeline (Bilder im
portieren, MCMC-Training starten) ist agnostisch 
gegenüber der Quelle. Die Bilder werden über 
das App-Sandbox-Bookmark-System security-sco
ped geöffnet, sodass der Import auch in der 
App-Store-Version funktioniert. Speziell für den Fall 
„Metashape-Export ohne Rekonstruktion neu rech
nen„ gedacht. Die im File-Menü-Eintrag erwähnte 
Erkennung warnt im App-Log, falls der gewählte 
Ordner kein erkennbarer Workspace ist.

E I N FAC H  G E S AG T

Speziell die Metashape-User-
Funktion. Wenn du eine Lizenz 
für Metashape oder RealityCap­
ture hast und dort die Kame­
ra-Rekonstruktion gemacht hast, 
kannst du den Export-Ordner 
einfach hier reinziehen und so­
fort mit dem Training starten. 
Spart bei großen Szenen mehre­
re Stunden Rechenzeit, weil Ra­
dianceKit das SfM dann nicht 
selbst macht.
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Welches Backend wann?

Szenario Empfohlenes Backend

Objekt-Scan, 50–200 Fo
tos

Q1 Apple Photogrammetry

Großer Outdoor / Drohne / 
>500 Bilder

Q6 Workspace-Import (in Metashape oder COLMAP rech
nen, dann einladen)

Metashape/RealityCaptu
re-Export liegt vor

Q6 Import (kein SfM nötig)

ETH3D / akademisches 
COLMAP-Text-Set

Q3 COLMAP-Text-Import

Strikt App-Store-konform 
+ Orbit-Szene

Q4 Native inkrementell

Q4 schlägt fehl Q5 Native global (automatisch)

ETH3D-Benchmark-Daten Q3 (autotest precomputed)

Schnell-Vergleich

Ba
ckend

App-Store Sand
box

Externe Binary Best Use Max 
~Cams

Q1 Apple 
PG

✅ ✅ — Orbit-Ob
ject

~300

Q2 COL
MAP Bi

nary

❌ (nur De
veloper-
Build)

— colmap/glomap Outdoor 
large

~5 000

Q3 COL
MAP-

Text-Im
port

✅ ✅ — Bench rigs ~1 500

Q4 Nati
ve incre
mental

✅ ✅ — Orbit-Ob
ject

~200

Q5 Nati
ve global

✅ ✅ — Q4-Fall
back

~1 351

Q6 Workspace-
Import

✅ ✅ — Metasha
pe-Reuse

per Quelle
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K A P I T E L

Kapitel 10 — Einsteiger-Modus

Der Einsteiger-Modus (engl. Simple Mode, Cmd+1) ist der geführte Workflow für alle, 
die zum ersten Mal eine 3D-Gaussian-Splatting-Szene rekonstruieren. Statt eine Side
bar voller Inspector-Felder anzuzeigen, führt die App durch vier Schritte: zuerst Bilder 
oder ein Video importieren und ein Qualitäts-Preset wählen, dann läuft die Verarbeitung 
(SfM + Training), anschließend kann die fertige Szene in einer 3D-Vorschau begutachtet 
werden, und zum Schluss wird in das gewünschte Format exportiert. Eine schmale Fort
schrittsleiste am oberen Fensterrand zeigt jederzeit an, in welchem Schritt du gerade 
bist.

Im Vergleich zum Expert-Modus (Cmd+2), der alle Bedienfelder gleichzeitig zeigt, blen
det der Einsteiger-Modus ungenutzte Optionen aus, gibt Validierungs-Warnungen bei 
zu wenigen oder schlechten Bildern und bietet auf jedem Schritt nur die Buttons an, 
die im aktuellen Zustand sinnvoll sind. Du kannst jederzeit zwischen Einsteiger- und 
Expert-Modus wechseln (Cmd+1 / Cmd+2), der gesamte Zustand — importierte Bilder, 
gewähltes Preset, gerade laufendes Training, fertige Punktwolke — bleibt erhalten und 
ist im jeweils anderen Modus sofort verfügbar.

Z1 — Import (Bilder & Preset wählen)

Abbildung 35:  Simple-Mode Schritt 1 — leere Drop-Zone vor Bild-Import, Crumb-Trail oben 
(Import → Frame Quality → Cameras → Training → Preview → Export), Format-Pills JPG/PNG/

TIFF/HEIC/MP4/MOV/PLY/SPZ/SPLAT/SCENE/COLMAP
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WAS IM BILD ZU SEHEN IST  Crumb-Trail (Import aktiv) zeigt den vierschrittigen Workflow. 
Linke Drop-Zone mit drei CTAs: „Browse Files„ (NSOpenPanel), „Try Sample Sce
ne“ (bundled Demo), „Download Sample Photos (~427 MB)„ (Mip-NeRF360 flowers 
Subset). Format-Pills darunter listen alle akzeptierten Dateitypen. Rechts „Imported 
Files“ mit Counter „0 images„ und Empty-State „No files imported yet“. Unten Quality-
Picker (Default: Preview) und „Start Processing„ (deaktiviert solang keine Bilder da 
sind).

Der erste Schritt besteht darin, der App Bildmaterial zu geben. Per Drag-and-Drop in 
das große, gestrichelte Feld in der Mitte, per „Browse Files„-Button oder per Klick auf 
die mitgelieferte Sample-Szene. Rechts erscheint eine Liste aller importierten Bilder mit 
Auflösung und Dateigröße; unten in der schwebenden Werkzeugleiste wählst du das 
Qualitäts-Preset und startest mit „Start Processing“ die Pipeline. Validierungs-Warnun
gen (rot bei < 3 oder < 10 Bildern, orange bei 10–19) zeigen an, ob die App eine 
sinnvolle Rekonstruktion erwartet oder nicht.

C-01 ProgressIndicator (Schritt-Anzeige)

WO

Oben über dem Workflow, immer sichtbar.

T E C H N I S C H

Zeigt eine horizontale Fortschrittsleiste über die ge
samte Pipeline (Frame-Quality → SfM → Training) 
mit Stage-Allocation: Frame-Quality belegt 0–5 % 
(Phase 3.11, sehr kurz), SfM belegt 0–30 % der Bar, 
Training 30–100 %. Daneben Status-Text und pha
sen-benannte Prozent-Anzeige („SfM 41 %„, „Trai
ning 12 500/20 000“), damit Anwender nicht den 
scheinbaren Rückschritt „41 % SfM → 25 % Trai
ning„ als Fehler lesen — die Bar zeigt den gesamten 
Pipeline-Fortschritt, nicht die Sub-Stage. ETA-Be
rechnung beginnt, sobald genug Trainings-Tempo 
gemessen ist (typischerweise nach den ersten 100 
Iterationen). Dieselbe Anzeige wird auch im Expert-
Modus oberhalb des Inspectors verwendet.

E I N FAC H  G E S AG T

Die schmale Leiste ganz oben 
ist deine Karte durch den Work­
flow. Sie sagt dir nicht nur, was 
die App gerade macht (Kame­
ras ausrichten, Training läuft, …), 
sondern auch, wie weit sie insge­
samt schon ist. Die Aufteilung ist 
absichtlich so, dass die Kamera-
Berechnung das erste Drittel der 
Leiste belegt und das eigentliche 
Training die hinteren zwei Drittel 
— sonst würde es wirken, als wä­
re der Fortschritt nach SfM plötz­
lich zurück bei null. Du kannst 
dich also entspannt zurückleh­
nen, ein Blick auf die Leiste ge­
nügt, um die grobe Etappe zu 
sehen. Der Text daneben sagt dir, 
ob du gerade in der SfM-Stufe (z. 
B. „SfM 41 %„) oder im Training 
(z. B. „Training 12 500/20 000“) 
steckst, damit die Zahlen nicht 
verwirrend wirken. Wenn du die 
ETA nicht angezeigt bekommst, 
ist das Training einfach noch zu 
jung — die App schätzt erst, so­
bald sie genug Tempo gemessen 
hat.
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C-03 DropZoneView (Drag-and-Drop-Bereich)

WO

Linke Seite des Import-Schritts, großes gestrichel
tes Rechteck mit Symbol. Wird im Einsteiger-Modus 
mit dem Label „Drop photos or a video here„ ange
zeigt.

T E C H N I S C H

Drop-Bereich, der das Symbol kurz hüpfen lässt und 
den Hintergrund einfärbt, sobald Drag-Items über 
dem Feld schweben. Akzeptiert JPG, PNG, TIFF, 
HEIC, MP4, MOV, PLY, SPZ, .splat, .radiancescene-
Bundles und Verzeichnisse. Drop-Routing nach Typ: 
Bilder werden gesammelt und sortiert übergeben, 
Videos triggern den Frame-Sampling-Pfad, Splat-
Dateien öffnen direkt die Vorschau, Scene-Bundles 
werden eingelesen. Verzeichnisse werden enume
riert und alle enthaltenen Bilder importiert. Secu
rity-scoped Bookmarks für sandbox-konformen Zu
griff werden korrekt aufgenommen und freigegeben. 
Nicht-unterstützte Endungen werden als Warnban
ner für 5 Sekunden angezeigt.

E I N FAC H  G E S AG T

Das große gestrichelte Feld ist 
die Hauptbedienung des ersten 
Schritts. Zieh einfach Fotos oder 
ein Video hinein, oder einen gan­
zen Ordner — die App nimmt 
alles, was sie kennt, und ignoriert 
den Rest. Wenn das Feld blau 
wird und das Symbol kurz hüpft, 
hat die App den Drag erkannt. 
Lass los, und der Import star­
tet sofort: Bilder wandern in die 
Liste rechts, Videos triggern au­
tomatisch den Frame-Sampling-
Schritt, und bereits trainierte 
.ply / .spz / .splat  Datei­

en öffnen direkt die Vorschau. 
Falls ein Format gar nicht passt 
(etwa PDF oder BMP), erscheint 
ein kurzer Hinweis am oberen 
Rand — die App schluckt unbe­
kanntes Material nicht stumm.

C-05 Browse Files Button

WO

Innerhalb der Drop-Zone, prominenter Button.

T E C H N I S C H

Button, der den macOS-Datei-Dialog mit Mehrfach-
Auswahl und den Dateitypen JPG, PNG, TIFF, MP4, 
MOV, Ordner sowie dem App-eigenen Scene-For
mat öffnet. Ergebnis-URLs sind security-scoped 
und werden über dieselben Import-Pfade weiterge
leitet wie Drag-and-Drop. Wenn der Benutzer einen 
Ordner auswählt, wird er rekursiv nach Bildern enu
meriert.

E I N FAC H  G E S AG T

Wenn dir Drag-and-Drop unbe­
quem ist, klick einfach diesen 
Button und navigiere im macOS-
Datei-Dialog zu deinen Fotos. Du 
kannst mehrere Dateien gleich­
zeitig wählen (Cmd-Klick auf die 
einzelnen Bilder) oder einen gan­
zen Ordner auswählen — die 
App durchsucht den Ordner dann 
rekursiv nach allen unterstütz­
ten Bildtypen. Das ist besonders 
praktisch, wenn deine Aufnah­
men verschachtelt in Unterord­
nern liegen (z. B. „shoot-day1/„, 
„shoot-day2/“) — ein Klick auf 
den Hauptordner reicht. Funktio­
nal macht der Button exakt das, 
was auch Drag-and-Drop macht; 
wähl einfach den Weg, der dir be­
quemer ist.
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C-06 Try Sample Scene Button

WO

Innerhalb der Drop-Zone, nur sichtbar wenn das 
App-Bundle die Sample-Scene enthält und noch 
keine Bilder/Splats importiert sind.

T E C H N I S C H

Erscheint nur, wenn (a) eine sample-scene.splat , 
.spz  oder .ply  im App-Bundle vorhanden ist 

UND (b) noch keine Bilder/Videos importiert und 
noch keine Punktwolke vorhanden ist. Bei Klick 
lädt die fertige Punktwolke (bevorzugt das kleinste 
Format — .splat  ~3 MB, .spz  ~1.4 MB, Fall
back .ply ) und setzt nach 400 ms hartkodierte 
Kamera-Werte aus dem Original-Metadaten der Blu
men-Szene für eine ästhetisch sinnvolle Eingangs-
Perspektive.

E I N FAC H  G E S AG T

Wenn du die App zum ersten Mal 
startest und einfach mal sehen 
willst, was am Ende rauskommt 
— klick hier. Das öffnet eine 
fertig trainierte Blumen-Szene, 
die du sofort drehen und ex­
portieren kannst, ohne dass die 
App rechnen muss. Die Kame­
ra ist voreingestellt auf eine äs­
thetisch sinnvolle Eingangsper­
spektive, sodass du gleich was 
Schönes siehst. Perfekt, um die 
3D-Steuerung und den Export-
Schritt risikolos auszuprobieren, 
bevor du auf eigene Aufnah­
men losgehst. Sobald du eigene 
Bilder importierst, verschwindet 
der Button automatisch — er 
wird nur angezeigt, solange das 
Projekt komplett leer ist.

C-07 Download Sample Photos Button

WO

Innerhalb der Drop-Zone, neben „Try Sample Sce
ne„; gleiche Sichtbarkeits-Bedingungen.

T E C H N I S C H

Triggert einen Download (Repo github.com/​
bkindler/​radiancekit-sample-photos), der ca. 427 
MB an 960 Vollauflösungs-Frames lädt und in die 
App speist. Während des Downloads wird der But
ton deaktiviert. Der Fortschritt erscheint in der obe
ren Progress-Bar als „Downloading X %„ in einer 
eigenen Stage, weil diese Stage ihre eigene 0–100 
%-Skala behält und der spätere SfM-Stage nicht 
überlappt.

E I N FAC H  G E S AG T

Genau wie die Sample-Scene, nur 
mit den Ausgangs-Fotos statt 
mit dem fertigen Ergebnis. So 
kannst du die gesamte Pipeline 
einmal selbst durchlaufen lassen 
und sehen, wie lange SfM und 
Training auf deinem Mac wirk­
lich dauern. Der Download ist 
groß (etwa eine halbe DVD = 427 
MB), passiert aber nur einmal 
— danach sind die Fotos lokal 
und du kannst die Pipeline be­
liebig oft mit verschiedenen Pre­
sets neu starten. Während der 
Download läuft, zeigt die obe­
re Fortschrittsleiste den aktuel­
len Download-Stand in Prozent, 
sodass du abschätzen kannst, 
wann es losgeht. Tipp: nimm da­
zu am besten ein schnelles WLAN 
oder Kabel-Netz — die 427 MB 
ziehen sich sonst.
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C-09 Quality Presets Picker

WO

Schwebende untere Werkzeugleiste des Import-
Overlays, links neben dem Start-Button.

T E C H N I S C H

Bedienelement mit Label „Quality„ gruppiert die ver
fügbaren Presets nach Kategorie (Classic / MCMC / 
Custom). Built-in Presets werden nach Kategorie 
gruppiert; die Abschnitts-Header sind hartkodiert. 
Custom-Presets nur sichtbar wenn welche existie
ren. Locked-State: Presets, die nicht in der Free-

Liste (Quick + Preview) liegen, bekommen ein „🔒“-
Suffix am Namen, wenn der User nicht gekauft hat; 
bei Auswahl springt der Picker auf Preview zurück 
und öffnet automatisch das Purchase-Sheet. Bei 
Wahl wird das Preset angewendet, was die gesamte 
Trainings-Konfiguration ersetzt.

E I N FAC H  G E S AG T

Hier wählst du, wie genau und 
wie lange die App rechnen soll. 
„Quick„ und „Preview“ sind oh­
ne Kauf nutzbar und liefern in 
wenigen Minuten ein erstes Er­
gebnis — ideal, um zu testen, 
ob deine Bilder überhaupt sinn­
voll sind. „Balanced„ und „Quali­
ty“ brauchen die Vollversion und 
liefern deutlich saubere Modelle, 
dauern dafür aber Stunden statt 
Minuten. MCMC ist eine andere 
Strategie, die mit weniger Gauss-
Splats auskommt — gut, wenn 
du das Modell später kompakt 
exportieren oder ins Web stellen 
willst. Premium-Presets erkennst 
du am kleinen Schloss-Symbol 
am Namen; tippst du eines ohne 
Lizenz an, springt der Picker zu­
rück auf Preview und das Kauf-
Sheet öffnet sich automatisch. 
Faustregel: starte immer mit Pre­
view, schau dir das Ergebnis an, 
und entscheide dann, ob sich ein 
längerer Lauf lohnt.

C-10 Start Processing Button

WO

Schwebende untere Werkzeugleiste des Import-
Overlays, rechts neben dem Preset-Picker.

T E C H N I S C H

Button, der grau bleibt, solange weder Bilder noch 
ein Video importiert sind. Bei Klick startet die Pipe
line und schaltet die Stage-Maschine in die Reihen
folge Frame-Quality → SfM → Training um. Der But
ton selbst hat keinen weiteren Status; eine laufende 
Verarbeitung erscheint stattdessen als separater 
Verarbeitungsbildschirm.

E I N FAC H  G E S AG T

Der „Loslegen„-Knopf. Solange 
er grau ist, fehlen noch Eingabe-
Bilder oder ein Video. Sobald du 
Fotos hereingezogen hast, wird 
er aktiv und du klickst ihn an, um 
SfM und Training nacheinander 
zu starten. Ab da übernimmt die 
App den gesamten Ablauf und 
du landest automatisch auf dem 
Verarbeitungsbildschirm (Z2). Du 
musst nichts weiter klicken — 
erst nach Trainings-Ende wech­
selt die App wieder in die Vor­
schau (Z3). Wenn du es dir noch­
mal anders überlegst, kannst du 
auch danach noch jederzeit per 
Cancel abbrechen.
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C-11 Video Sampling Slider

WO

Rechte Bilderliste, sichtbar nur wenn ein Video 
(statt Bildern) importiert wurde.

T E C H N I S C H

Schieberegler 0.5 fps – 30 fps in 0.5er-Schritten. 
Bei Änderung wird die Frame-Dichte aktualisiert 
und zusätzlich die Anzahl der Zielframes (mindes
tens 10) aus Dichte und Videolänge berechnet. 
Der Schieberegler liegt außerhalb der Bilderliste, 
weil Listen-Elemente Maus-Events von Schiebereg
lern blockieren würden. Unter dem Schieberegler 
stehen die berechneten Zielframes („247 frames„) 
und die Videolänge („1m23s video“). Tooltip warnt: 
„Doubling the density doubles the number of 
frames and increases SfM time by ~100%.„

E I N FAC H  G E S AG T

Wenn du statt Fotos ein Video 
importiert hast, entscheidet die­
ser Schieberegler, wie viele Ein­
zelbilder die App aus dem Video 
herausziehen soll. Mehr Bilder 
= bessere Qualität, aber linear 
mehr Rechenzeit. Für ein 30-
Sekunden-Orbit-Video sind 5 fps 
(150 Bilder) ein guter Anfang; bei 
1-minütigen Aufnahmen reicht 
oft 3 fps völlig. Unter dem Regler 
zeigt die App live an, wie viele 
Frames bei der aktuellen Einstel­
lung herauskommen — so siehst 
du sofort, ob du in den sinnvol­
len Bereich von etwa 100–300 
Bildern triffst. Wenn das Ergeb­
nis schlecht wird, zieh den Regler 
nach rechts und probier es noch­
mal; die Verdopplung der Frame-
Rate verdoppelt aber auch grob 
die SfM-Dauer.

C-12 Clear All Button

WO

Rechte Bilderliste, unten rechts; sichtbar nur wenn 
Bilder importiert wurden.

T E C H N I S C H

Roter Button. Klick öffnet einen Bestätigungs-Dialog 
mit Titel „Clear all imported files?„ und Message „N 
images will be removed.“. Bestätigung leert alle im
portierten Bilder/Videos, Staging-Verzeichnisse, die 
Punktwolke, den Trainings-Status, das SfM-Ergeb
nis und alle Caches; die Stage springt zurück auf 
Import. Auf Cancel bleibt alles erhalten. Der Dialog 
ist als zerstörungsfreier Default-Pfad konfiguriert 
(zerstörender Button rot markiert).

E I N FAC H  G E S AG T

Wenn du komplett neu anfan­
gen willst, klick hier. Die Bestäti­
gungs-Frage erscheint, weil das 
Löschen alle aktuellen Importe 
samt ggf. bereits berechneten 
Kameras und Trainings-Resulta­
ten verwirft — du kannst es nicht 
rückgängig machen. Sinnvoll, 
wenn du das gewählte Bildmate­
rial komplett austauschen willst 
oder ein altes Projekt loswerden 
möchtest, bevor du ein neues 
startest. Beachte: ein einzelnes 
Bild rauszunehmen geht über 
die Liste rechts (siehe nächster 
Punkt), nicht über diesen Button. 
Deine Dateien auf der Festplatte 
werden dabei nicht gelöscht — 
die App vergisst nur ihre Refe­
renzen.
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C-13 File List ForEach (Einzel-Image-Entfernen)

WO

Rechte Bilderliste, jeder Eintrag.

T E C H N I S C H

Liste über die importierten Bilder mit Swipe-zum-
Löschen. Pro Bild eine Zeile mit Icon, Dateiname, 
Auflösung („1920 × 1080″) und Dateigröße (forma
tiert KB/MB). Auflösung kommt aus einem Metada
ten-Cache, der asynchron aus den Bild-Headern 
befüllt wird, damit die Oberfläche nicht blockiert. 
Die Löschen-Aktion bietet macOS-typisches Swipe-
Delete (Trackpad-Swipe links auf einer Zeile) sowie 
Tastatur-Delete bei selektierter Zeile. Hinweis: Der 
erweiterte Image-Delete-Pfad mit explizitem Minus-
Button, Backspace und Cmd-Z zum Rückgängigma
chen wurde nur im Expert-Modus im Project Navi
gator ergänzt — im Einsteiger-Modus bleibt es bei 
Swipe-Delete.

E I N FAC H  G E S AG T

Die Liste rechts zeigt jedes im­
portierte Bild mit Auflösung und 
Dateigröße — praktisch, um auf 
einen Blick zu sehen, ob du 
gemischt hochauflösendes mit 
niedrigauflösendem Material zu­
sammengewürfelt hast. Um ein 
einzelnes Bild rauszunehmen, 
wisch es mit zwei Fingern nach 
links auf dem Trackpad — wie 
in iOS Mail — oder wähle es 
an und drücke Delete. Die App 
löscht die Datei selbst nicht; sie 
nimmt sie nur aus dem aktuel­
len Projekt. Falls du eine richtige 
Minus-Schaltfläche oder Cmd-Z-
Rückgängig brauchst, wechsle in 
den Expert-Modus (Cmd+2), dort 
gibt es das im Project Navigator. 
Im Einsteiger-Modus bleibt es 
bewusst beim einfachen Swipe-
Pattern.
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C-15 Validation Warnings (3-Stufen-Tier)

WO

Unter der Bilderliste, oberhalb des Clear-All-But
tons.

T E C H N I S C H

Drei aufeinander folgende Schwellen basierend auf 
der Anzahl importierter Bilder (nur aktiv wenn Bilder 
vorhanden und kein Video): - < 3 Bilder: rotes 
Banner (red octagon), Text „At least 3 images are 
required. Camera alignment cannot be computed 
from fewer images.„ - 3–9 Bilder: rotes Banner, Text 
„With fewer than 10 images, SfM often fails and the 
trained scene tends to overfit […]. 15–20 images 
minimum recommended; 30+ for object captures.“ 
- 10–19 Bilder: orangefarbenes Banner (warning tri
angle), Text „Workable, but quality usually improves 
with 20+ images and good coverage around the 
scene.„

Ab 20 Bildern verschwindet das Banner. Schwellen
werte sind hartkodiert und basieren auf empirischen 
560+-Trainings-Experimenten.

E I N FAC H  G E S AG T

Die App schaut sich an, wie vie­
le Bilder du importiert hast, und 
gibt dir eine farbige Einschät­
zung. Rot heißt: das wird mit ho­
her Wahrscheinlichkeit nichts — 
entweder kann SfM keine Kame­
ras berechnen oder das Training 
überfittet auf zu wenig Materi­
al. Orange heißt: könnte klappen, 
aber rechne nicht mit Top-Qua­
lität, weil der Algorithmus zwi­
schen den Bildern wenig Über­
lapp findet. Kein Banner heißt: 
gute Voraussetzungen, du hast 
genug Material. Wenn du wirklich 
saubere Modelle willst, peile min­
destens 30–50 gleichmäßig ver­
teilte Aufnahmen rund um dein 
Motiv an — gerne auch deut­
lich mehr bei Außenszenen oder 
großen Räumen. Du kannst trotz 
Warnung starten, aber sei nicht 
überrascht, wenn SfM kommen­
tarlos abbricht oder das Modell 
löchrig aussieht.
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C-16 COLMAP Workspace Detection

WO

Beim Drop eines Ordners — keine sichtbare Schalt
fläche, sondern Erkennungs-Logik.

T E C H N I S C H

Beim Drop eines Verzeichnisses wird geprüft, 
ob darin eine der drei kanonischen Workspace-
Layouts vorliegt: sparse/​0/​cameras.bin, sparse/​
cameras.bin oder direkt cameras.bin  im Root. 
Trifft das zu, wird die Standard-Bild-Enumeration 
abgebrochen und stattdessen ein modaler Alert 
geöffnet, der den User fragt, ob die bestehende 
Rekonstruktion verwendet oder die Bilder neu durch 
Apple Photogrammetry geschickt werden sollen. 
Gleicher Pfad auch für Text-Format-Workspaces 
(cameras.txt) und ETH3D-Exporte. Siehe Kapitel 9 
Backend Q6 für Details. Wirkt im Einsteiger-Modus 
genauso wie im Expert-Modus.

E I N FAC H  G E S AG T

Wenn du schon einmal mit 
Metashape, RealityCapture oder 
COLMAP gearbeitet hast und 
dort die Kamera-Berechnung 
schon laufen ließest, kannst 
du den Export-Ordner einfach 
hier reinziehen. RadianceKit er­
kennt am Inhalt automatisch, 
dass es sich um ein COLMAP-
Workspace handelt (es prüft 
auf sparse/​0/​, cameras.bin  
und Co.), und fragt dich, ob 
es die fertige Rechnung über­
nehmen oder selbst neu rech­
nen soll. Übernehmen spart bei 
großen Szenen Stunden Warte­
zeit, weil SfM komplett über­
sprungen wird — das Training 
startet sofort. Auch Text-Format-
Workspaces (cameras.txt) und 
ETH3D-Exporte werden erkannt. 
Diese Funktion ist im Einsteiger-
Modus genauso wie im Expert-
Modus verfügbar; mehr Details 
stehen in Kapitel 9 unter Ba­
ckend Q6.

Wann zur nächsten Stufe?

Du kannst Start Processing klicken, sobald (a) mindestens ein Bild oder ein Video 
importiert ist und (b) das Validation-Banner orange oder verschwunden ist. Bei rotem 
Banner lässt die App dich zwar trotzdem starten, du kannst aber mit hoher Wahrschein
lichkeit die Verarbeitung gleich wieder abbrechen. Empfohlen: mindestens 20 Bilder, 
scharf, mit deutlichem Überlapp zwischen aufeinander folgenden Aufnahmen, alle aus 
etwa der gleichen Distanz zum Motiv. Wähle vor dem Start ein Preset, das zu deinem 
Zeitbudget passt — bei 30 Bildern und Quick-Preset bist du in wenigen Minuten durch, 
bei Quality dauert es eher 1–2 Stunden.
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Z2 — Verarbeitung (SfM + Training)

Abbildung 36:  Z2 SfM-Phase — Stage-Icon „Structure from Motion„ mit 41 % im großen 
Kreis, oberer Statusbalken bei „SfM 25 %“, Cancel-Button unten rechts

SfM-Phase (Kameras werden ausgerichtet): Großer Fortschrittskreis zeigt Sub-
Stage-Progress (hier 41 % der laufenden Apple-Photogrammetry-Session). Status-Text 
„Aligning cameras…„ oben links. Crumb-Trail markiert „Cameras“ als aktive Stufe. Obe
rer Statusbalken zeigt Pipeline-Gesamtprogress (25 %) — SfM belegt die erste Hälfte 
des Balkens. Schwebende Wireframe-Kameras im Hintergrund deuten an, dass Posen 
geschätzt werden.

Abbildung 37:  Z2 Training-Phase — Stage-Icon „Training Gaussians„ mit 6 %, Live-Metriken 
oben (Training: 400/5000 — Loss: 0.1642 — 138.7 it/s), ETA 33s, Pause/Cancel unten

Training-Phase (Gaussians werden optimiert): Sub-Stage-Icon wechselt zu „Training 
Gaussians„, Prozent zählt Iterationen vom gewählten Preset (hier 400 / 5 000 für Pre
view-Preset = 8 % der Stage). Live-Metrik-Zeile zeigt Loss-Wert (0.1642), Iterationen-
pro-Sekunde (138.7 it/s) und ETA (33 s). Pipeline-Gesamtprogress klettert von 50 % bis 
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100 % während dieser Phase. Pause-Button (statt Cancel-Only in SfM-Phase) erlaubt 
Resume später; Cancel verwirft das Training-Ergebnis und kehrt zurück nach Z1.

Sobald die Pipeline läuft, blendet die App das Import-Overlay aus und zeigt einen voll
flächigen Verarbeitungsbildschirm. Mittig läuft ein großer Fortschrittskreis (220 × 220 
Pixel) mit Stage-Icon, Status-Text und Prozent-Zahl; im Hintergrund visualisiert eine 
dezente Splat-Animation symbolisch die laufende Berechnung. Oben links lässt sich ein 
Info-Panel einblenden, das Live-Metriken aus Training und SfM zeigt. Unten gibt es 
Pause/Resume, Cancel und im Fehlerfall einen Retry-Button.

C-18 SplatTrainingView (Hintergrund-Animation)

WO

Vollflächiger Hintergrund hinter dem Progress-
Kreis, ausgeblendet bei Abbruch oder Fehler.

T E C H N I S C H

Dekorative Animation, die je nach Pipeline-Fort
schritt (0…1) eine zunehmende Anzahl kleiner ani
mierter Splat-Partikel rendert. Die Quelle ist ein be
rechneter Fortschrittswert, der SfM-Phasen auf 0–
0.2 abbildet und Training auf 0.2–1.0 (Frame-Quality 
auf 0–0.05). Damit „bauen„ sich die Splats sichtbar 
auf, während das Training läuft. Ausschließlich de
korativ — die Anzeige zeigt keine echten Zwischen
ergebnisse des aktuellen Trainings (das wäre Live-
Preview im Expert-Modus). Bei Cancel oder Failure 
wird sie ausgeblendet und nur der Status-Kreis 
bleibt sichtbar.

E I N FAC H  G E S AG T

Im Hintergrund läuft eine kleine 
Animation aus tanzenden Punk­
ten, damit der Bildschirm nicht 
so leer wirkt während der Be­
rechnung. Das ist nicht dein ech­
tes 3D-Modell — das siehst du 
erst nach dem Training in Schritt 
Z3. Die Animation hat aber die­
selbe Tonalität, sodass du am un­
gefähren Verdichtungsgrad able­
sen kannst, wie weit das Trai­
ning fortgeschritten ist. Anfangs 
sind nur wenige Punkte sichtbar, 
gegen Ende füllt sich der Hin­
tergrund deutlich dichter — ein 
hübscher visueller Indikator zu­
sätzlich zur Prozent-Anzeige im 
Kreis. Wenn dich die Animation 
stört (z. B. weil du im Hinter­
grund nebenher arbeiten willst), 
kannst du in den Expert-Modus 
wechseln, wo sie wegfällt.
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C-19 Großer Progress-Kreis

WO

Mittig auf dem Verarbeitungsbildschirm, 220 × 220 
Pixel.

T E C H N I S C H

Zwei übereinander gerenderte Ringe: außen ein 
gedämpfter Track-Ring, innen ein gefüllter Fort
schritts-Ring mit Akzent- oder Rot-Stroke (rot 
bei Fehler). Innerhalb des Kreises ein Stage-Icon 
(Gehirn für Training, Kamera für SfM, Film für Vi
deo-Frame-Extraktion, Sparkles für Frame-Quality), 
Stage-Titel und die live animierte Prozent-Zahl in 
32-Punkt-Rounded-Font. Das Icon pulsiert sanft, 
solange die Verarbeitung aktiv ist. Die Anzeige in
terpoliert auf einem 30-Hz-Timer sanft in Richtung 
des aktuellen echten Fortschritts — mit Constant-
Creep (0.0003/Frame) plus Proportional-Anteil (4 % 
des Gaps) und einem Soft-Ceiling, das auf 80 % 
des nächsten erwarteten Milestone setzt (für SfM 
aus einer hartkodierten Milestone-Tabelle). So wirkt 
der Fortschritt flüssig, selbst wenn die echten SfM-
Updates nur alle paar Sekunden eintreffen.

E I N FAC H  G E S AG T

Der große Kreis in der Mitte 
ist deine Haupt-Anzeige während 
die App rechnet. Er füllt sich 
sanft, auch wenn die echten Be­
rechnungs-Updates nur alle paar 
Sekunden kommen — das gibt 
dir das Gefühl, dass etwas pas­
siert, statt minutenlang auf ein 
eingefrorenes Prozent zu star­
ren. Das Symbol in der Mitte 
wechselt, je nachdem ob gerade 
Frames extrahiert werden (Film-
Icon), Kameras ausgerichtet wer­
den (Kamera-Icon), oder Gaus­
sians trainiert werden (Gehirn-
Icon). Die Prozent-Zahl bezieht 
sich auf den aktuellen Teilschritt 
— die Gesamt-Pipeline siehst 
du in der schmalen Leiste ganz 
oben. Bei einem Fehler färbt sich 
der Ring rot statt blau, und das 
Icon pulsiert nicht mehr, sodass 
du sofort merkst, dass etwas 
schiefgelaufen ist.

C-22 Info Button (Metriken einblenden)

WO

Oben links auf dem Verarbeitungsbildschirm, 32 × 
32 Pixel.

T E C H N I S C H

Schlichter Button mit Material-Hintergrund. Schaltet 
das Info-Panel ein oder aus. Icon wechselt zwischen 
Info-Kreis-Outline und Info-Kreis-Gefüllt, wenn ak
tiv. Sanfte Einblend-Animation. Im Tooltip „Show de
tailed processing metrics„.

E I N FAC H  G E S AG T

Standardmäßig ist der Bild­
schirm bewusst aufgeräumt — 
nur der große Fortschrittskreis, 
mehr siehst du erstmal nicht. 
Wenn du als technisch interes­
sierter Nutzer genauer wissen 
willst, was passiert (welche Itera­
tion, wie hoch der Loss, wie viele 
Gaussians), klick auf das i-Sym­
bol oben links. Ein kleines Panel 
klappt unten auf und zeigt al­
le Live-Werte. Ein erneuter Klick 
blendet es wieder aus. Die Ein­
stellung ist nicht persistent — 
bei jedem neuen Trainingslauf ist 
das Panel zunächst wieder aus­
geblendet, was bewusst so ge­
wählt ist, um Einsteiger nicht zu 
erschrecken.
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C-23 Info Panel (Live-Metriken)

WO

Unten links auf dem Verarbeitungsbildschirm, sicht
bar nur wenn showProcessingInfo == true.

T E C H N I S C H

Zwei-spaltiges Panel mit Ultra-Thin-Material-Back
ground. Linke Spalte: stage-spezifische Info-Zeilen 
— für SfM Status-Text und Prozent; für Trai
ning Iteration, kombinierter Loss, L1-Loss, D-SSIM-
Loss, Gaussian-Count (orange gefärbt), Speed (it/
s), Elapsed-Time, berechnete ETA, SH-Degree und 
Learning-Rate. Rechte Spalte: Status-Text, Time-
Info-String, inline Loss-Chart (siehe C-28) und ein 
Discoverability-Nudge (siehe C-32). Alle Werte wer
den aus dem Trainings-Status gelesen, der bei 
jedem Trainings-Tick aktualisiert wird.

E I N FAC H  G E S AG T

Das Info-Panel zeigt alle Live-
Werte, die im Expert-Modus dau­
erhaft in der Inspector-Sidebar 
stehen würden: aktuelle Iterati­
on, Loss-Wert (kleiner = besser), 
Anzahl der Gaussians, Geschwin­
digkeit, geschätzte Restzeit, SH-
Degree und Learning-Rate. Auf 
der rechten Seite läuft zusätzlich 
eine winzige Loss-Kurve mit, die 
dir auf einen Blick verrät, ob das 
Training in die richtige Richtung 
läuft. Wenn das Training zäh 
wirkt, hilft ein Blick hier — ein 
Loss, der nicht mehr fällt, oder 
eine ETA, die nicht mehr sinkt, 
deuten auf Probleme hin. Wenn 
der Loss explodiert (plötzlich rie­
sig wird) oder NaN anzeigt, ist 
das Training instabil geworden 
und ein Cancel + Retry oder 
Wechsel auf ein anderes Preset 
ist sinnvoll.

C-25 Pause/Resume Button

WO

Untere Navigationsleiste, sichtbar nur während der 
Trainings-Stage (NICHT während SfM) und solange 
die Verarbeitung läuft.

T E C H N I S C H

Bordered Button. Ruft je nach Status Pause oder 
Resume auf. Label wechselt zwischen „Pause„ (mit 
Pause-Icon) und „Resume“ (Play-Icon). Während 
des SfM-Schritts wird der Button nicht gezeigt, 
weil Apple Photogrammetry keine Pause-Semantik 
kennt. Der Pause-Zustand erhält Iteration, Gaus
sian-Status und Optimizer-Momentum komplett — 
Resume macht da weiter, wo zuvor angehalten wur
de.

E I N FAC H  G E S AG T

Während das Training läuft, 
kannst du es jederzeit anhal­
ten und später fortsetzen. Sinn­
voll, wenn du zwischendurch et­
was anderes auf dem Mac ma­
chen willst, das viel GPU braucht 
— z. B. Videoschnitt, Spieletest 
oder ein Render-Export aus ei­
ner anderen App. Klick Pause, 
mach dein Ding, klick Resume, 
das Training läuft genau dort 
weiter, wo es war. Iterations-
Zähler, Gaussian-Anzahl und Op­
timizer-Momentum bleiben dabei 
vollständig erhalten, der Pause-
State kostet dich nichts an Quali­
tät. Während der SfM-Phase ist 
Pause nicht verfügbar — Apple 
Photogrammetry kennt keine An­
halte-Funktion, da musst du im 
Notfall mit Cancel arbeiten.
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C-26 Cancel Button

WO

Untere Navigationsleiste, sichtbar während die Ver
arbeitung läuft (SfM oder Training).

T E C H N I S C H

Roter Bordered-Button. Öffnet einen Bestätigungs-
Dialog mit Titel „Stop and discard progress?„, But
tons „Discard Progress“ (zerstörend) und „Keep 
Running„ (Cancel). Auf Bestätigung wird das Can
cel-Flag gesetzt, der Trainings-Task beendet, der 
SfM-Subprozess wenn nötig beendet und eine Sum
mary-Zeile mit Abbruch-Status in das JSONL-Log 
geschrieben. Im Gegensatz zu Pause werden Trai
nings-Buffer und Status verworfen.

E I N FAC H  G E S AG T

Der Abbruch-Knopf. Im Gegen­
satz zu Pause ist das endgültig 
— wenn du danach neu star­
ten willst, läuft die Verarbeitung 
von vorne, sämtliche bereits trai­
nierten Iterationen sind verloren. 
Sinnvoll, wenn du dich beim Pre­
set vertan hast, das Training 
viel zu langsam läuft, oder die 
App offensichtlich Müll-Ergeb­
nisse produziert und du nicht 
warten willst. Vor dem tatsäch­
lichen Abbruch fragt die App 
über einen Bestätigungs-Dialog 
nochmal nach, damit du nicht 
aus Versehen Stunden Rechen­
zeit verlierst. Falls du nur kurz 
unterbrechen willst, nimm lieber 
Pause.

C-27 Retry Button

WO

Untere Navigationsleiste, sichtbar wenn die Pipeline 
fehlgeschlagen ist (SfM-Status startet mit „SfM fai
led„ oder Training ist im Fehler-Zustand).

T E C H N I S C H

Akzent-Button. Startet die gesamte Pipeline neu. 
Vor dem Start wird geprüft, ob noch importierte Bil
der/Videos vorhanden sind. Vorherige Fehler-Logs 
bleiben im JSONL-Verzeichnis erhalten; ein neuer 
Run schreibt eine neue Logdatei mit aktuellem 
Timestamp.

E I N FAC H  G E S AG T

Falls SfM oder Training mit 
einer Fehlermeldung abbricht, 
kannst du es hier neu versu­
chen. Manchmal hilft das, weil 
viele Schritte (RANSAC, Densifi­
cation) Zufallsanteile haben und 
ein zweiter Anlauf erfolgreich 
sein kann, wo der erste ge­
scheitert ist. Die gesamte Pipe­
line läuft dann erneut von vor­
ne durch — SfM und Training, 
in einer frischen JSONL-Log-Da­
tei. Wenn auch der zweite Ver­
such fehlschlägt, sind meistens 
die Eingangsbilder das Problem 
(zu wenige, zu wenig Überlapp, 
Bewegungsunschärfe, schlech­
tes Licht); geh dann zurück mit 
Back und tausch dein Material 
aus. Tipp: schau parallel in die 
Training-Logs (Help → Open Trai­
ning Logs), dort steht detaillier­
ter, an welcher Stelle es konkret 
hakte.
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C-28 Inline Loss Chart

WO

Im Info-Panel, rechte Spalte, sichtbar nur während 
Training mit nicht-leerer Verlaufs-Historie.

T E C H N I S C H

Kompakter Zeichen-Bereich (40 Pixel hoch), zeich
net die Loss-History als 1-Pixel-Linie in Akzent-
Farbe. Daten werden auf finite Werte gefiltert (NaN-
Schutz für unstabile Trainings). Min/Max werden 
über die gesamte History berechnet — der Chart 
auto-zoomt also auf den Wertebereich. Der letzte 
Loss-Wert steht rechts oben über dem Chart. Die 
History selbst wird im App-Zustand bei jedem Trai
nings-Tick aufgebaut (typisch alle 100 Iterationen).

E I N FAC H  G E S AG T

Eine winzige Loss-Kurve, die 
dir auf einen Blick zeigt, ob 
das Training „konvergiert„ (Linie 
fällt nach rechts) oder ob es 
feststeckt oder explodiert (Linie 
flach oder steigt). Bei einem ge­
sunden Training fällt die Linie 
zu Beginn steil und flacht dann 
ab — das ist der erwartete Ver­
lauf, ähnlich einer Halbierungs­
kurve. Der Chart zoomt automa­
tisch auf den aktuellen Wertebe­
reich, sodass auch kleine Verbes­
serungen am Ende des Trainings 
sichtbar bleiben. Wenn die Linie 
plötzlich nach oben schießt oder 
einfriert, ist das ein gutes Si­
gnal, dass etwas schiefläuft — 
entweder das Material ist proble­
matisch oder ein anderes Preset 
wäre besser geeignet. Den Chart 
findest du im Info-Panel, das du 
oben links mit dem i-Symbol ein­
blendest.
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C-32 Discoverability Nudge (Expert-Mode-Hinweis)

WO

Im Info-Panel, rechte Spalte unten, sichtbar nur 
während Training UND im Einsteiger-Modus.

T E C H N I S C H

Kleine Zeile mit Augen-Icon und Caption-Text 
„Switch to Expert Mode (⌘2) for live splat preview„, 
in zurückhaltender Tönung und 10-Punkt-Schrift. 
Kein interaktives Element, nur Hinweis. Reagiert 
nicht auf Klick — der User muss tatsächlich Cmd+2 
drücken oder das Menü Mode → Expert Mode ankli
cken.

E I N FAC H  G E S AG T

Ein dezenter Hinweis, dass im 
Expert-Modus während des Trai­
nings die aktuelle Zwischenver­
sion deines 3D-Modells live im 
Viewport zu sehen ist. Im Ein­
steiger-Modus wird das absicht­
lich ausgeblendet, um die Ober­
fläche ruhig zu halten — aber 
viele User wissen gar nicht, dass 
es diese Funktion gibt, also wei­
sen wir hier sanft darauf hin. 
Drücke Cmd+2 und das Training 
läuft im Hintergrund weiter, wäh­
rend du dabei zuschauen kannst, 
wie sich dein Modell vor deinen 
Augen zusammensetzt. Das ist 
auch ein gutes Werkzeug, um 
schon nach wenigen tausend Ite­
rationen abzuschätzen, ob das 
Ergebnis was wird, oder ob du 
lieber abbrichst und neu an­
fängst. Cmd+1 bringt dich jeder­
zeit wieder zurück in die Einstei­
ger-Ansicht.

Wann zur nächsten Stufe?

Die App wechselt automatisch in Z3 (Vorschau), sobald das Training erfolgreich abge
schlossen ist — du musst nichts klicken. Die untere Navigationsleiste wechselt dann 
von Pause/Cancel auf einen Back-Button (zurück zu Import) und einen Export-Button 
(vorwärts zu Export). Im Fehlerfall (rote Fehlermeldung, Stage-Icon ist X) erscheint 
stattdessen Retry, und du musst entscheiden, ob du nochmal startest oder mit Back 
zum Import zurückgehst, um Bildmaterial zu ändern.

221 / 233



R A D I A N C E K I T Kapitel 10 — Einsteiger-Modus

Z3 — Vorschau (3D-Modell drehen)

Abbildung 38:  Simple-Modus Preview-Schritt mit 3D-Viewer

Abbildung 39:  Z3 Preview nach Training-Abschluss — Bjoerns Blender-Bouquet rekonstru
iert, Header zeigt „Training complete — 3,022 Gaussians in 13s„, Back- und Export-Buttons 

unten

WAS IM BILD ZU SEHEN IST  Crumb-Trail markiert „Preview„ als aktive Stufe. Vollflächiger 
3D-Viewport rendert die fertig trainierte Bouquet-Szene (synthetisches Blender-Test-
Set von Bjoern, 60-Frame-Subset aus 960 hemisphärischen Cams). Header-Statusbal
ken: „Training complete — 3 022 Gaussians in 13 s“ — gibt finale Gaussian-Anzahl 
und Trainingszeit. Drag im Viewport rotiert die Kamera (Yaw/Pitch); Scroll-Wheel zoomt 
entlang der View-Direction. „Back„-Button (unten links) kehrt zurück zu Z2 für Resume 
oder Re-Run; „Export“-Button (unten rechts, primary) navigiert weiter zu Z4.

Nach Abschluss des Trainings landet die App automatisch in der Vorschau. Hier 
siehst du dein fertiges Gaussian-Splatting-Modell in einer Fullscreen-Metal-Ansicht und 
kannst es mit Maus und Trackpad drehen, zoomen und schwenken. Auf der Oberseite 
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des Viewports liegt ein kleines Overlay mit Kamerasteuerung und Info — Auto-Rotation, 
Trainings-Statistik, Reset-Knopf. Vor dem nächsten Schritt (Export) bietet es sich an, 
das Modell aus verschiedenen Winkeln zu prüfen, um sicherzugehen, dass die Rekon
struktion sauber ist.

C-36 SplatViewportView (3D-Hauptansicht)

WO

Fullscreen-Hintergrund des Vorschau-Schritts.

T E C H N I S C H

Metal-basierter 3D-Viewport, der die fertige Punkt
wolke rendert. Der Renderer ist RadianceKits EIGE
NER ForwardPass-Rasterizer — derselbe, der die 
Splats schon während des Trainings rendert — also 
echtes WYSIWYG (was trainiert wird, wird genau so 
angezeigt und exportiert). Tile-basierte Rendering-
Pipeline mit Order-Independent Transparency. Wenn 
der Renderer nicht initialisiert werden kann (z. B. 
weil Metal auf dem System nicht verfügbar ist), er
scheint stattdessen ein schwarzer Hintergrund mit 
„Metal not available„-Text. Die Ansicht ignoriert die 
Safe-Area, sodass das Modell bis an die Fenster
kante reicht.

E I N FAC H  G E S AG T

Der Hauptviewport. Hier siehst 
du dein fertiges 3D-Modell aus 
deinen Fotos rekonstruiert, ge­
rendert auf der GPU in Echt­
zeit. Klick und zieh mit der 
linken Maustaste, um zu dre­
hen. Scrollrad oder Trackpad-
Geste mit zwei Fingern, um zu 
zoomen. Rechte Maustaste oder 
Cmd+Drag zum Schwenken. Das 
Modell besteht aus zigtausen­
den semi-transparenten 3D-El­
lipsoiden („Gaussians„), die dei­
ne Szene fotorealistisch rekon­
struieren — jedes einzelne hat 
eine Position, Ausrichtung, Form 
und Farbe, die das Training 
gelernt hat. Im seltenen Fall, 
dass dein Mac kein Metal unter­
stützt, siehst du stattdessen ei­
nen schwarzen Hintergrund mit 
einer Hinweismeldung — Radi­
anceKit braucht zwingend eine 
Metal-fähige GPU.
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C-37 CameraControlsOverlay (Steuerungs-Overlay)

WO

Über dem Viewport, schwebend.

T E C H N I S C H

Kompaktes UI-Overlay mit Buttons für Auto-Rotati
on (Turntable), Reset-Camera, Hintergrund-Auswahl 
(Gray/Black/White), Save-Screenshot, Toggle-Info-
Panel. Bindet an die Kamera-Parameter (Distanz, 
Azimut, Elevation, Target, FOV) und steuert das 
Auto-Turntable. Während des Trainings (wenn der 
User im Expert-Modus den Viewport mit-laufen se
hen will) zeigt das Overlay zusätzlich eine kompakte 
Trainings-Status-Zeile.

E I N FAC H  G E S AG T

Die kleine Schwebeleiste über 
dem Modell. Hier startest du die 
Auto-Rotation (das Modell dreht 
sich von alleine, gut für Screen­
shots und kurze Demos), setzt 
die Kamera per Reset zurück 
auf die Anfangsposition (falls du 
dich verirrt hast), wechselst den 
Hintergrund (Grau für neutral, 
Schwarz für maximalen Kontrast, 
Weiß für helle Modelle), und 
machst direkt Screenshots, die 
unter  /Pictures gespeichert wer­
den. Praktisch, wenn du ein be­
stimmtes Detail aus einem ganz 
bestimmten Winkel zeigen willst, 
ohne extra das ganze Modell 
zu exportieren. Die Auto-Rotati­
on ist auch ein guter Test, ob das 
Modell von allen Seiten gleich 
gut aussieht oder ob es eine 
„Schmuddelseite„ gibt, die durch 
fehlende Aufnahmen entstanden 
ist.
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C-38 Export Button (Navigationsleiste)

WO

Untere Navigationsleiste in Z3.

T E C H N I S C H

Akzent-Button mit Label „Export„ und Share-Icon. 
Klick triggert den Wechsel zu Z4. Vorher prüft die 
übergeordnete Ansicht, ob die Vollversion freige
schaltet ist — wenn nicht, wird statt der Export-
Bühne die Sperr-Ansicht gezeigt (siehe U-06).

E I N FAC H  G E S AG T

Wenn du mit dem Ergebnis zu­
frieden bist, klick Export und du 
landest im letzten Schritt, wo 
du das Format auswählst und 
speicherst. Ohne gekaufte Voll­
version landest du stattdessen 
auf einer Bildschirmsperre mit 
Unlock-Hinweis und Kauf-Button 
— die App will dir keine Voll­
version in die Schuhe schieben, 
aber der Export ist eines der Pre­
mium-Features. Sobald du den 
Kauf abgeschlossen hast, läuft 
die App direkt im freigeschalte­
ten Zustand weiter und du lan­
dest in der gewohnten Export-
Bühne. Wenn du es dir doch an­
ders überlegst, kommst du über 
den Back-Button wieder in die 
Vorschau und kannst weiter am 
Modell drehen.

Wann zur nächsten Stufe?

Bevor du exportierst, dreh das Modell einmal komplett herum und prüfe: Sind alle Berei
che, die du in deinen Eingangsbildern abgedeckt hast, vorhanden? Gibt es schwebende 
„Floater„ (frei in der Luft schwebende Gauss-Splat-Wolken)? Wirkt der Hintergrund/
Himmel sauber oder verschmiert? Schwerwiegende Probleme lassen sich nur durch 
Neu-Training fixieren — entweder mit mehr Bildern, anderem Preset, oder im Expert-
Modus mit Floater-Reduction-Settings.
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Z4 — Export (Format wählen & speichern)

Abbildung 40:  Simple-Modus Export-Schritt mit Format-Karten

Abbildung 41:  Z4 Export-Karten — 6 Formate (PLY 742 KB ausgewählt, SPZ 74 KB, glTF 
708 KB, .splat 96 KB, Orbit Video, Web Viewer 133 KB), Export-History-Sidebar rechts mit 

bereits exportiertem PLY

WAS IM BILD ZU SEHEN IST  Crumb-Trail markiert „Export„ als aktive Stufe. Linkes Karten-
Grid „Choose Export Format“ mit allen sechs Optionen: PLY (Standard-3DGS, 742 
KB, mit vollen SH-Koeffizienten — hier vorausgewählt mit blauem Häkchen), SPZ 
(komprimiertes 3DGS-Format, ~90 % kleiner als PLY, 74 KB), glTF (mit KHR_​gaussian_​
splatting-Extension, 708 KB), .splat (Web-Viewer-kompatibel via antimatter15, 96 KB), 
Orbit Video (360°-MP4 der Szene, Live-Größenberechnung), Web Viewer (eigenständi
ges HTML mit eingebettetem 3D-Viewer, 133 KB). Größenangaben werden live aus 
dem aktuellen Gaussian-Count und Format-Overhead berechnet. Rechts „Export Histo
ry„ listet bereits abgeschlossene Exporte mit Format-Pill, Dateiname und Zeitstempel 
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— Click reveals im Finder. Primary-CTA unten links: „Export PLY (3DGS Standard)“ mit 
Gaussian-Subtitle „2,991 Gaussians · SH degree 3″.

Im letzten Schritt wählst du aus 6 Export-Formaten (PLY, SPZ, glTF, .splat, Orbit-Video, 
Web-Viewer) per 2-spaltiges Karten-Grid, klickst Export und wählst Speicherort im ma
cOS-Dialog. Rechts läuft eine History aller bisherigen Exports — bei der Karten-Auswahl 
wird unter jeder Karte sofort der geschätzte Dateigröße angezeigt, sodass du z. B. SPZ 
bevorzugst, wenn du ins Web willst (klein), und PLY, wenn du in eine andere Software 
(SuperSplat, Postshot, Blender via Plugin) importieren willst (groß und vollständig).

C-39 2-Column Format Grid

WO

Linke Hauptseite des Export-Schritts.

T E C H N I S C H

Karten-Raster mit zwei flexiblen Spalten und 12 
Punkt Abstand. Iteriert über die im Einsteiger-
Modus angebotenen Formate — eine gefilterte Teil
menge der vollen Formatliste, die nur die 6 wich
tigsten Formate enthält: PLY, SPZ, glTF, .splat, Or
bit-Video, Web-Viewer. Compressed-PLY und SOG 
werden NUR im Expert-Modus angeboten.

E I N FAC H  G E S AG T

Ein Karten-Raster mit den 6 For­
maten, die im Einsteiger-Modus 
relevant sind: PLY (Standardfor­
mat für andere 3D-Tools), SPZ 
(komprimierte Variante für Web), 
glTF (offizieller Web3D-Stan­
dard), .splat (für antimatter15-
Web-Viewer), Orbit-Video (fer­
tiges MP4 zum Vorzeigen), 
und Web Viewer (eigenständige 
HTML-Datei mit eingebettetem 
3D-Player). Damit deckst du 90 
% der Anwendungsfälle ab. Wenn 
du eines der weniger gängigen 
Formate brauchst (Compressed-
PLY oder SOG für extreme Kom­
primierung), wechsle in den Ex­
pert-Modus, dort sind alle 8 For­
mate verfügbar. Die kompakte 
Auswahl hier ist bewusst, damit 
Einsteiger nicht von der Vielfalt 
überfordert werden.
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C-40 Format Card Button

WO

Jede Karte im Grid.

T E C H N I S C H

Schlichter Button mit Karten-Layout: Icon (z. B. Do
kument-Zipper für PLY, Archivbox für SPZ, Video-
Icon für Orbit-Video) oben, Format-Name als Head
line, Beschreibungs-Caption (2-zeilig gekürzt), dar
unter die geschätzte Dateigröße (live aus Format, 
Gaussian-Count und SH-Degree berechnet und als 
KB/MB formatiert). Bei Klick wird das Format aus
gewählt. Selektierte Karte bekommt Akzent-Hinter
grund, Akzent-Border und ein Häkchen-Icon rechts 
oben. Tooltip ist die Format-Beschreibung.

E I N FAC H  G E S AG T

Eine Karte pro Format. Klick eine 
an, sie wird mit Akzent-Farbe und 
einem Häkchen hervorgehoben, 
und der Export-Button darunter 
passt seinen Text an („Export 
PLY„, „Export SPZ“, etc.). Jede 
Karte zeigt ein passendes Sym­
bol, den Namen, eine zweizei­
lige Kurz-Erklärung und die ge­
schätzte Dateigröße bei deinem 
aktuellen Trainings-Ergebnis. Die 
Größe hilft dir, sinnvoll zu wäh­
len — wenn du das Ergebnis 
per Email schicken willst, nimm 
die kleinste Variante (meist SPZ 
oder .splat); wenn du in einer an­
deren 3D-Software weiterarbei­
ten willst, nimm die mit der bes­
ten Kompatibilität (typischerwei­
se PLY). Beim Hovern über einer 
Karte zeigt der Tooltip eine aus­
führlichere Beschreibung, falls 
du die Unterschiede zwischen 
den Formaten unklar findest.

C-41 Video Duration Slider

WO

Unter dem Format-Grid, sichtbar nur wenn ein 
Video-Format gewählt ist (Orbit-Video oder Social-
Video).

T E C H N I S C H

Schieberegler 3–30 Sekunden in 1-Sekunden-
Schritten, bindet an die Video-Länge im App-Zu
stand. Maximal-Breite 300 Pixel. Wird nur einge
blendet, wenn ein Video-Format ausgewählt ist. Bei 
nicht-Video-Formaten wird der Schieberegler kom
plett aus der Ansicht entfernt — kein toter Platz.

E I N FAC H  G E S AG T

Wenn du ein Orbit-Video als Ex­
port wählst, kannst du hier die 
Länge bestimmen. 3 Sekunden 
= sehr schnelle Drehung, 30 Se­
kunden = langsame, ruhige Dre­
hung um dein Modell. Für Social-
Media-Reels (Instagram, TikTok) 
ist meistens 6–10 Sekunden ide­
al — lang genug, um das Mo­
dell zu zeigen, kurz genug, dass 
die Zuschauer nicht abspringen. 
Bei Präsentationen oder Portfo­
lio-Videos darfst du gerne 15–
20 Sekunden nehmen. Der Slider 
taucht nur auf, wenn ein Video-
Format ausgewählt ist; bei Datei-
Formaten wie PLY oder SPZ wäre 
er sinnlos und ist ausgeblendet.
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C-42 Export Button

WO

Unter dem Format-Grid (und unter dem Duration-
Slider, falls Video gewählt).

T E C H N I S C H

Großer Akzent-Button. Label: „Export {Format-Na
me}„, Share-Icon. Bei Klick wird der macOS-Spei
chern-Dialog mit Format-passender Endung und 
Default-Filename „scene.{ext}“ geöffnet; bei Bestä
tigung wird der Export an die gewählte URL ge
schrieben. Deaktiviert, wenn kein Trainings-Ergeb
nis vorhanden ist oder ein Export bereits läuft.

E I N FAC H  G E S AG T

Klick, wähle Speicherort im ma­
cOS-Dialog, fertig — die App 
schreibt die Datei im gewähl­
ten Format an die ausgewähl­
te Stelle. Default-Name ist „sce­
ne.{Endung}„ (z. B. „scene.ply“ 
oder „scene.spz„), den kannst 
du im Dialog beliebig ändern, 
bevor du speicherst. Der But­
ton ist grau, solange noch kein 
Training-Ergebnis vorhanden ist 
(sollte hier nie passieren, weil 
du sonst gar nicht im Export-
Schritt wärst) oder ein anderer 
Export bereits läuft. Sobald der 
Export läuft, erscheint darunter 
eine Fortschrittsanzeige; die App 
bleibt bedienbar, du kannst also 
schon den nächsten Export vor­
bereiten.

C-43 Export Progress Bar

WO

Unter dem Export-Button, sichtbar nur während ein 
Export läuft.

T E C H N I S C H

Fortschrittsanzeige mit Max-Breite 300 Pixel, dar
unter Caption „Exporting… N %„. Der Wert läuft von 
0 bis 1 und wird während des Schreibens aktuali
siert — bei PLY in Chunks von 10 000 Gaussians, bei 
SPZ einmalig nach Quantisierung, bei Orbit-Video in 
Frame-Intervallen.

E I N FAC H  G E S AG T

Während der Export läuft, siehst 
du hier den Fortschritt als 
schmalen Balken plus Prozent-
Anzeige. PLY ist meistens binnen 
Sekunden fertig, weil die Datei 
einfach binär weggeschrieben 
wird. SPZ braucht etwas länger, 
weil die Daten dabei quantisiert 
und komprimiert werden. Orbit-
Video ist der zeitaufwendigste 
Export — hier wird jedes einzel­
ne Frame neu gerendert; je nach 
Auflösung und Länge kann das 
eine Minute oder länger dauern. 
Während des Exports bleibt die 
App bedienbar, du kannst also 
schon das nächste Format vorbe­
reiten oder im Viewport weiter­
klicken.
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C-44 Export Error Display

WO

Unter der Progress-Bar, sichtbar nur wenn beim 
letzten Export ein Fehler aufgetreten ist.

T E C H N I S C H

Rote Zeile mit Warning-Icon und Fehlertext. Rote 
8 %-Hintergrund-Opacity, abgerundete Ecken. Max-
Breite 400 Pixel. Häufige Fehlerursachen: SOG er
wartet cwebp  im System-PATH (nicht App-Store-
konform); Schreibfehler bei vollem Plattenspeicher; 
Sandbox-Fehler bei Speicherzielen außerhalb des 
erlaubten Bereichs.

E I N FAC H  G E S AG T

Wenn der Export schiefgeht, er­
scheint hier in Rot eine kurze 
Klartext-Beschreibung des Pro­
blems. Meistens ist die Ursache 
offensichtlich — kein Platz auf 
der Platte, keine Schreibrechte 
für den Zielordner, oder ein Ziel­
ort außerhalb der Sandbox-er­
laubten Bereiche. Speziell beim 
SOG-Format kommt es vor, dass 
cwebp  im System fehlt; in die­

sem Fall ist SOG nicht nutzbar 
und du musst auf SPZ auswei­
chen. Wenn die Fehlermeldung 
unklar ist, schau in das Log-Ver­
zeichnis (Help → Open Training 
Logs), dort steht ausführlicher, 
was schiefgegangen ist. Im Zwei­
fel hilft es, einfach einen ande­
ren Speicherort zu wählen — z. 
B. den Schreibtisch.

C-46 Export History List

WO

Rechte Seite des Export-Schritts.

T E C H N I S C H

Liste über die Export-Historie (persistent als JSON 
in den UserDefaults gespeichert, nach jedem er
folgreichen Export gepflegt). Jede Zeile zeigt 
Format-Badge (klein, akzentfarbig), Timestamp 
(HH:mm), Dateiname (1 Zeile gekürzt) und forma
tierte Dateigröße. Klick auf eine Zeile öffnet Finder 
mit selektierter Datei. Empty-State: „No exports 
yet„.

E I N FAC H  G E S AG T

Eine Liste deiner bisherigen Ex­
ports — Format, Uhrzeit, Datei­
name, Größe, in chronologischer 
Reihenfolge. Klick eine Zeile an 
und die Datei wird im Finder 
hervorgehoben angezeigt, ohne 
dass du selber durch Ordner na­
vigieren musst. Praktisch, wenn 
du eine Stunde später nochmal 
den letzten Export brauchst und 
nicht mehr weißt, wo du ihn hin­
gespeichert hast — die History 
merkt sich das. Wenn du noch 
nie etwas exportiert hast, steht 
hier ein freundlicher Hinweis „No 
exports yet„. Die Liste übersteht 
Neustarts der App, weil sie in den 
UserDefaults gespeichert ist.
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C-48 History Context Menu (Rechtsklick)

WO

Rechtsklick auf eine History-Zeile.

T E C H N I S C H

Kontextmenü auf jedem Listen-Eintrag mit zwei 
Aktionen: „Reveal in Finder„ (öffnet Finder mit se
lektierter Datei, wie der Einfach-Klick) und „Copy 
Path“ (legt den vollen Dateipfad als Text in die 
Zwischenablage). Letzteres ist nützlich für Drag-
and-Drop in andere Apps oder zur Übergabe an die 
Kommandozeile.

E I N FAC H  G E S AG T

Rechtsklick auf einen History-
Eintrag öffnet ein kleines Menü 
mit zwei Aktionen. „Reveal in 
Finder„ macht dasselbe wie ein 
normaler Klick — öffnet den Fin­
der mit selektierter Datei, sodass 
du sie sofort siehst. „Copy Path“ 
legt den kompletten Dateipfad in 
die Zwischenablage, sodass du 
ihn z. B. in Terminal-Befehlen, 
in andere Apps oder in eine No­
tiz einfügen kannst. Besonders 
praktisch, wenn du den Export 
an jemanden weitergeben willst 
oder ihn in einem anderen Pro­
gramm öffnen möchtest, das per 
Pfad-Eingabe arbeitet. Funktio­
nal ein kleines, aber hilfreiches 
Detail, das auf Mac-typische Be­
dienungs-Patterns setzt.

Wann ist der Workflow abgeschlossen?

Nach einem erfolgreichen Export hast du dein 3D-Modell als Datei auf der Platte und 
die History zeigt einen neuen Eintrag. Es gibt keinen „Done„-Button — du kannst 
beliebig viele Exports in unterschiedlichen Formaten anhängen, ohne neu zu trainieren. 
Wenn du zurück zur Vorschau willst (z. B. um nochmal eine Kameraperspektive zu 
prüfen), nutze den Back-Button in der unteren Navigationsleiste. Wenn du eine komplett 
neue Szene anfangen willst, gehe via Back bis Z1 und nutze dort Clear All, oder File → 
New Project (Cmd+⇧+N).

Wechsel zu Expert-Modus

Drücke jederzeit Cmd+2 oder wähle Mode → Expert Mode ( M8 ). Der gesamte 
Zustand bleibt erhalten: importierte Bilder, gewähltes Preset, laufendes oder fertiges 
Training, fertige Punktwolke, Export-History, sogar die aktuelle Stage. Im Expert-Modus 
wird statt der vier-Schritt-Bühne das volle Inspector-Sidebar gezeigt mit allen ~150 
Bedienfeldern. Insbesondere: der Project Navigator (siehe Kapitel 2) bietet die erweiter
ten Bild-Operationen (Minus-Button, Backspace-Delete, Cmd-Z-Undo, Quick-Look-Vor
schau), die Live-Preview im Viewport während des Trainings, sowie alle Loss-, MCMC-, 
Densification- und Mip-Splatting-Parameter. Cmd+1 schaltet zurück in den Einsteiger-
Modus — auch das verliert keinen Zustand.
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Häufige Fragen

Warum bleibt mein Start-Processing-Button grau?

Du hast noch keine Bilder oder kein Video importiert. Zieh mindestens eine Datei in 
die Drop-Zone oder benutze „Browse Files„. Sobald die Bilder-Liste rechts mindestens 
einen Eintrag enthält, wird der Button aktiv. (Bei nur 1–2 Bildern startet er zwar, aber 
SfM bricht direkt mit Fehler ab — siehe das rote Validation-Banner.)

Warum ist mein Export-Button gesperrt?

Im Einsteiger-Modus gibt es zwei Stufen: (a) Wenn die Trainings-Pipeline noch nicht 
fertig ist und du keine hast, ist der Button deaktiviert — du musst erst Z2 abschließen. 
(b) Wenn du die Vollversion noch nicht gekauft hast (PurchaseManager.hasAccess == 
false), siehst du statt der Export-Bühne eine Sperr-Ansicht mit Schloss-Icon und „Un
lock Full Version„-Button, der das Purchase-Sheet öffnet. Quick- und Preview-Presets 
erlauben Training kostenlos, aber Export ist Premium.

Warum kann ich kein Preset auswählen?

Du kannst es auswählen — aber wenn du ein Premium-Preset (Balanced, Quality, 
MCMC-Varianten) ohne gekaufte Vollversion antippst, springt der Picker automatisch 
zurück auf Preview und das Purchase-Sheet öffnet sich. Quick und Preview sind die 
einzigen kostenlos benutzbaren Presets.

Warum ist meine Drop-Zone leer und gestrichelt-grau, obwohl ich Bilder reinzie
he?

Wahrscheinlich ein UTI-Typ-Mismatch. Die App akzeptiert JPG, PNG, TIFF, HEIC, MP4, 
MOV plus die App-eigenen Splat-Formate. Andere Bildformate (BMP, GIF, WebP, RAW-
Formate) werden NICHT erkannt. Wenn du sicher bist, dass dein Bildtyp dabei sein 
müsste, prüfe die Dateinamens-Endung — die App geht primär nach Extension, nicht 
nach Datei-Inhalt.

Warum dauert SfM so lange, obwohl ich nur 30 Bilder habe?

Apple Photogrammetry skaliert nicht linear — bei manchen Bild-Konstellationen (Innen
räume mit komplexen Texturen, Bewegungsunschärfe, schlechtes Licht) braucht es 
deutlich länger als das Bild-Count vermuten lässt. Wenn SfM nach 10+ Minuten bei 30 
Bildern noch hängt, breche ab und versuche es nochmal mit besserem Material, oder 
wechsle in den Expert-Modus und probiere COLMAP/Native-SfM (Cmd+2 → Inspector 
→ Camera Alignment).

Wo finde ich meine Training-Logs?

Help → Open Training Logs (Cmd+⇧+L). Das öffnet ~/​Documents/​RadianceKit/​Logs/​
. Jede Trainings-Session schreibt eine eigene JSONL-Datei mit Timestamp im Dateina
men — erste Zeile ist die Konfiguration, danach folgt eine Progress-Zeile alle 100 
Iterationen, letzte Zeile ist die Summary mit Final-Loss und Success-Flag.
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